Nokia Eksos N20
Narrowband Multiservice Access Node
System Release C2.0 DEU
User Manual
C33993.20 B0
The following products comply with the protection requirements of the European Union Council Directive 89/336/EEC relating to electromagnetic compatibility (EMC), provided that installed using EMC-compatible installation practices (installation in mechanical housings stated to be EMC-compatible and using cabling material [at least as well shielded] and practices as stated in relevant Nokia Networks user manuals):

<table>
<thead>
<tr>
<th>Product code</th>
<th>Product name</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eksos N20</td>
<td>Narrowband Multiservice Access Node (see the System Release Item List)</td>
<td>C2.0 DEU</td>
</tr>
</tbody>
</table>

The information in this document is subject to change without notice and describes only the product defined in the introduction of this documentation. This document is intended for the use of Nokia Networks’ customers only for the purposes of the agreement under which the document is submitted, and no part of it may be reproduced or transmitted in any form or means without the prior written permission of Nokia Networks. The document has been prepared to be used by professional and properly trained personnel, and the customer assumes full responsibility when using it. Nokia Networks welcomes customer comments as part of the process of continuous development and improvement of the documentation.

The information or statements given in this document concerning the suitability, capacity, or performance of the mentioned hardware or software products cannot be considered binding but shall be defined in the agreement made between Nokia Networks and the customer. However, Nokia Networks has made all reasonable efforts to ensure that the instructions contained in the document are adequate and free of material errors and omissions. Nokia Networks will, if necessary, explain issues which may not be covered by the document.

Nokia Networks’ liability for any errors in the document is limited to the documentary correction of errors. Nokia Networks WILL NOT BE RESPONSIBLE IN ANY EVENT FOR ERRORS IN THIS DOCUMENT OR FOR ANY DAMAGES, INCIDENTAL OR CONSEQUENTIAL (INCLUDING MONETARY LOSSES), that might arise from the use of this document or the information in it.

This document and the product it describes are considered protected by copyright according to the applicable laws.

Nokia logo is a registered trademark of Nokia Corporation.

Any other trademarks mentioned in the documents are the property of their respective companies, and they are mentioned for identification purposes only.

Copyright © Nokia Corporation 2002–2003. All rights reserved.
## Document History

<table>
<thead>
<tr>
<th>Document</th>
<th>Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>C33993001PE_00</td>
<td>20 Sep 2002</td>
<td></td>
</tr>
<tr>
<td>C33993001PE_A0</td>
<td>29 Jan 2003</td>
<td>System Release Notes updated.</td>
</tr>
</tbody>
</table>
## Contents

1. Guide to Documentation  
   C33836004SE_01
2. Installation  
   C33836005SE_B0
3. Commissioning and Maintenance  
   C33836006SE_D0
4. System Release Item List  
   EKN C2.0HA.1
5. System Release Notes  
   C33993002SE_A0
6. Product Description  
   C33836008SE_A1
7. Specific Instructions for Germany  
   C33993003SE_00
8. Glossary  
   C33836010SE_01
9. Index  
   C33993004SE_A0
1 About this document

This document describes the contents of the *Nokia Eksos N20 User Manual* and includes:

- a navigation aid for the documents included in the user manual
- a short description of the documents included in the user manual
- product codes of the Eksos N20 documents and documents of related products
- instructions for ordering the documents
- a description of typographic conventions.

For brevity, the name *Eksos N20* is used in place of Nokia Eksos N20 throughout this manual.

Readership

This manual is for the application planning, installation and commissioning personnel of the Eksos N20 Node. The reader is assumed to have basic knowledge of V5, SDH and PCM voice transmission.

Your comments

We appreciate your feedback. If you have any comments about this or any other manual, please fill in the documentation comment form in the beginning of this manual and return it to your local Nokia representative.
2 Contents of the User Manual

This chapter helps you to find the documents that help you in accomplishing your tasks. The navigation aid in Table 1 lists the documents, which are then described briefly in the order that they appear in the manual.

<table>
<thead>
<tr>
<th>Task</th>
<th>Documents</th>
</tr>
</thead>
</table>
| Finding your way through the manual       | – Guide to Documentation  
                                            | – Index  
                                            | – Glossary                                       |
| Familiarisation with Eksos N20            | – Product Description                               |
| Planning the application                  | – Product Description  
                                            | – System Release Item List  
                                            | – System Release Notes  
                                            | – Country-Specific Instructions                |
| Installing Eksos N20                      | – Installation                                      |
| Commissioning Eksos N20                   | – Commissioning and Maintenance  
                                            | – System Release Notes  
                                            | – Country-Specific Instructions                |
| Maintaining and upgrading Eksos N20       | – Commissioning and Maintenance  
                                            | – System Release Notes                         |

Table 1 Navigation aid

Installation

- installation procedure
- instructions for routing the cables
- instructions for connecting power supplies and station alarms
- instructions for installing the subrack or cartridge
- instructions for protective earthing
- instructions for installing cable trays
- instructions for connecting interfaces
- instructions for installing plug-in units
- instructions for Ethernet cabling
- instructions for installing auxiliary equipment and accessories.

Commissioning and Maintenance

- commissioning requirements and procedure
- detailed instructions for commissioning
- instructions for managing alarms
- instructions for upgrading
- instructions for installing and using Eksos N20 Node Manager
- list of alarm messages.
System Release Item List
- lists all the products and the product codes for the hardware items and their respective software.

System Release Notes
- compatibility with other products
- new features
- known problems and remedies.

Product Description
- detailed information needed, for example, for application planning: examples of network and node applications, network management tools, construction, power supply, and specifications.

Country-Specific Instructions
- instructions for configuring country-specific settings
- brief description of the key features supported by the mapping.

Glossary
- all technical abbreviations used in the manual
- key terms.

Index

Note
The Eksos N20 User Manual does not provide any in depth description of the SYNFONET Access Node (SAN). For a detailed description of SAN, refer to its documentation.
3 Ordering documents

Tables 2 and 3 contain the titles of the documents and the product codes that are needed when ordering them.

To order the documents, contact your Nokia sales representative.

<table>
<thead>
<tr>
<th>Eksos N20 documents</th>
<th>Product code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nokia Eksos N20 Product Overview</td>
<td>C33478.20</td>
</tr>
<tr>
<td>Nokia Eksos N20 C2.0 Upgrade Instructions</td>
<td>C33836.22</td>
</tr>
<tr>
<td>ACCNODE CD-ROM</td>
<td>C33463.93</td>
</tr>
</tbody>
</table>

Table 2  Product codes for Eksos documents

<table>
<thead>
<tr>
<th>Documents of related products</th>
<th>Product code</th>
</tr>
</thead>
<tbody>
<tr>
<td>T35025.** OSI-DCN Adaptor User Manual</td>
<td>C33585.20</td>
</tr>
<tr>
<td>T30406 ETSI Rack Installation Instructions</td>
<td>C33472.20</td>
</tr>
<tr>
<td>T30400.01/.02 ETSI Rack Installation Instructions</td>
<td>C33912.20</td>
</tr>
<tr>
<td>DC-PSA Operating Instructions</td>
<td>C33470.20</td>
</tr>
<tr>
<td>Fuse Terminal Operating Instructions</td>
<td>C33508.20</td>
</tr>
<tr>
<td>Fan Unit Operating Instructions</td>
<td>C33461.20</td>
</tr>
</tbody>
</table>

Table 3  Product codes for documents of related products

There is no separate **Nokia Eksos N20 Node Manager User’s Manual**. Instructions on how to start using Eksos N20 Node Manager are given in the Commissioning and Maintenance document of the Eksos N20 User Manual and in the on-line help of the Nokia Eksos N20 Node Manager software.

The **Product Overview** describes the basic features and applications of the Eksos N20 Node. It presents general information about the product and is not tied to any specific Eksos N20 release.

The **ACCNODE CD-ROM** includes the customer documents of Nokia’s Access Nodes and the documents for the related mechanical structures and power supplies.
4 Typographic conventions

Table 4 presents the typographic conventions used in the *Eksos N20 User Manual*.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Italic font</em></td>
<td>Indicates a word or phrase that is emphasised, or a reference to the title of a manual, for example: Refer to the <em>Nokia Eksos N20 User Manual</em>.</td>
</tr>
<tr>
<td><em>Bold font</em></td>
<td>Indicates the title of a window, or an option, command, field, group or button, or anything that you must type exactly as it appears, for example: Help → Index means: choose Index from the Help menu. A:\install means: type A:\install</td>
</tr>
<tr>
<td>ALL CAPITALS</td>
<td>Indicate a directory or file name, for example: INSTALL.EXE</td>
</tr>
<tr>
<td>SMALL CAPITALS</td>
<td>Indicate the keys of the terminal keyboard, for example: CTRL</td>
</tr>
<tr>
<td></td>
<td>Indicates the start of a procedure.</td>
</tr>
<tr>
<td></td>
<td>Indicates the end of a document.</td>
</tr>
</tbody>
</table>

**Table 4** Typographic conventions
Nokia Eksos N20

Narrowband Multiservice Access Node

Installation
The information in this document is subject to change without notice and describes only the product defined in the introduction of this documentation. This document is intended for the use of Nokia Networks’ customers only for the purposes of the agreement under which the document is submitted, and no part of it may be reproduced or transmitted in any form or means without the prior written permission of Nokia Networks. The document has been prepared to be used by professional and properly trained personnel, and the customer assumes full responsibility when using it. Nokia Networks welcomes customer comments as part of the process of continuous development and improvement of the documentation.

The information or statements given in this document concerning the suitability, capacity, or performance of the mentioned hardware or software products cannot be considered binding but shall be defined in the agreement made between Nokia Networks and the customer. However, Nokia Networks has made all reasonable efforts to ensure that the instructions contained in the document are adequate and free of material errors and omissions. Nokia Networks will, if necessary, explain issues which may not be covered by the document.

Nokia Networks’ liability for any errors in the document is limited to the documentary correction of errors. Nokia Networks WILL NOT BE RESPONSIBLE IN ANY EVENT FOR ERRORS IN THIS DOCUMENT OR FOR ANY DAMAGES, INCIDENTAL OR CONSEQUENTIAL (INCLUDING MONETARY LOSSES), that might arise from the use of this document or the information in it.

This document and the product it describes are considered protected by copyright according to the applicable laws.

NOKIA logo is a registered trademark of Nokia Corporation.

Any other trademarks mentioned in the documents are the property of their respective companies, and they are mentioned for identification purposes only.

Copyright © Nokia Corporation 2000-2002. All rights reserved.
### Document History

<table>
<thead>
<tr>
<th>Document</th>
<th>Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>C33836005SE_00</td>
<td>13 Dec 2000</td>
<td></td>
</tr>
<tr>
<td>C33836005SE_A0</td>
<td>9 Apr 2001</td>
<td></td>
</tr>
<tr>
<td>C33836005SE_B0</td>
<td>4 Jan 2002</td>
<td></td>
</tr>
</tbody>
</table>
Contents

Chapter 1
About this document ............................................. 1

Chapter 2
Precautions ......................................................... 3

Chapter 3
Installation procedure ........................................... 7
  3.1 Task list ..................................................... 7
  3.2 Tools ....................................................... 9

Chapter 4
Routing the cables and optical fibres ....................... 11
  4.1 Routing electrical cables and installing strain reliefs .... 11
  4.2 Marking cables ............................................. 13
  4.3 Laying optical fibres ....................................... 15
    4.3.1 Handling ............................................. 15
    4.3.2 Routing ............................................. 15

Chapter 5
Connecting the station alarms and power supply ............ 19
  5.1 17-slot subrack .............................................. 19
    5.1.1 Jumper settings ...................................... 19
    5.1.2 Power supply interfaces .......................... 22
  5.2 8-slot cartridge .......................................... 28
    5.2.1 Jumper settings ...................................... 28
    5.2.2 Power supply interfaces .......................... 30
Chapter 6
Installing the 17-slot subrack ............................................. 33
6.1 Construction ............................................................... 33
6.2 Mounting the subrack to rack ........................................ 34
6.3 Mounting the subrack on the wall ................................. 37
6.4 Mounting the bottom plate .......................................... 39
6.5 Installing the service connector panel ............................ 40

Chapter 7
Installing the 8-slot cartridge ............................................. 41
7.1 Construction ............................................................... 41
7.2 Mounting the cartridge shelf to the rack ...................... 42
7.3 Mounting the cartridge onto cartridge shelf ............... 43

Chapter 8
Protective earthing ......................................................... 47
8.1 Earthing a station ......................................................... 47
8.2 Earthing the rack (protective earth) ............................. 49
8.3 Earthing the subrack ..................................................... 50

Chapter 9
Installing the cable trays ................................................. 53

Chapter 10
Connecting the interfaces .................................................. 57
10.1 Eksos N20 cables ......................................................... 58
10.2 Node Control Unit ....................................................... 60
10.2.1 2 Mbit/s interfaces .................................................. 61
10.2.2 Synchronisation interfaces ...................................... 62
10.2.3 Q1/AUX management interface .............................. 63
10.2.4 External supervisory interface ................................. 64
10.2.5 Q3 management interface ....................................... 64
10.3 Line Measurement Unit ............................................... 65
10.3.1 External supervision interface ................................. 65
10.3.2 External test access interface ................................. 65
10.4 PSTN and ISDN units .................................................. 67
10.5 TR2M4 unit ............................................................... 71
10.6 Data Interface Units ..................................................... 73
10.7 SAN CORE2M units .................................................... 77
10.7.1 Coaxial 2 Mbit/s interfaces (TRIB) ......................... 78
10.7.2 Symmetrical 2 Mbit/s interfaces (TRIB) .................... 78
10.7.3 Auxiliary interface (AUX) ....................................... 79
10.7.4 Synchronisation interfaces (SR, ST) ....................... 79
Chapter 11
Installing and cabling the plug-in units ............................. 81
11.1 Unit locations ................................................................. 82
11.1.1 Coding system of the unit slots ....................................... 82
11.1.2 Recommended unit slots ............................................... 83
11.2 Handling plug-in units ....................................................... 85
11.3 Inserting plug-in units ....................................................... 86
11.4 Fitting blanking plates for unused unit locations ..................... 87
11.5 Cabling plug-in units ......................................................... 88
11.5.1 Inserting and replacing connector carriers ......................... 88
11.5.2 Cabling the Data Interface Unit ....................................... 89
11.5.3 Tying electrical cables to cable trays ................................. 91
11.6 Connecting Eksos N20 to SAN ........................................... 91
11.7 Service switch cabling ....................................................... 95

Chapter 12
Ethernet cabling ................................................................. 101

Chapter 13
Installing auxiliary equipment and accessories .......................... 105
13.1 Fan unit ................................................................. 105
13.2 Air deflectors ............................................................. 107
13.3 Subrack front cover ....................................................... 108
Chapter 1
About this document

Before beginning the installation, make sure that you have an installation plan available.

This document describes the general methods for mechanical installation and cabling of the Eksos N20 equipment.

In addition to this document, you will also need separate installation documents for the Rack, DC-PSA, Fan Unit, SYNFONET Access Node (SAN) CORE2M unit and OSI-DCN Adaptor, and Indoor / Outdoor Cabinet, if used.

This document provides advice on:

- Precautions (Chapter 2)
- Installation procedure: task list and tools required (Chapter 3)
- Routing cables and optical fibres (Chapter 4)
- Connecting station alarms and power supply (Chapter 5)
- Installing the subrack (Chapter 6)
- Installing the cartridge (Chapter 7)
- Protective earthing (Chapter 8)
- Installing cable trays (Chapter 9)
- Connecting interfaces (Chapter 10)
- Installing and cabling plug-in units (Chapter 11)
- Ethernet cabling (Chapter 12)
- Installing auxiliary equipment and accessories (Chapter 13).
Chapter 2
Precautions

This chapter describes the general precautions that have to be taken into consideration when installing Eksos N20. These precautions ensure the safe and correct installation and operation of Eksos N20. Notice that specific chapters can also contain warnings and cautions that should be taken into account when performing specific tasks.

Laser safety


<table>
<thead>
<tr>
<th>The maximum output power of Class 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1310 nm nominal wavelength</td>
</tr>
<tr>
<td>1550 nm nominal wavelength</td>
</tr>
</tbody>
</table>

Caution
Using this equipment in ways other than those specified in these instructions may result in exposure to laser radiation exceeding the limits of laser Class 1.
Anti-static precautions

Caution
Always take standard anti-static precautions (such as wearing a wrist strap earthed to the rack) when handling Eksos N20 units because they contain components which may be damaged by static discharge.

Sensitivity to ESD

Caution
Always use shielded cables with the RJ45 connectors on the Node Control Unit (NCU). Units may be disturbed by high-level static discharges to the NCU if unshielded cables are used for cabling the RJ45 connectors (Q1, AUX, Supervision and Q3 Ethernet 10Base-T connectors) on the NCU.

Handling plug-in units

Caution
In addition to taking standard anti-static precautions, it is important to only hold plug-in units by the insertion/extraction levers or by the back connectors.

Inserting units in subrack

Caution
Take care that the front plate of the unit is in good contact with the subrack after the finger screws have been tightened.
Installing Eksos N20 on the wall in closed spaces

Caution
Do not install Eksos N20 directly above a radiator or a heater or store flammable materials near Eksos N20. Also, ensure that the air circulation in the space is adequate.

Caution
The wall onto which the Wall Mounting Set is installed must be suitable by its bearing capacity and fire resistance grading.

Optical fibres and electrical cables

Caution
Where electrical cables and optical fibres are run through the same shaft, use optical fibre guides to prevent damage occurring to the optical fibres.

Caution
Make sure that there is a standard protecting plate installed below the rack.

Storage of manuals

Caution
Do not store any paper or user manuals at the bottom of the rack. They may obstruct the air flow and cause a fire hazard.
Chapter 3
Installation procedure

Before beginning the installation, make sure that you have an installation plan available.

This chapter gives the order in which to install the equipment and lists the tools that are needed to install Eksos N20.

3.1 Task list

Before the actual installation procedure can be started, it is essential that the installation has been properly planned and that you are familiar with the installation and thermal plans.

We recommend that you start the installation from the subrack which is furthest from the point where cables enter the rack. Start with the lowermost subrack when guiding cables upwards and the uppermost subrack when guiding cables downwards. Note that a cabling space of at least 1U is recommended above and below the subrack if cable trays are not used.

Caution

Take standard anti-static precautions (such as wearing a wrist strap earthed to the rack) when handling the units because they contain components which may be damaged by static discharge.

Planning the installation

1. Make an installation plan. See the Product Description for information needed for the plan.

2. Make sure that you have the required tools available. See section 3.2.

3. Make sure that you have the required Eksos N20 equipment to complete the installation procedure.
Installing the Eksos N20 node

1. If air deflectors have been preinstalled, remove them to allow for more cabling space.

2. If you are installing the node on the wall using the Wall Mounting Set, mount the set on the wall.

3. Bring the cables into the rack or cabinet. A subrack or cartridge can be used as a gauge to determine the correct cable length of each separate cable when installing the cables into the rack or cabinet. See Chapter 4.

4. Mark the signal cables and power supply cables. See Chapter 4.

5. Install the power supply unit(s) into the rack, cabinet or Wall Mounting Set.

6. Preinstall the power supply, alarm and earthing cables to be connected to the extension board of the subrack or cartridge. See Chapter 5.

7. Install the 17-slot subrack into the rack or cabinet, set the extension board jumpers and connect the power supply, alarm and earthing cables. See Chapter 6.

8. If you are using the 8-slot cartridge, first install the cartridge shelf into the rack or cabinet and then mount the cartridge on it. Set the extension board jumpers and connect the power supply, alarm and earthing cables. See Chapter 7.

9. Connect the earthing wire to the rack earth. See Chapter 8.

10. Install the cable trays. See Chapter 9.

11. Cut the cables to the correct length and fit connectors onto them.

12. Install the plug-in units in their places. See Chapter 11.

13. Connect the cables to unit connectors. Adjust the cables in the rack, if necessary, and then fully tighten the cable ties. See Chapters 10 and 11.

Finishing off the installation procedure

1. Fit blanking plates to all unused locations of the subrack to provide electromagnetic shielding. See section 11.4.

2. Mark down the required information about the installation on a marking sheet.

3. Install air deflectors and fan units, if needed. See Chapter 13. Connect the power and alarm cable to the fan unit.

4. Fix the subrack cover in its place, if needed. See section 13.3. Note that the 8-slot cartridges do not have covers.

5. Install the bottom plate below the rack.

6. Make sure that there are no manuals or other papers stored at the bottom of the rack.
3.2 Tools

Below is a list of general tools for installing the subracks, air deflectors and other such mechanical parts.

- anti-static wrist strap
- allen key, 5 mm
- screwdriver, flat head, 0.6 x 3.5 mm
- screwdriver, flat head, 1.0 x 6 mm
- screwdriver, cross head, Pozidriv No. 2 and 3
- crimp tool ABIKO no. 3165, size 16
- socket wrench, 10 mm
- socket wrench, 13 mm
- adjustable wrench
- side-cutting pliers
- pointed pliers
- tool for the coaxial 1.0/2.3 (DIN 41626/2) connector, for example, crimping tool Rosenberger 11W150–000
- tool for Euroconnector, for example, wire-wrapping tool Gardner Denver, wrap bit 506445, sleeve 507100
- tool for RJ45 connectors, for example, Stewart Connector Systems hand crimping tool A32900.02
- cable tie tool.

The recommended connector and cable types are described in Chapter 5 (power cables) and Chapter 10 (signal cables).
Chapter 4
Routing the cables and optical fibres

Before beginning to route the cables, make sure that you have a routing plan available.

4.1 Routing electrical cables and installing strain reliefs

Note
The shielding foil of the cables does not usually need to be earthed except in the following special cases:
• when using the RJ45 connectors (Q1, AUX, Supervision and Q3 Ethernet 10Base-T) on the NCU
• when the CORE2M interface is connected by Euroconnector to the NCU
• when connecting the CORE2M synchronisation transmit connection to the NCU synchronisation input
• always when a Data Interface Unit (DIU) is used.

Routing the cables
1. Mount the strain reliefs to both sides of the rack. The orientation of the strain reliefs depends on whether cables are routed from the top or bottom of the rack. See Figure 1.

2. Mark the cables and install the connectors. See section 4.2.

3. Route the cables via the sides of the rack from the subrack location. It is easier to handle the connectors in the subrack connector field if cables are routed equally through both sides of the rack. An empty subrack can be used as a guide to gauge the exact length of cable required. See Figure 1.

4. Loosely tie the electrical signal cables to the strain reliefs using cable ties. Each cable must be tied to the strain relief closest to the subrack to which the cable is connected, see Figure 1.
Note
Only fully tighten the cable ties when the connectors have been connected to the plug-in units and any excess cable has been eased out of the rack.

Installing strain reliefs

Figure 1 Strain reliefs, tying the cables and schematic diagram of electrical cable routing
4.2 Marking cables

To facilitate the cable installation, maintenance, upgrades, and possible changes in the cabling, mark the cables and record their route information.

<table>
<thead>
<tr>
<th>Product</th>
<th>Order code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Labels for laser printers</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TI 22736.10</td>
<td></td>
<td>2500 pcs Brady LAT–17–361 laser marker for &gt;4 mm cables</td>
</tr>
<tr>
<td>TI 22736.20</td>
<td></td>
<td>500 pcs Brady LAT–18–361 laser marker for 5–7 mm cables</td>
</tr>
<tr>
<td>TI 22736.30</td>
<td></td>
<td>1000 pcs Brady LAT–19–361 laser marker for 8–11 mm cables</td>
</tr>
<tr>
<td><strong>Labelling Pen</strong></td>
<td>TI 22738</td>
<td>Brady Labelling Pen MP–1</td>
</tr>
<tr>
<td><strong>Labels for Bradymarker XC printer</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TI 22737.10</td>
<td></td>
<td>250 pcs Brady WML–211–292 marker for &gt;4 mm cables</td>
</tr>
<tr>
<td>TI 22737.20</td>
<td></td>
<td>250 pcs Brady WML–311–292 marker for 5–7 mm cables</td>
</tr>
<tr>
<td>TI 22737.30</td>
<td></td>
<td>100 pcs Brady WML–711–292 marker 8–11 mm cables</td>
</tr>
<tr>
<td><strong>Label Printer</strong></td>
<td>TI 22739</td>
<td>Bradymarker XC Printer for TI 22737.xx Labels</td>
</tr>
</tbody>
</table>

Table 1 Recommended accessories for cable marking

Mark both ends of the cable by wire labels according to Figure 2, for example.

![Marking strip on a cable](image)

Figure 2 A marking strip on a cable
Example of marking structure
This example shows how to mark the cable to a connector.

![Example marking code]

Figure 3 Example of the marking code

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rack row: Rack rows follow consecutive numbering beginning from the front.</td>
</tr>
<tr>
<td>B</td>
<td>Rack: The location of the rack within the row is indicated by the letters A, B, C, ....</td>
</tr>
<tr>
<td>2</td>
<td>Shelf (or power supply unit): The location of the shelf (or power supply) in the rack is indicated by the numbers 1, 2, 3 .... The marking begins at the top of the rack.</td>
</tr>
<tr>
<td>A</td>
<td>Cartridge: The location of the cartridge in the shelf is indicated by letters A, B, C .... The marking begins from the left of the shelf.</td>
</tr>
<tr>
<td>1</td>
<td>Unit location: The location of the plug-in unit in the cartridge is indicated by numbers 1, 2, 3 .... The marking begins from the left of the cartridge.</td>
</tr>
<tr>
<td>TRIB</td>
<td>Interface abbreviation: The abbreviations of the interfaces are shown on the plug-in units, see Chapter 10.</td>
</tr>
<tr>
<td>R8</td>
<td>Connector abbreviation: Needed when coaxial 2 Mbit/s interfaces are used, see Chapter 10.</td>
</tr>
</tbody>
</table>

Table 2 Example on how to mark the cable to a connector
4.3 Laying optical fibres

4.3.1 Handling

Optical fibres require more careful handling than copper cables. To minimise the handling, it is recommended that the copper cables are installed before the optical fibres. Follow the recommendations for the bending radius and tensile strength of the fibre. Do not leave fibres under permanent stress.

Caution

Do not tie optical fibres to strain reliefs.

4.3.2 Routing

Routing in a rack

Route the fibres through fibre cable reels, if available. This way the fibres do not need to be cut to exact lengths, and the installation becomes easier. The reels are installed in the fibre cable reel cases above the rack, see Figure 5.

Bring the optical fibres into the back or side of the rack. Route the fibres through the fibre guides which are located on top of each subrack. See Figure 4. Fibre guides are available in the cabling accessory sets of optical plug-in units. If cable trays are used, fit guiding tubes onto the optical cables and then route in the same way as PSTN and ISDN cables.

![Figure 4](image_url)  Using the optical fibre guides on the subrack
Note
Use separate protective fibre guiding tubes if the electrical cables and optical fibres are guided through the same cable shaft.

Figure 5  Optical fibre routing scheme
Fibre cable reels
Each fibre needs one reel, into which the excess length, maximum 3 m, is rolled. Each fibre cable reel case holds 16 reels. For each rack, four cases can be installed, so a maximum of 64 fibres per rack can be handled.

Figure 6  Fibre cable reel and a case
Follow the instructions shown in Figure 7. When placing the reel into the case, be careful not to leave the fibres under the edge of the reel. Mark the reels on the marking labels on the case, so that the fibres can be easily identified later by maintenance personnel, for instance.

Figure 7  Rolling the excess fibre length into fibre cable reel
Chapter 5
Connecting the station alarms and power supply

This chapter describes the power supply and alarm cabling combinations for the Eksos N20 17-slot subrack, 8-slot cartridge and fan unit.

You might also need to refer to the following documents:

- *DC-PSA Operating Instructions*, which also covers the Capacitor Unit and Extension Unit
- *Fan Unit Operating Instructions*.

5.1 17-slot subrack

5.1.1 Jumper settings

Jumpers J1 to J4 are located on the extension board inside the subrack or cartridge, and must be set prior to installing plug-in units. J1 and J3 are used to connect the power supply buses together. J2 and J4 are used to connect the positive supply voltages to earth. See Figures 8 and 9, and Table 3.

![Jumper locations on the subrack extension board](image)

Figure 8 Jumper locations on the subrack extension board
Each power supply bus provides power to units in alternate unit slot locations; one bus provides power to the odd-numbered unit locations in the range 1-15 and the other provides power to the even-numbered slots and slot 17. The buses can be connected together using jumpers J1 and J3. See Figure 9.

![Figure 9](image)

**Figure 9**  Power supply distribution and jumper principle

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Position</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1</td>
<td>1-2 (default)</td>
<td>VNB1 and VNB2 not connected together</td>
</tr>
<tr>
<td></td>
<td>2-3</td>
<td>VNB1 and VNB2 connected together</td>
</tr>
<tr>
<td>J2</td>
<td>1-2</td>
<td>VPB1 and GND not connected together</td>
</tr>
<tr>
<td></td>
<td>2-3 (default)</td>
<td>VPB1 and GND connected together</td>
</tr>
<tr>
<td>J3</td>
<td>1-2 (default)</td>
<td>VPB1 and VPB2 not connected together</td>
</tr>
<tr>
<td></td>
<td>2-3</td>
<td>VPB1 and VPB2 connected together</td>
</tr>
<tr>
<td>J4</td>
<td>1-2</td>
<td>VPB2 and GND not connected together</td>
</tr>
<tr>
<td></td>
<td>2-3 (default)</td>
<td>VPB2 and GND connected together</td>
</tr>
</tbody>
</table>

Caution: Use only default jumper settings for PSTN and ISDN applications.

**Table 3**  Jumper settings on the extension board
Connecting the station alarms and power supply

Figure 10 and Table 4 illustrate the connections between a power supply unit and Eksos N20. The numbers given to the cables in Figure 10 refer to the numbers in column ‘#’ of Table 4. The order codes of these cables can be found in the System Release Item List.

To handle the high current requirements of some Eksos N20 nodes, it is recommended that all of the power cables are fitted as shown in Figure 10 and that the jumpers are set to their default positions. For partially populated nodes, this makes it easy to add plug-in units in the future without having to change the jumper settings. If the Eksos N20 node has less than eight PSTN or ISDN units, jumpers J1 and J3 can be reset to position 2-3 and feeding can be done with cable 2 (see Figure 10).

![Diagram of connections between power supply, Eksos N20, and Fan Unit]

**Figure 10**  Power and alarm cables from a power supply to Eksos N20 and Fan Unit

<table>
<thead>
<tr>
<th>#</th>
<th>Cable</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alarm cable NTM 0.5 m, 1.0 m, 1.5 m, 2.0 m, 2.5 m, 3.0 m, 3.5 m</td>
<td>DC-PSA to Eksos N20</td>
</tr>
<tr>
<td>2 and 3</td>
<td>Power cable NTM 0.5 m, 1.0 m, 1.5 m, 2.0 m, 2.5 m, 3.0 m, 3.5 m</td>
<td>DC-PSA, Extension Unit to Eksos N20</td>
</tr>
<tr>
<td>4</td>
<td>Fan interface cable Eksos 1.5 m</td>
<td>Eksos N20 to Fan Unit</td>
</tr>
</tbody>
</table>

**Table 4**  Power and alarm cables with Eksos N20
5.1.2 **Power supply interfaces**

The following connectors are located on the extension board at the back of the subrack (See Figure 11):

- station alarm (‘rack alarm’) (P4)
- service switch (‘external switch matrix’) (J2A: A to D)
- test bus (J3A: C and D) and SV1 measurement (J3A: A and B)
- future option (J11, J12, J13)
- power supply (P1, P2)
- fan connector (J5)
- signalling voltage (P3).

Fuses X1 and X2 on the extension board provide protection for the fans and are each rated at 2.5 A.

---

**Figure 11** Power supply panel of the subrack extension board
Connecting the station alarms and power supply

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>RK_AL_A</td>
<td>1</td>
<td>Rack alarm A</td>
</tr>
<tr>
<td>RK_AL_B</td>
<td>2</td>
<td>Rack alarm B</td>
</tr>
<tr>
<td>RK_AL_D</td>
<td>3</td>
<td>Rack alarm D</td>
</tr>
<tr>
<td>VAP5</td>
<td>4</td>
<td>Auxiliary power supply</td>
</tr>
<tr>
<td>RK_AL_E2</td>
<td>5</td>
<td>Rack alarm E2</td>
</tr>
<tr>
<td>RK_AL_F2</td>
<td>6</td>
<td>Rack alarm F2</td>
</tr>
<tr>
<td>N.C.</td>
<td>7</td>
<td>Unused</td>
</tr>
<tr>
<td>N.C.</td>
<td>8</td>
<td>Unused</td>
</tr>
<tr>
<td>GND</td>
<td>9</td>
<td>Ground</td>
</tr>
<tr>
<td>GND</td>
<td>10</td>
<td>Ground</td>
</tr>
<tr>
<td>GND</td>
<td>11</td>
<td>Ground</td>
</tr>
<tr>
<td>GND</td>
<td>12</td>
<td>Ground</td>
</tr>
<tr>
<td>RK_AL_E1</td>
<td>13</td>
<td>Rack alarm E1</td>
</tr>
<tr>
<td>RK_AL_F1</td>
<td>14</td>
<td>Rack alarm F1</td>
</tr>
<tr>
<td>N.C.</td>
<td>15</td>
<td>Unused</td>
</tr>
</tbody>
</table>

Table 5  Station alarm outputs connector P4 pinout
### Table 6  Service switch connector block J2A pinout

<table>
<thead>
<tr>
<th>RJ45 connectors</th>
<th>Pinout of the service switch connector block J2A as seen from the front of the subrack extension board</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC1A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC1B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC2A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC2B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC3A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC3B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC4A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC4B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC5A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC5B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC6A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC6B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC7A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC7B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC8A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>PSVC8B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC1A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC1B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC2A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC2B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC3A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC3B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC4A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC4B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC5A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC5B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC6A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC6B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC7A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC7B</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC8A</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>ISVC8B</td>
</tr>
</tbody>
</table>
### Connecting the station alarms and power supply

#### Pinout of the test bus and SV1 measurement connector block J3A as seen from the front of the subrack extension board

<table>
<thead>
<tr>
<th>RJ45 connectors</th>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TL1A</td>
<td>1</td>
<td>Line test bus</td>
</tr>
<tr>
<td></td>
<td>TL1B</td>
<td>2</td>
<td>Line test bus</td>
</tr>
<tr>
<td></td>
<td>TI1B</td>
<td>3</td>
<td>Inward test bus</td>
</tr>
<tr>
<td></td>
<td>TI1A</td>
<td>4</td>
<td>Inward test bus</td>
</tr>
<tr>
<td></td>
<td>N.C.</td>
<td>5</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>N.C.</td>
<td>6</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>N.C.</td>
<td>7</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>GND</td>
<td>8</td>
<td>Ground</td>
</tr>
</tbody>
</table>

Table 7  Test bus and SV1 measurement connector block J3A pinout. See also Table 31 for the NCU/LMU front connector pinout.

#### Pinout of connectors J11 and J12 as seen from the front of the subrack extension board

<table>
<thead>
<tr>
<th>Phoenix mini-combicon connector</th>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>VNB</td>
<td>1</td>
<td>Negative battery voltage</td>
</tr>
<tr>
<td></td>
<td>N.C.</td>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>VPB</td>
<td>3</td>
<td>Positive battery voltage</td>
</tr>
</tbody>
</table>

Table 8  Connector J11 and J12 pinout (future option)
### Phoenix mini-combicon connector

**Pinout of connector J13 as seen from the front of the subrack extension board**

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SV1</td>
<td>1</td>
<td>Signalling voltage</td>
</tr>
<tr>
<td>N.C.</td>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>GND</td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>

**Table 9** Connector J13 pinout (future option)

### AMP Mate'n'lok

**Pinout of the power connectors P1 and P2 as seen from the front of the subrack extension board**

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNB</td>
<td>1</td>
<td>Negative battery voltage</td>
</tr>
<tr>
<td>VPB</td>
<td>2</td>
<td>Positive battery voltage</td>
</tr>
<tr>
<td>GND</td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>

**Table 10** Power connector P1 and P2 pinout

### AMP Mate'n'lok

**Pinout of the signalling voltage connector P3 as seen from the front of the subrack extension board**

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SV1</td>
<td>1</td>
<td>Signalling voltage</td>
</tr>
<tr>
<td>GND</td>
<td>2</td>
<td>Ground</td>
</tr>
<tr>
<td>GND</td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>

**Table 11** Signalling voltage connector P3 pinout
### Pinout of the fan power and alarm connector J5 as seen from the front of the subrack extension board

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNB2_FAN</td>
<td>1</td>
<td>Fan 2 negative battery voltage</td>
</tr>
<tr>
<td>N.C.</td>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>GND</td>
<td>3</td>
<td>Ground</td>
</tr>
<tr>
<td>FALA</td>
<td>4</td>
<td>Fan alarm A</td>
</tr>
<tr>
<td>VNB1_FAN</td>
<td>5</td>
<td>Fan 1 negative battery voltage</td>
</tr>
<tr>
<td>N.C.</td>
<td>6</td>
<td>Unused</td>
</tr>
<tr>
<td>VPB_FAN</td>
<td>7</td>
<td>Fan positive battery voltage</td>
</tr>
<tr>
<td>VPB_FAN</td>
<td>8</td>
<td>Fan positive battery voltage</td>
</tr>
<tr>
<td>FALB</td>
<td>9</td>
<td>Fan alarm B</td>
</tr>
</tbody>
</table>

**Table 12** Fan power and alarm connector J5 pinout
5.2 8-slot cartridge

5.2.1 Jumper settings

Jumpers J2 and NR1 are located on the extension board inside the cartridge, and must be set prior to installing the plug-in units. J2 is used to connect the positive supply voltages to earth. See Figure 12 and Table 13.

![Figure 12: Jumper locations on the cartridge extension board](image)

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Position</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>J2</td>
<td>1-2</td>
<td>VPB1 and GND not connected together</td>
</tr>
<tr>
<td></td>
<td>2-3 (default)</td>
<td>VPB1 and GND connected together</td>
</tr>
<tr>
<td>NR1</td>
<td>1–3, 2–4 (default)</td>
<td>When a SAN unit is installed in the cartridge, Fan Unit alarms E1 or F1 are not on.</td>
</tr>
<tr>
<td></td>
<td>3–5, 4–6</td>
<td>When a SAN unit is installed in the cartridge, Fan Unit alarms E1 or F1 are enabled.</td>
</tr>
</tbody>
</table>

Caution: Use only default jumper settings for jumper J2 in PSTN and ISDN applications.

Table 13 Jumper settings on the extension board
Figure 13 and Table 14 illustrate the connections between a power supply unit and Eksos N20. The numbers given to the cables in Figure 13 refer to the numbers in column “#” of Table 14. The order codes of these cables can be found in the System Release Item List.

To handle the high current requirements of some Eksos N20 nodes, it is recommended that all of the power cables are fitted as shown in Figure 13 and that the jumpers are set to the default positions. For partially populated nodes, this makes it easy to add plug-in units in the future without having to change the jumper settings.

**Figure 13**  Power and alarm cables from a power supply to Eksos N20 and Fan Unit

<table>
<thead>
<tr>
<th>#</th>
<th>Cable</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alarm cable NTM 0.5 m, 1.0 m, 1.5 m, 2.0 m, 2.5 m, 3.0 m, 3.5 m</td>
<td>DC-PSA to Eksos N20</td>
</tr>
<tr>
<td>2 and 3</td>
<td>Power cable NTM 0.5 m, 1.0 m, 1.5 m, 2.0 m, 2.5 m, 3.0 m, 3.5 m</td>
<td>DC-PSA, Extension Unit to Eksos N20</td>
</tr>
<tr>
<td>4</td>
<td>Fan interface cable Eksos 1.5 m</td>
<td>Eksos N20 to Fan Unit</td>
</tr>
</tbody>
</table>

**Table 14**  Power and alarm cables with Eksos N20 and the 8-slot cartridge
5.2.2 Power supply interfaces

The following connectors are located on the extension board at the back of the cartridge (See Figure 14):

- station alarm (‘rack alarm’) (P4)
- fan connector (J5)
- service switch (‘external switch matrix’) (J2A: A to D)
- test bus (J3A: C and D) and SV1 measurement (J3A: A and B)
- power supply (P1)
- signalling voltage (P3)
- future option (J1, J3).

Fuse X1 on the extension board provides protection for the fans and is rated at 2.5 A.

Figure 14    Power supply panel of the cartridge extension board
### Pinout of the station alarm outputs connector P4 as seen from the front of the cartridge extension board

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>RK_AL_A</td>
<td>1</td>
<td>Rack alarm A</td>
</tr>
<tr>
<td>RK_AL_B</td>
<td>2</td>
<td>Rack alarm B</td>
</tr>
<tr>
<td>RK_AL_D</td>
<td>3</td>
<td>Rack alarm D</td>
</tr>
<tr>
<td>VAP5</td>
<td>4</td>
<td>Auxiliary power supply</td>
</tr>
<tr>
<td>RK_AL_E2</td>
<td>5</td>
<td>Rack alarm E2</td>
</tr>
<tr>
<td>RK_AL_F2</td>
<td>6</td>
<td>Rack alarm F2</td>
</tr>
<tr>
<td>N.C.</td>
<td>7</td>
<td>Unused</td>
</tr>
<tr>
<td>N.C.</td>
<td>8</td>
<td>Unused</td>
</tr>
<tr>
<td>GND</td>
<td>9</td>
<td>Ground</td>
</tr>
<tr>
<td>GND</td>
<td>10</td>
<td>Ground</td>
</tr>
<tr>
<td>GND</td>
<td>11</td>
<td>Ground</td>
</tr>
<tr>
<td>GND</td>
<td>12</td>
<td>Ground</td>
</tr>
<tr>
<td>RK_AL_E1</td>
<td>13</td>
<td>Rack alarm E1</td>
</tr>
<tr>
<td>RK_AL_F1</td>
<td>14</td>
<td>Rack alarm F1</td>
</tr>
<tr>
<td>N.C.</td>
<td>15</td>
<td>Unused</td>
</tr>
</tbody>
</table>

**Table 15** Station alarm outputs connector P4 pinout

### Pinout of the fan power and alarm connector J5 as seen from the front of the cartridge extension board

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNB2_FAN</td>
<td>1</td>
<td>Fan 2 negative battery voltage</td>
</tr>
<tr>
<td>N.C.</td>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>GND</td>
<td>3</td>
<td>Ground</td>
</tr>
<tr>
<td>FALA</td>
<td>4</td>
<td>Fan alarm A</td>
</tr>
<tr>
<td>VNB1_FAN</td>
<td>5</td>
<td>Fan 1 negative battery voltage</td>
</tr>
<tr>
<td>N.C.</td>
<td>6</td>
<td>Unused</td>
</tr>
<tr>
<td>VPB_FAN</td>
<td>7</td>
<td>Fan positive battery voltage</td>
</tr>
<tr>
<td>VPB_FAN</td>
<td>8</td>
<td>Fan positive battery voltage</td>
</tr>
<tr>
<td>FALB</td>
<td>9</td>
<td>Fan alarm B</td>
</tr>
</tbody>
</table>

**Table 16** Fan power and alarm connector J5 pinout

The pinout of connector blocks J2A and J3A is the same as on the extension board of the 17-slot subrack, see section 5.1.2.
### Table 17  Power connector P1

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNB</td>
<td>1</td>
<td>Negative battery voltage</td>
</tr>
<tr>
<td>VPB</td>
<td>2</td>
<td>Positive battery voltage</td>
</tr>
<tr>
<td>GND</td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>

### Table 18  Signalling voltage connector P3 pinout

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SV1</td>
<td>1</td>
<td>Signalling voltage</td>
</tr>
<tr>
<td>GND</td>
<td>2</td>
<td>Ground</td>
</tr>
<tr>
<td>GND</td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>

### Table 19  Connector J1 pinout (future option)

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNB</td>
<td>1</td>
<td>Negative battery voltage</td>
</tr>
<tr>
<td>N.C.</td>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>VPB</td>
<td>3</td>
<td>Positive battery voltage</td>
</tr>
</tbody>
</table>

### Table 20  Connector J3 pinout (future option)

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SV1</td>
<td>1</td>
<td>Signalling voltage</td>
</tr>
<tr>
<td>N.C.</td>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>GND</td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>
Chapter 6
Installing the 17-slot subrack

Before beginning the installation procedure, make sure that you have an installation plan available.

6.1 Construction

![Diagram of the 17-slot subrack](image)

Note: The mounting brackets can be adjusted 20 mm further back for installing the subrack into shallow racks.

Figure 15  17-slot subrack without front cover
6.2 Mounting the subrack to rack

A standard ETSI or 19” rack can contain either three or four Eksos subracks, depending on the power consumption and the number of ventilation components required.

An airspace of at least 1U in 19” racks or 25 mm in ETSI racks must be left beneath the front cover of the lowest subrack in the rack if cable trays are not used.

In a 2-meter high rack, the capacitor unit and the air deflector can be mutually exclusive options.

---

Note
We recommend that the fan unit is installed also in 3-subrack installations if the maximum number of units are installed in the rack.

---

Figure 16   Equipping recommendation for 19” racks
Installing the 17-slot subrack

1) Install as close to above and below the subrack as possible (max. 22 mm)

Figure 17  Equipping recommendations for ETSI racks
For 19” assembly, turn mounting brackets and fix them to opposite ends of the subrack.

Figure 18   Mounting the subrack to a rack (ETSI and 19”)

Cage nut position
6.3 Mounting the subrack on the wall

The Wall Mounting Set can be used for mounting 17-slot Eksos N20 subracks in small locations where space is a premium. In addition to the subrack, the Wall Mounting Set can also accommodate a DC-PSA, fan unit and connecting bar frame.

Figure 19  Eksos N20 in a Wall Mounting Set
The procedure for installing the subrack in a Wall Mounting Set is shown in Figure 20.

Install Eksos N20 in a Wall Mounting Set in the following order:

1. Eksos N20 subrack
2. DC-PSA
3. Connecting bar frame, if used
4. Fan unit.

When cable direction is upward, turn the cable support 180° and fix the support above the cable opening.

Figure 20  Installing Eksos N20 into Wall Mounting Set
6.4 Mounting the bottom plate

If the rack contains 1 to 3 subracks, install a bottom plate below the lowest subrack. If the rack is fully equipped (that is, contains 4 subracks), install only the floor plates.

When a Wall Mounting Set is used, the bottom plates are always used.

Figure 21 Installing the bottom plate below a rack
6.5 Installing the service connector panel

Attach the service connector panel to the rack edge or cabinet mounting rail, for example.

The Y-type connector on the service connector panel interface contains an integrated switch. When the node manager cable is not plugged in, a direct connection is formed past the connector.

Caution

The Ethernet connectors must not come into contact with any metal parts of the subrack or the service connector panel. Take care to correctly install the insulating plates and shields for the Ethernet connectors.

If only one subrack is to be installed, terminate the other interface of the Y-type connector as shown in Figure 23.

Connecting the service connector panel

1. Mount the service connector panel with the Y-type connector to the rack, see mounting principle in Figure 22.
2. Connect the Ethernet cables:
   - Connect the Ethernet cable from the Y-type connector to the NCU Q3 connector (Figure 22).
   - Connect Ethernet cables to other network elements if necessary.
   - Terminate the Ethernet where necessary (Ethernet terminated at the Y-type connector; Figure 23).

![Figure 22](image-url) Example on connecting the service connector panel

![Figure 23](image-url) Terminating the Ethernet connection at the Y-type connector
Chapter 7
Installing the 8-slot cartridge

Before beginning the installation procedure, make sure that you have an installation plan available.

7.1 Construction

Figure 24  Dimensions of the 8-slot cartridge

Recommended minimum installation height: 9 U (405 mm)
7.2 Mounting the cartridge shelf to the rack

The cartridge shelf is a rack mounting device for Eksos N20 8-slot cartridges. The cartridge shelf offers the possibility to install other equipment, such as broadband equipment, next to the Eksos N20 node.

The shelf can be installed in the ETSI or 19" rack. The installation procedure is shown in Figure 25.

**Figure 25** Mounting the cartridge shelf to a rack (ETSI and 19")
7.3 Mounting the cartridge onto cartridge shelf

Installing the cartridge shelf and cartridge to the rack is similar to the installation of the 17-slot subrack, except that you must take into account the required height of the complete cartridge shelf installation. This height depends on the equipment installed alongside the cartridge. On their own, the cartridge and shelf require 8U.

Typically, you need to reserve 10U for the cartridge and shelf, and 1U for the Fan Unit, which is installed below the cartridge shelf. The Fan Unit should be used when the equipment installed next to the Eksos N20 cartridge requires enhanced heat dissipation.

The greyed area indicates the space needed for broadband equipment if they are to be mounted on the same shelf as Eksos N20 cartridge.

Figure 26 Equipping example for the cartridge and shelf
Attach to the rack edge. See Figure 28.

Figure 27 Attaching the 8-slot cartridge to rack and shelf

Attach to the shelf. See Figure 29.

Figure 28 Attaching the side support to the rack edge
Figure 29 Attaching the cartridge to the shelf

The service connector panel is attached, for example, to the rack edge or cabinet mounting rail. For instructions, see Section 6.5.
Chapter 8
Protective earthing

Before beginning the earthing activities, make sure that you have an earthing plan available.

This chapter describes the general aspects of protective earthing. The exact earthing of terminals and connectors are specified in the rack documentation.

8.1 Earthing a station

WARNING
Adjacent racks must be linked by a conductor to prevent voltage differences occurring between them (safety risk).

Caution
The principles given below are especially important if there are outgoing subscriber lines connected.

When earthing multiple racks or rack rows, you should pay attention to the following details:

- Prevent any earth loops between protective earth and signal cable sleeves. If loops cannot be avoided, the area of the loops should be restricted to the minimum, for example by using cable trays for earthing.

- If external AC-powered apparatus (for example, measuring devices) are connected to the telecommunications equipment, the earthing should be done so that differences between earth potentials are avoided. This is achieved best by using isolation transformers in AC-feeding.

- The earth structure of multiple racks should form a mesh network to provide an impedance as low as possible.
The cross-connection frame must also be earthed.

For PSTN and ISDN applications, the battery plus must always be earthed at the DC-PSA.

---

**Figure 30** Earthing by connection to a single earthing conductor (in accordance with ETS 300253)

---

**Figure 31** Earthing by connection to an earthing bus (loop) conductor

Wherever possible, earthing should be implemented as shown in Figure 31. However, if no earthing bus conductor is available, connect the racks directly to the combiner bar or directly to the main earthing bar if it is closer or if there is no
combiner bar at all. The positive pole of the ACDC charger system should be connected to the same bar.

8.2 Earthing the rack (protective earth)

The rack can be earthed either with rigid connection to a mechanical support or cable tray, or with a separate wire. The recommended minimum cross-section for the conductor is 16 mm² for copper cables or 25 mm² for aluminium cables.

Each rack must be earthed to the main earthing bar (MEB) with a copper wire of at least 16 mm² either directly, via combiner bar or via earthing bus conductor.

![Diagram of rack earthing](image)

**Figure 32** Principle of rack earthing
8.3 Earthing the subrack

All metal surfaces that the user can access during normal operation should be connected together and directly to the rack. Exceptions to this rule of thumb are those cable sleeves and connectors which are recommended to be insulated from the earth to avoid circulating current.

⚠️ Caution
The Ethernet LAN cables must not be earthed to the rack or subrack.

If the equipment is placed into a dry environment (RH < 60% most of the time), the insulation stickers of the subrack mounting brackets should be left away to get the impedance between the subrack and the rack the smallest possible.

If the installation environment is humid (RH ≥ 60 % most of the time) and the rack is not of stainless steel, the mounting brackets must be insulated from the rack body to avoid corrosion. This is done by installing the stickers included in the grounding accessories. Also, the DC-PSA must be provided with stickers (see the DC-PSA documentation for further details).

The subrack must always be earthed with a separate wire, see Figure 33. The cross-section of the earthing conductor must be equal to or larger than that of the power feeding conductors. The recommended minimum cross-section is 6 mm². This wire has to be as short as possible.

![Connection on subrack and Connection to rack](image)

**Figure 33** Earthing wire connected to earthing point
For PSTN/ISDN applications, set the jumpers on the subrack to their default positions as described in Table 3 of Chapter 5 ‘Connecting station alarms and power supply’ (positive supply voltages are connected to earth).

---

**Note**

Make sure that all contacts are tight (in many racks, cage nuts do not make good contact).
Chapter 9
Installing the cable trays

Cable trays are installed above and below the subrack and cartridge. The space required by the cable tray is 1U. Without any cable trays, the subrack requires a space of 8U. The cable tray is used to secure the cable in place and also to ensure that the airflow through the rack installation is not obstructed.

**Figure 34** Principle of the cable tray installation (including subrack and air deflector)
To mount the cable trays to an ETSI rack (see Figure 35):

1. Fix the nuts to the rack.
2. Fix the mounting brackets to the cable tray.
3. Fix the cable tray to the rack with four screws.
4. If the Q3 interface is used, remove the sticker from the cable tray.

Figure 35   Mounting cable trays to ETSI rack
To mount the cable trays to a 19-inch rack (see Figure 36):

1. Fix the nuts to the rack.
2. Fix the mounting brackets to the cable tray.
3. Fix the cable tray to the rack with two screws.

Figure 36  Mounting cable trays to 19-inch rack
Chapter 10
Connecting the interfaces

Before beginning to connect the interfaces, make sure that you have a cabling plan available.

It is important that you have the required cables and connectors and you know which interfaces to connect before installing the plug-in units.

This chapter illustrates the connectors and pinout of the following Eksos N20 plug-in units:

- Node Control Unit (75 Ω)
- Node Control Unit (120 Ω)
- Node Control Unit (75/120 Ω)
- Line Measurement Unit
- PSTN unit
- ISDN BRA U-interface unit
- TR2M4 unit (75 Ω)
- TR2M4 unit (120 Ω)
- Data Interface Unit
- SAN CORE2M units.
## 10.1 Eksos N20 cables

<table>
<thead>
<tr>
<th>Cable type</th>
<th>Product Code</th>
<th>Connector and main usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>MMHS 4 x 2 x 0.4 + 0.4</td>
<td>TI 22701.41</td>
<td><strong>RJ45 connector</strong>&lt;br&gt;120 Ω synch in/out&lt;br&gt;Management interfaces&lt;br&gt;Service switch cabling&lt;br&gt;Test bus&lt;br&gt;SV1 measurement</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>C/4 Euroconnector</strong>&lt;br&gt;2 x 2 Mbit/s - 120 Ω&lt;br&gt;4 channel PSTN and ISDN-U</td>
</tr>
<tr>
<td>MMHS 8 x 2 x 0.4 + 0.4</td>
<td>TI 22701.42</td>
<td><strong>2 x C/4 Euroconnector</strong>&lt;br&gt;4 x 2 Mbit/s - 120 Ω&lt;br&gt;8 channel PSTN and ISDN-U</td>
</tr>
<tr>
<td>MMHS 2 x 8 x 2 x 0.4 + 0.4</td>
<td>TI 22701.70</td>
<td><strong>C/1 Euroconnector</strong>&lt;br&gt;16 channel PSTN and ISDN-U</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>C/2 Euroconnector</strong>&lt;br&gt;8 x 2 Mbit/s - 120 Ω&lt;br&gt;(CORE2M)</td>
</tr>
</tbody>
</table>

**Table 21**  
Twin pair cables used in Eksos N20 applications

<table>
<thead>
<tr>
<th>Cable type</th>
<th>Product Code</th>
<th>Connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaxial cable 75 double screen / Amgab</td>
<td>TI 22706.1</td>
<td>Coaxial 1.0/2.3</td>
</tr>
</tbody>
</table>

**Table 22**  
Coaxial cables used in Eksos N20 applications

<table>
<thead>
<tr>
<th>Optical fibre type</th>
<th>Connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>D3.0 mm SM-10/125 μm, blu</td>
<td>FC/PC and SC connector (CORE2M)</td>
</tr>
<tr>
<td>D3.0 mm SM-10/125 μm, orn</td>
<td>FC/PC and SC connector (CORE2M)</td>
</tr>
<tr>
<td>D2.0 mm SM-10/125 μm, yel, HF</td>
<td>FC/PC and SC connector (CORE2M)</td>
</tr>
</tbody>
</table>

**Table 23**  
Optical fibres used in Eksos N20 applications
Connecting the interfaces

<table>
<thead>
<tr>
<th>Cable type</th>
<th>Product Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Manager Cable</td>
<td>T30404.21</td>
</tr>
<tr>
<td>Ethernet Cable, 50 cm</td>
<td>T30405.01</td>
</tr>
<tr>
<td>80 cm Ethernet cable (Subrack–Subrack)</td>
<td>T30405.08</td>
</tr>
<tr>
<td>120 cm Ethernet Cable (Rack–Rack)</td>
<td>T30405.12</td>
</tr>
<tr>
<td>NTM Dual Ethernet Cable 1 m</td>
<td>T30436.01</td>
</tr>
<tr>
<td>NTM Dual Ethernet Cable 3 m / 0.5 m</td>
<td>T30436.02</td>
</tr>
</tbody>
</table>

**Table 24** Thin wire Ethernet cables used in Eksos N20 applications

<table>
<thead>
<tr>
<th>Accessory type</th>
<th>Product Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter for NTM Ethernet cable</td>
<td>T30436.03</td>
</tr>
<tr>
<td>T-BNC Connector with protective cover</td>
<td>T30405.11</td>
</tr>
<tr>
<td>50 Ω Ethernet Line Termination</td>
<td>T30405.10</td>
</tr>
<tr>
<td>Eksos Service Connector Panel</td>
<td>E30444.02</td>
</tr>
</tbody>
</table>

**Table 25** Thin wire Ethernet cabling accessories
10.2 Node Control Unit

**Figure 37** Connectors on NCU (75 Ω, 75/120 Ω and 120 Ω)
### 10.2.1 2 Mbit/s interfaces

#### Euroconnector

<table>
<thead>
<tr>
<th>Pin</th>
<th>a</th>
<th>b</th>
<th>c</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>15</td>
<td>R1A</td>
<td>N.C.</td>
<td>R1B</td>
<td>Receive 1</td>
</tr>
<tr>
<td>14</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>13</td>
<td>T1A</td>
<td>N.C.</td>
<td>T1B</td>
<td>Transmit 1</td>
</tr>
<tr>
<td>12</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>11</td>
<td>R2A</td>
<td>N.C.</td>
<td>R2B</td>
<td>Receive 2</td>
</tr>
<tr>
<td>10</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>9</td>
<td>T2A</td>
<td>N.C.</td>
<td>T2B</td>
<td>Transmit 2</td>
</tr>
<tr>
<td>8</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>7</td>
<td>R3A</td>
<td>N.C.</td>
<td>R3B</td>
<td>Receive 3</td>
</tr>
<tr>
<td>6</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>T3A</td>
<td>N.C.</td>
<td>T3B</td>
<td>Transmit 3</td>
</tr>
<tr>
<td>4</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>3</td>
<td>R4A</td>
<td>N.C.</td>
<td>R4B</td>
<td>Receive 4</td>
</tr>
<tr>
<td>2</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>1</td>
<td>T4A</td>
<td>N.C.</td>
<td>T4B</td>
<td>Transmit 4</td>
</tr>
</tbody>
</table>

Table 26 4 x 2 Mbit/s Euroconnector C/2

#### Diagrams

**Figure 38** 2 Mbit/s coaxial connectors
10.2.2 Synchronisation interfaces

<table>
<thead>
<tr>
<th>RJ45 female connector</th>
<th>Pins of the SYNC IN interface as seen from the front of the NCU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Pin</td>
</tr>
<tr>
<td>N.C.</td>
<td>1</td>
</tr>
<tr>
<td>N.C.</td>
<td>2</td>
</tr>
<tr>
<td>N.C.</td>
<td>3</td>
</tr>
<tr>
<td>SYN R1A</td>
<td>4</td>
</tr>
<tr>
<td>SYN R1B</td>
<td>5</td>
</tr>
<tr>
<td>N.C.</td>
<td>6</td>
</tr>
<tr>
<td>N.C.</td>
<td>7</td>
</tr>
<tr>
<td>N.C.</td>
<td>8</td>
</tr>
</tbody>
</table>

Table 27  SYNC IN connector pins

<table>
<thead>
<tr>
<th>RJ45 female connector</th>
<th>Pins of the SYNC OUT interface as seen from the front of the NCU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Pin</td>
</tr>
<tr>
<td>SYN T1A</td>
<td>1</td>
</tr>
<tr>
<td>SYN T1B</td>
<td>2</td>
</tr>
<tr>
<td>N.C.</td>
<td>3</td>
</tr>
<tr>
<td>N.C.</td>
<td>4</td>
</tr>
<tr>
<td>N.C.</td>
<td>5</td>
</tr>
<tr>
<td>N.C.</td>
<td>6</td>
</tr>
<tr>
<td>N.C.</td>
<td>7</td>
</tr>
<tr>
<td>N.C.</td>
<td>8</td>
</tr>
</tbody>
</table>

Table 28  SYNC OUT connector pins
10.2.3 Q1/AUX management interface

<table>
<thead>
<tr>
<th>RJ45 female connector</th>
<th>Pins of the Q1 interface as seen from the front of the NCU</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Signal</strong></td>
<td><strong>Pin</strong></td>
</tr>
<tr>
<td>Q1OCL+</td>
<td>1</td>
</tr>
<tr>
<td>Q1OCL–</td>
<td>2</td>
</tr>
<tr>
<td>Q1OUT+</td>
<td>3</td>
</tr>
<tr>
<td>Q1IN+</td>
<td>4</td>
</tr>
<tr>
<td>Q1IN–</td>
<td>5</td>
</tr>
<tr>
<td>Q1OUT–</td>
<td>6</td>
</tr>
<tr>
<td>Q1ICL+</td>
<td>7</td>
</tr>
<tr>
<td>Q1ICL–</td>
<td>8</td>
</tr>
</tbody>
</table>

¹) Clock is not used in asynchronous Q1 use.

Table 29  Q1 connector pins

<table>
<thead>
<tr>
<th>RJ45 female connector</th>
<th>Pins of the AUX interface as seen from the front of the NCU</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Signal</strong></td>
<td><strong>Pin</strong></td>
</tr>
<tr>
<td>AUXOCL+</td>
<td>1</td>
</tr>
<tr>
<td>AUXOCL–</td>
<td>2</td>
</tr>
<tr>
<td>AUXOUT+</td>
<td>3</td>
</tr>
<tr>
<td>AUXIN+</td>
<td>4</td>
</tr>
<tr>
<td>AUXIN–</td>
<td>5</td>
</tr>
<tr>
<td>AUXOUT–</td>
<td>6</td>
</tr>
<tr>
<td>AUXICL+</td>
<td>7</td>
</tr>
<tr>
<td>AUXICL–</td>
<td>8</td>
</tr>
</tbody>
</table>

Table 30  AUX connector pins
10.2.4 External supervisory interface

<table>
<thead>
<tr>
<th>RJ45 female connector</th>
<th>Pins of the external supervisory interface as seen from the front of the NCU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Pin</td>
</tr>
<tr>
<td>PAI1</td>
<td>1</td>
</tr>
<tr>
<td>PAI2</td>
<td>2</td>
</tr>
<tr>
<td>PAI3</td>
<td>3</td>
</tr>
<tr>
<td>PAIO1</td>
<td>4</td>
</tr>
<tr>
<td>PAIO2</td>
<td>5</td>
</tr>
<tr>
<td>IAV1</td>
<td>6</td>
</tr>
<tr>
<td>IAV2</td>
<td>7</td>
</tr>
<tr>
<td>GND</td>
<td>8</td>
</tr>
</tbody>
</table>

Table 31 External supervisory connector pins

10.2.5 Q3 management interface

<table>
<thead>
<tr>
<th>RJ45 female connector</th>
<th>Pins of the Q3 interface as seen from the front of the NCU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Pin</td>
</tr>
<tr>
<td>TD+</td>
<td>1</td>
</tr>
<tr>
<td>TD−</td>
<td>2</td>
</tr>
<tr>
<td>RD+</td>
<td>3</td>
</tr>
<tr>
<td>RXD</td>
<td>4</td>
</tr>
<tr>
<td>TXD</td>
<td>5</td>
</tr>
<tr>
<td>RD−</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>7</td>
</tr>
<tr>
<td>GND</td>
<td>8</td>
</tr>
</tbody>
</table>

Table 32 Q3 connector pins
10.3 Line Measurement Unit

![Connectors on LMU](image)

**Figure 39** Connectors on LMU

10.3.1 External supervision interface

The external supervision interface connector pinout is the same as for the NCU. Please refer to section 10.2.4.

10.3.2 External test access interface

This interface is not normally used. It should only be used when external test equipment will be used for testing the lines.
<table>
<thead>
<tr>
<th>RJ45 female connector</th>
<th>Pins of the external test access interface as seen from the front of the LMU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>TEST IN A</td>
<td>TEST IN B</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>External test in</td>
<td>External test in</td>
</tr>
</tbody>
</table>

**Table 33**  
External test connector pins
10.4 PSTN and ISDN units

Figure 40 Connectors on PSTN and ISDN plug-in units
### Table 34  
**PSTN TRIB 1-16 Euroconnector pins (Upper Euroconnector)**

<table>
<thead>
<tr>
<th>Pin</th>
<th>a</th>
<th>c</th>
<th><strong>Explanation</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>Pa1</td>
<td>Pb1</td>
<td>Line Interface 1</td>
</tr>
<tr>
<td>29</td>
<td>Pa2</td>
<td>Pb2</td>
<td>Line Interface 2</td>
</tr>
<tr>
<td>27</td>
<td>Pa3</td>
<td>Pb3</td>
<td>Line Interface 3</td>
</tr>
<tr>
<td>25</td>
<td>Pa4</td>
<td>Pb4</td>
<td>Line Interface 4</td>
</tr>
<tr>
<td>23</td>
<td>Pa5</td>
<td>Pb5</td>
<td>Line Interface 5</td>
</tr>
<tr>
<td>21</td>
<td>Pa6</td>
<td>Pb6</td>
<td>Line Interface 6</td>
</tr>
<tr>
<td>19</td>
<td>Pa7</td>
<td>Pb7</td>
<td>Line Interface 7</td>
</tr>
<tr>
<td>17</td>
<td>Pa8</td>
<td>Pb8</td>
<td>Line Interface 8</td>
</tr>
<tr>
<td>15</td>
<td>Pa9</td>
<td>Pb9</td>
<td>Line Interface 9</td>
</tr>
<tr>
<td>13</td>
<td>Pa10</td>
<td>Pb10</td>
<td>Line Interface 10</td>
</tr>
<tr>
<td>11</td>
<td>Pa11</td>
<td>Pb11</td>
<td>Line Interface 11</td>
</tr>
<tr>
<td>9</td>
<td>Pa12</td>
<td>Pb12</td>
<td>Line Interface 12</td>
</tr>
<tr>
<td>7</td>
<td>Pa13</td>
<td>Pb13</td>
<td>Line Interface 13</td>
</tr>
<tr>
<td>5</td>
<td>Pa14</td>
<td>Pb14</td>
<td>Line Interface 14</td>
</tr>
<tr>
<td>3</td>
<td>Pa15</td>
<td>Pb15</td>
<td>Line Interface 15</td>
</tr>
<tr>
<td>1</td>
<td>Pa16</td>
<td>Pb16</td>
<td>Line Interface 16</td>
</tr>
<tr>
<td>Euroconnector</td>
<td>Pins of the PSTN interface as seen from the front of the PSTN unit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a b c</td>
<td>Pin</td>
<td>a</td>
<td>c</td>
</tr>
<tr>
<td>a32 c32</td>
<td>31</td>
<td>Pa17</td>
<td>Pb17</td>
</tr>
<tr>
<td>a1 c1</td>
<td>29</td>
<td>Pa18</td>
<td>Pb18</td>
</tr>
<tr>
<td></td>
<td>27</td>
<td>Pa19</td>
<td>Pb19</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>Pa20</td>
<td>Pb20</td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>Pa21</td>
<td>Pb21</td>
</tr>
<tr>
<td></td>
<td>21</td>
<td>Pa22</td>
<td>Pb22</td>
</tr>
<tr>
<td></td>
<td>19</td>
<td>Pa23</td>
<td>Pb23</td>
</tr>
<tr>
<td></td>
<td>17</td>
<td>Pa24</td>
<td>Pb24</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>Pa25</td>
<td>Pb25</td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>Pa26</td>
<td>Pb26</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>Pa27</td>
<td>Pb27</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>Pa28</td>
<td>Pb28</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>Pa29</td>
<td>Pb29</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Pa30</td>
<td>Pb30</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Pa31</td>
<td>Pb31</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Pa32</td>
<td>Pb32</td>
</tr>
</tbody>
</table>

**Table 35** PSTN TRIB 17-32 Euroconnector pins (Lower Euroconnector)
## Pins of the ISDN U-interface as seen from the front of the ISDN unit

<table>
<thead>
<tr>
<th>Pin</th>
<th>a</th>
<th>c</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>A1</td>
<td>B1</td>
<td>Line Interface 1</td>
</tr>
<tr>
<td>29</td>
<td>A2</td>
<td>B2</td>
<td>Line Interface 2</td>
</tr>
<tr>
<td>27</td>
<td>A3</td>
<td>B3</td>
<td>Line Interface 3</td>
</tr>
<tr>
<td>25</td>
<td>A4</td>
<td>B4</td>
<td>Line Interface 4</td>
</tr>
<tr>
<td>23</td>
<td>A5</td>
<td>B5</td>
<td>Line Interface 5</td>
</tr>
<tr>
<td>21</td>
<td>A6</td>
<td>B6</td>
<td>Line Interface 6</td>
</tr>
<tr>
<td>19</td>
<td>A7</td>
<td>B7</td>
<td>Line Interface 7</td>
</tr>
<tr>
<td>17</td>
<td>A8</td>
<td>B8</td>
<td>Line Interface 8</td>
</tr>
<tr>
<td>15</td>
<td>A9</td>
<td>B9</td>
<td>Line Interface 9</td>
</tr>
<tr>
<td>13</td>
<td>A10</td>
<td>B10</td>
<td>Line Interface 10</td>
</tr>
<tr>
<td>11</td>
<td>A11</td>
<td>B11</td>
<td>Line Interface 11</td>
</tr>
<tr>
<td>9</td>
<td>A12</td>
<td>B12</td>
<td>Line Interface 12</td>
</tr>
<tr>
<td>7</td>
<td>A13</td>
<td>B13</td>
<td>Line Interface 13</td>
</tr>
<tr>
<td>5</td>
<td>A14</td>
<td>B14</td>
<td>Line Interface 14</td>
</tr>
<tr>
<td>3</td>
<td>A15</td>
<td>B15</td>
<td>Line Interface 15</td>
</tr>
<tr>
<td>1</td>
<td>A16</td>
<td>B16</td>
<td>Line Interface 16</td>
</tr>
</tbody>
</table>

### Table 36
ISDN U-interface TRIB 1-16 Euroconnector pins
10.5 TR2M4 unit

Figure 41 Connectors on TR2M4 (75 Ω and 120 Ω)
Table 37 4 x 2 Mbit/s Euroconnector C/2

<table>
<thead>
<tr>
<th>Pin</th>
<th>a</th>
<th>b</th>
<th>c</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>15</td>
<td>R1A</td>
<td>N.C.</td>
<td>R1B</td>
<td>Receive 1</td>
</tr>
<tr>
<td>14</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>13</td>
<td>T1A</td>
<td>N.C.</td>
<td>T1B</td>
<td>Transmit 1</td>
</tr>
<tr>
<td>12</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>11</td>
<td>R2A</td>
<td>N.C.</td>
<td>R2B</td>
<td>Receive 2</td>
</tr>
<tr>
<td>10</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>9</td>
<td>T2A</td>
<td>N.C.</td>
<td>T2B</td>
<td>Transmit 2</td>
</tr>
<tr>
<td>8</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>R3A</td>
<td>N.C.</td>
<td>R3B</td>
<td>Receive 3</td>
</tr>
<tr>
<td>6</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>T3A</td>
<td>N.C.</td>
<td>T3B</td>
<td>Transmit 3</td>
</tr>
<tr>
<td>4</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>3</td>
<td>R4A</td>
<td>N.C.</td>
<td>R4B</td>
<td>Receive 4</td>
</tr>
<tr>
<td>2</td>
<td>N.C.</td>
<td>GND</td>
<td>N.C.</td>
<td>Ground</td>
</tr>
<tr>
<td>1</td>
<td>T4A</td>
<td>N.C.</td>
<td>T4B</td>
<td>Transmit 4</td>
</tr>
</tbody>
</table>

Figure 42 2 Mbit/s coaxial connectors
10.6 Data Interface Units

Figure 43 Connectors on Data Interface Units (DIU)
### Euroconnector

<table>
<thead>
<tr>
<th>Pin</th>
<th>a</th>
<th>b</th>
<th>c</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>31</td>
<td>P1_104a</td>
<td>N.C.</td>
<td>P1_104b</td>
<td>Receive data</td>
</tr>
<tr>
<td>30</td>
<td>P1_142</td>
<td>N.C.</td>
<td>P1_102a</td>
<td>Test indicator/DTE ground</td>
</tr>
<tr>
<td>29</td>
<td>P1_114a</td>
<td>N.C.</td>
<td>P1_114b</td>
<td>Tx element timing (DCE)</td>
</tr>
<tr>
<td>28</td>
<td>P1_141</td>
<td>N.C.</td>
<td>–</td>
<td>Local loopback and reserved</td>
</tr>
<tr>
<td>27</td>
<td>P1_115a</td>
<td>N.C.</td>
<td>P1_115b</td>
<td>Rx element timing (DCE)</td>
</tr>
<tr>
<td>26</td>
<td>P1_113a</td>
<td>N.C.</td>
<td>P1_113b</td>
<td>Tx element timing (DTE)</td>
</tr>
<tr>
<td>25</td>
<td>P1_103a</td>
<td>N.C.</td>
<td>P1_103b</td>
<td>Transmit data</td>
</tr>
<tr>
<td>24</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>23</td>
<td>P1_106a</td>
<td>N.C.</td>
<td>P1_106b</td>
<td>Send</td>
</tr>
<tr>
<td>22</td>
<td>P1_107a</td>
<td>N.C.</td>
<td>P1_107b</td>
<td>Data set ready</td>
</tr>
<tr>
<td>21</td>
<td>P1_109a</td>
<td>N.C.</td>
<td>P1_109b</td>
<td>Data channel received</td>
</tr>
<tr>
<td>20</td>
<td>P1_108a</td>
<td>N.C.</td>
<td>P1_108b</td>
<td>Data terminal ready</td>
</tr>
<tr>
<td>19</td>
<td>P1_105a</td>
<td>N.C.</td>
<td>P1_105b</td>
<td>Send</td>
</tr>
<tr>
<td>18</td>
<td>P1_140</td>
<td>N.C.</td>
<td>P1_102b</td>
<td>Remote loopback/DCE ground</td>
</tr>
<tr>
<td>17</td>
<td>P1_102</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Signal ground</td>
</tr>
<tr>
<td>16</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>15</td>
<td>P2_104a</td>
<td>N.C.</td>
<td>P2_104b</td>
<td>Receive data</td>
</tr>
<tr>
<td>14</td>
<td>P2_142</td>
<td>N.C.</td>
<td>P2_102a</td>
<td>Test indicator/DTE ground</td>
</tr>
<tr>
<td>13</td>
<td>P2_114a</td>
<td>N.C.</td>
<td>P2_114b</td>
<td>Tx element timing (DCE)</td>
</tr>
<tr>
<td>12</td>
<td>P2_141</td>
<td>N.C.</td>
<td>–</td>
<td>Local loopback and reserved</td>
</tr>
<tr>
<td>11</td>
<td>P2_115a</td>
<td>N.C.</td>
<td>P2_115b</td>
<td>Rx element timing (DCE)</td>
</tr>
<tr>
<td>10</td>
<td>P2_113a</td>
<td>N.C.</td>
<td>P2_113b</td>
<td>Tx element timing (DTE)</td>
</tr>
<tr>
<td>9</td>
<td>P2_103a</td>
<td>N.C.</td>
<td>P2_103b</td>
<td>Transmit data</td>
</tr>
<tr>
<td>8</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>7</td>
<td>P2_106a</td>
<td>N.C.</td>
<td>P2_106b</td>
<td>Send</td>
</tr>
<tr>
<td>6</td>
<td>P2_107a</td>
<td>N.C.</td>
<td>P2_107b</td>
<td>Data set</td>
</tr>
<tr>
<td>5</td>
<td>P2_109a</td>
<td>N.C.</td>
<td>P2_109b</td>
<td>Data channel received</td>
</tr>
<tr>
<td>4</td>
<td>P2_108a</td>
<td>N.C.</td>
<td>P2_108b</td>
<td>Data terminal ready</td>
</tr>
<tr>
<td>3</td>
<td>P2_105a</td>
<td>N.C.</td>
<td>P2_105b</td>
<td>Send</td>
</tr>
<tr>
<td>2</td>
<td>P2_140</td>
<td>N.C.</td>
<td>P2_102b</td>
<td>Remote loopback/DCE ground</td>
</tr>
<tr>
<td>1</td>
<td>P2_102</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Signal ground</td>
</tr>
</tbody>
</table>

Table 38 2 x 2 Mbit/s Euroconnector C/2 for V.xx interfaces
### Euroconnector

#### Pins of the 2 x X.21 connector as seen from the front of the DIU

<table>
<thead>
<tr>
<th>Pin</th>
<th>a</th>
<th>b</th>
<th>c</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>31</td>
<td>P1_104a</td>
<td>N.C.</td>
<td>P1_104b</td>
<td>Receive data, R</td>
</tr>
<tr>
<td>30</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>29</td>
<td>P1_114a</td>
<td>N.C.</td>
<td>P1_114b</td>
<td>Signal element timing DCE, S</td>
</tr>
<tr>
<td>28</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>27</td>
<td>P1_115a</td>
<td>N.C.</td>
<td>P1_115b</td>
<td>Byte timing/DTE signal element timing, B</td>
</tr>
<tr>
<td>26</td>
<td>P1_113a</td>
<td>N.C.</td>
<td>P1_113b</td>
<td>Signal element timing DTE, X</td>
</tr>
<tr>
<td>25</td>
<td>P1_103a</td>
<td>N.C.</td>
<td>P1_103b</td>
<td>Transmit data, T</td>
</tr>
<tr>
<td>24</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>23</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>22</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>21</td>
<td>P1_109a</td>
<td>N.C.</td>
<td>P1_109b</td>
<td>Indication I</td>
</tr>
<tr>
<td>20</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>19</td>
<td>P1_105a</td>
<td>N.C.</td>
<td>P1_105b</td>
<td>Control C</td>
</tr>
<tr>
<td>18</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>17</td>
<td>P1_102</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Signal ground</td>
</tr>
<tr>
<td>16</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>15</td>
<td>P2_104a</td>
<td>N.C.</td>
<td>P2_104b</td>
<td>Receive data, R</td>
</tr>
<tr>
<td>14</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>13</td>
<td>P2_114a</td>
<td>N.C.</td>
<td>P2_114b</td>
<td>Signal element timing DCE, S</td>
</tr>
<tr>
<td>12</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Local loopback and reserved</td>
</tr>
<tr>
<td>11</td>
<td>P2_115a</td>
<td>N.C.</td>
<td>P2_115b</td>
<td>Byte timing/DTE signal element timing, B</td>
</tr>
<tr>
<td>10</td>
<td>P2_113a</td>
<td>N.C.</td>
<td>P2_113b</td>
<td>Signal element timing DTE, X</td>
</tr>
<tr>
<td>9</td>
<td>P2_103a</td>
<td>N.C.</td>
<td>P2_103b</td>
<td>Transmit data, T</td>
</tr>
<tr>
<td>8</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>7</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>6</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>5</td>
<td>P2_109a</td>
<td>N.C.</td>
<td>P2_109b</td>
<td>Indication I</td>
</tr>
<tr>
<td>4</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>3</td>
<td>P2_105a</td>
<td>N.C.</td>
<td>P2_105b</td>
<td>Control C</td>
</tr>
<tr>
<td>2</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>1</td>
<td>P2_102</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Signal ground</td>
</tr>
</tbody>
</table>

Table 39 2 x 2 Mbit/s Euroconnector C/2 for X.21 interfaces
<table>
<thead>
<tr>
<th>Pin</th>
<th>a</th>
<th>b</th>
<th>c</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>31</td>
<td>P1_104a</td>
<td>N.C.</td>
<td>P1_104b</td>
<td>Receive data</td>
</tr>
<tr>
<td>30</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>29</td>
<td>P1_114a</td>
<td>N.C.</td>
<td>P1_114b</td>
<td>Transmit element timing DCE</td>
</tr>
<tr>
<td>28</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>27</td>
<td>P1_115a</td>
<td>N.C.</td>
<td>P1_115b</td>
<td>Receive element timing DCE</td>
</tr>
<tr>
<td>26</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>25</td>
<td>P1_103a</td>
<td>N.C.</td>
<td>P1_103b</td>
<td>Transmit data</td>
</tr>
<tr>
<td>24</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>23</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>22</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>21</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>20</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>19</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>18</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>17</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>16</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>15</td>
<td>P2_104a</td>
<td>N.C.</td>
<td>P2_104b</td>
<td>Receive data</td>
</tr>
<tr>
<td>14</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>13</td>
<td>P2_114a</td>
<td>N.C.</td>
<td>P2_114b</td>
<td>Transmit element timing</td>
</tr>
<tr>
<td>12</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>11</td>
<td>P2_115a</td>
<td>N.C.</td>
<td>P2_115b</td>
<td>Receive element timing</td>
</tr>
<tr>
<td>10</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>9</td>
<td>P2_103a</td>
<td>N.C.</td>
<td>P2_103b</td>
<td>Transmit data</td>
</tr>
<tr>
<td>8</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>7</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>6</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>5</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>4</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>3</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>2</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
<tr>
<td>1</td>
<td>N.C.</td>
<td>N.C.</td>
<td>N.C.</td>
<td>Unused</td>
</tr>
</tbody>
</table>

Table 40 2 x 64 kbit/s Euroconnector C/2 for G.703 interface
10.7 SAN CORE2M units

Refer to the *Synfonet Access Node Operating Manual* for further instructions on installing the SAN CORE2M units.

![SAN CORE2M units diagram](image)

**Figure 44** Connectors on the SAN CORE2M units T31491.
10.7.1 Coaxial 2 Mbit/s interfaces (TRIB)

![Diagram showing Coaxial 2 Mbit/s interfaces (TRIB)]

As seen from the front of the SAN CORE2M unit

Figure 45 Coaxial 2 Mbit/s interfaces, TRIB. Notice that the interface numbering starts here from the bottom.

10.7.2 Symmetrical 2 Mbit/s interfaces (TRIB)

<table>
<thead>
<tr>
<th>Euroconnector</th>
<th>Pins of the 2 Mbit/s interface as seen from the front of the SAN CORE2M unit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pin</td>
</tr>
<tr>
<td></td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

Table 41 CORE2M symmetrical 2 Mbit/s interfaces connector, TRIB
10.7.3 Auxiliary interface (AUX)

<table>
<thead>
<tr>
<th>9-pole male D-connector</th>
<th>Pins of the SR auxiliary interface as seen from the front of the SAN CORE2M unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Pin</td>
</tr>
<tr>
<td>RCLKB</td>
<td>1</td>
</tr>
<tr>
<td>RXB</td>
<td>2</td>
</tr>
<tr>
<td>GIO</td>
<td>3</td>
</tr>
<tr>
<td>TXB</td>
<td>4</td>
</tr>
<tr>
<td>TCLKB</td>
<td>5</td>
</tr>
<tr>
<td>RCLKA</td>
<td>6</td>
</tr>
<tr>
<td>RXA</td>
<td>7</td>
</tr>
<tr>
<td>TXA</td>
<td>8</td>
</tr>
<tr>
<td>TCLKA</td>
<td>9</td>
</tr>
</tbody>
</table>

Table 42 AUX connector pins

10.7.4 Synchronisation interfaces (SR, ST)

<table>
<thead>
<tr>
<th>9-pole male D-connector</th>
<th>Pins of the SR synchronisation interface as seen from the front of the SAN CORE2M unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Pin</td>
</tr>
<tr>
<td>N.C.</td>
<td>1</td>
</tr>
<tr>
<td>RCLKB</td>
<td>2</td>
</tr>
<tr>
<td>GIO</td>
<td>3</td>
</tr>
<tr>
<td>N.C.</td>
<td>4</td>
</tr>
<tr>
<td>N.C.</td>
<td>5</td>
</tr>
<tr>
<td>GIO</td>
<td>6</td>
</tr>
<tr>
<td>RCLKA</td>
<td>7</td>
</tr>
<tr>
<td>N.C.</td>
<td>8</td>
</tr>
<tr>
<td>N.C.</td>
<td>9</td>
</tr>
</tbody>
</table>

Table 43 SR synchronisation connector pins
### Pins of the ST synchronisation interface as seen from the front of the SAN CORE2M unit

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>N.C.</td>
<td>1</td>
<td>Unused</td>
</tr>
<tr>
<td>N.C.</td>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>GIO</td>
<td>3</td>
<td>Common signal ground</td>
</tr>
<tr>
<td>TCLKB</td>
<td>4</td>
<td>Transmitted synchronisation reference, wire b</td>
</tr>
<tr>
<td>N.C.</td>
<td>5</td>
<td>Unused</td>
</tr>
<tr>
<td>N.C.</td>
<td>6</td>
<td>Unused</td>
</tr>
<tr>
<td>N.C.</td>
<td>7</td>
<td>Unused</td>
</tr>
<tr>
<td>TCLKA</td>
<td>8</td>
<td>Transmitted synchronisation reference, wire a</td>
</tr>
<tr>
<td>GIO</td>
<td>9</td>
<td>Common signal ground</td>
</tr>
</tbody>
</table>

#### Table 44 ST synchronisation connector pins

**Coaxial interface option**

Each synchronisation interface can be equipped with an asymmetrising adapter, which converts the interface into 75 Ω coaxial interface. The connector can be chosen as Type43 or SMB. The same adapter can be used in either the receiving or transmitting interface.
Chapter 11
Installing and cabling the plug-in units

Before beginning the installation procedure, make sure that you have an installation plan available.

Caution
Do not add units in the configuration during software download.

Install the plug-in units into the subrack after the subrack has been mounted into the rack.

The units’ front panels provide effective EMC screening, and in most cases unshielded cables can be used (see Chapter 2 and section 4.1 for restrictions).

Installing the units

1. Familiarise yourself with the installation plan.
   Do not insert units into incorrect slots (section 11.1).

2. Open the subrack cover, if fitted, see section 13.3.

Caution
Wear a wrist earthing strap or other such protection when handling plug-in units which have been removed from their package (section 11.2).

3. Insert the plug-in units into the subrack (section 11.3).

4. Fit blanking plates to all unused subrack locations to provide electromagnetic shielding (section 11.4).

5. Keep a record of the unit identification data of each unit, see markings in section 4.2.

6. Connect the optical fibres to the optical interface units. Route the fibres as illustrated in section 4.3.
7. Connect electrical cables to the interfaces, see section 11.5.

8. Close the subrack cover (optional). See that the optical fibres are not left in stress under the cover (section 13.3).

11.1 Unit locations

11.1.1 Coding system of the unit slots

Each plug-in unit type is provided with a mechanical unit slot coding block. The coding prevents you from installing the unit into an incorrect slot in the subrack. The coding blocks of the plug-in units and backplane connectors are colour coded. Plug-in units must only be connected to backplane connectors with matching coding blocks.

![Diagram of unit slot coding](image)

**Figure 46** Unit slot coding. When the coding pin and the slot in the coding block match, the plug-in unit can be inserted into the unit slot.
11.1.2 **Recommended unit slots**

Two different 17-slot Eksos subrack and 8-slot Eksos cartridge versions are available. One of these has slots reserved for housing SAN CORE2M units.

Tables 45 and 46 show which plug-in units can be fitted into each unit slot of the 17-slot Eksos subracks.

**Key to slot coding tables**

- ☑️ = required unit slot
- 🟢 = allowed unit slot
- ⚠️ = not allowed unit slot

**Note:** This subrack cannot house CORE2M units

<table>
<thead>
<tr>
<th>Unit/slot</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCU</td>
<td><img src="image1" alt="NCU" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSTN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LMU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISDN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TR2M4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACL4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 45**  
Recommended unit slots in Eksos N20 subrack

<table>
<thead>
<tr>
<th>Unit/slot</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
</tr>
</thead>
<tbody>
<tr>
<td>CORE2M</td>
<td><img src="image2" alt="CORE2M" /></td>
<td>☑️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU</td>
<td></td>
<td>⚠️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSTN</td>
<td></td>
<td>⚠️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LMU</td>
<td></td>
<td>⚠️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISDN</td>
<td></td>
<td>⚠️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TR2M4</td>
<td></td>
<td>⚠️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIU</td>
<td></td>
<td>⚠️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACL4</td>
<td></td>
<td>⚠️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 46**  
Recommended unit slots in Eksos N20/SAN subrack
Key to slot coding tables

- **☑** = required unit slot
- **☐** = allowed unit slot
- **☐** = not allowed unit slot

**Note:** This cartridge cannot house CORE2M units

<table>
<thead>
<tr>
<th>Unit/slot</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCU</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSTN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>LMU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>ISDN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>TR2M4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>DIU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>ACL4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
</tbody>
</table>

Table 47  Recommended unit slots in Eksos N20 cartridge

<table>
<thead>
<tr>
<th>Unit/slot</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>CORE2M</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU</td>
<td></td>
<td></td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSTN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>LMU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>ISDN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>TR2M4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>DIU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>ACL4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
</tbody>
</table>

Table 48  Recommended unit slots in Eksos N20/SAN cartridge
11.2 Handling plug-in units

Grasp the plug-in units by the insertion/extraction levers or back connectors.

![Diagram of holding a plug-in unit]

**Figure 47**  Holding a plug-in unit

---

**Caution**

When removing a plug-in unit from its anti-static packaging, you must equalise your potential with the rack. Always use an earthing wrist strap when handling plug-in units. The subrack and rack have special connectors for this purpose, see Figure 48.

![Diagram of connecting the earthing wrist strap to the subrack]

**Figure 48**  Example of connecting the earthing wrist strap to the subrack
Optical interface units
The optical interfaces are sealed with protective caps. Remove the caps before connecting the optical fibres. Store the caps for later use.

When removing optical interface units, disconnect the unit from the subrack backplane before removing the optical cables from the optical connectors. When the optical interface unit has been removed, make sure that the protective caps are put back on to the optical interfaces. Fit protective caps to optical cables if they are going to be left disconnected.

11.3 Inserting plug-in units

Note
Before installing a plug-in unit, ensure that its colour coding block matches the colour of the coding block in the backplane slot.

Inserting a plug-in unit (see Figure 49):
1. Open the unit’s insertion/extraction levers.
2. Insert the unit into the subrack slot.
3. Close the insertion/extraction levers when the plug-in unit is in place.
4. Firmly tighten the finger screws of the plug-in units.

Figure 49 Inserting a plug-in unit into a subrack
11.4 Fitting blanking plates for unused unit locations

For correct EMC performance, one-slot blanking plates must be fitted to the front of the subrack to cover all slots which are not occupied by plug-in units. When installing blanking plates, take care not to damage the EMI gasket.

Figure 50    One-slot blanking plate for unused plug-in unit locations
11.5 Cabling plug-in units

11.5.1 Inserting and replacing connector carriers

Tie the cables with a cable tie. Remove the cable tie before removing connectors from the carrier.

Press here to unplug the carrier.

Remove/insert the whole carrier when changing a plug-in unit.

Slide handle down when detaching a single connector.

Coaxial carrier for NCU

Figure 51 Inserting and replacing cables and carriers: coaxial connectors
11.5.2 Cabling the Data Interface Unit

If you are using cables that are shorter than 3 m, the cable must always be EMC-shielded. If you are using cables longer than 3 m, the first 3 m of the cable must be shielded, but the rest of the cable can be unshielded.

The earth wire must always be connected.

For EMC reasons, the connectors on the DIU must have a protective metallic housing whenever the V.24/V.28 interface is used. If this interface is not used at all, a plastic housing can also be used.

The metallic housing is rather rigid, so you may need to use pliers or other such tool to close the snaps.
Figure 53  Assembling the EMC connector of the Data Interface Unit

1) Lock the frame gently to its place to avoid damaging the frame.
2) Push the connector housing onto the frame.

Figure 54  Connecting cables to Data Interface Unit
11.5.3 Tying electrical cables to cable trays

Figure 55    Principle of tying electrical cables to cable trays

11.6 Connecting Eksos N20 to SAN

Connecting 2 Mbit/s interfaces

The 2 Mbit/s aggregate interfaces of the NCU can be connected to tributary 2 Mbit/s interfaces of SAN CORE2M units to provide STM-1 interfaces.

A SAN CORE2M unit can be installed into a special Eksos N20/SAN Subrack (T30427.03). Alternatively, separate SDH units such as a SAN CORE2M and SAN2M unit can be installed into a separate SAN Cartridge.

One SAN CORE2M unit provides 8 x 2 Mbit/s interfaces, three SAN2M units provide up to 3 x 21 x 2 Mbit/s interfaces and an NCU provides 4 x 2 Mbit/s interfaces. This means that the SAN units can provide tributary interfaces to multiple NCU aggregate interfaces.
75 Ω interfaces
The 2 Mbit/s interfaces (75 Ω) of both the NCU and SAN CORE2M unit are realised by the use of coaxial 1.0/2.3 connectors with a dual layout principle utilising similar coaxial carrier construction practices (see Figure 51).

Note
The connections must be made externally using jumper cables.

The point-to-point connections are made using coaxial jumper cables. See Chapter 10.

120 Ω interfaces
The 2 Mbit/s interfaces (120 Ω) of both the NCU and the SAN CORE2M units are realised by the use of 3 x 16 pin Euroconnectors. See Chapter 10.

Note
The connections must be made externally using shielded jumper cables.

A prefabricated shielded jumper cable (E30445.04) is available for connecting a SAN CORE2M unit (8 x 2 Mbit/s) to two NCUs (2 x 4 x 2 Mbit/s). This cable can be used to connect a SAN CORE2M unit to an NCU. The NCU can be in a neighbouring Eksos N20 subrack or, in the case of the Eksos N20/SAN Subrack, installed in the same subrack as the SAN CORE2M unit.
Installing and cabling the plug-in units

Figure 56  Example of connecting SAN CORE2M and NCU 2 Mbit/s interfaces

Connecting external synchronisation interfaces

The different NCU variants provide both 75 Ω unbalanced and 120 Ω balanced external synchronisation interfaces. See Chapter 10.

The 75 Ω unbalanced interface is realised by the use of Coaxial 1.0/2.3 connectors and the 120 Ω balanced interface is realised by the use of RJ45 connectors. Both interface types provide one input and one output connector.

The SAN CORE2M units provide only 120 Ω balanced external synchronisation interfaces realised by the use of 9-pin input and 9-pin output D-connectors.
Note
To provide an external synchronisation interface between an NCU and SAN CORE2M unit installed into the same Eksos N20/SAN subrack (T30427.03), we recommend that the T35010.11 and T35010.21 versions of the NCU are used.

Both NCU versions provide a 120 Ω balanced interface type. In this case a 9-pin D-connector / RJ45 Adapter Cable will need to be made.

Figure 57 Connecting synchronisation interfaces

If a 75 Ω external synchronisation input of the NCU is to be connected to a 120 Ω external synchronisation output of a SAN CORE2M unit in a separate cartridge or to another SYNFONET equipment, the 120 Ω output can be converted by the use of an external Synchronisation Adapter (T30420.09 or T30420.10). See the equipment’s manual for information concerning the installation of the adapter.
11.7 Service switch cabling

**Wiring before the service is switched**

Each PSTN and ISDN unit has relays for switching up to two subscriber interfaces to some dedicated lines in the backplane. These service switch lines are wired to a set of RJ45 connectors on the subrack extension board. Each line uses two pins on an RJ45, so when a service is switched, each subscriber line is connected to two pins of one of the RJ45 connectors. Cabling is needed from this point onwards and it has to be installed in advance.

To provide for remote upgrades from PSTN to ISDN, cabling is needed from the RJ45 connector on extension board of the Eksos N20 subrack to an ISDN interface (of the same Eksos N20 node, or the interface on another node).

To provide for remote upgrades from PSTN to ADSL+PSTN, cabling is needed from the RJ45 connector on extension board of the Eksos N20 subrack to the Digital Subscriber Line Access Multiplexer (DSLAM), then from the splitter on the DSLAM back to a PSTN interface (of the same Eksos N20 node, or the interface on another node).

---

**Figure 58**  Principle of wiring for PSTN and ISDN service upgrade; main distribution frame used
Eksos N20

Connected ISDN and PSTN interfaces

Free ISDN interfaces for temporary switching to ISDN

Subrack extension board

1) Wiring 1 to 8 interfaces for moving service from PSTN (see Table 50)
2) Wiring 1 to 8 interfaces for moving service from ISDN (see Table 49)
3) Changing to permanent connection.
The free lines must have been connected to MDF.
4) Service switch connection inside Eksos (controlled by Network Management System)

Figure 59  Principle of wiring for PSTN and ISDN service upgrade; reserved service upgrade connectors
Installing and cabling the plug-in units

1) Wiring 1 to 8 interfaces for moving service from PSTN (see Table 50)
2) Wiring 1 to 8 interfaces for moving service from ISDN (see Table 49)
3) Service switch cross connection in Main Distribution Frame (MDF)
4) Service switch connection inside Eksos (controlled by Network Management System)

**Figure 60**  Principle of wiring for PSTN or ISDN service upgrade; main distribution frame used
1) Wiring 1 to 8 interfaces for moving service from PSTN (see Table 50)
2) Wiring 1 to 8 interfaces for moving service from ISDN (see Table 49)
3) Changing temporary switching to permanent connection
4) Service switch connection inside Eksos (controlled by Network Management System)
5) Service upgrade connection rearranged

**Figure 61** Principle of wiring for PSTN and ISDN service upgrade; the existing line is changed to fixed ADSL/PSTN (ISDN) connection

For pinout of service switch connectors in connector block J2A, see Chapter 5. For pinout of PSTN and ISDN units, see section 10.4.
Installing and cabling the plug-in units

Correlation between unit slot in which the unit is installed and the pins to which the interface can be wired

<table>
<thead>
<tr>
<th>Unit slot number</th>
<th>J2A (RJ45)</th>
<th>RJ45 pin where the interface is switched to</th>
<th>Switched ISDN lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>2, 6, 10, 14</td>
<td>B</td>
<td>1,2 and 3,4</td>
<td>1 and 2</td>
</tr>
<tr>
<td>3, 7, 11, 15</td>
<td>B</td>
<td>5,6 and 7,8</td>
<td>3 and 4</td>
</tr>
<tr>
<td>4, 8, 12, 16</td>
<td>A</td>
<td>1,2 and 3,4</td>
<td>5 and 6</td>
</tr>
<tr>
<td>5, 9, 13, 17</td>
<td>A</td>
<td>5,6 and 7,8</td>
<td>7 and 8</td>
</tr>
</tbody>
</table>

Table 49  Correlation between unit slot and switched ISDN line

<table>
<thead>
<tr>
<th>Unit slot number</th>
<th>J2A (RJ45)</th>
<th>RJ45 pin where the interface is switched to</th>
<th>Switched PSTN lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>5, 9, 13, 17</td>
<td>D</td>
<td>1,2 and 3,4</td>
<td>1 and 2</td>
</tr>
<tr>
<td>2, 6, 10, 14</td>
<td>D</td>
<td>5,6 and 7,8</td>
<td>3 and 4</td>
</tr>
<tr>
<td>3, 7, 11, 15</td>
<td>C</td>
<td>1,2 and 3,4</td>
<td>5 and 6</td>
</tr>
<tr>
<td>4, 8, 12, 16</td>
<td>C</td>
<td>5,6 and 7,8</td>
<td>7 and 8</td>
</tr>
</tbody>
</table>

Table 50  Correlation between unit slot and switched PSTN line

Wiring after the service has been switched

To make the switch permanent, the subscriber lines have to be cabled as if there was no temporary remote switch:

- Wire the switch cabling to other, free interfaces that can then be used for future remote switches.
- Wire the switched subscriber lines directly to the interfaces these subscribers have been switched to.

This wiring should be done when the site is visited the first time after the subscriber lines have been switched.
Chapter 12
Ethernet cabling

When planning your Ethernet topology, you should divide the Ethernet into segments as follows:

- Connect network elements which belong to the same IS-IS level 2 routing area into the same Ethernet segment. This will reduce ISO/IP traffic in your local area management network.

- We recommend that ISO/IP and TCP/IP networks are kept separate.
Figure 62  Q3 DCN via SAN 10Base-2 Ethernet connector
Installing and cabling the plug-in units

Figure 63  10Base-2 (thin wire) Ethernet connection to WAN
Figure 64  Q3 DCN via SAN DCC and 10Base-T Hub
Chapter 13
Installing auxiliary equipment and accessories

Before beginning the installation, make sure that you have an installation plan available.

13.1 Fan unit

![Fan Unit with earthing cable and rotatable mounting brackets](image)

**Figure 65** Fan Unit with earthing cable and rotatable mounting brackets
To mount the fan unit in an ETSI rack, the short edge of the mounting brackets must be attached to the fan unit.

Figure 66  Mounting the Fan Unit into 19” and ETSI racks with rotatable mounting brackets
13.2 Air deflectors

The air deflectors, with or without front grilles, are available in 1U or 4U heights, but 2U and 5U air deflectors can also be used if no cable trays are installed below and above the subrack.

1. Always use this orientation in installations where the “exhaust opening” behind the subracks is less than 50 mm deep.

2. This orientation can be used in all installations where the “exhaust opening” behind the subracks is more than 50 mm deep.

Note: To install the air deflector in this orientation:
   a) remove the front grille and mounting brackets
   b) invert the air deflector
   c) refit the front grille and mounting brackets.

Figure 67 Principle of mounting the air deflector and front grille
13.3 **Subrack front cover**

The front cover provides protection for the cables but is not necessary for EMC shielding purposes. Front covers are not necessary if you are installing the subrack into a rack which has a front door.

If a front cover is to be used with an Eksos N20 subrack, it is necessary to fit spring clips to each side of the subrack to hold the cover (see Figure 68). Adjust the vertical position of the spring clips so that the unit LEDs can be seen through the front cover.

- **Attaching the front cover:**
  1. Align the holes in the cover with the red spring clips on the subrack.
  2. To secure the cover, push the cover squarely onto the subrack until all of the spring clips have clicked.

- **Detaching the front cover:**
  1. Push in the top red spring clips at each side of the cover (see Figure 69).
  2. With the springs depressed, lift the cover up and away from the subrack.

![Diagram of attaching spring clips to subrack](image)

**Figure 68** Attaching the spring clips to the subrack
Figure 69  Attaching and detaching the front cover to the 17-slot subrack

Front covers are also available for the DC-PSA, Fan Unit and Capacitor Unit. For further details, see their respective documentation.
Nokia Eksos N20
Narrowband Multiservice Access Node
Commissioning and Maintenance
### Document History

<table>
<thead>
<tr>
<th>Document</th>
<th>Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>C33836006SE_00</td>
<td>14 Dec 2000</td>
<td></td>
</tr>
<tr>
<td>C33836006SE_A0</td>
<td>5 Apr 2001</td>
<td></td>
</tr>
<tr>
<td>C33836006SE_B0</td>
<td>4 Jan 2002</td>
<td></td>
</tr>
<tr>
<td>C33836006SE_C0</td>
<td>20 Sep 2002</td>
<td></td>
</tr>
<tr>
<td>C33836006SE_D0</td>
<td>29 Jan 2003</td>
<td>Change in Appendix B.</td>
</tr>
</tbody>
</table>
# Contents

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>About this document</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2</td>
<td>Commissioning requirements and procedure</td>
<td>3</td>
</tr>
<tr>
<td>2.1</td>
<td>General commissioning procedure</td>
<td>3</td>
</tr>
<tr>
<td>2.2</td>
<td>Basic commissioning for all Eksos N20 nodes</td>
<td>4</td>
</tr>
<tr>
<td>2.2.1</td>
<td>Requirements</td>
<td>4</td>
</tr>
<tr>
<td>2.2.2</td>
<td>Procedure</td>
<td>5</td>
</tr>
<tr>
<td>2.3</td>
<td>Commissioning a V5.2 multiplexer</td>
<td>6</td>
</tr>
<tr>
<td>2.3.1</td>
<td>Requirements</td>
<td>6</td>
</tr>
<tr>
<td>2.3.2</td>
<td>Procedure</td>
<td>7</td>
</tr>
<tr>
<td>2.4</td>
<td>Commissioning a V5.1/V5.2 converter</td>
<td>9</td>
</tr>
<tr>
<td>2.4.1</td>
<td>Requirements</td>
<td>9</td>
</tr>
<tr>
<td>2.4.2</td>
<td>Procedure</td>
<td>10</td>
</tr>
<tr>
<td>2.5</td>
<td>Commissioning a service switch</td>
<td>11</td>
</tr>
<tr>
<td>2.5.1</td>
<td>Requirements</td>
<td>11</td>
</tr>
<tr>
<td>2.5.2</td>
<td>Procedure</td>
<td>11</td>
</tr>
<tr>
<td>2.6</td>
<td>Commissioning leased lines</td>
<td>13</td>
</tr>
<tr>
<td>2.6.1</td>
<td>Requirements</td>
<td>13</td>
</tr>
<tr>
<td>2.6.2</td>
<td>Procedure</td>
<td>14</td>
</tr>
<tr>
<td>2.7</td>
<td>Commissioning an application for scheduled line testing</td>
<td>14</td>
</tr>
<tr>
<td>2.7.1</td>
<td>Requirements</td>
<td>14</td>
</tr>
<tr>
<td>2.7.2</td>
<td>Procedure</td>
<td>15</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Detailed instructions</td>
<td>17</td>
</tr>
<tr>
<td>3.1</td>
<td>Switching the power on</td>
<td>17</td>
</tr>
<tr>
<td>3.2</td>
<td>Connecting Node Manager cable to the node</td>
<td>18</td>
</tr>
<tr>
<td>3.3</td>
<td>Starting Node Manager</td>
<td>19</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>3.4 Connecting to a node</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>3.4.1 Connecting to a fresh node</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>3.4.2 Reconnecting using the new address</td>
<td>23</td>
<td></td>
</tr>
<tr>
<td>3.5 Changing node settings</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>3.6 Installing plug-in units</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>3.7 Configuring 2M interfaces</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>3.8 Configuring synchronisation</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>3.9 Configuring management channels (DCN time slots)</td>
<td>29</td>
<td></td>
</tr>
<tr>
<td>3.10 Configuring external alarms and station alarms</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>3.10.1 Configuring Digital Inputs</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>3.10.2 Configuring Digital Inputs/Outputs</td>
<td>34</td>
<td></td>
</tr>
<tr>
<td>3.10.3 Configuring Analog Inputs</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>3.11 Creating and configuring a V5 interface</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>3.11.1 V5.2 interface</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>3.11.2 V5.1 interface</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>3.12 Configuring PSTN interfaces</td>
<td>49</td>
<td></td>
</tr>
<tr>
<td>3.13 Configuring ISDN interfaces</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>3.14 Provisioning user ports</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>3.14.1 Identifying interfaces and time slots</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>3.14.2 Configuring, editing and deleting user ports</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>3.14.3 Blocking and unblocking a user port</td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>3.15 Starting or stopping a V5 interface</td>
<td>59</td>
<td></td>
</tr>
<tr>
<td>3.16 Editing or deleting a V5 interface</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>3.17 Configuring service switches</td>
<td>61</td>
<td></td>
</tr>
<tr>
<td>3.17.1 Configuring service switch cabling</td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>3.17.2 Switching a service</td>
<td>63</td>
<td></td>
</tr>
<tr>
<td>3.17.3 Re-configuring service switches</td>
<td>64</td>
<td></td>
</tr>
<tr>
<td>3.18 Configuring DIU interfaces</td>
<td>65</td>
<td></td>
</tr>
<tr>
<td>3.19 Configuring leased lines</td>
<td>67</td>
<td></td>
</tr>
<tr>
<td>3.20 Configuring and viewing monitoring data</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>3.20.1 Current alarms list</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>3.20.2 Event history log</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>3.20.3 Performance monitoring</td>
<td>73</td>
<td></td>
</tr>
<tr>
<td>3.20.4 Block status</td>
<td>77</td>
<td></td>
</tr>
<tr>
<td>3.21 Line testing</td>
<td>78</td>
<td></td>
</tr>
<tr>
<td>3.21.1 On-demand tests</td>
<td>79</td>
<td></td>
</tr>
<tr>
<td>3.21.2 Scheduled tests</td>
<td>86</td>
<td></td>
</tr>
<tr>
<td>3.22 Stopping Node Manager</td>
<td>89</td>
<td></td>
</tr>
<tr>
<td>3.23 Clearing node configuration data (‘blasting’ the node)</td>
<td>91</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 4
Managing alarms .................................................. 93
4.1 Alarm severity .................................................. 93
4.2 LED indicators of plug-in units .............................. 94
4.3 Station alarm lamps and relays .............................. 95
4.4 Managing alarms with Node Manager ..................... 96

Chapter 5
Upgrading ............................................................ 99
5.1 Adding and removing tributary units ....................... 99
5.1.1 Adding tributary units ...................................... 99
5.1.2 Removing tributary units .................................. 100
5.1.3 Replacing tributary units .................................. 100
5.2 Downloading software ........................................ 101

Appendix A
Installing and using Eksos N20 Node Manager ............... A-1
A.1 Installing Eksos N20 Node Manager ....................... A-1
A.1.1 Modifications to your Windows operating system ........ A-2
A.1.2 Installation procedure ...................................... A-4
A.1.3 Changing the stack startup ................................ A-6
A.1.4 Changing the NSAP address after installation .......... A-7
A.1.5 Enabling security ........................................... A-7
A.1.6 Frequently asked questions ............................... A-10
A.2 Using Eksos N20 Node Manager ............................ A-11
A.2.1 Description of Eksos N20 Node Manager ............... A-11
A.2.2 Operating Eksos N20 Node Manager .................... A-13
  Selecting actions ................................................ A-13
  Receiving data from the node ................................ A-14
  Making changes to the node ................................ A-14
A.2.3 Using online Help .......................................... A-14
A.2.4 Saving and loading data as files ......................... A-15
  Saving the whole node ......................................... A-15
  Saving data from a window ................................... A-16
  Loading a whole node configuration from file ............. A-17
A.2.5 Printing data ................................................ A-18
A.2.6 Frequently asked questions ............................... A-19
A.2.7 Main menus of Eksos N20 Node Manager ............... A-20

Appendix B
Alarm messages ..................................................... B-1
Appendix C
Windows for Data Interface Units ......................................... C-1
C.1 Subrack window .......................................................... C-1
C.2 Unit configuration window ................................................. C-1
C.3 Functional block settings window ........................................ C-2
C.4 Advanced interface settings tabs ........................................ C-6
C.4.1 G.703 tab ............................................................... C-7
C.4.2 X.21 tab ................................................................. C-8
C.4.3 V.xx tab ................................................................. C-10
C.4.4 V110 Adaptation tab ..................................................... C-13
C.4.5 X.30 Adaptation tab ..................................................... C-15
C.4.6 Input buffer tab ......................................................... C-16
C.4.7 Sampling tab ............................................................ C-17
C.4.8 V.14 tab ................................................................. C-18
C.4.9 POH tab ................................................................. C-19
C.4.10 Bitmasks tab .......................................................... C-20
Chapter 1
About this document

This document explains how to take Nokia Eksos N20 nodes into use. The tool used to perform the actions described in this document is called Nokia Eksos N20 Node Manager.

For brevity, the name Node Manager is used for Nokia Eksos N20 Node Manager.

This document covers the following topics:

- Commissioning requirements and procedures (Chapter 2)
- Detailed instructions for the commissioning: (Chapter 3)
  - Switching power on
  - Connecting Node Manager cable to a node
  - Starting Node Manager
  - Connecting to a node
  - Changing node settings
  - Installing plug-in units
  - Configuring 2M interfaces
  - Configuring synchronisation settings
  - Configuring management channels
  - Configuring external alarms
  - Creating and configuring a V5 interface
  - Configuring PSTN and ISDN interface settings
  - Provisioning user ports
  - Starting and stopping a V5 interface
  - Editing or deleting a V5 interface
  - Configuring service switches
  - Configuring Data Interface Unit interfaces
  - Configuring leased lines
  - Configuring event history log and performance monitoring settings
  - Line testing
  - Stopping Node Manager
- Managing alarms (Chapter 4)
- Upgrading (Chapter 5)
- Installing and using Eksos N20 Node Manager (Appendix A)
- Alarm messages (Appendix B)
- DIU windows . (Appendix C).
Chapter 2
Commissioning requirements and procedure

This chapter explains how to take Eksos N20 nodes into use. It assumes that the following tasks have already been successfully completed:

- mechanical installation has been completed
- cables have been connected and plug-in units inserted
- the power supply has been connected
- Node Manager has been installed in the PC
- you have made an application plan (a node configuration plan).

For instructions for commissioning the SAN CORE2M units, refer to the SYNFONTET Access Node documentation.

For instructions for commissioning the OSI-DCN Adaptor units, refer to the OSI-DCN Adaptor User Manual.

Note
Information for application planning can be found in the Product Description.

2.1 General commissioning procedure

This section presents the general procedure required to commission the Eksos N20 node. Note that commissioning must always begin with an application plan. The actual commissioning tasks vary according to this plan and the required Eksos N20 application.

All Eksos N20 nodes require basic commissioning (section 2.2). The commissioning procedures for specific applications are given in sections 2.3 to 2.7.
Follow this procedure to start and configure a node:

1. Make an application plan. For information needed in planning, see sections 2.2 to 2.7 in this document and the relevant sections in the Product Description document.

2. Switch the power on (see section 3.1).

3. Connect Node Manager cable to the node (see section 3.2).

4. Start Node Manager (see section 3.3).

5. Make the basic node settings (see sections 2.2 and 3.4).

6. Disconnect from the node and reconnect to the node using the new address (see section 3.4.2).

7. Do the commissioning tasks according to sections 2.3 to 2.7:
   - Commissioning a V5.2 multiplexer (see section 2.3)
   - Commissioning a V5.1 / V5.2 converter (see section 2.4)
   - Commissioning a service switch (see section 2.5)
   - Commissioning leased lines (see section 2.6)
   - Configuring scheduled line tests (see section 2.7).

Note that Eksos N20 nodes support simultaneously all of these applications. If you want to use Eksos N20 for all applications, follow the detailed instructions in Chapter 3.

8. Make the event log settings and configure performance monitoring if wanted (see section 3.20).

9. Close the connection to the node (see section 3.22).

2.2 Basic commissioning for all Eksos N20 nodes

Basic commissioning is needed for all Eksos N20 applications. This procedure configures the basic settings that the node needs to operate. Before starting the basic commissioning, make sure that the installation and cabling have been done as shown in the Installation document and that there exists an application plan.

2.2.1 Requirements

For basic commissioning of an Eksos N20 node, you will need the following:

- a minimum of one NCU unit
  - in slot one if Eksos N20 subrack or cartridge is used
  - in slot three if Eksos N20/SAN subrack or cartridge is used
- node address (NSAP) to identify the node in the network
- node name and its location information
- information about synchronisation sources
- information about the time slots used for communication channels
- local exchange (LE) information.
2.2.2 Procedure

To do the basic commissioning on the Eksos N20 node, follow the procedure in Table 1:

<table>
<thead>
<tr>
<th>Task</th>
<th>How? Refer to:</th>
<th>Remarks and tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Set node name and location.</td>
<td>Section 3.4</td>
<td>This is optional but recommended. Node names can be added to databases to help network management.</td>
</tr>
<tr>
<td>2. Set the node address (NSAP).</td>
<td>Section 3.4</td>
<td>For the node address, you need the following information: – Area name – AFI – IDI – Node system ID.</td>
</tr>
<tr>
<td>3. Install the units with the software.</td>
<td>Section 3.4</td>
<td>Node Manager does this when commissioning the node for the first time.</td>
</tr>
<tr>
<td>4. Configure the aggregate 2M interface.</td>
<td>Section 3.7</td>
<td>Some of the interfaces will be used as synchronisation sources. Often the same interfaces are used as V5 links. One or two of these interfaces may carry Q3 traffic.</td>
</tr>
<tr>
<td>5. Build the synchronisation priority list.</td>
<td>Section 3.8</td>
<td>Possible synchronisation sources: – any 2 Mbit interface from NCU or TR2M4 – external synchronisation input from master NCU – internal clock (always last on the list) Typically, the bits in the 2Mbit/s signal that is used to connect to an LE are used for synchronisation.</td>
</tr>
<tr>
<td>6. Set up the Q3 management channel.</td>
<td>Section 3.9</td>
<td>Typically, a time slot in one of the 2 Mbit/s signals towards the LE is used for Q3. If the LE does not support fractional V5.2 interface (where some of the time slots are used for other than V5), it may be better to connect the Q3 traffic through Ethernet interface to the Ethernet interface of the on-site SYNFONET equipment and route the Q3 in the SDH overhead. Alternatively, the Q3 traffic could be connected to the V.11 interface and then to third-party equipment that route it onwards.</td>
</tr>
</tbody>
</table>

Table 1 Procedure for basic commissioning
2.3 Commissioning a V5.2 multiplexer

Before commissioning a V5.2 multiplexer, make sure that the installation and cabling have been done as shown in the Installation document. Also make sure that the basic commissioning has been done as explained in section 2.2.

The configuration at both ends of a V5 interface must always match. Thus, the configuration of the V5.2 interface in Eksos N20 must be exactly the same as in the LE.

2.3.1 Requirements

To commission a V5.2 multiplexer, you will need the following:

- plug-in units
  - a minimum of one NCU unit
    in slot one (Eksos N20 subrack or cartridge) or slot three (Eksos N20/SAN subrack or cartridge);
  - each V5.2 interface requires one NCU
- PSTN and/or ISDN units for subscriber interfaces

- configuration information about the V5.2 interfaces at the local exchange (LE)
  - interface ID and provisioning variant
  - IDs for the 2M links used to connect to the LE
  - time slots and IDs for the communication channels
  - time slots used to provide protection
  - L3 and EF addresses for user ports (subscriber interfaces).

Each NCU provides four 2 Mbit/s interfaces that can be associated with any V5.2 interface. There must be at least one NCU per each V5.2 interface. One 2 Mbit/s interface can carry up to 30 (or 31, if time slot 16 is not used for signalling) simultaneous phone calls.
2.3.2 Procedure

To commission a V5.2 multiplexer, follow the procedure in Table 2:

<table>
<thead>
<tr>
<th>Task</th>
<th>How? Refer to:</th>
<th>Remarks and tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do the basic commissioning.</td>
<td>Section 2.2.2</td>
<td></td>
</tr>
<tr>
<td>2. Set the interface ID and provisioning variant. Optionally give a name.</td>
<td>Section 3.11.1</td>
<td>The ID has to be the same on the node and LE. The node’s provisioning variant must match the active variant at the LE.</td>
</tr>
<tr>
<td>3. Configure 2M links.</td>
<td>Section 3.11.1</td>
<td>You can simplify the procedure by using numbering schemes or rules. The links can be given IDs that start from the interface ID: for example, an interface with interface ID 53 could use links with IDs 53, 54 and 55.</td>
</tr>
<tr>
<td>4. Configure communication channels (C-channels).</td>
<td>Section 3.11.1</td>
<td>– The C-channel configuration must be identical with the configuration defined in the LE.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– At least one C-channel carrying the vital protocols must be assigned to time slot 16 of one link.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– If two or more links are used, time slot 16 of the secondary link must be assigned as the location for a vital standby channel.</td>
</tr>
<tr>
<td>5. Configure signalling and protection.</td>
<td>Section 3.11.1</td>
<td>– You can simplify the procedure by always placing the signalling protocols in time slot 16 of the primary link and the protection in time slot 16 of the secondary link.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– PSTN and ISDN protocols can be placed in the time slot used for the vital protocols or in a different time slot.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– It is possible to set the ISDN-Ds signalling in several different C-channels.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– It may be wise to place the ISDN protocols in a link that is located on an NCU that is a pure V5 slave. This way ISDN messages can be routed through the node without loading the V5 master.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Up to three protecting standby channels can be set for PSTN and ISDN protocols. These can be set to any of free time slots 15, 16 or 31 of any link.</td>
</tr>
<tr>
<td>6. Start interfaces.</td>
<td>Section 3.11.1</td>
<td></td>
</tr>
<tr>
<td>7. Configure user ports.</td>
<td>Section 3.14.2</td>
<td>Numbering rules can be used. For example, you can set the PSTN L3 addresses to be: (slot number – 1) × 32 + interface number.</td>
</tr>
</tbody>
</table>

Table 2 Procedure for commissioning a V5.2 multiplexer
Examples for configuring V5.2 interfaces

<table>
<thead>
<tr>
<th>Link</th>
<th>TS 15</th>
<th>TS 16</th>
<th>TS 31</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCU 1, interface 1, link ID 21</td>
<td></td>
<td>C-channel 0: vital protocols, PSTN, ISDN-Ds</td>
<td></td>
</tr>
<tr>
<td>NCU1, interface 2, link ID 22</td>
<td></td>
<td>Vital standby</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3** Configuring a simple, small V5.2 interface

In the example of Table 3, a problem in link 21 would cause all protocols to be moved to time slot 16 of link 22.

<table>
<thead>
<tr>
<th>Link</th>
<th>TS 15</th>
<th>TS 16</th>
<th>TS 31</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCU 1, interface 1, link ID 71</td>
<td>C-channel 1: ISDN-Ds</td>
<td>C-channel 0: vital protocols PSTN</td>
<td></td>
</tr>
<tr>
<td>NCU 1, interface 2, link ID 72</td>
<td>Standby</td>
<td>Vital standby</td>
<td></td>
</tr>
<tr>
<td>NCU 1, interface 3, link ID 73</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU 1, interface 4, link ID 74</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU 2, interface 3, link ID 75</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU 2, interface 4, link ID 76</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 4** Configuring a large V5.2 interface

In the example of Table 4, a problem in link 71 (the primary link) would cause the vital protocols to be moved to time slot 16 of link 72 (the secondary link) and the ISDN-Ds protocol to time slot 15.
2.4 Commissioning a V5.1/V5.2 converter

Before commissioning a V5.1/V5.2 converter, make sure that the installation and cabling have been done as shown in the Installation document. As the converter application is an extension of the V5.2 multiplexer application, read first also section 2.3. Also, make sure that the basic commissioning has been done as explained in section 2.2.

The configuration at both ends of a V5 interface must always match. In the converter application, the configuration of the V5.2 interfaces must match the configuration information at the local exchange (LE) and the configuration of the V5.1 interfaces must match the configuration information in the V5.1 node.

2.4.1 Requirements

To commission a V5.1/V5.2 converter, you will need the following:

- plug-in units
  - a minimum of one NCU unit
    in slot one (Eksos N20 subrack or cartridge) or
    slot three (Eksos N20/SAN subrack or cartridge)
  - a minimum of one TR2M4 unit to provide a V5.1 interface to the V5.1 node (one TR2M4 unit can connect to four V5.1 nodes)

- configuration information about the V5.2 interfaces at the local exchange (LE)
  - interface ID and provisioning variant
  - IDs for the 2M links used to connect to the LE
  - time slots for the communication channels
  - time slots used to provide protection
  - L3 and EF addresses for user ports (subscriber interfaces)

- configuration information about the V5.1 nodes
  - physical 2 Mbit/s used for Eksos N20
  - time slots and IDs for the communication channels
  - time slots used for user ports and their addresses
  - information about possible leased lines on the V5.1 node.
2.4.2 Procedure

To commission a V5.1/V5.2 converter, follow the procedure in Table 5:

<table>
<thead>
<tr>
<th>Task</th>
<th>How? Refer to:</th>
<th>Remarks and tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do the basic commissioning.</td>
<td>Section 2.2.2</td>
<td></td>
</tr>
<tr>
<td>2. Configure V5.2 interface if not done already.</td>
<td>Section 3.11.1</td>
<td>See Table 2.</td>
</tr>
<tr>
<td>3. Set the V5.1 interface ID and provisioning variant, optionally give a name.</td>
<td>Section 3.11.2</td>
<td></td>
</tr>
<tr>
<td>4. Configure the 2M link.</td>
<td>Section 3.11.2</td>
<td>Possibly reserve a time slot for Q1 management.</td>
</tr>
<tr>
<td>5. Configure communication channels (C-channels).</td>
<td>Section 3.11.2</td>
<td>Time slots available: 15, 16 and 31.</td>
</tr>
</tbody>
</table>
| 6. Configure signalling. | Section 3.11.2 | – Vital protocols always use the C-channel in time slot 16.  
– The PSTN and ISDN protocols can be placed in any C-channel created.  
– In V5.1, there can be only one instance for the ISDN-Ds protocol. |
| 7. Start interface. | Section 3.11.2 | |
| 8. Configure user ports for V5.2 and V5.1 interfaces. | Section 3.14.2 | A PSTN subscriber uses one time slot; an ISDN subscriber normally uses two time slots. |
| 9. Set up Q1 management of the V5.1 node. | Section 3.9 | |

Table 5 Procedure for commissioning a V5.1/V.2 converter
2.5 Commissioning a service switch

Note
Before starting to configure service switches, make a plan and follow it consistently.

Before commissioning a service switch, make sure that the installation and cabling have been done as shown in the Installation document. Also, make sure that the basic commissioning has been done as explained in section 2.2.

2.5.1 Requirements

To commission a service switch, you will need the following:

- plug-in units
  - a minimum of one NCU in slot one (Eksos N20 subrack/cartridge) or slot three (Eksos/SAN subrack or cartridge)
  - PSTN and/or ISDN units
  - to provide ADSL services, broadband equipment should be available.

- application specific installation and cabling
  - the service switch cabling must be in place

- configuration information
  - configuration information of the V5.2 user ports and their addresses
  - information about the service switch cabling. It is often logistically efficient to standardise the configurations for sets of node types.
  - cabling information about other equipment, such as broadband equipment.

2.5.2 Procedure

The work takes place in three phases:

1. Preparing the service switch cabling. This phase is the most efficient when the service switch is taken into account in the initial installation. The cabling information is also configured in the node.

2. Switching services for one or more subscriber lines. This is done when a customer requests upgrading to ISDN or ADSL. Switching is done remotely, without visiting the site.

3. Changing the temporary service switches into permanent ones and releasing the resources for new remote service switches. This should be done during the first site visit after the service upgrade.
Restrictions

When configuring the service switch, take into consideration the following restrictions:

- one service switch connection per plug-in unit
- each plug-in unit can access one out of two accessible bus lines
- up to eight service switch connections for PSTN units per subrack
- up to eight service switch connections for ISDN units per subrack
- service switch connections are not activated during ongoing line tests
- line tests have higher priority than service switch connections if the Super Cut Call option is used in line testing.

To commission a service switch, follow the procedure in Table 6:

<table>
<thead>
<tr>
<th>Task</th>
<th>How? Refer to:</th>
<th>Remarks and tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do the basic commissioning.</td>
<td>Section 2.2.2</td>
<td></td>
</tr>
<tr>
<td>2. Add cabling information to the node.</td>
<td>Section 3.17.1</td>
<td>The node has no means for checking the cabling, so special attention is required.</td>
</tr>
</tbody>
</table>
| 3. Configure services that will be provided when the service is switched. | Section 3.17.1 | – User ports can be preconfigured (also on the LE). The advantage of a preconfigured user port is that less work is needed at the time of the actual upgrade. A disadvantage may be that the L3 will change and it thus has to be reassigned with the directory number (in the LE), or the directory number will change.
– Broadband and other equipment may also need to be configured. |
| 4. When the customer makes a request, switch the service and inform the customer. | Section 3.17.2 | The customer may have to install ISDN or broadband equipment. |
| 5. When the node is visited, recable the node. | Installation document. |  |
| 6. Update the cabling information. | Section 3.17.1 |  |

Table 6 Procedure for commissioning a service switch
2.6 Commissioning leased lines

Before commissioning a leased line, make sure that the installation and cabling have been done as shown in the Installation document. Also, make sure that the basic commissioning has been done as explained in section 2.2.

2.6.1 Requirements

To commission a leased line, you will need the following:

- mandatory plug-in units
  - a minimum of one NCU in slot one (Eksos N20 subrack/cartridge) or slot three (Eksos/SAN subrack or cartridge)
- optional plug-in units
  - depending on the leased line utilised, either PSTN, ISDN, Data or TR2M4 units
  - in case of remote application, you may use Nokia HDSL line cards to provide the high speed connection over subscriber cable pairs. ACL4 can be installed in the Eksos subrack, whereas ACL2 needs its own mechanics. At the remote end, you have the choice of Nokia stand-alone terminals and plug-in ACL4/ACL2 line terminals, for example, in the case of a remote access multiplexer.
- configuration information about the leased lines
  - configuration information about the interfaces and time slots that will be used for leased lines
- configuration information about other equipment
  - configuration information of the data terminals.

Special care must be taken to ensure that the configuration of leased line data interface parameters, bit allocations to time slots and possible bit masks are the same at both ends of the leased line connection.

Restrictions

A full ISDN leased line reserves three time slots: two for B-channels, each 1 x 64 kbit/s, and one for D-channel, 1 x 16 kbit/s. Although the D-channel has a bit rate of 16 kbit/s, it is cross-connected at the 64 kbit/s level.

In case of $n \times 64k / n > 1$ connections, all time slots used for a single leased line must be consecutive ones. For example, a single leased line can use time slots 11, 12 and 13, but not 11, 12 and 14.
2.6.2 Procedure

To commission leased lines, follow the procedure in Table 7:

<table>
<thead>
<tr>
<th>Task</th>
<th>How? Refer to:</th>
<th>Remarks and tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do the basic commissioning.</td>
<td>Section 2.2.2</td>
<td></td>
</tr>
</tbody>
</table>
| 2. Configure the interfaces involved. If already configured, check the configuration of these interfaces. | Section 3.19. | – Remember to bring the 2M interfaces into use and to enable power on the ISDN units or interfaces.  
– Time slot 0 cannot be cross-connected.  
– All time slots used for a single leased line must be consecutive ones. |
| 3. Add the leased line to the active bank. | Section 3.19. | Alternatively, add the leased line to the inactive bank and then switch banks.     |

Table 7 Procedure for commissioning leased lines

2.7 Commissioning an application for scheduled line testing

Before commissioning the node, make sure that the installation and cabling have been done as shown in the Installation document. Also, make sure that the basic commissioning has been done as explained in section 2.2.

The lines to be tested must be in V5 use. The configuration at both ends of a V5 interface must always match. The configuration of the V5.2 interfaces must match the configuration information at the local exchange (LE) and the configuration of the V5.1 interfaces must match the configuration information in the V5.1 node.

2.7.1 Requirements

To commission an application for scheduled line testing, you will need the following:

- plug-in units
  - a minimum of one NCU unit  
in slot one (Eksos N20 subrack or cartridge) or  
slot three (Eksos N20/SAN subrack or cartridge)  
- an LMU  
PSTN and/or ISDN units
- a plan for the tests  
  - what tests will be run?  
  - how often and when will the tests be run?  
  - what interfaces will be tested?  
  - what thresholds will be used?
2.7.2 Procedure

To commission an application for scheduled line testing, follow the procedure in Table 8:

<table>
<thead>
<tr>
<th>Task</th>
<th>How? Refer to:</th>
<th>Remarks and tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do the basic commissioning.</td>
<td>Section 2.2.2</td>
<td></td>
</tr>
<tr>
<td>2. Create the V5 interface, if not already created.</td>
<td>Section 3.11</td>
<td></td>
</tr>
<tr>
<td>3. Choose the schedule for the tests.</td>
<td>Section 3.21.2</td>
<td>In the scheduled tests, the subscriber line is blocked for the duration of the test. If the subscriber line is not in V5 use, the system will issue an Access Fail error message.</td>
</tr>
<tr>
<td>4. Choose the tests to be run.</td>
<td>Section 3.21.2</td>
<td>Available tests: electrical test, loop resistance, POTS diagnostics, dial tone test.</td>
</tr>
<tr>
<td>5. Choose the interfaces to be tested.</td>
<td>Section 3.21.2</td>
<td>You can choose several interfaces at a time.</td>
</tr>
<tr>
<td>6. Set thresholds for the tests.</td>
<td>Section 3.21.2</td>
<td></td>
</tr>
</tbody>
</table>

Table 8  Procedure for commissioning an application for scheduled line testing
Chapter 3
Detailed instructions

Before starting the commissioning, make sure that you have a node configuration plan available. For information needed for making a plan, see Chapter 2 and the Product Description document.

The instructions in this chapter follow the recommended order of commissioning in cases where all functionalities of Eksos N20 are wanted.

3.1 Switching the power on

The power is switched on with the switch on the rack power supply used.

![Power switches in DC-PSA](image)

Figure 1  Power switches in DC-PSA
3.2 Connecting Node Manager cable to the node

One end of the management cable is connected to the Ethernet interface of the PC where Node Manager is running, and the other end to the Q3 interface on the NCU or on a service connector panel located on the rack.

![Diagram of NCU and rack mechanics](image)

**Figure 2** Q3 interface on NCU and on service connector panel

There may be several Eksos N20 Node Managers at a time connected to the management network. One node can handle up to four management connections, for example, connections to Nokia NMS and Eksos N20 Node Manager.
3.3 Starting Node Manager

Make sure that you start the correct Node Manager version.

To start Node Manager:

1. Switch on your computer.

   Node Manager must be installed on your computer. Instructions for installing Node Manager can be found in Appendix A.

   The computer must be physically connected to a new Eksos N20 node via an Ethernet cable connected from the Ethernet port on the computer to the NCU in the subrack (see section 3.2).

2. If Windows NT 4.0 is not operating already, start it now.

3. Double-click the Eksos N20 Node Manager Program-item icon on the desktop.

   Node Manager will start up and display the Eksos Node Manager window (Figure 3):

   ![Eksos Node Manager window showing the Manage Node window](image)

   Figure 3   Eksos Node Manager window showing the Manage Node window
3.4 Connecting to a node

3.4.1 Connecting to a fresh node

When you set up a connection to a fresh node with Node Manager, make sure that the node is not connected to any other fresh nodes. Otherwise this other node will also get the identification data, which must be unique to each node. If necessary, disconnect the node you are commissioning from the local Ethernet LAN network.

When you are connecting to a fresh node with Node Manager, the node installation wizard will start and guide you through the first phases of the installation.

To connect to a fresh node, follow this procedure:

1. When starting Node Manager, the Manage Node dialog box opens automatically. You can also access it from the Eksos Node Manager window by selecting Node → Manage....

![Manage Node dialog box](image)

**Figure 4** Manage Node dialog box

2. In the Area group box, select Local LAN from the drop-down list box.

3. In the Node List group box, select the fresh node: DEADDEADF5B0. This is the node that you are connected to.

4. Click Manage.

---

**Note**
There should only be one DEADDEADF5B0 node in the network at a time.
If the connection is successful, and you are connecting to a previously uninstalled node, the first dialog box of the Installation Wizard will be displayed.

![Installation Wizard - Node Information](image)

**Figure 5** The first dialog box of Installation Wizard

If the node has already been installed, the **Eksos Node Manager** window will be displayed containing the **Subrack** window of the selected node.

The different steps of the installation and the related Installation wizard windows are briefly described in the following. Some of the windows are discussed also in section 3.5, “Changing node settings”.

To set **Node Information**, fill in the following boxes:

**Type:** In this system release, the default type is ‘Eksos Mux’.

**Name:** Enter the descriptive name of the node according to the node configuration plan, with possibly the transmission connection information.

**Location:** Enter the descriptive name of the equipment station or equivalent according to the node configuration plan, with possibly the rack row and subrack location in the rack.

**Release:** Always ‘EKN C2.0’ in this system release.
To give Node Address (NSAP), fill in the following boxes:

**Area Name:** Select the correct area for the node according to the node configuration plan. If your Node Manager installation does not yet have the correct area in its database, you might want to add it now by clicking on **Database...**

Make sure that the **AFI**, **IDI** and **Area address** are according to the node configuration plan. These define the area the node is in.

**Node System ID:** Type in the node ID (12 hexadecimal characters) according to the node configuration plan. This ID identifies the node within a particular area.

To install units:

1. Each type of node configuration has a default card set associated with it. To install it, select the node type in the **Default Units Set** drop-down list box.
2. If you have already inserted all the units in the node, select **None** in the **Default Units Set** and click **Configure From Node**. This will automatically read which units are present in the node and set up this dialog box accordingly.

---

**Note**  
This procedure can take up to one minute.

---

You can also set the unit configuration manually, see section 3.6. Afterwards, you can add, change and remove units from the configuration.

3. Set the correct time on the node. You can enter the time manually or set it to match the PC time. Click **Finish**.

   The **Real Time Clock** window is not dynamically updated. To update its contents, click in the **Real Time Clock** window to make it active and select **Data → Refresh from Node**.

4. Read through the **Information** window that is automatically displayed to ensure that the configuration is as you want it. If the configuration is correct, click **Send**. The details of the new node will be sent to the node and it will be installed.

---

**Note**  
This procedure can take a few minutes.

---

If the configuration is not correct, click `<Back` to return to the previous dialog box in the Installation Wizard.
3.4.2 Reconnecting using the new address

To update the node information from DEADDEADF5B0 to the new node information defined in section 3.4.1:

1. Disconnect from the node you are managing by selecting Node → Stop Managing.
2. Select Node → Manage. The Manage Node dialog box opens.
3. In the Area group box, select the node from the drop down box.
4. To update the node (NSAP) address, wait a few minutes and click the Refresh button a couple of times until the DEADDEADF5B0 address disappears. The new address is displayed in the Node List.
5. Select the new address and click Manage in the toolbar to start managing the node again.
3.5 Changing node settings

To view or change settings on a node, select Configure→Node Settings.

After the system has taken a few moments to get the current settings from the node, the Node Settings dialog box will be displayed. The first window to be displayed is Node. You can move to any of the other windows by clicking on its tab.

When you edit data obtained from the node, the changes which you can see on your screen are not immediately applied to the node. To put the changes into effect, you must send the edited data to the node by selecting Data→Send to Node. This command updates the node with the changed data that is currently in the active window.

3.6 Installing plug-in units

If you have already installed the plug-in units by using the Installation wizard, you can move directly to section 3.7.

All plug-in units have to be installed with Node Manager before they can be used in a node. We recommend that you place the units in the subrack before you start to install them, although it is not obligatory to do so.

You can install one or several units at a time. When all modifications have been done, Node Manager will check the new configuration before sending it to the node. Node Manager reports an error if an obviously incorrect configuration is set up.

The node configuration can be changed as often and as many times as necessary.

Before Node Manager can accept the configuration, it must include the units that are vital for correct operation. A Node Control Unit (NCU) must always be in place, whereas the other necessary units depend on the application. For information about the units required in the most common applications, see Chapter 2.

To install a unit in a node, follow the procedure below:

1. In the Subrack window, click the slot where you want to install the unit.

2. Select Configure → Unit Type...

   The Unit Type dialog box will be displayed for the currently selected slot in the Subrack window.

3. In the Type drop-down list box, select the new unit type you want to install in the selected slot. Then click on OK.
   - The unit types listed are the only units that can be installed in the selected slot.
   - If you want to uninstall a unit, that is, remove the unit from the node, select No Unit from the list box.
The **Subrack** window will be updated with the new unit for the currently selected slot. The way that the unit is displayed in the **Subrack** window will indicate whether it has been correctly installed (see Figure 7).

![Diagram of Subrack window with correct and incorrect installations]

**Figure 7**  Correct and incorrect installations in a subrack

4. After you have installed all the units, select **Data → Send to Node** to send the contents of the window to the node.

To view information on a unit, click first on the unit and then select **Node → Unit Information**.

### 3.7 Configuring 2M interfaces

To bring the 2M interface(s) into use:

1. Select an NCU or TR2M4 by clicking on it in the **Subrack** window. Then select **Configure → Interface**. The **Ux 2M** window (the 2M window for unit in slot x) will open.

2. Right-click the selected interface and select **Configure** from the pop-up menu.

3. In **E12** tab, bring the interface into use. You can select several interfaces by clicking the **Also Apply To...** button and selecting the interfaces in the window that opens.
   - For configuring Performance Collection, see section 3.20.3.

4. In **E12/P12** tab, select whether the CRC check is on or off. You can set CRC on for several interfaces by clicking the **Also Apply To...** button and selecting the interfaces in the window that opens.

5. Click **OK**. Then select **Data → Send to Node** to send the contents of the window to the node.
3.8 Configuring synchronisation

Synchronisation source priority list

Take the synchronisation sources into use and arrange them into priority order as planned. The following source candidates are available:

- any 2 Mbit/s interface from NCU or TR2M4
- external synchronisation input from master NCU
- internal clock (always the last item on the list).

Node synchronisation proceeds according to the priority list of the allowed synchronisation sources. The source with the highest priority is used to synchronise the node clock.

In case the source being used becomes unavailable, the equipment switches automatically to the second highest synchronisation source.

To change the priority of the synchronisation sources, follow the procedure below:

1. Select **Configure → Synchronisation**. The **Synchronisation** window will be displayed.

![Synchronisation window](image)

Figure 8 Synchronisation window

2. Click the **NE Clock** tab if it is not already selected.
3. In the Mode group box, select Priority List. This sets the source automatically, using the sources in the Priority List list box. The other mode options are:
   - Manual (forces the synchronisation to a set reference source from the Sources List)
   - Hold-over (forces the synchronisation source to use the internal oscillator that holds over the previously used source).

4. Select a source from the Sources list box by clicking on it. Click Add to move the selected source into the Priority List list box. Repeat this step until all the sources you require have been added to the Priority List list box.

5. Select an entry in the Priority List list box whose level of priority you want to either raise or lower.

6. Set the priority of the new signal source by either:
   - clicking on Raise to increase the priority for that signal
   - clicking on Lower to decrease the priority.

7. Continue moving the signal sources until they are ordered in the desired priority. You can also remove a signal source from the Priority List list box by selecting it and then clicking on Remove.

8. Select Data → Send to Node to send the contents of the window to the node.

9. To update the Synchronisation window, select Data → Refresh from Node.

---

**Note**

You cannot raise the priority of the Internal synchronisation source (Internal clock). This is always the last source in the Priority List. This source will be used if none of the other synchronisation sources in the priority list are available.

---

To calibrate the internal node clock:

1. Select Configure → Synchronisation. The Synchronisation window will be displayed.

2. Click the NE Clock tab if it is not already selected. The current internal source being used for synchronisation is shown in the Status group box.

3. In the Internal Clock group box, check the Calibrate Internal Clock option.

4. Select Data → Send to Node.

The internal node clock should be calibrated at least once a year.
To select the source to be used for external synchronisation output:

1. Select **Configure → Synchronisation**. The **Synchronisation** window will be displayed.

2. Click the **Sync Output** tab if it is not already selected.

![Synchronisation window](image)

**Figure 9**  **Sync Output** tab of the **Synchronisation** window

3. Select the source of the ExtS1 Reference Signal.
   
   The options are:
   
   - **Node clock** (the current node clock is used as the reference for the output)
   - **Other** (a manually selected source is used for the output).

4. Select **Data → Send to Node** to send the contents of the window to the node.

---

**Note**

The synchronisation output is out of use:

- in hold-over mode
- when the internal clock is used.
3.9 Configuring management channels (DCN time slots)

This section describes the settings for Node Manager and network management communication between the nodes. These settings define whether the management data channel is connected via the data communications channel of the selected 2M signal to the remote node. When the channel is enabled at both ends of the 2M link, management traffic can access the remote node.

To connect to the Q3 stack:

1. Select Configure → Man. and Aux. Channels to open the Management and Auxiliary Channels window. The window shows the current management channel status for all the Q3 stacks in the node. The Q3 Management tab is displayed by default.

![Management And Auxiliary Channels window](image)

Figure 10 The Q3 Management tab

2. In the Q3 Management tab, select a Q3 stack of the wanted unit in the Q3 Stack column.

   The NCU has two Q3 stacks and TR2M4 unit four Q3 stacks to choose from, each of these stacks providing 31 time slots (1 to 31).

3. Click the Configure button. The Configure Ux NCU/TR2M4 stack dialog box opens (the x stands for the unit slot number).

4. In the Connection tab, click on the + of the desired interface.

5. Click on the desired time slot + Ux 2M if 1 TS-x for the DCN channel to be created. The To PDH will be highlighted. Click OK.

Repeat steps 2. to 5. for each DCN channel you want to create.

6. Select Data → Send to Node.
To add a node neighbour manually to the Q3 routing table:

1. Select Configure → Man. and Aux. Channels. The Management and Auxiliary Channels window will be displayed.

2. In the Q3 Management tab, select a Q3 stack of the desired unit in the Q3 Stack column. Then click on Configure to open the Configure Ux NCU/TR2M4 Stack dialog box (the x stands for the unit slot number).


4. Select a member from the Sub-Network Point of Attachment (SNPA) list.

5. Type in a System ID and click OK.

6. Select Data → Send to Node.
To connect to the Q1 stack:

1. Select **Configure → Man. and Aux. Channels** to open the **Man. and Aux. Channels** window where you can set up the DCN.

2. Click on the **Summing Points** tab.

3. In the **Summing Points** tab, select a summing point for the configuration from the drop-down list. Then click on the **Configure** button. The **Configure Summing Point** dialog box opens.

4. In the **Aux.**, **TS-N** and **ISDN-UQ** tabs, select the type of connection point.

5. Click on the + of the desired interface and item for the Q1 connection to be created.

6. Select the desired item:
   - for the auxiliary interfaces (**AUX** tab): asynchronous, co-directional, contra-directional DCE or contra-directional DTE
   - for the 2M time slots (**TS-N** tab): To PDH
     
     Note that in every separate NCU or TR2M4 unit, only two time slots from all the 2M interfaces of the unit can be connected to a summing point.
   - for the ISDN interface (**ISDN-UQ** tab): D-channel.
To determine the role of the connection, click the Add Master or Add Slave button. Repeat steps 4. to 7. for each Q1 summing point you want to create.

8. Click OK. Then select Data → Send to Node to send the contents of the window to the node.

### 3.10 Configuring external alarms and station alarms

You can use Node Manager to enable or disable the use of external alarms and station alarms on the node. The default setting is Disabled.

To enable or disable the use of station alarms:

1. Select Monitor → External Alarms. The External Alarms and Station Alarms window will appear.

![External Alarms And Station Alarms window](image)

**Figure 13 External Alarms And Station Alarms window**

2. In any of the three tabbed windows, click the Station Alarms check box to enable or disable station alarms.

**Note**

To avoid problems in interpreting the alarm history log, we recommend that you do not change severities for alarms that are ON.
3.10.1 Configuring Digital Inputs

To configure digital inputs:

1. In the External Alarms and Station Alarms window, Digital Inputs tab, select an input from the drop-down list box in the Alarm group box. There are three PAIs for each NCU and LMU. PAI1, PAI2 and PAI3 are for the first (leftmost) NCU in the subrack and the next three inputs for the LMU (or the next NCU).

   The Status box shows whether the alarm is On or Off. If you have a colour monitor, the background colour of the Status box will be red when the alarm is on and green when the alarm is off. If you have a monochrome monitor, the background colour of the Status box will be dark grey when the alarm is on and white when the alarm is off.

2. From the Indication drop-down list box, select whether this input is shown as an Alarm or as a Status report.

3. From the Severity drop-down list box, select a severity for the alarm. There are four levels of severity:
   - Critical
   - Major
   - Minor
   - Warning.

4. From the Probable Cause drop-down list box, select an alarm text for the alarm.

5. In the Time constant drop-down list box, select No filtering or a time period.
   - The time constant is the minimum filtering time before an alarm state change can occur on the node.

6. From the Polarity drop-down list box, select Normal logic or Reverse logic.
   - Normal logic: an alarm is triggered by the signal going high
   - Reverse logic: an alarm is triggered by the signal going low.

7. In the Additional text box, enter a description of the alarm.

8. Select Data → Send To Node to send the new setup to the node.
3.10.2 Configuring Digital Inputs/Outputs

This window is used to configure interfaces which can be set to act as either inputs or outputs. In the External Alarms and Station Alarms window, Digital Inputs/Outputs tab, select the appropriate option button:

- Use as alarm output
- Use as alarm input.

To configure a digital interface as an alarm output:

1. In the Alarm group box, select an interface from the drop-down list box. There are two PAIOs for each NCU and LMU. PAIO1 and PAIO2 are for the first (leftmost) NCU in the subrack and the next two inputs for the LMU (or the next NCU).

2. From the Polarity drop-down list box, select Normal logic or Reverse logic.
   - Normal logic: an alarm is triggered by the signal going high
   - Reverse logic: an alarm is triggered by the signal going low.

3. In the Additional text box, enter a description of the alarm.

4. From the Forced alarm status drop-down list box, select one of the three options:
   - Active
   - Auto
   - Cleared.

5. From the Connect to input drop-down list box, select the alarm input to which the alarm output is to be mapped. The content of the list depends on the number of NCUs and LMUs present in the subrack.

6. Select Data → Send To Node to send the new setup to the node.

To configure a digital interface as an alarm input, please refer to section 3.10.1.
3.10.3 Configuring Analog Inputs

To configure analog inputs:

1. In the External Alarms and Station Alarms window, Analog Inputs tab, select an input from the drop-down list box in the Alarm group box. There are two IAVs for each NCU and LMU. IAV1 and IAV2 are for the first (leftmost) NCU in the subrack and the next two inputs for the LMU (or the next NCU).
   - IAV1 is an input with a voltage range from 0 to +5 V.
   - IAV2 is an input with a voltage range from 0 to –70 V.

   The Status box shows whether the alarm is On or Off. If you have a colour monitor, the background colour of the Status box will be red when the alarm is on and green when the alarm is off. If you have a monochrome monitor, the background colour of the Status box will be dark grey when the alarm is on and white when the alarm is off.

2. From the Indication: drop-down list box, select whether this input is shown as an Alarm or as a Status report.

3. From the Severity: drop-down list box, select a severity for the alarm. There are four levels of severity:
   - Critical
   - Major
   - Minor
   - Warning.

4. From the Probable Cause drop-down list box, select a text for the alarm.

5. In the Time Constant drop-down list box, select either No filtering or a time period.
   - The time constant is the minimum filtering time before an alarm state change can occur on the node.

6. From the Polarity: drop-down list box, select either Normal logic or Reverse logic.
   - Normal logic: an alarm is triggered when the voltage is outside the range
   - Reverse logic: an alarm is triggered when the voltage is within the set range.

7. In the Additional text box, enter a description of the alarm.

8. From the Edit threshold box, select a value for the high and low threshold to trigger or cancel the alarm. The range for the high threshold is 100 to –99 and for the low threshold –100 to 99. (The values are percentages of the maximum voltage level for the selected input, see the examples below.)
   - The Voltage box is read-only. It displays the last read voltage from the selected line.

9. Select Data → Send To Node to send the new setup to the node.
Examples of setting alarm thresholds

*Input 1 (IAV1), with the voltage range from 0 to +5 V*

To set the allowed voltage range from 2 V to 4 V (so that an alarm will be raised if the voltage is outside of this range):

1. Set the low threshold value to 40(%), which gives voltage level
   \[0.4 \times 5 \text{ V} = 2 \text{ V}\]
2. Set the high threshold value to 80(%), which gives voltage level
   \[0.8 \times 5 \text{ V} = 4 \text{ V}\]

*Note*

Giving a negative value (−1 to −100) has the same effect as setting the threshold value to 0 (zero).

*Input 2 (IAV2), with the voltage range from 0 to −70 V*

To set the allowed voltage range from −35 V to −56 V (so that an alarm will be raised if the voltage is outside of this range):

1. Set the low threshold value to −80(%), which gives voltage level
   \[−0.8 \times 70 \text{ V} = −56 \text{ V}\]
2. Set the high threshold value to −50(%), which gives voltage level
   \[−0.5 \times 70 \text{ V} = −35 \text{ V}\]

*Note*

Giving a positive value (1 to 100) has the same effect as setting the threshold value to 0 (zero).
3.11 Creating and configuring a V5 interface

Note
An Eksos N20 node can have up to four V5.2 interfaces. The maximum number of V5.1 interfaces depends on how many TR2M4 units have been installed in the Eksos N20 node.

---

Note
The V5.2 interface running in the node master unit can support the maximum of 256 ISDN or 512 PSTN connections. If you need a bigger node, you must install a second NCU unit to operate the V5.2 interface.

---

Note
We recommend that you configure the V5.2 interfaces at the Local Exchange end and the V5.1 interface at the V5.1 multiplexer before configuring them in Eksos N20. This way you get the needed IDs at the LE and at the V5.1 multiplexer and also minimise the number of management sessions to the LE and V5.1 multiplexer.

3.11.1 V5.2 interface

The V5.2 Interface wizard leads you through all the necessary windows, which cover the following main tasks:

- configuring interface settings
- configuring 2M links
- configuring communication channels (C-channels)
- configuring signalling.

To configure interface settings:

1. Select Configure → V5 Interfaces. The V5.2 Interface Wizard starts with Configure V5 Interfaces dialog box as its first window.
Figure 14  Configure V5 Interfaces dialog box

2. Click the New V5.2... button. Then, click Next>.
   - The New V5.2... button is enabled if the number of existing V5.2 interfaces is less than four.

3. Enter Interface name, Interface ID and Provisioning variant.
   - Interface ID is the interface's unique number within the LE and therefore the Interface ID must be the same as the ID at the LE. If the ID is not the same at both ends, the exchange cannot recognise the Eksos N20 node.
   - The provisioning variant must be the same as the one at the LE.

4. Select the V5 Master Unit. The V5 Master Unit box contains a list of the unit numbers for all NCUs that can be selected as the V5 master unit. If not selected otherwise, Node Manager puts the V5 Master Unit on the first NCU available that is not the Node Master. If the Node Master is the only NCU available, this unit will be proposed by Node Manager.

Note
Selecting the node master unit of the Eksos N20 node to be the V5 master will reduce the overall performance of the Eksos N20 node. The node master unit is the NCU in slot 1 in the Eksos N20 subrack or in slot 3 in the Eksos N20 / SAN subrack.

5. In the Interface window, click Advanced... The Advanced V5.2 Interface Settings dialog box will be displayed.
   If you are willing to accept the default settings shown, click Cancel to return to the Interface window, and then click Next> to proceed immediately to configuring 2M links. If you want to change some of the settings, continue from step 6.
Figure 15  Advanced V5.2 Interface Settings dialog box

6. Select one of the three option buttons in the Link ID Checking group box.
   - The setting should be the same at the LE.
   - The Enable Link ID Checking is the default and recommended selection as long as CRC4 error checking is selected for the link.

7. In the Startup group box, select the options wanted.
   - The possible values for Startup delay are 1 to 60 minutes. The default value is 2 minutes.
   - The settings for Startup allowed during PSTN failure and Accelerated Unblocking should match the settings on the corresponding V5.2 interfaces within the LE.

8. In the Alarm Reporting group box, select which error types you wish to have reported.

9. In the 2M Fault Timers group box, select the values for Fault On and Fault Off. The values can be set in the range 1 to 250.

10. Click OK.
To configure 2M links:

1. In the **Interface** window, click **Next** to proceed. The **2M Links** dialog box is displayed.

![2M Links dialog box](image)

**Figure 16** 2M Links dialog box

2. Select a 2M link by clicking on it, then click the **Add Link** button. The **Add Link** dialog box opens.

A V5.2 interface can contain up to 16 links. When the maximum number of links has been reached, the **Add Link** button becomes disabled.
3. In the **Add Link** dialog box, enter a suitable **Link ID**. The Link ID given here must be the same as the one given at the LE. In the **Timeslot usage** group box, select the time slots which you want to use for V5.2 and then click **OK**.

The V5.2 interface may use some or all of the 2M links available on the node. Each link in the interface has a unique link ID within the interface. This ID must be supplied at both ends of the link (that is, the Eksos N20 node and the LE).

4. Click **OK**.

---

**Note**

Repeat steps 2. to 4. for each 2M link.
To configure communication channels (C-channels):

**Caution**

The C-channel configuration in the Eksos N20 end must be identical with the configuration defined in the LE.

1. In the **2M Links** window, click **Next** to open the **C-channels** dialog box.

![C-channels dialog box](image)

**Figure 18**  **C-channels** dialog box

2. In the **C-channels** dialog box, click the TS 16 cell to select it. Then click **Add** to open the **Add C-channel** dialog box.

   For each of the 2M links created, configure a C-channel by selecting a cell representing the required time slot.

**Note**

Vital signalling and vital standby must always be configured in time slot 16.
3. In the Add C-channel dialog box, type a C-channel ID and click OK.

Notice that C-channel IDs must be mapped to time slots before PSTN or ISDN C-paths can be configured for them.

4. If more than one link is used, a protecting signalling protocol (Vital Standby) must be assigned. Select time slot 16 of the secondary link and assign the protecting signalling protocol to it by clicking on Vital Standby. Then click Next>.
   - The protecting C-channels do not require C-channel IDs.

5. Set standby C-channels for the PSTN or ISDN signalling by selecting a time slot and clicking on Standby. The maximum number of standby channels per V5.2 is three.

To configure signalling (mapping):

1. In the C-channels dialog box, click one of the time slot cells to select it. Then click Add... to open the Add Signalling dialog box.

2. Check the Vital check box.

   The link for which you configure the vital signalling will be the primary link.

3. Check the PSTN check box. The C-path for PSTN signalling can be configured to the same time slot as the vital signalling. Click OK.

4. Select a time slot from the list by clicking on it, then click Add... to open the Add Signalling dialog box.
The C-path for ISDN signalling is recommended to be configured to a separate time slot from the PSTN and Vital signalling. Select, for example, time slot 15 of the primary link and assign the ISDN signalling to it.

5. Check the **ISDN-Ds** and **ISDN-p** check boxes, if these are relevant for you, and click **OK**.

6. Select the **PSTN mapping** drop down box to set the country mapping.

7. When all configuration is complete, click **Finish**. A summary page will be displayed to allow entered details to be verified. If any details shown are incorrect, click **<Back** to return to previous pages.

8. Once all details are verified correct, click **Create** to create the V5.2 interface.

**Figure 21** Summary page
3.11.2 V5.1 interface

The V5.1 Interface wizard leads you through all the necessary windows which cover the following main tasks:

- setting interface settings
- configuring a 2M link
- configuring communication channels (C-channels).

Note
It is necessary that a V5.2 interface be configured before configuring the V5.1 interface.

To configure interface settings:

1. Start by selecting Configure → V5 Interfaces. The V5.1 Interface Wizard opens with Configure V5 Interfaces dialog box as its first window.

2. Click the New V5.1... button to create a new V5.1 interface. Then, click Next>.
   - The New V5.1... button is enabled when the Eksos N20 node has less than the maximum number of V5.1 interfaces that can be supported by the TR2M4 units.

3. Enter Interface name, Interface ID and Provisioning variant.
   - Interface ID is the interface’s unique number within the V5.1 node and therefore the Interface ID must be the same as the ID at the V5.1 node.

4. In the Interface window, click Advanced... The Advanced V5.1 Interface Settings dialog box will open.
If you are willing to accept the default settings shown, click **Cancel** to return to the **Interface** window. Then click **Next** to proceed immediately to configuring the 2M link. If you want to change some of the settings, continue from step 5.

![Advanced V5.1 Interface Settings dialog box](image)

**Figure 23**  **Advanced V5.1 Interface Settings** dialog box

5. In the **Startup** group box, select the options wanted and click **OK**.

6. In the **Startup** group box, select the options wanted.
   - The possible values for **Startup delay** are 1 to 60 minutes. The default value is 2 minutes.

7. In the **Alarm Reporting** group box, select which error types you wish to have reported.

8. In the **2M Fault Timers** group box, select the values for **Fault On** and **Fault Off**. The values can be set in the range 1 to 250.

9. Click **OK**.
To configure the 2M link:

1. In the Interface window, click Next>. The 2M Links dialog box will open.

2. From the Associated and Available Links list, select a 2M link, then click Add Link…. The Add Link dialog box opens.

3. In the Add Link dialog box, select the time slots which you want to use for V5.1 and then click OK.

Note
When you have selected and added a link, it is not possible to add any further links because there is only one link in a V5.1 interface.

To configure communication channels (C-channels):

1. In the 2M Links dialog box, click Next> to open the C-channels dialog box.

2. In the C-channels dialog box, click one of the time slot cells to select it.

3. Click the Next> button to open the Signalling dialog box.

4. In the Signalling dialog box, click the cell where you placed the C-channel. Then click Add to open the Add Signalling dialog box.

5. Check the Vital, PSTN, ISDN-Ds and ISDN-p boxes if they are relevant for you to set the signalling. Then click OK. Your selections now show in the Signalling dialog box.

Note
As there is only one 2M link in a V5.1 interface, time slot 16 is always used for vital signalling. Vital signalling cannot be moved from time slot 16.

6. When the configuration is complete, click Finish. A summary page will be displayed to allow the entered details to be verified. If any details shown are incorrect, click <Back to return to previous pages.
Figure 24  Summary page

7. Once all details are verified correct, click Create to create the V5.1 interface.
3.12 Configuring PSTN interfaces

This section lists the interface-specific attributes that need to be set before the PSTN interfaces can be brought into use.

Caution

The DC feed settings affect PSTN units' power consumption and heat dissipation. For more information about the settings, see the Country Specific Instructions.

To specify the DC Set/General/Speech settings:

1. Select the PSTN unit which you want to configure by clicking on it in the Subrack window.
2. Select Configure → Interface to open the Ux PSTN dialog box (x stands for the slot number where the unit is installed).
3. Select an interface by clicking on it, then right-click Configure. The Configure PSTN Ux dialog box opens.

![Configure PSTN Ux dialog box](image)

Figure 25 The DC Set tab of the Configure PSTN Ux dialog box

4. In the DC Set tab/General tab/Speech tab, select the interface you want to configure.
- The Also Apply To... button allows you to specify that any editing changes which you have made in one interface will also be made to one or more of the other interfaces in the tab which is open. These editing changes only become visible after the data has been sent to the node.

5. If you want, enter a name for the interface. The name can be up to 20 characters long.

6. Select the wanted options from the drop-down list boxes.
   For information about the values needed, see the Specific Instructions for XX in this manual.

7. When the settings in the tab are as you want them, click OK. Then select Data → Send to Node to send the contents of the window to the node.
3.13 Configuring ISDN interfaces

This section lists the attributes that need to be set before the ISDN interfaces can be brought into use.

To configure the Power Feeding:

1. Select the ISDN unit which you want to configure by clicking on it in the Subrack window.

2. Select Configure → Interface to open the Ux ISDNUQ dialog box (x stands for the slot number where the unit is installed).

3. Select an interface by clicking on it, then right-click Configure. The Configure ISDNUQ Ux dialog box opens.

4. Select the Power Feeding tab.

5. In the Unit Power Feeding group box, select the Feeding voltage required. This voltage is applied to all ports of the selected ISDN unit. The default is 0 V. For more detailed instructions, see the Country Specific Instructions.
6. In the **Interface Power Feeding** group box, set the interface levels. Select one of the ports, which are listed by number, and then click **Edit...** Set the maximum power in the **Maximum Power** text box at the planned level in range 0 to 6 000 mW. The maximum power can be adjusted at 100 mW intervals. Setting the maximum power to 0 mW means that the port is switched off, regardless of the **Unit Power Feeding** settings, as no current is driven to the ports. Be careful not to exceed the maximum permitted unit power level.

---

**Caution**

If the configuration is incorrect (that is, if the sum of maximum power defined for all interfaces is bigger than the maximum permitted unit power), the unit may reset or stop working.

If the configuration is correct and the power consumption of the whole unit is bigger than the maximum permitted unit power, the interface with the biggest delta is switched off (delta = power consumption of the interface – maximum interface power). If the power consumption is still too high, further interfaces are switched off. This only happens if the interfaces are driven in the unit mode.

<table>
<thead>
<tr>
<th>Line feeding voltage</th>
<th>Maximum permitted unit power level</th>
</tr>
</thead>
<tbody>
<tr>
<td>65 V</td>
<td>23.8 W</td>
</tr>
<tr>
<td>70 V</td>
<td>25.5 W</td>
</tr>
<tr>
<td>97 V</td>
<td>35.0 W</td>
</tr>
<tr>
<td>110 V</td>
<td>37.3 W</td>
</tr>
</tbody>
</table>

**Table 9** Maximum unit power levels allowed for different feeding voltages

7. From the **Power Limited by** drop-down list box, select either **Unit** (power to the interface is cut off when the unit limit is exceeded) or **Interface** (power to the interface is cut off when the interface limit is exceeded). When the settings are as you want them, click **OK**.

- **Unit** is the default setting and means that the power is cut off when the unit-level limit has been exceeded.

**Actual Power** is not editable. This value shows the actual power as measured at the interface. It is not updated automatically, so if you want to see what the current level is, close the window and select **Data → Refresh from Node**.

8. Click **OK**. Then select **Data → Send to Node** to send the contents of the window to the node.
Thresholds allow you to specify two parameters relating to DEG (DEGraded signal) alarms, for a particular interface or for a specified set of interfaces.

To configure the Threshold parameters, follow the procedure below:

1. Select the ISDN unit which you want to configure by clicking on it in the Subrack window.

2. Select Configure → Interface to open the Ux ISDN dialog box (x stands for the slot number where the unit is installed).

3. Select an interface from the list and right-click Configure. The Configure ISDNUQ Ux dialog box opens.

4. In the Thresholds tab, select the interface you want to configure.
   - The Also Apply To... button allows you to specify that any editing changes which you have made in one interface will also be made to one or more of the other interfaces in the tab which is open.

5. If you want alarms to be reported for this unit, check the Monitored check box.

6. If you want, enter a name for the interface in the Name text box. The name can be up to 15 characters long.

7. In the Definition of Bad Seconds group box, select a number from the Minimum number of bad blocks in a bad second box.
   - This attribute specifies the threshold value for bad blocks during one second. Note that the detection of bit errors differs between units using 2B1Q and 4B3T line code. 2B1Q units detect bit errors using CRC12 checks on multiframe basis, whereas 4B3T units detect line code violations. For this reason also the allowed range of values is different for 2B1Q and 4B3T units:
     - 2B1Q: 0 to 666 blocks
     - 4B3T: 0 to 1000 blocks.
   - The default value is 0, which means that no performance alarms (Far-End Block Error) are generated from this interface.

8. To define when a DEG alarm is being issued, select a number from the Number of consecutive bad seconds before DEG alarm box.
   - The number selected specifies the number of consecutive bad seconds that are detected before the DEG (Degraded signal) alarm is generated. The minimum number you can select is 2, and the maximum is 10 (default is 5).

9. Click OK and select Data → Send to Node to send the contents of the window to the node.
3.14 Provisioning user ports

Note
To provision user ports, the V5 interface has to be created first.

This section gives advice on how to configure interfaces and time slots using the Interface Usage window. This window displays how the tributary and aggregate interfaces of the Eksos N20 node are used. The window displays the following information:

- physical interfaces of the PSTN, ISDN and DIU units
- time slots of the TR2M4 unit
- interfaces of the NCU unit.

You can carry out the following tasks with the Interface Usage window:

- identifying tributary and aggregate interfaces and time slots in use
- tracking faults
- configuring, editing and deleting user ports for specified physical interfaces
- blocking user ports for testing purposes.
3.14.1 Identifying interfaces and time slots

To identify interfaces and time slots, follow the procedure below:

1. Select the unit in the Subrack window by clicking on the unit.

2. Select Configure → Interface Usage from the menu. The Interface Usage dialog box will open.

![Interface Usage dialog box](image)

Figure 27 The Interface Usage dialog box

3. In the Tributaries tab and NCUs tab, you can identify how the tributary and aggregate interfaces and time slots are being used.

- The Location column gives the unit number, interface number and for TR2M4 units the time slots.
- For ISDN interface, the Capacity column shows how much capacity has been used for the application given in the Usage column. The possible values are b1, b2, d, blank and any combination of these.
- The Usage column shows what the interface or time slot is being used for
- The Alarm column shows the most severe alarms.
3.14.2 Configuring, editing and deleting user ports

Note
Before starting to configure, edit or delete user ports, refresh the window manually by selecting Data → Refresh from Node.

Each PSTN unit may have up to 32 user ports and each ISDN unit up to 16 user ports. The TR2M4 unit has four 2M interfaces. Each user port must be individually added to the V5.2 or V5.1 interface, and the appropriate user port address supplied. This is the address which identifies the subscriber at the local exchange.

To select user ports, follow the procedure below:

1. Select the unit in the Subrack window by clicking on the unit.
2. Select Configure → Interface Usage from the menu. The Interface Usage dialog box will open.
3. Select the User Ports tab.

![Interface Usage dialog box]

**Figure 28** The User Ports tab in the Interface Usage dialog box

4. In the Units to include list box, select which units you want the window to show: All units, PSTN units, ISDN units, TR2M4 units.
5. In the Usage to include drop-down list box, select All.
The other alternatives can be used to edit or delete user ports:

- **User ports** (all assigned interfaces/time slots which have been assigned as user ports)
- **Unassigned** (all interface/time slots which have not been assigned, but can be assigned)
- **Non-V5** (all interfaces/time slots which are not in V5 use).

6. In the **Data to show** group box, select whether you want to identify V5.1 or V5.2 interfaces. The other options in this group box are:

- **Location** displays the unit and interface number, and the time slot number for TR2M4 units.
- **Usage** displays whether the interface is used for a leased line, management & auxiliary channel, V5.1 or V5.2.
- **Operational data** displays the operational state, status, request and alarm information.
- **Port settings** displays if the port is used for leased lines or grading.

The availability of these options is determined by the selections in the **Units to include** and **Usage to include** list boxes.

7. Select a port by clicking on it in the list. To add the port to the V5.2 or V5.1 interface, click **Assign**. You can select more than one port by using the **SHIFT** or **CTRL** key in conjunction with the mouse or the up and down arrow keys, in the standard way for Windows.

To delete a port, click on **Unassign**.

Depending on the port selected, the **Assign L3 Address to PSTN Port**, **Assign EF Address to ISDN Port** or **Assign User Ports on TR2M4 Unit** dialog box will open.

![Assign L3 Address to PSTN Port](image)

**Figure 29** The Assign L3 Address to PSTN Port dialog box
To assign addresses to user ports, follow the procedure below:

**Note**
You can assign ISDN and PSTN user ports by double-clicking the line in the **Location** group box.

1. In the **Interface Usage** dialog box, select the **User Ports** tab.
2. PSTN or ISDN unit: enter the V5.2 interface ID and L3/EF address in the **User Ports** tab, **Address to assign** group box.
   TR2M4 unit: enter the V5.2 interface ID and L3/EF address in the **V5.2 address to assign** and **V5.1 address to assign** group box.
   - The L3 addresses of the PSTN ports and the EF addresses of the ISDN ports have to be identical to the port addresses assigned at the LE.
3. PSTN and TR2M4 units: you can set up a semi-permanent leased line by checking the **Semi-permanent leased port** box. By default, this feature is off.
   ISDN and TR2M4 units: select the **C-Channel ID** in the **Signalling** group box.
   You can also enable **Grading Messages** in the **Description** group box.
   Enabling grading messages causes a notification to be sent to the LE if the threshold set for the DEG alarm has been exceeded (see above).
4. Click **OK** and select **Data → Send to Node**.

### 3.14.3 Blocking and unblocking a user port

Node Manager allows you to block or unblock a port in the V5 interface for testing purposes, for example.

**Note**
If you want to block PSTN semi-permanent lines, make sure that the LE supports this function. All local exchanges do not support blocking of semi-permanent lines.

To block a user port:

1. Select the unit in the **Subrack** window.
2. Select **Configure → Interface Usage** from the menu. The **Interface Usage** dialog box will open.
3. Select the **User Ports** tab.
4. From the list, select the user port that you want to block.
5. Select either **Block** or **Block Now**.
   - Selecting **Block** causes a blocking request to be sent to the LE. The port will not be blocked until the LE grants a blocking permission (that is, not until the ongoing call is finished).
   - Selecting **Block Now** causes the port to be blocked immediately, that is, it interrupts a phone call possibly on at the moment of giving the blocking command.

To cancel a blocking request selected with the **Block** option:
1. Open the appropriate user port window.
2. Select the user port which is blocking.
3. From the **Request** box, select **Abort Block**.

To unblock a user port:
1. Open the appropriate user port window.
2. Select the user port that you want to unblock.
3. From the **Request** box, select **Unblock**.

### 3.15 Starting or stopping a V5 interface

To start or stop a V5 interface, follow the procedure below:
1. Select **Configure** → **V5 Interface**. The **Configure V5 Interface** dialog box will be displayed.
2. From the **V5.1 and V5.2 Interfaces** list box, select an interface.
3. Select the wanted option.
   - The buttons are enabled only if the related actions are valid for the selected interface. This box only displays values which are valid for the current state of the selected interface.
   - To start an interface, select **Start**. You cannot change the signalling without stopping an interface.
   - To stop an interface, select **Stop**. Note that selecting **Stop** will stop all traffic.
   - Selecting **Restart PSTN** will restart PSTN protocols and will disconnect all PSTN traffic.
4. Select **Data** → **Send to Node**. You can check the **Status** in the **V5.1 and V5.2 Interfaces** list box.
3.16 Editing or deleting a V5 interface

Note
Before starting the editing, refresh the window manually by selecting Data -> Refresh from Node. Some of the edit functions also require stopping the interface.

Editing an existing V5 interface may be necessary:
- to review configuration in case it does not match that on the local exchange
- to move or add/delete signalling from one 2 link to a new link
- to run tests on the 2M link
- to block a 2M link.

Note
If security is enabled, you must hold at least user access level 4 to be able to configure an existing V5 interface.

To edit or delete a V5 interface, follow the procedure below:
1. Select Configure -> V5 Interface to display the Configure V5 Interface dialog box.
2. From the V5.1 and V5.2 Interfaces list box, select an interface.
3. Click the Delete or Edit button for the wanted option.
   Selecting the Edit button opens the Configure V5.2 Interface Properties or Configure V5.1 Interface Properties dialog box, depending on the selected interface type.
4. Select Data -> Data Send to Node.

Note
If the selected link belongs to an interface that has been started, you should first stop the interface. However, it is possible to delete a link from a started interface as long as the link contains no signalling.

To add a new 2M link to an existing V5 interface, follow the procedure below:
1. Stop the V5 interface in Eksos N20. If you do not want to configure C-channels, this step is unnecessary.
2. Make the necessary modifications in the LE configuration.
4. Add the new link to the Eksos N20 V5 interface. First add the link, then assign C-channels if necessary.
5. If you had to stop the V5 interface, start it again.
Note
When you are reconfiguring the subscriber signalling, first delete the old part (C-channels and standby channels) and send the changes to the node. Then refresh the settings manually and only after that configure the new subscriber signalling with the same settings as at the LE.

3.17 Configuring service switches

This section lists the procedures that are required to bring the service switch into use. When configuring the service switch, take into account the following configuration restrictions:

- one service switch connection per plug-in unit
- plug-in units can access one out of two accessible bus lines
- up to eight service switch connections for PSTN units per subrack
- up to eight service switch connections for ISDN units per subrack
- line tests have higher priority than service switch connections, which is why service switch connections are not activated during ongoing line tests.

Note
Before starting to configure service switches, make a plan and follow it consistently.

Note
Make sure that the units have been installed and physical cabling for the service switch has been done before configuring the service switch cabling.
3.17.1 Configuring service switch cabling

To configure the service switch cabling:

1. Select Configure → Service Switch Cabling from the main menu. The Service Switch Cabling dialog box will open.

   The Service Switch Cabling dialog box provides an overview of all service switch connections and available services.

![Service Switch Cabling dialog box]

   Figure 30 Service Switch Cabling dialog box

2. Select the line that you want to configure in the PSTN connections or ISDN connections group box, and then click the Configure button. (Alternatively double-click the line you want to change.) The Configure Service Switch Cabling dialog box will open.

   The Configure button will only be enabled when a line is selected in one of the group boxes.

   External units are indicated by Ext. in front of the unit description.

3. In the Configure Service Switch Cabling dialog box, you can add, edit or delete cabling information for the associated connector.
4. Select the line to be configured in the **Line No** drop-down box in the **Connector** group box. Node Manager automatically chooses the line selected in the **PSTN connections** or **ISDN connections** group box as the default choice.

5. In the **Service** group box, select the required service.

6. In the **Splitter** group box, you can write the name, location, slot and interface for the splitter.

7. In the **PSTN/ISDN** group box, select the tributary interface. You can also write the name, location and slot for the service.

8. In the **ADSL unit** group box, you can write the name, location, slot and interface of the ADSL unit.

9. When the settings are as you want them, click **OK**.

10. Select **Data** → **Send to Node**. To check the updated window, select **Data** → **Refresh from Node**.

### 3.17.2 Switching a service

The procedure below presents the generic rules of service switching.

---

**Note**

Make sure that the units have been installed, physical cabling for the service switch has been done and the service switch cabling has been configured.
To switch a service, follow the procedure below:

1. Select the unit in the Subrack window by double-clicking it. The Ux <unit> window opens (x stands for the slot number where the unit is installed).

2. In the Ux <unit> window, select the interface and right-click to open the pop-up menu.

3. Select Switch Service from the pop-up menu.

4. Select a service from the Service Switch Unitx dialog box.

5. In the pop-up menu that opens, click OK, then select Data → Send to Node.

---

**Note**
If only the None option is available in the pop-up menu, make sure that you have configured service switch cabling correctly, see section 3.17.1.

---

**Note**
If you want to remove service switch cabling for a particular line, there must be no service set for that line (that is, the None option must be selected).

---

### 3.17.3 Re-configuring service switches

This section outlines the procedure for changing temporary service switches into permanent ones and releasing the resources for new remote service switches. This should be done during the first site visit after the temporary switches have been configured.

To re-configure service switches, follow the procedure below:

1. Release the service switch according to the instructions given in section 3.17.2. After this, the selected service should be None.

2. Modify the service switch cabling, if that is needed, according to instructions given in section 3.17.1.

3. If you need to install or remove plug-in units, or modify cabling, do these only after the first two steps have been done.
3.18 Configuring DIU interfaces

This section lists the interface-specific attributes that need to be set before the DIU interfaces can be brought into use.

Caution

Do not configure DIU settings when the interface is in use.

To configure a DIU interface:

1. Select the DIU unit which you want to configure by clicking it in the Subrack window. Note that the Subrack window also shows the type of the DIU unit:
   - **DIU-GG** is the 4 x G.703/G.704 unit
   - **DIU-VV** is the 4 x V.xx/X.21 unit
   - **DIU-VG** is the 2 x V.xx/X.21 + 2 x G.703/G.704 unit.

2. With the DIU unit selected, select **Configure → Interface** or double-click the DIU unit. The Ux DIU_XX window is displayed. The Unit Configuration window shows one functional block for each interface.

3. Select the interface by either double-clicking it or by right-clicking it and then selecting **Configure** from the pop-up menu. The Configure DIU-XX Ux dialog box will open.

![Configure DIU_XX Ux window](image-url)

Figure 32  Configure DIU_XX Ux window
4. In the **Interface** group box, select the desired values.
   - The **Also Apply To...** button allows you to copy all of the attribute settings to all of the interfaces selected in the **Number** box.
   - Enter a name for the interface in the **Name** text box.

5. In the **Settings** group box select the appropriate interface settings.

---

**Note**
User action in this window can cause changes to data in proceeding windows. Because of this, non-valid combinations are greyed-out.

---

You can set the rate in the **User rate** drop-down box, but note that the rate can change according to selections made in the **Settings** group box. **Cross-connect rate** is display only and its value updated by Node Manager according to the current settings.

---

**Note**
Clicking **Advanced...** opens the **Advanced DIU Interface Settings** dialog box. The contents of this window depend on the settings made in Step 5.

---

6. When the settings are as you want them, click **OK**.

7. Select **Data → Send to Node**. If you want to check the current settings, select **Data → Refresh from Node** and the view the window again.
3.19 Configuring leased lines

Note
A semi-permanent leased line is under the V5 control. A permanent leased line is provided via a cross-connect and it is not under V5 control.

Note
The Eksos N20 node cannot determine when a V5 ISDN B-channel is operating as a semi-permanent leased line. Semi-permanent ISDN B-channels are configured on the LE only.

Eksos N20 provides two separate banks for leased line settings. Each bank contains separate configuration information of leased lines for the Eksos N20 node. Only one of these banks can be activated at a time. The other bank will remain passive until it is activated.

Eksos N20 supports permanent leased lines and semi-permanent leased lines. You can edit active or inactive banks, switch an inactive bank to be active or vice versa, and copy information from one bank to another.

The following plug-in units support leased lines:

- TR2M4 (time slot 0 cannot be cross-connected)
- DIU
- NCU (time slot 0 cannot be cross-connected)
- ISDN (up to 48 x 64 kbit/s time slots for cross-connection)
- PSTN (up to 32 x 64 kbit/s time slots for cross-connection).

Note
A line test and switching an interface override a leased line.

When creating a new leased line, take into account the following restrictions:

- There must be equal capacity on both sides.
- Use only continuous blocks of connection points (time slots).
- A block of connection points (time slots) must be completely on one interface.

Note
If a PSTN interface is configured as a V5.2 user port, it cannot be reconfigured as a leased line interface. You first have to take the port out of V5 use and then you can change it to a leased line connection.
To add or edit leased lines:

1. Select **Configure → Leased Lines → Active Leased Line Bank** from the main menu (Alternatively, you can select **Inactive Leased Line Bank**). The **Active Leased Line Bank** window will open.

![Active Leased Line Bank Window](image.png)

**Figure 33** The **Active Leased Line Bank** window

2. Click the **Add.../Edit** button to create a new leased line or to edit one. The **Add Leased Line** or **Edit Leased Line** dialog box opens according to your selection.

   In the **Add Leased Line** dialog box, you can define one or more leased lines. For a leased line to be formed, you have to define two connection points.
3. In the **CP 1** list, select the first connection point. Multiple connections must use continuous connection points. Those connection points that cannot be selected are greyed out.

4. In the **CP 2** list, select the second connection point. Multiple connections must use continuous connection points. Those connection points that cannot be selected are greyed out.

5. In the **Number of Connections** box, select the number of cross-connections. Note that you cannot select this option before you have defined both connection points.

6. You can also enter or edit a name for the leased line in the **Name** box. Note that when more than one leased lines are created in the same operation, all leased lines will have the same name.

7. Once you have created or edited the required leased lines, click **OK**. The **OK** button will not be enabled until an equal number of connections are made at both connection points.

---

**Note**

Repeat steps 2. to 7. for each leased line to be added or edited.

8. Select **Data** → **Send To Node** to send the new setup to the node.
To delete a leased line:

1. Select Configure → Leased Line → Active Leased Line Bank or Inactive Leased Line Bank from the main menu. For example, the Active Leased Line Bank window will open.

2. From the n x 64 kbit/s tab, select one or more lines that you want delete.

3. To delete the cross-connections, click the Delete button.

4. Select Data → Send To Node to send the new setup to the node.

To manage a leased line bank:

1. Select Configure → Leased Lines → Bank Management from the main menu. The Bank Management window will open.

2. From the Inactive box, select a bank.

3. From the box in the middle, select the required command.
   - Copy copies all configured cross-connections from one bank to another
   - Swap activates an inactive bank
   - None is the default command which does not alter the settings.

   The arrow attributed to a command indicates the direction in which the command is to be issued.

4. Select Data → Send to Node to send the contents of the window to the node.
3.20 Configuring and viewing monitoring data

3.20.1 Current alarms list

To view current alarms, select Monitor → Current Alarms. The Current Alarms List window will be displayed, containing details of the current alarms on the currently managed node. The window is automatically updated if any new alarms occur on the node while the window is open.

![Current Alarm List](image)

Figure 35 Current Alarms List window

The alarms are displayed in the window, one per line, the most recent at the top. Each line contains the severity and classification of the alarm followed by the long form of the descriptive text message about the alarm. The severities are:

- Critical
- Major
- Minor
- Warning.

3.20.2 Event history log

The event history log is a file that is stored in memory on a node. It is used to record information about:

- alarms that have been generated by the node
- alarms that have been cleared on the node.

After the units are installed, the default state for the event logging is ‘Enabled’.

We recommend that the event history log is enabled, because if there are any problems, examining the event log will help to trace the possible fault.
To view the event history log file for the node which is currently being managed:

1. Select Monitor → Event History Log.

2. Update the contents of the Event History Log window by selecting Data → Refresh from Node.

![Event History Log window]

**Figure 36**  The Event History Log window

The alarms are displayed exactly as they would be displayed in the Current Alarm List window, except that the time and date the alarm occurred is also given. The events can be sorted according to time, severity, type or name of the event.

Alarms are displayed in the window one per line, the most recent at the top. Each line contains the time and date, severity and classification of the alarm followed by the long form of the descriptive text message about the alarm.

At the bottom of the window, you can view how full the log is and check the number of entries in the log.
To set up an event history log file for the node which is currently being managed:

1. Select Monitor → Event History Log.
2. Click Set Up…. The Set Up Event History Log dialog box appears.
3. To enable the event history file, check the Enabled check box in the Data Collection group box.
4. Select Wrap or Halt from the Full Action group box, depending on what you want to happen to the event history log file when it becomes full:
   - Wrap starts to overwrite the log file from the beginning with new alarms
   - Halt stops appending new alarms to the log file and logging will be continued only after you have cleared the log.
5. Click OK.
6. Select Data → Send To Node.

To clear the event history log file:

1. Select Monitor → Event History Log.
2. Check the Clear Log check box.
3. Select Data → Send To Node.

The event history log file will be cleared of all information. The configuration settings for the log file will be retained.

### 3.20.3 Performance monitoring

The performance windows provide the current and past error performance on functional blocks within an Eksos N20 node. Performance information conforms to G.826 and is available as absolute counts or as ratios.

The NCU collects the following performance information on both the aggregate and the tributary 2M interfaces:

- Errored Seconds (ES)
- Severely Errored Seconds (SES)
- Unavailable Seconds (UAS)
- Background Block Errors (BBE).

Before you can view performance data, you must first enable the collection of the data by configuring the performance attributes.
To configure the performance data collection:

1. In the **Subrack** window, double-click the unit (NCU or TR2M4) you want to configure.

2. Double-click the interface (2M) for which you want to enable data collection. The **Configure Ux 2M** window (x stands for the slot number where the unit is installed) is displayed.

3. In every window in which it appears, the **Performance Collection** group box allows you to choose whether performance data will be collected every 15 minutes, every 24 hours, at both of these intervals, or not at all. To enable or disable either or both of the collection intervals, check the appropriate check box.

4. Click **OK** and then select **Data** → **Send to Node**.
To view the performance data:

1. In the **Subrack** window, double-click the unit you want to configure.
2. Right-click the selected interface
   
   A pop-up menu is displayed enabling you to choose whether you want to view **Current Performance** or **Performance History**.
   
   - **Current Performance** shows information about the current recording period.
   - **Performance History** shows information about previously completed recording periods (up to 16 records).

To monitor current performance:

1. In the **Subrack** window, double-click the unit (NCU or TR2M4 unit) you want to monitor. Select an interface from the next window that is displayed.
2. Select **Monitor → Current Performance**. The **Current Performance** window will be displayed. This window contains performance details for the currently-selected unit/interface in the **Subrack** window. If no details are shown, configure the performance data collection attributes.

![Figure 38 Current Performance window](image)

Performance data is collected in periods of 15 minutes and 24 hours. The 15-minute periods start at 0, 15, 30 and 45 minutes past each hour and the 24-hour periods start at midnight each day. This means that the first period after starting data collection will generally be shorter than a full period and hence will be marked by the node as **Suspect**.

You can see the data either in absolute counts or as ratios.

**Time Elapsed** indicates the time from the start of the period.
The status can be one of the following:

- **OK**
- **Suspect**
- **Not Collected**

To monitor performance history:

1. In the **Subrack** window, double-click the unit (NCU or TR2M4 unit) you want to monitor. Select an interface from the next window that is displayed.

2. Select **Monitor** $\rightarrow$ **Performance History**. The **Performance History** window will be displayed. This window contains performance details for the currently-selected unit/interface in the **Subrack** window. If no details are shown, configure the performance data collection attributes.

![Performance History window](image)

**Figure 39**  **Performance History** window

You can select either the 15-minute periods or 24-hour periods to monitor. For other details of the window, please refer to the **Current Performance** window.
3.20.4 Block status

The Block Status window shows the active alarms and events of the selected block of the unit. Block status can be viewed for NCU, TR2M4, ISDN and PSTN units.

To view the block status:

1. In the Subrack window, double-click the unit you want to monitor.
2. Select an interface from the unit window. Then select Monitor → Block Status.

3. If you want the window to be updated automatically when new alarms occur, check Auto Refresh.

There can be multiple instances of this window to view the details of more than one block.
3.21 Line testing

This section explains how to use the line testing feature of Eksos N20. To perform most of these tests, an LMU must be installed in the node.

The tests for the ISDN and DIU units become available only when the units have been configured in their slots.

The types of tests supported are listed in Tables 10 to 13.

<table>
<thead>
<tr>
<th>Test type</th>
<th>Result format</th>
<th>Criteria, thresholds</th>
<th>Activation</th>
</tr>
</thead>
</table>
| Basic test-out (electrical tests), including measurements for the following subtests:  
- ACRMS voltage (a–gnd, b–gnd, and a–b)  
- DC voltage (a–gnd, b–gnd, and a–b)  
- Capacitance (a–gnd, b–gnd, and a–b)  
- Leakage resistance (a–gnd, b–gnd, a–b, a–batt, and b–batt) | Pass, Fail. Subtests: Value & status | All subtests’ status OK. Subtests configurable: Low, High | On-demand/scheduled |
| Loop resistance measurement $R_{a-b}$ | Value & status | Configurable Low, High | On-demand/scheduled |

Table 10  Supported test-out measurements

<table>
<thead>
<tr>
<th>PSTN Test-in tests</th>
<th>Result format</th>
<th>Criteria, thresholds</th>
<th>Activation</th>
</tr>
</thead>
</table>
| PSTN interface diagnostic test, including the following subtests:  
- Feeding voltage test  
- Feeding current test  
- Loop detection test  
- Ring trip detection test  
- Ringing current test  
- Private meter pulse test  
- CODEC test | Pass, Fail. Subtests: OK/NOK | All subtests OK. Subtests: fixed value | On-demand/scheduled |
| Dial tone test | Pass, Fail | Dial tone detected 1) | On-demand/scheduled |

1) Note that only the continuous dial tone (425 Hz) is supported.

Table 11  Supported PSTN test-in measurements
Table 12  
Supported ISDN loopback tests

<table>
<thead>
<tr>
<th>ISDN loopback tests</th>
<th>Result format</th>
<th>Criteria, thresholds</th>
<th>Activation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop1 (in line termination (LT))</td>
<td>Pass/Fail</td>
<td>1)</td>
<td>On-demand</td>
</tr>
<tr>
<td>Loop1A (in regenerator (REG))</td>
<td>Pass/Fail</td>
<td>1)</td>
<td>On-demand</td>
</tr>
<tr>
<td>Loop2 (in NT1)</td>
<td>Pass/Fail</td>
<td>1)</td>
<td>On-demand</td>
</tr>
</tbody>
</table>

1) Except for the LoopD, a selectable test pattern can be inserted and compared with the signal received through the loop. The criteria for comparing the received data is stated in Node Manager as **Percentage of error seconds**. There is a fixed threshold that will define the result of loopback test as **Fail** if more than 5% of the seconds during the loopback activation time are erroneous.

Table 13  
Supported ISDN remote tests

<table>
<thead>
<tr>
<th>ISDN Remote tests</th>
<th>Result format</th>
<th>Criteria, thresholds</th>
<th>Activation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partial activation test</td>
<td>Pass/Fail</td>
<td>NT confirmation</td>
<td>On-demand</td>
</tr>
<tr>
<td>Full activation test</td>
<td>Pass/Fail</td>
<td>NT confirmation</td>
<td>On-demand</td>
</tr>
<tr>
<td>Node sends corrupt CRC to NT1 *)</td>
<td>Pass/Fail</td>
<td>FarEndBlockError alarm</td>
<td>On-demand</td>
</tr>
<tr>
<td>NT1 sends corrupt CRC to node *)</td>
<td>Pass/Fail</td>
<td>NearEndBlockError alarm</td>
<td>On-demand</td>
</tr>
<tr>
<td>Hold NT1 state *)</td>
<td>Pass/Fail</td>
<td>NT confirmation</td>
<td>On-demand</td>
</tr>
<tr>
<td>Node sends pulse mask to NT1 *)</td>
<td>Pass/Fail</td>
<td>NA</td>
<td>On-demand</td>
</tr>
</tbody>
</table>

*) only with ISDNQ

3.21.1 On-demand tests

The **Interface Tests** window lists all of the interfaces on the node and their test-related attributes. This window allows you to request tests, view the requests before sending them to the node, and to decide against requests before sending them. It is also possible to abort or remove a running test.

Open the **Interface Tests** window by selecting **Configure → Interface Tests... → On-demand Tests** from the main menu bar.

- To request interface tests:
  1. Select **Request Test...** to open the **Configure Interface Tests** dialog box.
  2. You can now choose to perform line tests, ISDN loopbacks, ISDN remote test or DIU loopbacks by selecting the appropriate tab.
To perform line tests:

1. In the **Configure Interface Tests** dialog box, select the **Line Tests** tab.

![Configure Interface Tests](image)

**Figure 41** **Line Tests** tab

2. From the **Test Definition** group box, select the tests you want to perform.
   - **Electrical Test** and **Loop Resistance** apply to both PSTN and ISDN interfaces. The tests measure the electrical characteristics of the line. If the user sets up tests on more than one line in the same user interface operation, failure or cancellation affects all interfaces on which the test has been set up and cancels also all other tests on all interfaces sent with the same request.
   - **Interface Diagnostic** and **Dial Tone Test** only apply to PSTN interfaces. They can be requested on more than one interface.
- **External Test Access** and **Dry Loop** tests apply to both PSTN and ISDN interfaces. There can be only one external test access or dry loop in a node at a time. It is not possible to set up line tests on other interfaces while one interface is in the external test access or dry loop state. The timeout for these tests can be set in the node settings menu. These states can be cancelled also by the **Cancel** option.

- In the **External Test Access** state, the subscriber line is connected to the external test interface of the LMU, thus allowing you to conduct measurements using external measuring devices.

- Selecting the **Dry Loop** test option does not activate any tests. It is a function that disconnects the line circuit from the subscriber line and leaves the circuit in an open state, thus enabling external test access to the line (without using the LMU’s external test access interface).

- **Cable pair ID tone** behaves in the same way as the **External Test Access** and **Dry Loop** tests. **Cable pair ID tone** can only be requested for a single interface and cannot be included in a multiple test request or in a single test request on multiple interfaces. This state can be cancelled also by the **Cancel** option.

3. In the **Test Conditions** group box, specify the action which should be taken if a customer call occurs when the line test is attempted:

   - cut call,
   - reject test
   - wait.

   If there is a call attempt while the line tests are in progress and **Reject Test** has been selected, the call will fail. (This does not concern electrical measurements for PSTN interfaces).

   If you select **Wait**, the test will be conducted normally if the line becomes free during the wait time selected. If the line keeps busy, the test will be rejected.

   The **Super Cut Call** option in the **Test Conditions** group box is intended to be used when testing lines assigned for service switching. The service switch connections affect line testing only if the line to be tested is on the same unit as the switched line.

4. When you are satisfied with your selections, click **OK**. The **Test Result** window will automatically open if the **Show results when received** checkbox is checked in the **Interface Tests** window.

5. Select **Data → Send To Node**.

---

**Note**

Test results are not stored between sessions. When you click on **Close** to close down the **Interface Tests** window, the log is emptied automatically.
To perform ISDN loopbacks and patterns:

1. In the **Configure Interface Tests** dialog box, select the **ISDN Loopbacks** tab. It is only possible to make this selection if ISDN cards are installed in the node and the selected interfaces do not have active tests running.

![ISDN Loopbacks tab](image)

**Figure 42** **ISDN Loopbacks** tab

2. In the **Unit Test Pattern** group box, select the required option. The selectable test pattern options are:

   - **No Test Pattern**
   - **All bits on**
   - **All bits off**
   - **16 bit Fixed pattern**
   - pseudo random bit sequences based on **Polynomial** of orders 11 or 15.

   Each ISDN unit can have a different test pattern. Only one interface in an ISDN unit can use the test pattern.

3. In the **In result report show** box, select whether to show the results as an error ratio or as the absolute number of errored bits.
4. If you have selected a test pattern, the possible selections in the Type of loopback box are:
   - Loop1 (loop closed in the LT as close to the interface as possible)
   - Loop1A (loop closed in a repeater connected between the LT and NT)
   - Loop2 (loop closed in the NT).

   The different positions of the loops in the network make it possible to determine the position of faults.

5. In the Channels to loopback box, select a channel for loopback. The default value is b1b2d.

6. In the Test Conditions group box, specify the action which should be taken if a customer call occurs when the line test is attempted:
   - cut call
   - reject test
   - wait.

   If there is a call attempt while the line tests are in progress and Reject Test has been selected, the call will fail.

   If you select Wait, the test will be conducted normally if the line becomes free during the wait time selected. If the line keeps busy, the test will be rejected.

7. In the Loopback Test Timeout group box, set the timeout for each loopback.

8. When you are satisfied with your selections, click OK. The Test Result window will automatically open if the Show results when received checkbox is checked in the Interface Tests window.

9. Select Data → Send To Node.

---

**Note**

Test results are not stored between sessions. When you click on Close to close down the Interface Tests window, the log is emptied automatically.
To perform ISDN remote tests:

1. In the **Configure Interface Tests** dialog box, select the **ISDN Remote** tab.

2. There are six possible remote ISDN tests in the **Test Type** group box:
   - Node sends corrupt CRC to NT1 (ISDNUQ only)
   - NT1 sends corrupt CRC to node (ISDNUQ only)
   - Hold NT1 state (ISDNUQ only)
   - Node sends pulse mask to NT1
   - Partial activation test
   - Full activation test

   All of the tests can be used with ISDN 2B1Q units. Only the last three tests can be used with ISDN 4B3T units. You can set up one remote test for an interface.

3. In the **Test Timeout**, set the timeout for each test. Note that there are no timeouts for the partial and full activation tests.

4. When you are satisfied with your selections, click **OK**. The **Test Result** window will automatically open if the **Show results when received** checkbox is checked in the **Interface Tests** window.

5. Select **Data → Send To Node**.

---

**Note**

When using NT+2ab, the full activation test can pass even if there was no telephone connected to the NT.

---

**Note**

Test results are not stored between sessions. When you click on **Close** to close down the **Interface Tests** window, the log is emptied automatically.
To perform DIU loopback tests:

1. In the Configure Interface Tests dialog box, select the DIU Loopback tab.

2. There are up to eight possible remote DIU tests in the Type of loopback group box (depending on the type of DIU selected):
   - loop2 for V.xx interfaces
   - loop3 for V.xx interfaces
   - loop3C for X.21 interfaces
   - loop2B for X.21 interfaces
   - loop3B for X.21 interfaces
   - lineLoop for G.703 interfaces
   - equipmentLoop for G.703 interfaces.

3. In the Loopback Test Timeout group box, set the timeout for each test.

4. When you are satisfied with your selections, click OK. The Test Result window will automatically open if the Show results when received checkbox is checked in the Interface Tests window.

5. Select Data → Send To Node.

---

**Note**

Test results are not stored between sessions. When you click on Close to close down the Interface Tests window, the log is emptied automatically.

---

To cancel a test (after it has been configured but not sent to the node):

1. In the Interface Tests dialog box, select the test.

2. Click on the No Request button.

To abort a test (after the test configuration has been sent to the node):

1. In the Interface Tests dialog box, select the test.

2. Click on the Abort/Remove Tests button.
3.21.2 Scheduled tests

You can specify up to ten scheduled tests. For each scheduled test, you must specify:

- scheduled details (name, time periodicity)
- list of tests to be performed
- list of interfaces on which the test will performed.

To create or edit a new scheduled test:

1. Select Configure → Interface Tests... → Scheduled Tests from the main menu. The Configure Scheduled Tests dialog box will open.

![Configure Scheduled Tests dialog box](image)

Figure 43 Configure Scheduled Tests dialog box

The Test tab presents the scheduled tests actually configured on the Eksos N20 node.

- The tests are identified by an ID and a Name.
- The State column indicates if a test is enabled or disabled.
- The Result Available column displays two values for each test. The first value indicates the completion of the test and the second indicates the proportion of the test results available on Node Manager.
- The Result Request column indicates if you have requested some results to be downloaded to Node Manager.
- The State Request indicates if the state of the test should be modified.

2. Click the Add... or Edit... button to create a new scheduled test. The Add Scheduled Test dialog box opens. The Add Scheduled Test dialog box is used to configure a new or existing test.
Select an interface and click the **Delete** button to delete a specific interface. In the **Test State Request** box, you can **enable** or **disable** a scheduled test. **None** is the default value.

3. Enter a name in the **Scheduled Test Name** box.

4. In the **Schedule** group box, select a starting date, time periodicity in days and hours. Also, select the maximum duration for the test.
   - **Start time** is the time at which the first test will be conducted.
   - **Stop time** is the time at which the scheduler will stop conducting the tests.
   - **Period** is the interval between tests.
   - **Duration** is the maximum time one test round takes.
   - **Wait time** is the time before the cases rejected during the first test round are tested again.

5. In the **Stop Time** group box, select the test to run continuously (**No Stop Time-work continuously**) or set a stop time and date (**Set Stop Time**).

6. In the **Test To Perform** group box, select the test you want to perform. Then click **OK**.

The tests that you can perform are:

- **Electrical Test**
- **Loop Resistance**
- **POTS diagnostics**
- **Dial Tone Test**.

The **POTS diagnostics** and **Dial Tone Test** can also be set on ISDN units, but the tests will not be run.

7. The **Scheduled Tests** dialog box will open. Click the **Interfaces To Test...** button. The **Interface In Schedule Test** dialog box will open.

8. In the **Interface In Schedule Test** dialog box, select the interfaces to test. In the **Available Interfaces** list, select an interface you want test and then click the <= **Add** button. The selected interface will appear in the **Interfaces To Test** list. Note that you can select more then one interface at a time.

---

**Note**

You cannot perform a line test on a leased line. If you select a leased line, the <=**Add** button is greyed out.

If you want to remove an interface from the **Interfaces To Test** list, select the interface and click the **Remove =>** button.

9. Click **OK**. After clicking **OK**, Node Manager will give an estimation of the total duration of the configured test and compare it to the given **Max Duration** in the **Add Scheduled Test** dialog box. If the times are not the same, Node Manager will give a warning on this.

10. Select **Data → Send To Node**.
To view results of a scheduled tests:

1. Select Configure → Interface Tests... → Scheduled Tests from the main menu. The Configure Scheduled Tests dialog box will open.

2. In the the Test Results Get group box, select either Get Failed or Get All test information. The result can be viewed after the data has been sent to the node.

3. Click View Results. The View Results dialog box will open.

4. Click Print to print the available results. You can also clear the log by clicking Clear Log.

5. When you are finished, click Close to close the View Results dialog box.

To set a threshold for a scheduled test:

1. Select Configure → Interface Tests... → Scheduled Tests from the main menu. The Configure Scheduled Tests dialog box will open.

2. Select the Threshold Sets tab.

   You can configure up to 10 sets of threshold values for one or more interfaces. The list displays the thresholds configured on the Eksos N20 node and indicates the number of PSTN and ISDN interfaces using the threshold.

3. To create a new threshold value, click Add Set... If you want to change a threshold set that exists, select the threshold from the list and then click Edit Set... The Add Threshold Set dialog box will open.

   If you want to remove a threshold set, select it from the list and click Delete Set.

4. In the Threshold Set Name box, enter a name for the threshold set.

5. To create a new test type, click Add... If you want to change the values of a test type that exists, select the test type from the list and then click Edit... The Add threshold dialog box will open.

   If you want to remove a test type, select it from the list and click Delete.

6. In the Add threshold dialog box, select the test from the Test Type box.

   The different types of tests that are available are shown in Tables 10 and 11.

7. Select the threshold type from the Threshold Type box. Then click OK.

8. In the Threshold Sets tab, select the associated interfaces by clicking on the Associate interface button.

9. In the Interfaces In Schedule Test dialog box, you can select the interfaces to test. Select from the Available Interfaces list an interface you want to test and then click the <= Add button. The selected interface will appear in the Interfaces To Test list. Note that you can select more than one interface at a time.
Note
You cannot perform a scheduled line test on a leased line. If you select a leased line, the <Add> button is greyed out.

If you want to remove an interface from the Interfaces To Test list, select the interface and click the Remove => button.

10. Click OK. After clicking OK, Node Manager will give an estimation of the total duration of the configured test and compare it to the given Max Duration in the Add Scheduled Test dialog box.

11. Select Data → Send To Node.

To view a summary of the scheduled tests:

1. Select Configure → Interface Tests... → Scheduled Tests from the main menu. The Configure Scheduled Tests dialog box will open.

2. Select the Summary tab. This tab gives a summary of the scheduled tests and threshold sets associated with each interface. This page is read-only.

3. To close the Summary page, click on the close button in the top right corner of the window.

3.22 Stopping Node Manager

Closing the connection to a node

To stop managing the node, but without closing Node Manager:

1. Select Node → Stop Managing to end the management session.

Node Manager will now check if there are any unsent edits contained in any document windows. If there are, a warning message dialog box will be displayed telling you about the unsent edits.

2. Click OK and send the edits by selecting Data → Send To Node. Once this is complete, select Node → Stop Managing again.

When there are no document windows with unsent edits, a confirmation message dialog box will be displayed asking you to confirm that you really want to stop managing the node.

3. Click Yes. The connection to the node will be closed within a few seconds.

Closing document windows

When you choose to close down or refresh windows containing edited data which has not yet been sent to the node, Node Manager will always check first if you want to continue with the close or refresh, because you would lose the edits which you had made.
Closing down Node Manager

† Caution

It is important that you follow the procedure outlined below for closing down Node Manager. If you do not close down Node Manager using this procedure, data may be corrupted.

To completely close down Node Manager:

1. Select Node → Stop Managing.
   
   If Node Manager is managing a node when you try to close the manager, it will check if there are any document windows containing unsent edits. If there are, send the edits by selecting Data → Send To Node.

2. Close down Node Manager by one of the two following methods:
   
   • Select Node → Exit, or
   • Click the Close button (in the top right corner of the Eksos Node Manager window).

Node Manager itself will then close down. This may take a few seconds to complete.
3.23 Clearing node configuration data (‘blasting’ the node)

---

**WARNING**

Carrying out this procedure causes loss of any factory set operator configuration and any configurations you may have done yourself. Before blasting the node, you should save the configuration into a file.

---

If you are configuring a fresh node, please go to section 3.1.

If you are reconfiguring a node that has already been in use, clear first all of the existing node configuration data by carrying out the following steps.

Follow this procedure to clear node configuration data:

1. Exit from Node Manager.
2. Turn off the power to the node.
3. Remove the NCU plug-in unit from the subrack.
4. Connect a jumper across the bottom two pins of the NR2K jumper area. The jumper area is located near to the processor IC (the largest IC on the NCU) and the bottom two pins are those nearest to the NR1S jumper area.
5. Insert the NCU unit into the subrack.
6. Turn on the power to the node.
7. After a short time, the LED indicator on the NCU will start flashing orange, and the LED on the PSTN unit will turn red. The LED indicator on the ISDN unit will first start flashing orange, then go very quickly from red to orange to green, and finally turn red for a short while before going back to flashing orange. Wait about 3 minutes after this.
8. Turn off the power to the node.
9. Remove the NCU unit from the subrack again.
10. Remove the jumper from the bottom two pins of the NR2K jumper area that was set in step 4.
11. Reinsert the NCU unit into the subrack.
12. Switch the power to the node back on.
13. The LED indicator on the NCU unit will briefly go from red to orange to green, then off for a few seconds. Finally it will flash green for a few seconds, then change to a steady green.
14. Proceed to section 3.2.
Chapter 4
Managing alarms

Eksos N20 does not require scheduled maintenance. Maintenance is necessary only when the equipment indicates a fault by means of an alarm.

This chapter provides information on how to obtain detailed alarm information and how to configure alarms.

- Sections 4.2 and 4.3 describe how the LED indicators and rack alarms are interpreted.
- Section 4.4 describes how Node Manager is used for reading and managing the alarms.

See Appendix A for a list of alarm messages and probable causes for the alarms. For further information, see the Node Manager online help.

4.1 Alarm severity

All alarms have been divided into four severity classes which indicate how serious the alarms are.

**Critical alarm**
A significant part of the node functions has been lost. Typically this alarm is caused by a power failure or a missing unit.

**Major alarm**
Some functions of the node have been lost, for example, a signal fails.

**Minor alarm**
A less serious fault condition, for example, a degraded signal.

**Warning**
A condition that may cause problems under certain circumstances.
### 4.2 LED indicators of plug-in units

The plug-in units have a multicolour LED indicator on their front edge. With the subrack cover closed, the LEDs can be seen through the subrack cover.

#### Normal operation

When the node is functioning properly and there are no alarms, only the LED of the NCU is active (green), indicating that it is working and that the power is on. In Node Manager, all units where alarm monitoring is in effect are shown green.

#### Green LED

The LED will be green on the working master unit and SAN unit, when the correct power is applied to the node and no alarms are active.

#### Yellow LED

The LED of a plug-in unit turns yellow when the unit detects an alarm, whether or not the fault concerns the unit itself. A plug-in unit with the yellow LED lit should not be taken out of the subrack until the source of the failure has been located.

#### Red LED

If the red LED of a plug-in unit is illuminated, the unit has a severe fault and cannot perform its main function. The unit can be removed without further disturbance to system function, and replaced with a functioning unit. However, if the battery voltage to the DC-PSA fails, the auxiliary +5V voltage activates all the red LEDs of the node, even though there is nothing wrong with the plug-in units.

The LED can turn red for the following reasons:

- If the unit’s power block has failed or the battery voltage supply is missing. In this case the LED is illuminated by the reserve battery voltage generated by the power supply unit (DC-PSA).
- If the unit software has detected a fatal fault and is able to turn the red LED on. The failures which turn the red LED on are specific to each plug-in unit type.
- The NCU plug-in unit LED can turn red in case of critical external alarm.
- A unit that has not been commissioned can also have a red LED indication.

#### Table 14 Alarm severity mapping

<table>
<thead>
<tr>
<th>Alarm severity</th>
<th>Station alarm</th>
<th>Unit LED</th>
<th>Colour codes in Node Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>***</td>
<td>A</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Red</td>
</tr>
<tr>
<td>Major</td>
<td>**</td>
<td>A</td>
<td>Yellow</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Orange</td>
</tr>
<tr>
<td>Minor</td>
<td>*</td>
<td>B</td>
<td>Yellow</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Yellow</td>
</tr>
<tr>
<td>Warning</td>
<td>W</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Blue</td>
</tr>
</tbody>
</table>

Table 14 Alarm severity mapping
Flashing LEDs

The LED on a unit will flash when the unit is being installed with Node Manager, or if the unit is starting up, for example, after being inserted to the node.

When the LED of the NCU is flashing, the NCU is busy. For example, a unit has been inserted into the node or a unit is being installed.

LED colour and alarm severity

Alarms that have a direct physical mapping to a unit shall illuminate LEDs on the unit that they map to. This is called physical LED indication. Alarms that do not have a direct physical mapping to a unit shall illuminate LEDs on the node master unit. This is called logical LED indication. Because the unit is unable to display more than one colour simultaneously, only the highest colour severity alarm that maps to an LED shall be indicated.

4.3 Station alarm lamps and relays

Station alarms indicate problems in the Eksos N20 node or rack. When an alarm occurs, a lamp lights up on the feeding DC-PSA, so that you can quickly identify the node which is generating the alarm.

Each DC-PSA is provided with A, B and D relay outputs. In systems where a power supply adapter (DC-PSA) is used, the alarm relay information is forwarded to the alarm module of the power supply adapter. The alarm module then provides the combined A, B and D relay outputs to an external supervision system and to the corresponding rack alarm lamps. D is a reminder that the A and B alarms have been disabled with an Eksos N20 Node Manager setting.

The relay contact signal indicates an alarm by a closed contact. During normal operation, the A-alarm relay is continuously energised so that it can give an alarm even if the central battery voltage is interrupted or the power supply of the NCU fails.

Refer to the corresponding power supply documentation for more information on the function and connection options of the relay outputs.

Priorities

The station alarms have priorities A and B. The A-alarm is a prompt alarm, whose equivalence to the management system alarms is critical or major. The B-alarm is a deferred alarm, whose equivalence to management system alarms is minor. D-reminder indicates that A- and B-alarms have been disabled.

Disabling the station alarms

A and B station alarm indication for external alarms can be disabled with Node Manager. Select Monitor → External Alarms, which opens the External alarms and station alarms window where you can either enable of disable the station alarms. After they are disabled, the D-reminder becomes active and stays active until the A- and B- alarms are enabled.
4.4 Managing alarms with Node Manager

A number of different alarms can be generated by a node. For any alarm that has occurred on a node, Node Manager can provide the following information about the alarm:

- a descriptive text message about the alarm
- the severity of the alarm
- the classification of the alarm
- the time and date that the alarm occurred, if known. (This information is only available for alarms recorded in an Event history log.)

Along with a text message describing the alarm that occurred and the time of its occurrence, each alarm is graded to help identify how severe the alarm is. See section 4.1.

Using dynamic updating ensures that you are always aware of the severity of the most serious alarm on each unit in the node and that you are quickly warned when a serious alarm occurs on a unit. You can set dynamic updating on by checking the relevant options in the Categories that Poll by Default in the Polling window of the Manager Options menu.

Node Manager shows the alarm information in the following ways:

- The colour of the LED on the unit or functional block indicates the most severe alarm in that unit or block.
- **Alarm Status** area of the status bar shows the most severe alarm.
- The Current Alarms List window shows a list of current alarms for the node.
- Editable windows and all types of Configure windows show the alarms for the selected entity.
- The Block Status window shows the alarms and problems for a selected block.
- The Event History Log window shows the alarms and events chronologically with times and dates. See section 3.20.2.

When the Current Alarms window is open, it displays new alarms occurring on the node.

---

**Note**

AIS, RDI and SSF alarms only appear in the Block Status windows. These alarms are not shown in the Current Alarms List window.

---

When any type of configuration window is open, any new alarms will be displayed in the appropriate areas of the window.

When the Subrack window is open, it displays the most severe current alarm associated with each unit present in the subrack. Any new alarm occurring on a unit which is higher in severity than the current alarm shown will be dynamically updated.
When a new alarm occurs which is higher in severity than any alarm being shown, the Alarm Status area is updated.

**Current Alarm List**

Alarm information can be accessed via several windows, but if you want to view the current alarms in detail, select **Monitor → Current Alarms**.

Alarms are displayed in the window one per line, most recent at the top. Each line contains the severity and classification of the alarm followed by the long form of the descriptive text message about the alarm. The alarms can be sorted according to severity, type or name of the alarm.

Although the **Current Alarm List** window does not give you the date and time when the alarm occurred, you can obtain this information by setting up an Event History Log. For more information, refer to section 3.20.2.
Chapter 5
Upgrading

5.1 Adding and removing tributary units

Note
To ensure reliable operation, wait at least 5 seconds after removing a unit from a powered node for the unit power supplies to discharge before reinserting the unit.

Note
Do not add or remove units from the node while the green LED on the NCU is flashing. This LED flashes when the node is processing its internal data during node start-up, or after a change in the plug-in unit configuration. Note that the flashing does not always start immediately.

5.1.1 Adding tributary units

Note
When you add units, first remove the units from the configuration by selecting the No unit option and selecting Data → Send to Node. Then add the unit and send this information to the node.

To add new tributary units to the Eksos N20 configuration, follow these steps:
1. Bring the new tributary unit into use. For instructions, see section 3.6.
2. Check that the number of C-channels is adequate. See section 3.11.1.
3. Configure the unit following the instructions given in sections 3.12, 3.13 and 3.18.
5.1.2 Removing tributary units

To remove tributary units, perform the following steps:

1. Remove the unit from the equipment configuration.
2. Disconnect the signal cables and pull out the unit from the subrack.

5.1.3 Replacing tributary units

You may want to replace the existing unit with a new one, for example, when a hardware update is needed or there is a fault in the existing unit. There are two alternative ways to do the replacement depending on whether you want to restore the settings of the old unit to the new one or not.

Restoration of settings

When using this procedure, the new unit will have the same settings as the old one.

When the existing unit is replaced by a new one with the same hardware ID and the settings of the existing unit are also suitable for the new one, you should proceed as follows. No software-related configuration changes are needed.

To restore settings:

1. Disconnect the signal cables and pull out the existing tributary unit from the subrack.
2. Insert a new unit to the same unit location and connect the cables.

You will get a unit mismatch alarm or compatibility failure message if the new unit is not fully compatible with the one removed. This happens if the units are of different type (if you try to replace a PSTN unit with an ISDN unit, for instance) or if the hardware versions are not compatible with each other.

No restoration of settings

When using this procedure, the new unit will have all settings at their default values.

If you do not want to restore the settings of the existing unit or if the settings are not suitable for the new unit, proceed as follows.

1. Connect Node Manager.
2. Remove (with software command) the existing unit from the equipment configuration.
3. Disconnect the signal cables and pull out the unit from the subrack.
4. Insert the new unit in the subrack.
5. Add (with software command) the new unit to the equipment configuration.
6. Connect the signal cables.
7. Check operation.
8. Disconnect Node Manager.
5.2 Downloading software

Caution

Do not remove or install plug-in units while downloading software. This can cause the Eksos N20 node to crash.

Software can be downloaded to nodes using either the NMS Tools or Eksos N20 Node Manager. Node Manager should be used for downloading to just a few nodes.

There are two flash circuits on each unit, both of which can store software for one release. The software on one circuit is used whilst the other one is available for downloading new software to the unit. If the new software is found to be defective after activation, the old software can be taken back into use. The release of the currently used and reserve software can be seen using Node Manager.

Downloading with Eksos N20 Node Manager

Note

Software downloading should not be performed during busy hours.

Software download with Node Manager can be performed either locally or remotely. After the new software is downloaded to the units, the software can be activated using the Node Manager. The activation of the software will change the active flash circuit and start the new software.

Normally the software in the whole node, that is in every unit, is upgraded at the same time. The node software release is usually changed at the same time.

Full details for upgrading with Node Manager are given in the separate Upgrade Instructions document.

To upgrade the software from C1.1 to C2.0, do the following:

1. Install the Eksos N20 Node Manager (release C2.0).
2. Connect to a C1.1 node.
3. Download the C2.0 software.
4. Activate the software:
   - In the New Level list box of the Software Settings window, select the EKN C2.0 release.
   - Select all units from the list box and check that the unit software product code versions are the ones that you want.
   - Click on the Switch button
   - Select Data → Send to Node.
5. Disconnect from the node, then reconnect to the node.
6. Insert the new C2.0 units (DIU, TR2M4, new PSTN unit etc) in the subrack.

Full details for upgrading are given in the separate *Upgrade Instructions* document. See also *Eksos N20 Network Management Products, NMS Tools Product Overview*. 
Appendix A
Installing and using Eksos N20 Node Manager

A.1 Installing Eksos N20 Node Manager

This section describes how to install the Eksos N20 Node Manager software on the Microsoft Windows NT 4.0 operating system.

In these instructions, we assume that:

- You are an ‘administrator’ as defined by Microsoft Windows NT 4.0. If you are not an administrator, you will not be able to install Eksos N20 Node Manager.
- The computer onto which Eksos N20 Node Manager is being installed fulfills the hardware and software requirements as detailed in Product Description.
A.1.1 Modifications to your Windows operating system

Files and directories created

The Eksos N20 Node Manager installation program creates the following folder structure on your computer:

C:\NOKIAMGR
  \...other node managers
  \EksosNM2.0
    \DATA
    \NWD1.0
  \SYSTEM
    \DATABASE
    \SYSTEM32
    \INF

Figure A-1 Installation folder structure

NOKIAMGR
This is the folder in which all Nokia Node Managers are installed so that they can share common files and directories.

The default name and location for this folder is C:\NOKIAMGR. You can change the default, but you should make sure that all subsequent releases of this Eksos N20 Node Manager and any other Nokia Node Manager products are also installed in this new folder.

If an earlier version of Node Manager or any other Nokia Node Manager product has been installed, the Eksos N20 Node Manager version will be installed into this directory existing directory.

EksosNM2.0
This is the folder which contains all files specific to the Eksos N20 Node Manager version you are installing. The default folder name is derived from the product and the version number of Eksos N20 Node Manager you are installing.

DATA
This folder contains all the data which you create using Eksos N20 Node Manager, such as saved configuration details.

NWD1.0
This folder contains the Network Downloader tool.

SYSTEM
This is the folder in which files and directories common to all Nokia Node Managers are installed. The name of this folder should never be changed.
DATABASE
This folder contains the Nokia database of all areas and nodes (other than those on
the local LAN).

SYSTEM32
The same as SYSTEM (see above) but for 32-bit components.

INF
This is the folder in which all Nokia Node Manager information files are installed.
They are for use by Nokia only. The name of this folder should never be changed.

Folders created (Windows NT 4.0)
The Eksos N20 Node Manager installation program creates the Programs folder
Nokia Applications. This folder contains the Eksos N20 Node Manager
application.

If you have installed any other Nokia applications on your computer, this folder
window will have already been created. In this case, the Eksos N20 Node Manager
application will be added to this group window.

Files changed
The ODBC registry settings are amended to add an entry for [DBS] if one is not
already present. The ODBC files will be added to the WINNT\SYSTEM32 folder.

The Eksos N20 Node Manager installation program changes the Registry (part of
Microsoft Windows NT; use regedit32 to view it). The Registration sections entry
for HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services has the
following items:

- NokiaTP4
- StackMac.
A.1.2 Installation procedure

If you have any problems during the installation procedure described in this section, refer to Section A.1.6 which contains information on some of the more common problems that can be encountered.

To install Eksos N20 Node Manager:

1. Switch ON your computer.

2. Start Windows NT 4.0 if it has not already started by logging in as described in your Windows NT user documentation.

Note
You must log in to Windows NT with administrator privileges to install the Eksos N20 Node Manager.

If you are unsure which login names have administrator privileges, log in to Windows NT 4.0 as an administrator and select, from the Start menu, Programs → Administrative Tools → User Manager. In the lower pane, double-click Administrators to list those users who have administrator privileges. You can use a different login name to run Eksos N20 Node Manager than you used when you installed Eksos N20 Node Manager.

3. Insert the Eksos N20 Node Manager installation CD. Then click the Start button at the bottom left of your screen.

4. Select Run... from the Start menu.

5. Enter setup.exe in the Command Line box and click OK.

The Eksos N20 Node Manager installation setup program will be initialised and then the Eksos N20 Node Manager installation program will start up.

The Choose Destination Location dialog box appears with a default folder name. (For more information on the Nokia Eksos NM2.0 folder, refer to section A.1.1.)

6. Enter a new folder name or leave the default folder name, and click OK. (The default location is recommended.)

Note
The folder name must not contain blank spaces. The setup program will not install Eksos N20 Node Manager into a folder whose name contains a blank space.

A dialog box will be displayed to ask you whether you want security to be enabled. Select either Disable Security or Enable Security, and then click Next>.

The installation program will then begin the installation. A dialog box will be displayed indicating the progress.
Installing and using Eksos N20 Node Manager

When the installation has been completed, the system will ask you whether you want it to install shortcuts on your desktop automatically. (Shortcuts are icons on your desktop.)

**Note**

If an earlier type of Nokia Node Manager using Q3 has been previously installed on your PC, you do not need to carry out steps 7. and 8.

7. A prompt will be displayed to remind you to install the Q3 stack.
8. Restart your PC.

The **Nokia TP4 NSAP Configuration** dialog box is displayed (Figure A-2). (TP4 NSAP refers to the four lower layers in the communications protocol.) If you want the PC to have the same address as it did before you installed this version of Eksos N20 Node Manager, click **Restore Previous Address**. (The **Restore Previous Address** button will not be displayed if this is the first time you have installed an Eksos N20 Node Manager.) All the empty address boxes will be filled in automatically. If you want to give the PC a different address, enter new details in the **IDI** and **Area Address** boxes. When the address details are correct, click **Apply**.

![Figure A-2](nsap_config.png)

**Figure A-2**  NSAP Address dialog box

When you look in the **Start** menu, you will notice that a new group called **Nokia Applications** has been created, containing the Eksos N20 Node Manager application and the Configure PC Address application.
A.1.3 Changing the stack startup

The communications stack is installed so that it starts whenever Windows NT 4.0 is booted up. If you want to change the stack settings, run the STACK configuration application. In order to change the settings or manually start or stop the stack, you must have administrator privileges.

Figure A-3 Stack configuration dialog box

To change the stack startup, do the following:

Select how the stack will be started by clicking on one of the option buttons in the Startup Type group and then click Apply.

If you wish to start or stop the stack manually, click either Start Stack or Stop Stack.

The configuration utility also allows you to view other NSAPs which have been located on the Local LAN. These NSAPs will include the addresses of the Eksos N20 Node Manager and other management systems, as well as nodes. Click Refresh or check Auto Refresh to update the NSAPs list. Select an item in the list to view its Ethernet Address.

Click Close after you have made any changes. If you have selected Start when requested, Eksos N20 Node Manager users must have administrator privileges.
A.1.4 Changing the NSAP address after installation

To change the NSAP address after installation, do the following:

1. Run the PCQ3 address application to change the NSAP address.

   You must not be running any Nokia applications that use the Q3 stack while you are changing the NSAP address.

2. Edit the address, then click Apply to save the changes.

3. To accept the changes, click OK. To exit without changing the PC’s NSAP address, click Cancel.

A.1.5 Enabling security

Eksos N20 Node Manager offers a security feature, which the system administrator can choose to enable.

If security is enabled, the system administrator can control which users can make particular types of change to nodes. User privileges to make particular types of change are divided into five user access levels. A user’s access level is set by the system administrator.

User access levels

As a user, you may be allowed to carry out a range of editing functions, depending upon your user access level.

Controls which are not available for a user to edit because of too low an access level are greyed out in Node Manager. If you require a higher user access level to the node, ask your system administrator to raise your user access level status.

There are five user access levels, which are set by the system administrator. The prefix NMS10 is necessary in order to maintain compatibility with Nokia NMS/10 network management system.
The rest of this chapter is for system administrators only. It deals with features and procedures to which level 1–4 users do not have access.

Security administration

If you are a system administrator, you can:

- enable security when Eksos N20 Node Manager is installed
- set, raise, or lower a user’s access level.

You need to be familiar with Windows NT 4.0’s own security features in order to act as a system administrator for Eksos N20 Node Manager.

Enabling security at installation

You can enable security to control which users can make changes to the node. Other users will be given warning messages when they connect to a node and also if they try to send data to the node.

To enable security:

When the setup program asks you whether you want security enabled, select Enable Security and click Next>.
Setting a user’s access level

To set a user’s access level:

1. Click the Start button and select Programs → Administrative Tools (Common) → User Manager.

2. If you are adding a new user, select New User... from the User menu. If you want to change the access level of an existing user, select that user’s name from the list.

3. Select Properties... from the User menu. Click Groups. The Group Memberships dialog box will be displayed as shown in Figure A-4. If you are adding a new user, the four user access levels will already be listed in the Not member of list box. If you are editing the access level of an existing user, their current user access level will be shown in the Member of list box.

![Group Memberships dialog box](image)

**Figure A-4** Group Memberships dialog box

4. If you are adding a new user, select the user access level which you want to assign from the Not member of list box and then click <-Add. Click OK.

5. If you are editing the access level of an existing user, select the current access level from the Member of list box and then click Remove->. Select the user access level which you want to assign from the Not member of list box and then click <-Add. Click OK.
A.1.6 Frequently asked questions

This section contains information on some of the more common problems which you may encounter during the installation procedure.

How much disk space does Eksos N20 Node Manager require?
If you do not have enough free disk space on your PC, it will not be possible to install Eksos N20 Node Manager. You need a minimum of 10 MB of free disk space. If necessary, consult your system administrator for advice.

What should I do when the Q3 stack is not running?
Use the STACK configuration tool to ensure that the Q3 stack is started when Windows NT 4.0 is rebooted.

What should I do if Eksos N20 Node Manager does not start?
If the installation was successful, but you cannot start Eksos N20 Node Manager, ensure that the Q3 stack is running, using STACK configuration.

How much RAM does Eksos N20 Node Manager require?
If you have less than 128 MB of RAM, Eksos N20 Node Manager may function more slowly or not at all. If you have 128 MB, but are running several programs at the same time, you will also experience performance problems. Add more memory or run Eksos N20 Node Manager on its own.

Where can I find information about installing an Ethernet LAN card?
An Ethernet LAN card and supporting software is required. Consult the installation instructions that came with your card for details on how to install and configure it.

What should I do if I want to install an older version of the software?
If the version number of the files that are being installed is older than the version of files they are replacing, then a dialog box will be displayed indicating that a newer version of the software has been found.

Click Yes, if you wish to continue with the installation. Click No, if you wish to stop the installation program. (Choosing this option will mean that only a partial installation has taken place.) Select Exit to exit completely from the installation program.

You can also remove your old program files from the NOKIAMGR directories by using Delete from Windows NT Explorer.
A.2 Using Eksos N20 Node Manager

This section describes the design and basic operation of Eksos N20 Node Manager, and how it can be used to manage an Eksos N20 node.

For instructions on how to configure and take into use an Eksos N20 node, see the main body of the document.

A.2.1 Description of Eksos N20 Node Manager

The Eksos Node Manager window is the window that first appears when you start Eksos N20 Node Manager. From this window, you can reach any other window in Node Manager. Your screen shows this window during the whole management session.

The Subrack window is permanently present in the application window (either as a window or iconised) when Eksos N20 Node Manager is connected to a node.

![Figure A-5 Eksos Node Manager window showing the Subrack window](image)

The Subrack window has many uses:

- It identifies the type of node Eksos N20 Node Manager is connected to.
- It shows the type of units present in the node.
- It shows where the units are in the subrack.
- It shows what units should be present and what units are actually present in the current node type.
- It shows the most severe current alarms on each unit.
- It is used to install new units in the subrack.
- It is used to select units for subsequent node management operations. (For more information on selecting units, refer to Section A.2.2.)
### Table A-2 Toolbar icons in Eksos Node Manager window

<table>
<thead>
<tr>
<th>Icon</th>
<th>Associated command</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="" alt="Node icon" /></td>
<td>Node→Manage...</td>
</tr>
<tr>
<td><img src="" alt="Node icon" /></td>
<td>Node→Stop Managing</td>
</tr>
<tr>
<td><img src="" alt="Data icon" /></td>
<td>Data→Send to Node</td>
</tr>
<tr>
<td><img src="" alt="Data icon" /></td>
<td>Data→Refresh from Node</td>
</tr>
<tr>
<td><img src="" alt="Data icon" /></td>
<td>Data→Load from File</td>
</tr>
<tr>
<td><img src="" alt="Data icon" /></td>
<td>Data→Save to File</td>
</tr>
<tr>
<td><img src="" alt="Monitor icon" /></td>
<td>Monitor→Current Alarms</td>
</tr>
<tr>
<td><img src="" alt="Monitor icon" /></td>
<td>Monitor→Event History Log</td>
</tr>
<tr>
<td><img src="" alt="Monitor icon" /></td>
<td>Monitor→Block Status</td>
</tr>
<tr>
<td><img src="" alt="Monitor icon" /></td>
<td>Monitor→Current Performance</td>
</tr>
<tr>
<td><img src="" alt="Monitor icon" /></td>
<td>Monitor→Performance History</td>
</tr>
<tr>
<td><img src="" alt="Configure icon" /></td>
<td>Configure→Synchronisation</td>
</tr>
<tr>
<td><img src="" alt="Configure icon" /></td>
<td>Configure→Leased Lines</td>
</tr>
<tr>
<td><img src="" alt="Configure icon" /></td>
<td>Configure→Man. and Aux. Channels</td>
</tr>
<tr>
<td><img src="" alt="Configure icon" /></td>
<td>Configure→V5 interfaces</td>
</tr>
<tr>
<td><img src="" alt="Configure icon" /></td>
<td>Configure→Interface Usage</td>
</tr>
<tr>
<td><img src="" alt="Window icon" /></td>
<td>Window→Cascade</td>
</tr>
<tr>
<td><img src="" alt="Help icon" /></td>
<td>Help→Contents</td>
</tr>
</tbody>
</table>
A.2.2 Operating Eksos N20 Node Manager

Selecting actions

To use Eksos N20 Node Manager, you can use these two methods:

- select a slot and then an action
- select an action.

Select a slot and then select an action

To select a slot in the **Subrack** window, either:

- click on the slot, or
- use the left and right cursor keys. The selected slot will appear to protrude from the subrack. Select a menu item or just press the **Spacebar** when the correct slot is selected.

For example, if you want to configure an ISDN interface in a node, select the slot containing the ISDN you want to configure, and then select **Configure → Interfaces**. This displays the **Configure ISDNUQ Ux** window (x stands for the slot number where the unit is installed).

In another example, if you want to add a PSTN unit to a node, select the slot where you want to add the unit, and then select **Configure → Unit Type...** from the **Menu bar**. This displays the **Unit Type** dialog box enabling you to install the unit.

Select an action

Some options are always available from the **Menu bar**, irrespective of the selection status of the subrack units. For example, the **Current Alarms** window can always be displayed while a node is being managed.

To select an action, first select a command from the **Menu bar**. For example, to configure synchronisation, select **Configure** from the **Menu bar**, and then select **Synchronisation** from the **Configure** menu.

Selecting the default window for a slot

Double-clicking on any of the slots in the **Subrack** window opens the most appropriate (default) window for the slot.

For example, if you double-click an ISDN unit, Eksos N20 Node Manager assumes that you want to configure the interfaces on the ISDN unit and so displays the **Configure ISDN** window.

If you double-click an empty slot, Eksos N20 Node Manager assumes that you want to install a unit in the empty slot and so displays the **Unit Type** dialog box.
Receiving data from the node

Updating windows manually

Most windows can be manually updated by choosing the command Data→Refresh from Node. This command updates the data being displayed in the currently active window. The data is requested from the node and the window is updated with the new data received from the node.

The Data→Refresh from Node command is especially useful if you have edited a window (but have not yet sent the changes to the node) and want to return to the original configuration or setting which is currently present on the node. You could also use Data→Undo.

Updating windows dynamically

Block status, external alarms, current performance, and synchronisation status are regularly updated when Categories that Poll by Default is selected for a window. To view and set up dynamic updating of the options in the Polling tab, select Node→Manager Options...

In practice this means that whenever a new alarm occurs which changes any of the current alarm information shown in the windows, they are dynamically updated.

Making changes to the node

If the Node Manager’s security system has been enabled, you can make changes to the node only if your system administrator has granted you a high enough user access level.

When you edit data obtained from the node, the changes which you can see on your screen are not immediately applied to the node. To put the changes into effect, you must send the edited data to the node, using the Data→Send to Node command. This command updates the node with the changed data currently being displayed in the active window.

A.2.3 Using online Help

Eksos N20 Node Manager contains an online Help system which provides you with help information about how to use all aspects of Eksos N20 Node Manager. Help information is available at any time when you are using Eksos N20 Node Manager.

The online Help can be accessed in two main ways:

- by choosing a command from the Help menu on the Menu bar
- by pressing F1.

For more information on using online Help, refer to the Windows NT user documentation.
A.2.4 Saving and loading data as files

You can use files for three purposes:

- for copying configurations from one node to another
- to use an existing configuration as the basis of a more complex configuration
- as a simple way of backing up configurations.

Saving the whole node

To save the configuration details of the whole node:

1. Close all windows except the Subrack window.
2. Select Data → Save to File... The Save Configuration Data dialog box will be displayed. The Save All box is checked and all the other check boxes appear greyed out. Do not change these settings if you want to save the whole node.

   If you only want to save part of the node configuration, check the boxes for the details which you want to save.

3. Click OK. The Saving Configuration Data window will be displayed.

   When Node Manager has read all the data to be saved from the node, the Saving Configuration Data window will be closed and the Save As window will be displayed.
4. In the **Save As** window, enter a file name in the **File name** box. The file extension `.SNM` will be added automatically.

Caution

You must enter a file name (or select an existing file name) before you enter a name in the **Last edited by** box. If you enter the name of the person editing the file first, this name will be deleted automatically when you choose the file name.

5. When the details in the **Save As** window are as you want them, click **Save**. The details of the configuration of the whole node have now been saved under the file name which you specified in Step 4.

Note

Some details of the node configuration are not saved, either because they must not be copied from one node to another (such as the System ID), or because they consist of short-term information (such as current alarms).

The details which are not saved are:

- System ID
- Software Settings
- Maintenance State
- Current Alarms
- Event History Log contents
- Real Time Clock
- Current Performance
- Performance History.

**Saving data from a window**

To save the data in a window:

1. Open the configuration window whose data you want to save,
2. Edit the data, then select **Data → Send to Node**.
3. Select **Data → Save to File...** The **Save As** window will be displayed.
4. Carry out Steps 4. and 5. from ‘Saving the whole node’ procedure. The procedure is the same, except that you will have saved only the configuration data in the window which was open.

**Saving data in a window as text**

The **Data → Save As...** command allows you to save data from a window as text (.TXT file).
Loading a whole node configuration from file

You can load data from a file into a node which has already been installed.

To load a whole node configuration from file:

1. Close all windows except the Subrack window.
2. Select Data → Load from File... The Open window will be displayed.
3. Select the file which you want and click Open. The Node Information dialog box will be displayed, which is the first dialog box of the Whole Node Load Wizard.
4. Change the name of the node in the Name edit box, and the location of the node in the Location edit box, if required.
   This depends upon whether you are recreating a node, or copying or cloning another node.
5. Click Next>. The Subrack Information dialog box is displayed.
6. All the boxes in this window are read-only. Eksos N20 Node Manager enters the details for you automatically.
7. Click Next>. The Node Address dialog box is displayed.
8. Select a name for the area to which the node is to belong, from the Name drop-down list. If the area name which you want does not appear in the list, click Search Database... The Select Area dialog box will be displayed.
   You can use the Select Area dialog box to add a new area or edit an existing area. When you have finished, click OK to return to the Whole Node Load Wizard.
9. Enter the System ID of the node in the System ID box.
10. Click Next>. The Configuration Data dialog box is displayed.
11. If you do not want to load all the details which were saved, clear the boxes for the data which you do not want.
   You cannot choose not to load the Subrack details, so the Subrack box is always selected and greyed out. Any details which were not saved in the configuration are also greyed out.
12. When the details are as you want them, click Finish. The Loading Configuration Data window is displayed.

Eksos N20 Node Manager begins loading all the data from the file, starting with the Subrack details, and sends it to the node to which it is connected. When the data has been sent, the Loading Configuration Data window closes, and the Subrack window is displayed. The loading of the node configuration is now complete and the node is ready for use.
Loading a window configuration from file

To load a configuration from file:

1. Open the window into which you want to load the configuration details.

2. Select Data → Load from File... The Open window will be displayed.

3. Select the configuration file which you want and click Open. The Choose Block Type window is displayed.

4. Select the block type which you want. The block type must match the type of the window which is currently open.

5. Click OK. The configuration will be loaded into the window.

6. Select Data → Send to Node.

A.2.5 Printing data

The contents of every document window displayed by Eksos N20 Node Manager can be printed by choosing Data → Print. This command sends the contents of the window to the DEFAULT printer, as configured by the Windows Print Manager.

For best performance, we recommend that you select the Generic/Text Only printer, and that you set the character width to 80 characters.

It is always useful to have a copy of some of the most important configuration data of the node for reference, in case anything happens to the node causing a loss of information.

The window data is printed out in a non-paginated form.

At the start of the printout, the following information is printed:

- the name of the node currently being managed
- the title of the window being printed
- the date and time the data was printed (read from the computer).
A.2.6 Frequently asked questions

**What should I do if I change my mind after selecting an operation?**

Some operations can be aborted before they finish by clicking on the **Abort** button.

Clicking on the **Abort** button will cause the operation to stop communicating with the node. The progress indicators will be removed and the window will be displayed again.

If you have edited a window (but have not yet sent the changes to the node) and want to return to the original configuration or setting which is currently present on the node, you can use **Data→Undo**.

**What should I do if I cannot connect to node?**

If the installation was successful, but you cannot connect to a node:

- Ensure that the node is connected to the PC’s Ethernet port.
- Ensure that the node is switched on and operational, and that the PC’s Ethernet is installed correctly.
- Ensure that you have defined a valid NSAP address for the PC. Note that the PC must have the same area address as the node to which you want to connect.

**What happens if there is a communications failure?**

When a communications failure occurs between the node and the computer, the **Data→Send to Node** and **Data→Refresh from Node** commands, and all the other commands which depend on access to the node, will be disabled until communication with the node is re-established.

If a communications failure occurs while you are communicating with the node (for example, sending information to a node, or reading information from a node), the operation will be terminated. Once the node has established connection again, you can then repeat the operation.

If the connection between the computer and the node fails for some reason, Eksos N20 Node Manager will automatically make one attempt to reconnect to the node.

The system will keep trying to reconnect to the node unless you click **Stop trying**.

**What should I do if Node Manager finds no nodes?**

If, after installation, there are no nodes displayed in the **Select Node** dialog box, the Q3 stack may not have been installed. Refer to the instructions on installing the Q3 stack and setting the NSAP address. You can also try stopping and restarting the stack. Also check the Ethernet connection.
A.2.7 Main menus of Eksos N20 Node Manager

**Figure A-7** Main menus of Eksos N20 Node Manager
Appendix B
Alarm messages

The tables below list the alarms detected by Eksos N20 and show how the Eksos N20 nodes react to the alarms. Each table also gives a short description of the fault generating the alarm and provides some guidelines on how to rectify the fault.

The alarms are presented in alphabetical order according to the long alarm names. The alarm tables give the following information:

- **Table row** shows the long alarm name and also, in parentheses, the short name.
- **Severity** shows the severity class of the alarm as it appears in the Node Manager.
- **Unit** shows the plug-in unit indicating the alarm.
- **Block** shows the functional block indicating the alarm.
- **Type** shows the alarm type.
- **Consequence** shows whether an indication signal is sent upstream or downstream.
- **Meaning** gives the possible cause of the alarm.
- **Instructions** give instructions on how to rectify the fault.
- **Cancelling** gives instructions on how the alarm can be cancelled.

### Alarm Indication Signal (2M-AIS)

<table>
<thead>
<tr>
<th>Severity: Warning</th>
<th>Unit: NCU, TR2M4</th>
<th>Block: E12/P12_A</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong></td>
<td><strong>Consequence:</strong></td>
<td></td>
</tr>
<tr>
<td>Communications</td>
<td>AIS downstream, RDI</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** The incoming 2 Mbit/s signal is the AIS. The equipment indicating this alarm is not faulty, but the alarm is a consequence of a serious fault somewhere else in the network. This alarm does not show on the Current Alarms List; it is only displayed in the Block Status windows.

**Instructions:** Locate the fault that is causing the AIS to be sent from the other end.

**Cancelling:** The alarm is cancelled automatically when AIS disappears.
### Alarm Input

<table>
<thead>
<tr>
<th>Severity: Programmable</th>
<th>Unit: NCU; LMU</th>
<th>Block: Common</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong> Environment</td>
<td><strong>Consequence:</strong> –</td>
<td></td>
</tr>
<tr>
<td><strong>Meaning:</strong> One of the programmable alarm inputs on either NCU or LMU has been activated. The alarm text and severity are defined by the user.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions:</strong> –</td>
<td></td>
<td></td>
</tr>
<tr>
<td>** Cancelling:** The alarm is cancelled automatically when the fault is rectified.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Alarm List Incomplete

<table>
<thead>
<tr>
<th>Severity: Minor</th>
<th>Unit: NCU</th>
<th>Block: Common</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong> Processing</td>
<td><strong>Consequence:</strong> –</td>
<td></td>
</tr>
<tr>
<td><strong>Meaning:</strong> The alarm list cannot show all the active alarms due to the limited size of the alarm display stack. This message appears as the last item on the alarm list.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions:</strong> –</td>
<td></td>
<td></td>
</tr>
<tr>
<td>** Cancelling:** –</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Backup Fall (BKUP)

<table>
<thead>
<tr>
<th>Severity: Major</th>
<th>Unit: NCU; ISDN; LMU</th>
<th>Block: Common</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong> Equipment</td>
<td><strong>Consequence:</strong> –</td>
<td></td>
</tr>
<tr>
<td><strong>Meaning:</strong> Configuration data has been lost. If one plug-in unit is removed from the subrack and the same type of plug-in unit is inserted into the same slot, all functions will normally return to the unit without any additional actions from the user. However, a Backup Fail alarm may occur when several plug-in units are drawn away and then replaced with new, identical plug-in units.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions:</strong> Do not replace units while the yellow LED on the NCU is flashing. If the configuration data is lost, the units can be reconfigured using the back-up files.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>** Cancelling:** The alarm is cancelled automatically after 5 minutes.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### BCC Protocol Syntax Error (SYNT)

<table>
<thead>
<tr>
<th>Severity: Warning</th>
<th>Unit: NCU</th>
<th>Block: V5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong> Communications</td>
<td><strong>Consequence:</strong> –</td>
<td></td>
</tr>
<tr>
<td><strong>Meaning:</strong> A BCC (Bearer Channel Connection) protocol message field contains syntactically incorrect information. This alarm is shown in the event history log only.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions:</strong> –</td>
<td></td>
<td></td>
</tr>
<tr>
<td>** Cancelling:** The alarm is cancelled automatically.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Cessation of Flags on a C-channel (CCH)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>NCU</td>
<td>V5–P0</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** –  

**Meaning:** Physical C-channels carry the transmit flag ‘0111 1110’ when not transmitting L3 information. If this flag is not transmitted within 1 second, this alarm is generated.

**Instructions:** Check that the C-channels are configured identically in the AN and LE. Also check that there is a 64k physical C-channel connection between the AN and LE.

**Cancelling:** The alarm is cancelled automatically.

---

## Compatibility Failure (CMPF)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major</td>
<td>All</td>
<td>Common</td>
</tr>
</tbody>
</table>

**Type:** Equipment  
**Consequence:** –  

**Meaning:** The release of the unit software is not compatible with the node release currently in use. The unit is switched off (transmission is cut and no settings can be made, functionally the same as a Unit Mismatch). This alarm can also be raised if the unit hardware is incompatible with the software.

**Instructions:** Download a new, compatible software to the node or change the unit hardware version.

**Cancelling:** The alarm is cancelled automatically when the software or hardware is changed to compatible one.

---

## Control Protocol Syntax Error (SYNT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** –  

**Meaning:** A Control protocol message field contains syntactically incorrect information. This alarm is shown in the event history log only.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically.

---

## Control Protocol Time Out (TOUT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** –  

**Meaning:** Indication that a time-out error has occurred in Common Control protocol. This alarm is shown in the event history log only.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically.
### Critical Fan Failure (FAN)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>NCU</td>
<td>Common</td>
</tr>
</tbody>
</table>

**Type:** Equipment  
**Consequence:** –

**Meaning:** Two or more fans of the Fan Unit have stopped working and hence correct operating temperature cannot be provided.

**Instructions:** First check the fuses on the subrack’s extension board. If the fuse has not blown, replace the broken Fan Unit with a working one.

**Cancelling:** The alarm is cancelled automatically when the broken fan is replaced.

### Degraded Signal (DEG)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>NCU, TR2M4</td>
<td>E12</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** –

**Meaning:** Degraded incoming 2 Mbit/s signal (error ratio above $10^{-6}$). This failure does not cut the service but its quality is decreased.

**Instructions:** Check if there is a fault in the repeater or if the cable is faulty and generating disturbances on the 2M line.

**Cancelling:** The alarm is cancelled automatically when the error ratio decreases below $10^{-7}$.

### Degraded Signal (DEG)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>ISDN</td>
<td>ISDN</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** –

**Meaning:** Corrupted CRCs received. This failure does not cut the service but its quality is decreased.

**Instructions:** Check if the ISDN subscriber cable is faulty and generating disturbances on the line.

**Cancelling:** The alarm is cancelled when the error ratio decreases below $10^{-7}$.

### Dying Gasp (GSP)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>ISDN</td>
<td>NT</td>
</tr>
</tbody>
</table>

**Type:** Equipment  
**Consequence:** AIS upstream

**Meaning:** Both primary power and secondary power (if back-up battery is provided) on the NT are marginal or have failed. Voltage at the T-reference point is less than 34 V or reserved. The NT1 is likely to cease operation.

**Instructions:** Check the operation of power supply both to the ISDN unit and the NT.

**Cancelling:** The alarm is cancelled automatically when power is supplied again.
### Event Buffer Overflow (EBOF)

**Severity:** Minor  
**Unit:** NCU  
**Block:** Node  

**Type:** Processing  
**Consequence:** –

**Meaning:** This alarm is raised when the event buffer is full and new events are raised. The event buffer is used as a temporary store for events before they are sent to the registered user. This alarm does not show on the Current Alarms List; it is only displayed on the Event History Log.

**Instructions:** –

**Cancelling:** The alarm is cancelled manually by clearing the log or when EFD (Event Forwarding Discriminator) has sent all alarms to the NMS.

---

### Excessive Bit Error Ratio (EXC)

**Severity:** Major  
**Unit:** NCU, TR2M4  
**Block:** W12  

**Type:** Communications  
**Consequence:** AIS downstream, RDI

**Meaning:** Too many bit errors (error ratio above $10^{-3}$) in the incoming 2 Mbit/s signal. This failure causes the quality of service to decrease so badly that the service cannot be used any more.

**Instructions:** Check if there is a fault in the repeater or if the cable is faulty and generating disturbances on the 2M line.

**Cancelling:** The alarm is cancelled automatically when error ratio decreases to approx. $10^{-4}$.

---

### Fan Failure (FAN)

**Severity:** Minor  
**Unit:** NCU  
**Block:** Common

**Type:** Equipment  
**Consequence:** –

**Meaning:** One of the six fans in the Fan Unit has stopped working.

**Instructions:** Replace the broken Fan Unit with a working one.

**Cancelling:** The alarm is cancelled automatically when the broken fan is replaced.

---

### Far End Block Error (FEBE)

**Severity:** Minor  
**Unit:** ISDN  
**Block:** –

**Type:** Communications  
**Consequence:** –

**Meaning:** The far-end receiver is receiving errored blocks (i.e. corrupted CRCs).

**Instructions:** Check if the cable is faulty and generating disturbances on the line.

**Cancelling:** The alarm is cancelled automatically when a valid signal is received.
### Feeding Current Shortcut (FPS)

<table>
<thead>
<tr>
<th>Severity:</th>
<th>ISDN</th>
<th>Block: –</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meaning:</td>
<td>Interface-specific alarm.</td>
<td></td>
</tr>
<tr>
<td>Instructions:</td>
<td>Locate the short circuit or earth leakage in the cable or connection.</td>
<td></td>
</tr>
<tr>
<td>Cancelling:</td>
<td>The alarm is cancelled automatically when the short circuit is removed.</td>
<td></td>
</tr>
</tbody>
</table>

### Feeding Power Overload (FPO)

<table>
<thead>
<tr>
<th>Severity: Minor</th>
<th>ISDN</th>
<th>Block: –</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meaning:</td>
<td>Unit-level alarm indicating that there is an overload on the power supply feeding the ISDN lines.</td>
<td></td>
</tr>
<tr>
<td>Instructions:</td>
<td>Check if the overload on the line is caused, for example, by an earth leakage or a wrong type of NT.</td>
<td></td>
</tr>
<tr>
<td>Cancelling:</td>
<td>The alarm is cancelled automatically when the overload is removed.</td>
<td></td>
</tr>
</tbody>
</table>

### Feeding Power Supply Failure (FPSF)

<table>
<thead>
<tr>
<th>Severity: Critical</th>
<th>ISDN</th>
<th>Block: –</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meaning:</td>
<td>There is a problem with the voltage supply of the unit. The measured voltage in the unit differs more than 5% from the selected value.</td>
<td></td>
</tr>
<tr>
<td>Instructions:</td>
<td>Set the voltage to 0 V and then back to the original value. If this does not clear the alarm, replace the unit with a new one.</td>
<td></td>
</tr>
<tr>
<td>Cancelling:</td>
<td>The alarm is cancelled automatically when the voltage is back to the allowed range.</td>
<td></td>
</tr>
</tbody>
</table>

### Feeding Voltage Failure (FVF)

<table>
<thead>
<tr>
<th>Severity: Minor</th>
<th>ISDN</th>
<th>Block: –</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meaning:</td>
<td>Interface-specific alarm indicating that there is no power supply available.</td>
<td></td>
</tr>
<tr>
<td>Instructions:</td>
<td>Check if the cable is faulty and causing a short circuit. Also check the power supply on the ISDN unit: if it is faulty, replace the ISDN unit.</td>
<td></td>
</tr>
<tr>
<td>Cancelling:</td>
<td>The alarm is cancelled automatically when the power supply is available.</td>
<td></td>
</tr>
</tbody>
</table>
### General Problem DNT (GPD)

<table>
<thead>
<tr>
<th>Severity: Minor</th>
<th>Unit: ISDN</th>
<th>Block:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Communications</td>
<td>Consequence: –</td>
<td></td>
</tr>
<tr>
<td>Meaning: Indicates a far-end alarm from the DNT128 unit that is connected to an ISDN port.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Instructions: Check the alarms in the DNT128 by using the Q1 management tool. Make sure that the DNT128 is not in test mode.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancelling: The alarm is cancelled automatically as soon as the DNT128 is working again.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Input Buffer Overflow/Underflow (IBOU)

<table>
<thead>
<tr>
<th>Severity: Warning</th>
<th>Unit: DIU</th>
<th>Block:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Communications</td>
<td>Consequence: –</td>
<td></td>
</tr>
<tr>
<td>Meaning: Indicates that there is a synchronisation problem. There are two counters that log input buffer over- and underflows and two specified thresholds. If there are more input over- or underflow errors per minute than has been specified with the respective thresholds, the alarm is raised. The Input Buffer Underflow alarm is also raised in case of an external clock failure. The alarms are raised only if the buffer slip reported attribute is set to true.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Instructions: –</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancelling: The alarm is cancelled automatically when the number of input over- and underflow errors drops to the specified acceptable level.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### In Test (TEST)

<table>
<thead>
<tr>
<th>Severity: Major</th>
<th>Unit: NCU, TR2M4</th>
<th>Block: E12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td>Consequence: AIS upstream or downstream</td>
<td></td>
</tr>
<tr>
<td>Meaning: The 2 Mbit/s interface has been looped with the Node Manager.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Instructions: The loopbacks are used for troubleshooting. The loopbacks are automatically cancelled after a preset time-out, or you can cancel them immediately with a Node Manager command.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancelling: The alarm is cancelled automatically when the test state ends.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### In Test (TEST)

<table>
<thead>
<tr>
<th>Severity: Major</th>
<th>Unit: DIU</th>
<th>Block:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td>Consequence: AIS upstream or downstream</td>
<td></td>
</tr>
<tr>
<td>Meaning: The DIU interface has been looped with the Node Manager.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Instructions: The loopbacks are used for troubleshooting. The loopbacks are automatically cancelled after a preset time-out, or you can cancel them immediately with a Node Manager command.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancelling: The alarm is cancelled automatically when the test state ends.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Interface Broken (PBKN)**

<table>
<thead>
<tr>
<th>Severity:</th>
<th>Major</th>
<th>Unit:</th>
<th>PSTN</th>
<th>Block:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type:</td>
<td>Equipment</td>
<td>Consequence:</td>
<td>–</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** This alarm can mean two different alarm cases.
- If the alarm is given right after the start-up (within a few minutes after the POTS unit reset), one of the SLICs is broken.
- If the alarm is given during normal operation, there is a current leakage from wire a/b to ground (fault in the subscriber line).

**Instructions:** If a SLIC is broken, the PSTN unit must be replaced.
- If there is a current leakage, the fault in the subscriber line must be corrected.

**Cancelling:** The alarm is cancelled automatically when the unit is replaced with a new one (in case of a broken SLIC), or after the fault in the subscriber line has been cleared.

---

**Link Control Protocol Syntax Error (SYNT)**

<table>
<thead>
<tr>
<th>Severity:</th>
<th>Warning</th>
<th>Unit:</th>
<th>NCU</th>
<th>Block:</th>
<th>V5–P12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type:</td>
<td>Communications</td>
<td>Consequence:</td>
<td>–</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** A Link Control protocol message field contains syntactically incorrect information. This alarm is shown in the event history log only.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically.

---

**Link Control Protocol Time Out (TOUT)**

<table>
<thead>
<tr>
<th>Severity:</th>
<th>Warning</th>
<th>Unit:</th>
<th>NCU</th>
<th>Block:</th>
<th>V5–P12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type:</td>
<td>Communications</td>
<td>Consequence:</td>
<td>–</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** Indication that a time-out has occurred in Link Control Protocol. This alarm is shown in the event history log only.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically.

---

**Log Overflow (LGOF)**

<table>
<thead>
<tr>
<th>Severity:</th>
<th>Minor</th>
<th>Unit:</th>
<th>NCU</th>
<th>Block:</th>
<th>Node</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type:</td>
<td>Processing</td>
<td>Consequence:</td>
<td>–</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** Event history log overflow in the network element.

**Instructions:** Clear the log (and, if applicable, change the log file settings so that new alarms are written over the old ones when the log gets full).

**Cancelling:** The alarm is cancelled automatically when the problem is cleared in the node.
### Loss of Frame (LOF)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major</td>
<td>NCU, TR2M4</td>
<td>E12/P12</td>
</tr>
<tr>
<td>Type: Communications</td>
<td>Consequence: AIS downstream, RDI</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** Loss of frame in the incoming 2M signal (G.704). This failure causes the quality of service to decrease so badly that the service cannot be used any more.

**Instructions:** Check if there is a fault in the repeater or if the cable is faulty and generating disturbances on the 2M line.

**Cancelling:** The alarm is cancelled automatically when a valid frame is received.

### Loss of Frame (LOF)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>ISDN</td>
<td>–</td>
</tr>
<tr>
<td>Type: Communications</td>
<td>Consequence: AIS upstream</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** Loss of frame in the ISDN signal.

**Instructions:** Check if the cable is faulty and generating disturbances on the line.

**Cancelling:** The alarm is cancelled automatically when a valid frame is received.

### Loss of Multiframe (LOM)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major</td>
<td>NCU, TR2M4</td>
<td>E12/P12</td>
</tr>
<tr>
<td>Type: Communications</td>
<td>Consequence: RDI</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** Loss of multiframe in the ISDN signal.

**Instructions:** Make sure that the remote end has been correctly configured.

**Cancelling:** The alarm is cancelled automatically when a valid multiframe is received.

### Loss of Octet Timing (LOT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>DIU</td>
<td>–</td>
</tr>
<tr>
<td>Type: Communications</td>
<td>Consequence: –</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** Octet timing is lost. This alarm concerns G.703 and X.21 interfaces only.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically when valid timing is received.
### Loss of V.110 Frame Synchronisation (LOFS)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major</td>
<td>DIU</td>
<td></td>
</tr>
</tbody>
</table>

**Type:** Communications  

**Consequence:** –

**Meaning:** Raised when V.110 Frame synchronisation is no longer detected. This causes a transition from Data Transfer State to Frame search State and further to Disconnect State. The alarm will be reported only if the V.110LOFVS Reported attribute has been set.

**Instructions:** –

**Cancelling:** –

---

### Loss of Signal (2M-LOS)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major</td>
<td>NCU, TR2M4</td>
<td>E12</td>
</tr>
</tbody>
</table>

**Type:** Communications  

**Consequence:** AIS downstream, RDI

**Meaning:** This alarm indicates the loss of signal at 2 Mbit/s input.

**Instructions:** Check if the 2M cable is broken, or if the repeater or transmitter are defective.

**Cancelling:** The alarm is cancelled automatically when 2M signal is returned to the input.

---

### Loss of Signal (LOS)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major</td>
<td>NCU</td>
<td>T12S1R</td>
</tr>
</tbody>
</table>

**Type:** Communications  

**Consequence:** –

**Meaning:** Loss of 2M synchronisation signal

**Instructions:** Check if the synchronisation source has failed or if the cable is faulty.

**Cancelling:** The alarm is cancelled automatically when a valid signal is received.

---

### Loss of Signal (LOS)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>ISDN</td>
<td></td>
</tr>
</tbody>
</table>

**Type:** Communications  

**Consequence:** AIS upstream

**Meaning:** This indicates that no signal is being received by the receiver.

**Instructions:** Check if the cable is broken or if the NT is missing.

**Cancelling:** The alarm is cancelled when the signal is returned to the input.
### Loss of Signal (LOS)

**Severity:** Minor  
**Unit:** DIU  
**Block:**

**Type:** Communications  
**Consequence:** –

**Meaning:** A signal is missing from an interface. The alarm is typically raised if no signal is connected to a Vxx/X.21 or G.703 interface.

**Instructions:** Check if the cable is broken or if the DTE is missing

**Cancelling:** The alarm is cancelled when the signal is returned to the input.

### Loss of Timing Information (LTI)

**Severity:** Major  
**Unit:** NCU  
**Block:** SD/NS-SEL

**Type:** Equipment  
**Consequence:** –

**Meaning:** Generated when the associated 2 Mbit/s termination point has failed or no reference signal is connected to the node clock reference, that is, the node clock is in free-running or holdover mode. (This alarm is not generated if the internal clock has been defined as the only source for the node clock.)

**Instructions:** Check if the synchronisation source has failed or if the cable is faulty.

**Cancelling:** The alarm is cancelled automatically when a valid signal is received.

### Maintenance State (MAIN)

**Severity:** Minor  
**Unit:** NCU  
**Block:** Common

**Type:** Equipment  
**Consequence:** –

**Meaning:** The node has been set into maintenance state. Use this state to notify the network management system that you are going to perform some planned maintenance actions (for example, upgrading the software), and that some alarms will probably be generated.

**Instructions:** After you have finished the maintenance actions, set the maintenance state off.

**Cancelling:** The alarm is cancelled automatically when maintenance state is removed.
### Port Control Protocol Layer 3 Address Error (SYNT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurable as Non-alarmed or Warning</td>
<td>NCU (V5.2), TR2M (V5.1)</td>
<td>V5</td>
</tr>
</tbody>
</table>

**Type:** Communication  
**Consequence:** –  
**Meaning:** A mismatch in layer 3 addresses between the AN and LE (V5.2) or between the AN and the V5.1 equipment. Indicates that an L3 address has been received that has not been given to any existing PSTN or ISDN user port.  
**Instructions:** Check that the L3 addresses are correct.  
**Cancelling:** The alarm is cancelled automatically when the fault is rectified.

---

### Power Problem (POW)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>All</td>
<td>Common</td>
</tr>
</tbody>
</table>

**Type:** Equipment  
**Consequence:** AIS  
**Meaning:** The power supply block of the unit does not function correctly or the power supply is overloaded. If the plug-in unit is not identified, the alarm is generated on the NCU. The fault can relate to power supply adapters, batteries, or plug-in unit power blocks. The DC-PSA alerts with an A-alarm if the power supply of a plug-in unit fails.  
**Instructions:** Check to see if there is a short circuit which is overloading the power supply. If the power supply or a plug-in unit is faulty, replace it with a working one.  
**Cancelling:** The alarm is cancelled automatically when the fault is rectified.

---

### Primary Power Out (PPO)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>ISDN</td>
<td>PISDNUBA</td>
</tr>
</tbody>
</table>

**Type:** Equipment  
**Consequence:** –  
**Meaning:** Primary power on the NT is marginal or has failed. Secondary power (if back-up battery is provided) is normal. Voltage at the T-reference point is less than 34 V or reserved.  
**Instructions:** ISDN line feeding has failed or the cable is broken.  
**Cancelling:** The alarm is cancelled automatically when power is supplied again.

---

### Protection Protocol Syntax Error (SYNT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** –  
**Meaning:** A Protection protocol message field contains syntactically incorrect information. This alarm is shown in the event history log only.  
**Instructions:** –  
**Cancelling:** The alarm is cancelled automatically.
### Protection Protocol Time Out (TOUT)

<table>
<thead>
<tr>
<th>Severity: Warning</th>
<th>Unit: NCU</th>
<th>Block: V5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong> Communications</td>
<td><strong>Consequence:</strong> –</td>
<td></td>
</tr>
<tr>
<td><strong>Meaning:</strong> Indication that a time-out error has occurred in Protection protocol. This alarm is shown in the event history log only.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions:</strong> –</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cancelling:</strong> The alarm is cancelled automatically.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Q1 Not Supported (Q1NS)

<table>
<thead>
<tr>
<th>Severity: Major</th>
<th>Unit: ISDN</th>
<th>Block: Common</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong> Equipment</td>
<td><strong>Consequence:</strong> –</td>
<td></td>
</tr>
<tr>
<td><strong>Meaning:</strong> If an ISDN user port is configured for DNT128 usage (Q1 management over the D-channel), the C2.0 hardware is required. In case the ISDN unit is replaced with C1.0 hardware, this alarm appears to indicate that Q1 management is not possible.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions:</strong> Replace the ISDN unit with a unit containing the C2.0 hardware.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cancelling:</strong> The alarm is cancelled automatically.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Remote Defect Indication (2M-RDI)

<table>
<thead>
<tr>
<th>Severity: Warning</th>
<th>Unit: NCU, TR2M4</th>
<th>Block: P12_TT</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong> Communications</td>
<td><strong>Consequence:</strong> –</td>
<td></td>
</tr>
<tr>
<td><strong>Meaning:</strong> 2M Remote Defect Indication. The remote path termination has detected a fault in the incoming 2M signal. The equipment indicating this alarm is not faulty, but the alarm is a consequence of a serious fault elsewhere in the network. This alarm does not show on the Current Alarms List; it is only displayed in the Block Status windows.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions:</strong> Locate the fault that is causing the RDI to be sent from the remote end.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cancelling:</strong> The alarm is cancelled automatically when a valid signal is received.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Remote Power Feeding Unit Overload (RPFO)

<table>
<thead>
<tr>
<th>Severity: Minor</th>
<th>Unit: ISDN</th>
<th>Block: Common</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong> Equipment</td>
<td><strong>Consequence:</strong> –</td>
<td></td>
</tr>
<tr>
<td><strong>Meaning:</strong> Indicates that the actual drawn power of all interfaces is bigger than the configured power of all interfaces.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions:</strong> If the alarm is permanent, reconfigure the unit (the maximum power for each interface).</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cancelling:</strong> The alarm is cancelled automatically.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Restart Time Out (TOUT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** –

**Meaning:** Indication that a time-out has occurred in the PSTN restart. The PSTN restart has failed. This alarm is shown in the event history log only.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically.

### Secondary Power Out (SPO)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>ISDN</td>
<td>PISDNUBA</td>
</tr>
</tbody>
</table>

**Type:** Equipment  
**Consequence:** –

**Meaning:** Primary power on the NT is normal, but the secondary power (if back-up battery is provided) is marginal, unavailable or has failed. Normal power is provided at the T-reference point.

**Instructions:** Check if the NT has been accidentally disconnected.

**Cancelling:** The alarm is cancelled automatically when power is supplied again.

### Server Signal Fail (2M-SSF)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU, TR2M4</td>
<td>P12_TT</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** AIS downstream, RDI

**Meaning:** 2M Server Signal Failed. There is a severe fault upstream, e.g., 2M-LOS. This alarm does not show on the Current Alarms List; it is only displayed in the Block Status windows.

**Instructions:** Locate the fault that is causing the SSF to be sent from the remote end.

**Cancelling:** The alarm is cancelled automatically when a valid signal is received.

### Signalling Voltage Failure (SVF)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major</td>
<td>PSTN</td>
<td></td>
</tr>
</tbody>
</table>

**Type:** Equipment  
**Consequence:**

**Meaning:** +70 V, –70 V, –36 V and SV1 voltage failure.

**Instructions:** If the alarm persists, replace the PSTN unit with a new one.

**Cancelling:** The alarm is cancelled automatically when the fault has been rectified.
### Startup Failure (STP)

<table>
<thead>
<tr>
<th>Severity: Major</th>
<th>Unit: NCU</th>
<th>Block: V5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Communications</td>
<td>Consequence: –</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** The V5 interface has not started up. The reason may be, for example, failures in the physical layer, a V5 configuration mismatch between the AN and LE, or the other end may not yet be ready to start the interface.

**Instructions:** Check the configuration.

**Cancelling:** The alarm is cancelled automatically when the interface starts up.

### Synchronisation Forced (FORC)

<table>
<thead>
<tr>
<th>Severity: Minor</th>
<th>Unit: NCU</th>
<th>Block: NS_C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td>Consequence: –</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** The node has been forced to use one of the signals on the synchronisation priority list.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically when the forced state is removed.

### Threshold Crossed (THC)

<table>
<thead>
<tr>
<th>Severity: Warning</th>
<th>Unit: LMU</th>
<th>Block:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Quality of Service</td>
<td>Consequence: –</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** Indicates the first threshold violation of measured line values during a scheduled test round of a scheduled test.

**Instructions:** Read the test results to find the problematic interfaces. According to the test results, take appropriate actions to resolve the problem(s)

**Cancelling:** This alarm is sent as an event and cannot be cancelled. If all indicated problems have been solved, the alarm will not be raised again during the next scheduled test round.

### Time-out Activation Error (TAE)

<table>
<thead>
<tr>
<th>Severity: Major</th>
<th>Unit: ISDN</th>
<th>Block:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Communications</td>
<td>Consequence: –</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** This alarm is raised if a leased line is configured and it is not possible to keep the line permanently active.

**Instructions:** Make sure the line is OK. Check if the NT is connected. Make sure that the interface has been configured correctly, especially that the feeding voltage is correct.

**Cancelling:** The alarm is cancelled automatically.
**Unit Failure (FAIL)**

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit: NCU; ISDN; LMU</th>
<th>Block: Common</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td>Consequence: AIS</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** A hardware failure has been detected.

**Instructions:** Replace the faulty unit with a working one.

**Cancelling:** The alarm is cancelled automatically when the failed unit is replaced.

---

**Unit Mismatch (MISM)**

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit: All</th>
<th>Block: Common</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td>Consequence: AIS</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** A wrong type of plug-in unit has been inserted into a unit slot, or a unit has been inserted into a slot which was not expecting a unit.

**Instructions:** Install an expected unit to the slot that is causing the alarm.

**Cancelling:** The alarm is cancelled automatically when a correct unit is installed.

---

**Unit Missing (MISS)**

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit: All</th>
<th>Block: Common</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Equipment</td>
<td>Consequence: AIS</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** A plug-in unit is not present in its slot in the subrack. This alarm may also indicate that the communication between an NCU and a plug-in unit is not working.

**Instructions:** Install the missing unit.

**Cancelling:** The alarm is cancelled automatically when the unit is installed.

---

**V5 BCC Protocol Data Link Failure (DLF)**

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit: NCU</th>
<th>Block: V5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Communications</td>
<td>Consequence: –</td>
<td></td>
</tr>
</tbody>
</table>

**Meaning:** Initialisation of LAPV5-DL fails for BCC (Bearer Channel Connection) protocol. Communication with BCC protocol between the AN and LE is not possible.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically.
V5 BCC Protocol Time Out (TOUT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

Type: Communications

Consequence: –

Meaning: Indication that a time-out has occurred in BCC (Bearer Channel Connection) protocol. This alarm is shown in the event history log only.

Instructions: –

Cancelling: The alarm is cancelled automatically.

V5 Common Control Protocol Syntax Error (SYNT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU, TR2M4</td>
<td>V5</td>
</tr>
</tbody>
</table>

Type: Communication

Consequence: –

Meaning: Indicates that a control protocol message with syntactically incorrect information is received. The alarm is shown in the event history log only.

Instructions: –

Cancelling: The alarm is cancelled automatically.

V5 Control Protocol Data Link Failure (DLF)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

Type: Communications

Consequence: –

Meaning: Initialisation of LAPV5-DL fails for Control protocol. Communication with Control protocol between the AN and LE is not possible.

Instructions: –

Cancelling: The alarm is cancelled automatically.

V5 Link Control Protocol Error while “Out Of Service” (PROT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU</td>
<td>V5–P12</td>
</tr>
</tbody>
</table>

Type: Communications

Consequence: –

Meaning: Generated when a Link Control message is received from the LE when the Link Control L3 protocol entity in the AN is not ready to receive any messages. This alarm is shown in the event history log only.

Instructions: –

Cancelling: The alarm is cancelled automatically.
V5 Link Control Protocol Layer 3 Address Error (L3AD)

Severity: Warning Unit: NCU Block: V5

Type: Communications Consequence: –

Meaning: A mismatch in link IDs between the AN and LE. Indicates that an unknown link ID has been received. Each 2M link must have a unique ID and the IDs between AN and LE must match. This alarm is shown in the event history log only.

Instructions: Check that the link IDs are identical in the AN and LE.

Cancelling: The alarm is cancelled automatically.

V5 Link Control Protocol Data Link Failure (DLF)

Severity: Critical Unit: NCU Block: V5

Type: Communications Consequence: –

Meaning: Initialisation of LAPV5-DL fails for Link Control protocol. Communication with Link Control protocol between the AN and LE is not possible.

Instructions: –

Cancelling: The alarm is cancelled automatically.

V5 Link Identification Failure (LID)

Severity: Major Unit: NCU Block: V5–P12

Type: Communications Consequence: –

Meaning: Indicates that the V5 link identification check has failed.

Instructions: Check the following points: (1) the link IDs are identical in the AN and LE, (2) link identification has not been disabled at the LE end, (3) TS0 has been connected transparently between the AN and LE.

Cancelling: The alarm is cancelled automatically.

V5 Persistent Link Control Protocol Layer 3 Address Error (L3AD)

Severity: Warning Unit: NCU Block: V5

Type: Communications Consequence: –

Meaning: A mismatch in link IDs between the AN and LE. Indicates that an unknown link ID has been received. Each 2M link must have a unique ID and the IDs between AN and LE must match. This alarm is shown in the event history log only.

Instructions: Check that the link IDs are identical in the AN and LE.

Cancelling: The alarm is cancelled automatically.
### V5 Port Control Protocol Error while “Out of Service” (PROT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit: NCU, TR2M4</th>
<th>Block: V5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Communication</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consequence:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meaning:</td>
<td>A port control message is received for a user port that is out of service. The alarm is shown in the event history log only.</td>
<td></td>
</tr>
<tr>
<td>Instructions:</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>Cancelling:</td>
<td>The alarm is cancelled automatically.</td>
<td></td>
</tr>
</tbody>
</table>

### V5 Port Control Protocol Layer 3 Address Error (L3AD)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit: NCU</th>
<th>Block: V5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Communications</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consequence:</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>Meaning:</td>
<td>A mismatch in user ports between the AN and LE. Indicates that an unknown user port address has been received. Each user port must have a unique address and the addresses between the AN and LE must match. This alarm is shown in the event history log only.</td>
<td></td>
</tr>
<tr>
<td>Instructions:</td>
<td>Check that the user port addresses are identical in the AN and LE.</td>
<td></td>
</tr>
<tr>
<td>Cancelling:</td>
<td>The alarm is cancelled automatically.</td>
<td></td>
</tr>
</tbody>
</table>

### V5 Port Control Protocol Timer Expiration Error (TOUT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit: NCU, TR2M4</th>
<th>Block: V5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Communication</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consequence:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meaning:</td>
<td>Indicates that a time-out error has occurred in V5 port control. The alarm is shown in the event history log only.</td>
<td></td>
</tr>
<tr>
<td>Instructions:</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>Cancelling:</td>
<td>The alarm is cancelled automatically.</td>
<td></td>
</tr>
</tbody>
</table>

### V5 Port Control Protocol Syntax Error (SYNT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit: NCU</th>
<th>Block: V5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: Communications</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consequence:</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>Meaning:</td>
<td>A Port Control protocol message field contains syntactically incorrect information. This alarm is shown in the event history log only.</td>
<td></td>
</tr>
<tr>
<td>Instructions:</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>Cancelling:</td>
<td>The alarm is cancelled automatically.</td>
<td></td>
</tr>
</tbody>
</table>
## V5 Protection Protocol Data Link Failure (DLF)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** –

**Meaning:** Initialisation of LAPV5-DL fails for Protection protocol. Communication with Protection protocol between the AN and LE is not possible.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically.

## V5 Protection Protocol Timer Expiration Error (TOUT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

**Type:** Communication  
**Consequence:** –

**Meaning:** Indicates that a time-out has occurred in the protection protocol. The alarm is shown in the event history log only.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically.

## V5 Protection Protocol Syntax Error (SYNT)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

**Type:** Communication  
**Consequence:**

**Meaning:** Indicates that a protection protocol message with syntactically incorrect information is received. The alarm is shown in the event history log only.

**Instructions:** –

**Cancelling:** The alarm is cancelled automatically.

## V5 PSTN Protocol Data Link Failure (DLF)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Unit</th>
<th>Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major</td>
<td>NCU</td>
<td>V5</td>
</tr>
</tbody>
</table>

**Type:** Communications  
**Consequence:** –

**Meaning:** Initialisation of LAPV5-DL fails for PSTN protocol. Communication with PSTN protocol between the AN and LE is not possible.

**Instructions:** Check that the C-channel configuration for PSTN is identical in the AN and LE.

**Cancelling:** The alarm is cancelled automatically.
V5 PSTN Protocol Layer 3 Address Error (L3AD)

Severity: Warning | Unit: NCU | Block: V5
Type: Communications | Consequence: –

Meaning: A mismatch in user ports between the AN and LE. Indicates that an unknown user port address has been received. Each user port must have a unique address and the addresses between the AN and LE must match. This alarm is shown in the event history log only.

Instructions: Check that the user port addresses are identical in the AN and LE.

Cancelling: The alarm is cancelled automatically.

V5 PSTN Protocol Syntax Error (SYNT)

Severity: Warning | Unit: NCU, TR2M4 | Block: V5
Type: Communication | Consequence: –

Meaning: Indicates that a PSTN protocol message with syntactically incorrect information is received. The alarm is shown in the event history log only.

Instructions: –

Cancelling: The alarm is cancelled automatically.

V5 PSTN Protocol Time Out (TOUT)

Severity: Warning | Unit: NCU | Block: V5
Type: Communications | Consequence: –

Meaning: Indicates that a time-out error has occurred in V5 Port Control protocol. This alarm is shown in the event history log only.

Instructions: –

Cancelling: The alarm is cancelled automatically.
Appendix C
Windows for Data Interface Units

C.1 Subrack window

The subrack window shows the type of the DIU unit, which can be either DIU-GG, DIU-VV or DIU-VG.

C.2 Unit configuration window

Double–clicking on the DIU unit in the subrack view (or using the Configure -> Interface menu with the DIU unit selected) leads to the Unit configuration window:

![Unit configuration window](image)

Figure C-1  Unit configuration window

Functional blocks

In the Unit Configuration window, only one functional block is shown for each DIU interface.
The interface text is **Out of use** (that is, not in use by the cross-connect), **Leased Line** (that is, in use by the cross-connect) or **In use** (that is, the interface is in use but not used by the cross-connect).

### Interface type

- On a DIU-GG unit, there are four G.703 interfaces.
- On a DIU-VV unit, there are four V.xx interfaces.
- On a DIU-VG unit, there are two interfaces of each type. Interfaces 1 and 2 are always V.xx interfaces and interfaces 3 and 4 are always G.703 interfaces.

### C.3 Functional block settings window

The **Functional Block Settings** window is accessed from the **Unit Configuration** window either by double-clicking an interface button or by right-clicking an interface button and then selecting **Configure** from the resulting pop-up menu. The **Functional Block Settings** window allows setting the attributes that define the channel mode. Other attributes can be accessed via the **Advanced...** button.

![Functional Block Settings window](image)

**Figure C-2** Functional Block Settings window
The **Also Apply To...** button copies all attribute settings (including those that are set through the **Advanced...** button) to all interfaces specified. The **In Use** checkbox affects the administrative state settings.

**Permitted attribute combinations**

Table C-1 shows which values are allowed with each other, and the resulting channel mode. The channel mode is not displayed to the user.

<table>
<thead>
<tr>
<th>Possible values of interface standard</th>
<th>Possible values of interface timing</th>
<th>Possible values of interface conversion/adaptation</th>
<th>Channel mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>V.24 (D)</td>
<td>Asynchronous</td>
<td>Sampling</td>
<td>1</td>
</tr>
<tr>
<td>V.35</td>
<td></td>
<td>R111</td>
<td>2</td>
</tr>
<tr>
<td>V.36</td>
<td>Transparent + V14 (D)</td>
<td>3</td>
<td>1) 2)</td>
</tr>
<tr>
<td>EIA-530-A</td>
<td>V110 + V14</td>
<td>4</td>
<td>1) 2)</td>
</tr>
<tr>
<td></td>
<td>Synchronous codir. or contradir. (D)</td>
<td>Transparent (D)</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>V110</td>
<td>6</td>
</tr>
<tr>
<td>X.21</td>
<td>Synchronous S.E.T (D)</td>
<td>Transparent (D)</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Synchronous octet</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Synchronous external</td>
<td>X30</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G.703</td>
<td>Synchronous codir. or contradir. (D)</td>
<td>Transparent</td>
<td>13</td>
</tr>
</tbody>
</table>

Notes: 1) In channel modes 3 and 4, V.14 is used to perform the async–sync conversion. These are the only modes that use V.14 (when the user rate is higher than 0.6 kbit/s). The **Advanced...** window has a separate tab for V.14 configuration. The text displayed is **V.110+V.14** when the user rate is >0.6 kbit/s, and **V.110** in all other cases.

2) In modes 3 to 12 (that is, in the V.xx and X21 modes), the user can choose whether or not to use V.13. (The **Advanced...** window includes the V.13 options on the V.xx and X.21 tabs.)

Table C-1  Permitted attribute combinations

For **Interface standard**, the full range of possible values is always visible in the dropdown control. If the user sets the **Interface standard** to something which is not compatible with the existing setting of **Interface conversion/adaptation**, then the existing setting is replaced by the appropriate default value. The same applies to the interaction between **Interface standard** and **Interface timing**.

The **Interface standard** can be:

- V.24 (default setting)
- V.35
- V.36
- EIA-530-A
- X.21
- G.703.
For **Interface conversion/adaptation**, the values shown are the ones that are valid with the current setting of **Interface standard**.

The **Interface conversion/adaptation** can be:

- Sampling
- Transition coding (R111)
- Transparent
- V110 (for channel modes 4 and 6)/X.30 (for channel mode 12).

For **Interface timing**, the values shown are the ones that are valid with the current setting of **Interface standard**.

Interface timing is selected by the user; the text description appears automatically according to user selection. The possible options are listed in Table C-2.

<table>
<thead>
<tr>
<th>Interface timing</th>
<th>Text description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asynchronous</td>
<td>No timing circuits</td>
</tr>
<tr>
<td>Codirectional</td>
<td>– If interface standard is V.xx: Circuits 113/115 used for timing</td>
</tr>
<tr>
<td></td>
<td>– If interface standard is G.703: No separate timing circuits</td>
</tr>
<tr>
<td>Contradirectional</td>
<td>– If interface standard is V.xx: Circuits 114/115 used for timing</td>
</tr>
<tr>
<td></td>
<td>– If interface standard is G.703: One timing circuit in each direction</td>
</tr>
<tr>
<td>Signal element</td>
<td>Circuit S used for timing</td>
</tr>
<tr>
<td>Octet element</td>
<td>Circuits S and B used for timing</td>
</tr>
<tr>
<td>External</td>
<td>Circuits S and X used for timing</td>
</tr>
</tbody>
</table>

**Table C-2** Interface timing options

The **User rate** may change according to selections in **Interface standard, Interface conversion/adaptation**, or **Interface timing**.

**Note**
Selections in the **Functional Block Settings** window may cause changes to the data in other windows, so that only valid combinations are displayed. For example, changes to **User rate** in this window may mean that only certain values are valid for **Signal 106 delay** in the **V.xx** tab. In every case where a field is reset, it is reset to its default value.

The possible values for the User Rate depend on the channel mode, as shown in Table C-3.
<table>
<thead>
<tr>
<th>Internal representation</th>
<th>Rate</th>
<th>Channel mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>&lt;0.6</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0.6</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1.2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2.4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>4.8</td>
<td>(D)</td>
</tr>
<tr>
<td>8 (1 x 8)</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>9.6</td>
<td></td>
</tr>
<tr>
<td>16 (2 x 8)</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>19.2</td>
<td>(D)</td>
</tr>
<tr>
<td>24 (3 x 8)</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>32 (4 x 8)</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>40 (5 x 8)</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>48 (6 x 8)</td>
<td>48</td>
<td></td>
</tr>
<tr>
<td>56 (7 x 8)</td>
<td>56</td>
<td>(D)</td>
</tr>
<tr>
<td>64</td>
<td>64</td>
<td>(D)</td>
</tr>
<tr>
<td>N + 63</td>
<td>N x 64; N = 2–32</td>
<td>1)</td>
</tr>
</tbody>
</table>

Notes: 1) Nx64 is not allowed for V.24, only for V.35, V.36 and EIA-530-A
2) For the nx8, nx64 bit rates, select the resulting bit rate from the list (for example, bit rate 24 for 3x8). The equivalent nx8, nx64 bit rate representation will be shown alongside the current selection as read-only text.

**Table C-3**  Correlation between user rate and channel mode. The default values are marked with D.

The **Cross-connect rate** is read only. It shows the rate to be used (or in use) for cross-connecting this interface (that is, intermediate rate plus, if necessary, POH). This value is calculated and updated automatically according to the current settings. When the user opens this window for the first time, this field shows the default value.

When editing this window (on a configured interface), the controls are all disabled if there is a cross-connect on the interface excluding the **Advanced...** button. In such a situation, it is possible to view the advanced settings, but not edit them.
C.4 Advanced interface settings tabs

The Advanced... button leads to a tabbed window. The tabs available depend on the channel mode, as shown in Table C-4. The Advanced... button is greyed out until the Functional Block Settings window contains a valid set of values for the selected interface.

If any selections are made within the advanced interface settings tabs and the OK button is pressed, the selection is automatically copied to the Functional Block Settings window and the selections contained within the Settings groupbox in the Functional Block Settings window will be greyed out. This is to prevent users from making changes in the tabs which are valid for one channel mode, returning to the Functional Block Settings window and changing the channel mode to another, for which the advanced settings may not be valid.

The tabs available depend on the channel mode as shown in Table C-4.

<table>
<thead>
<tr>
<th>Tab name</th>
<th>Channel mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
</tr>
<tr>
<td>G.703</td>
<td></td>
</tr>
<tr>
<td>X.21</td>
<td></td>
</tr>
<tr>
<td>V.xx</td>
<td></td>
</tr>
<tr>
<td>V.110 Adaptation 1)</td>
<td></td>
</tr>
<tr>
<td>X.30 Adaptation 2)</td>
<td></td>
</tr>
<tr>
<td>Input buffer</td>
<td></td>
</tr>
<tr>
<td>Sampling</td>
<td></td>
</tr>
<tr>
<td>V.14</td>
<td></td>
</tr>
<tr>
<td>POH</td>
<td></td>
</tr>
<tr>
<td>Bitmasks</td>
<td></td>
</tr>
<tr>
<td>Number of visible tabs</td>
<td>4</td>
</tr>
</tbody>
</table>

Notes: 1) V.110 Adaptation when V.xx or EIA-530-A, that is, when the channel mode is 4 or 6
2) X.30 Adaptation when X.21, that is, when the channel mode is 13

Table C-4  Tabs available for different channel modes
C.4.1 G.703 tab

This tab is available only when the channel mode is 13 (that is, when the Interface standard is G.703).

![Advanced DIU Interface Settings](image)

**Figure C-3**  G.703 tab

<table>
<thead>
<tr>
<th>Attribute (UI term)</th>
<th>Possible values</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor (Rx)</td>
<td>Enabled, Disabled, Not supported</td>
<td>Disabled</td>
</tr>
<tr>
<td>Sent (Tx)</td>
<td>Fixed On, Fixed Off, Alarm Controlled</td>
<td>Fixed On</td>
</tr>
</tbody>
</table>

**Table C-5**  Possible values and default values for the G.703 tab
C.4.2 X.21 tab

This tab is available only when the channel mode is 11 or 12 (that is, when the interface standard is X.21).

![Advanced DIU Interface Settings]

Figure C-4 X.21 tab
Attribute | Possible values | Default
--- | --- | ---
Interface termination | Enabled/Disabled | Enabled
Circuit C | Fixed On, Fixed Off, Enabled | Enabled
Circuit I | Fixed On, Fixed Off, Enabled | Fixed Off
Circuit R | Fixed On, Fixed Off, Enabled | Enabled
Circuit T | Fixed On, Fixed Off, Enabled | Enabled
Loopback indication pattern | 0101..., 0000... | –

Table C-6   Possible values and default values for the X.21 tab

**Circuit usage**

The possible circuit state values are On, Off, Toggling and Not applicable for all circuits. It is not possible to set Circuit X.

---

**Note**

The circuit state values shown are a snapshot of the current value read from the node at the moment when the user accesses the Unit configuration window. These values are not dynamically updated. If an up-to-date value is required, the window has to be refreshed by selecting the Refresh from node command. Refreshing can be done only if the window is closed.

---

**V.13 usage and POH tab**

The V.13 usage selections appear also on the V.xx tab, but the X.21 tab and the V.xx tabs are never visible at the same time.

Generally, if any conversion/adaptation other than V.110 is used, the V.13 usage selections are available.

---

**Note**

The V.13 selections and the selections within the Control signal groupbox on the POH tab are mutually exclusive. That is, V.13 usage is selected, then the POH Control signal selections are not available. Conversely, if the Control signal selection is made on the POH tab, the V.13 selections on the X.21 tab are not available.

If the X.30 conversion/adaptation is selected, only the V.13 upstream checkbox is available. The V.13 downstream checkbox and the POH Control signal selections will not be available.
C.4.3 V.xx tab

This tab is available only for channel modes 1 to 6.

![Advanced DIU Interface Settings](image)

**Figure C-5** V.xx tab

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Possible values</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circuit 103</td>
<td>Fixed On, Fixed Off, Enabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Circuit 104</td>
<td>Fixed On, Fixed Off, Enabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Circuit 105</td>
<td>Fixed On, Fixed Off, Enabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Circuit 106</td>
<td>Fixed On, Fixed Off, Local Enabled, Remote Enabled</td>
<td>Local Enabled / Remote Enabled ¹)</td>
</tr>
<tr>
<td>Circuit 107</td>
<td>Fixed On, Fixed Off, Enabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Circuit 109</td>
<td>Fixed On, Fixed Off, Enabled</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

Notes: ¹) If the interface is in V.110 mode, the default value is Remote Enabled, otherwise Local Enabled.

**Table C-7** Possible values and default values for circuit usage
Circuit labels

When the Interface standard is EIA-530-A, the circuits are labelled as shown in Table C-8:

<table>
<thead>
<tr>
<th>V.24, V.35, V.36</th>
<th>EIA-530-A</th>
</tr>
</thead>
<tbody>
<tr>
<td>104</td>
<td>BB</td>
</tr>
<tr>
<td>106</td>
<td>CB</td>
</tr>
<tr>
<td>107</td>
<td>CC</td>
</tr>
<tr>
<td>109</td>
<td>CF</td>
</tr>
<tr>
<td>114</td>
<td>DB</td>
</tr>
<tr>
<td>115</td>
<td>DD</td>
</tr>
<tr>
<td>142</td>
<td>TM</td>
</tr>
<tr>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>103</td>
<td>BA</td>
</tr>
<tr>
<td>105</td>
<td>CA</td>
</tr>
<tr>
<td>108</td>
<td>CD</td>
</tr>
<tr>
<td>113</td>
<td>DA</td>
</tr>
<tr>
<td>140 (not for V.36)</td>
<td>RL</td>
</tr>
<tr>
<td>141 (not for V.36)</td>
<td>LL</td>
</tr>
</tbody>
</table>

Table C-8  Circuit labels when the Interface standard is EIA-530-A

Note
The circuit state values shown are a snapshot of the current value read from the node at the moment when the user accesses the Unit configuration window. These values are not dynamically updated. If an up-to-date value is required, the window has to be refreshed by selecting the Refresh from node command. Refreshing can be done only if the window is closed.

The circuit states are read-only.

Signal 106 delay is fixed in the following two cases:

- When V.13 is in use (that is, when either of the checkboxes in the V.13 Usage groupbox in this window is checked) Signal 106 delay is fixed at 8 bits.
- When V.110 is in use, Signal 106 delay is fixed at 24 bits.

In the above two cases, the actual delay depends on the User rate, which is visible on the original Unit configuration window. Node Manager calculates the actual delay based on the User rate and the number-of-bits delay.

In all other cases, the delay can be selected within the limits given in Table C-9.
Table C-9  Possible values for Signal 106 delay

<table>
<thead>
<tr>
<th>Attribute (UI term)</th>
<th>Possible values</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use V.13 for downstream control signal transfer</td>
<td>True, False</td>
<td>False (unchecked)</td>
</tr>
<tr>
<td>Use V.13 for upstream control signal transfer</td>
<td>True, False</td>
<td>False (unchecked)</td>
</tr>
</tbody>
</table>

Note: When one of these selections is checked, the Signal 106 delay in the Circuit usage groupbox is set to 8 bits and cannot be changed. These selections are not available in channel modes 1 and 2.

Table C-10  Possible values and default values for V.13 Usage

V.13 usage and the POH tab

The V.13 usage selections appear also on the X.21 tab, but the X.21 tab and the V.xx tabs are never visible at the same time.

Generally, if any conversion/adaptation other than V.110 is used, the V.13 usage selections are available.

Note

The V.13 selections and the selections within the Control signal groupbox on the POH tab are mutually exclusive. That is, V.13 usage is selected, then the POH Control signal selections are not available. Conversely, if the Control signal selection is made on the POH tab, the V.13 selections on the X.21 tab are not available.

If the V.110 conversion/adaptation is selected, only the V.13 upstream checkbox is available. The V.13 downstream checkbox and the POH Control signal selections will not be available.
C.4.4 V110 Adaptation tab

This tab is available only for channel modes 4 and 6, that is, when the interface standard is V.xx or EIA-530-A. (For channel mode 12, the tab is called X.30 Adaptation and the circuits are labelled differently; see Section C.4.5.)

![V.110 Adaptation tab](image)

**Figure C-6** V.110 Adaptation tab

When the **Interface standard** is EIA-530-A, the circuits are labelled as shown in Table C-11.

<table>
<thead>
<tr>
<th>V.xx</th>
<th>EIA-530-A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circuit 104 (D-bits)</td>
<td>Circuit BB</td>
</tr>
<tr>
<td>Circuit 107</td>
<td>Circuit CC</td>
</tr>
<tr>
<td>Circuit 108</td>
<td>Circuit CD</td>
</tr>
<tr>
<td>Circuit 105</td>
<td>Circuit CA</td>
</tr>
<tr>
<td>Circuit 109</td>
<td>Circuit CF</td>
</tr>
<tr>
<td>Circuit 106</td>
<td>Circuit CB</td>
</tr>
</tbody>
</table>

**Table C-11** Circuit labels when the **Interface standard** is EIA-530-A
In channel modes 4, 6 and 12, the user can also control some of these circuits from the V.xx tab.

<table>
<thead>
<tr>
<th>Attribute (UI term)</th>
<th>Possible values</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>V110 operation 1)</td>
<td>Duplex (Simplex Tx, Simplex Rx, Half duplex are not supported in release C2.0)</td>
<td>Duplex</td>
</tr>
<tr>
<td>Report LOVFS alarms</td>
<td>True, False</td>
<td>True (checked)</td>
</tr>
<tr>
<td>AIS on local loopback</td>
<td>Continue, Terminate</td>
<td>Continue (checked)</td>
</tr>
<tr>
<td>Adaptation of 56 kbit/s 2)</td>
<td>Use S and X bits (True), No control circuits (False)</td>
<td>True (Use S- and X-bits)</td>
</tr>
<tr>
<td>Circuit 104 (D-bits)</td>
<td>Normal, Fixed On, Fixed Off</td>
<td>Normal</td>
</tr>
<tr>
<td>Circuit 107</td>
<td>Normal, Fixed On, Fixed Off</td>
<td>Normal</td>
</tr>
<tr>
<td>Circuit 108</td>
<td>Normal, Transparent, Not in Use</td>
<td>Transparent</td>
</tr>
<tr>
<td>Circuit 105</td>
<td>Normal, Not in Use</td>
<td>Normal</td>
</tr>
<tr>
<td>Circuit 109</td>
<td>Normal, Fixed On, Fixed Off</td>
<td>Normal</td>
</tr>
<tr>
<td>Circuit 106 (X-bits)</td>
<td>Normal, Fixed On, Fixed Off</td>
<td>Normal</td>
</tr>
</tbody>
</table>

Notes:  
1) The V.110 operation box contains only Duplex in release C2.0.  
2) The control Adaptation of 56 kbit/s is enabled only when the user rate is 56 kbit/s

Table C-12  Possible values and default values for V.110 Adaptation tab

Note
The circuit state values shown are a snapshot of the current value read from the node at the moment when the user accesses the Unit configuration window. These values are not dynamically updated. If an up-to-date value is required, the window has to be refreshed by selecting the Refresh from node command. Refreshing can be done only if the window is closed.
C.4.5 **X.30 Adaptation tab**

This tab is available for channel mode 12 only. It is similar in behaviour to the **V.110 Adaptation** tab, but has fewer fields and different field labels.

![Image of X.30 Adaptation tab]

**Figure C-7 X.30 Adaptation tab**
C.4.6 Input buffer tab

This tab is available for channel modes 5 to 13, that is, for the synchronous modes.

![Input buffer tab](image)

**Figure C-8 Input buffer tab**

<table>
<thead>
<tr>
<th>Attribute (UI term)</th>
<th>Possible values</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report IBO/IBU alarms</td>
<td>True, False</td>
<td>True (checked)</td>
</tr>
<tr>
<td>Threshold for IBO</td>
<td>1 to 255</td>
<td>3</td>
</tr>
<tr>
<td>Threshold for IBU</td>
<td>1 to 255</td>
<td>3</td>
</tr>
</tbody>
</table>

**Table C-13** Possible values and default values for Input buffer tab

The tab also displays the number of underflow/overflow errors reported by the node. Note that this information is read from the node and is not updated after the window is accessed. To get the up-to-date value, refresh the window by selecting the **Refresh from node** command.
C.4.7 Sampling tab

This tab is available for channel mode 1 only, that is, when sampling is in use. This tab contains just one control, a check box labelled **Filter error bursts**.

![Sampling tab](image)

**Figure C-9** Sampling tab

<table>
<thead>
<tr>
<th>Attribute (UI term)</th>
<th>Possible values</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter error bursts</td>
<td>True, False</td>
<td>False (unchecked)</td>
</tr>
</tbody>
</table>

**Table C-14** Possible values and default values for Sampling tab
C.4.8 V.14 tab

This tab is available for channel modes 3 and 4.

![Advanced DIU Interface Settings](image)

**Figure C-10 V.14 tab**

<table>
<thead>
<tr>
<th>Attribute (UI term)</th>
<th>Possible values</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character length</td>
<td>8–11</td>
<td>8</td>
</tr>
<tr>
<td>Tolerance</td>
<td>Basic (–2.5 to +1%), Extended (–2.5 to +2.3%)</td>
<td>Basic (–2.5 to +1%)</td>
</tr>
</tbody>
</table>

**Table C-15** Possible values and default values for V.14 tab
C.4.9 POH tab

This tab is not available for channel modes that use V.110, that is for modes 4, 6 and 12.

![Advanced DIU Interface Settings](image)

**Figure C-11** POH tab

---

**Note**

If either of the V.13 checkboxes in the X.21 or V.xx tabs has been checked, these selections are not available. Conversely, if the Control signal selection is made on the POH tab, the V.13 selections on the X.21 tab are not available.
C.4.10 Bitmasks tab

This tab is available for all other channel modes except 3 and 13. It shows the up-/downstream bitmask, which is fixed and determined by the intermediate rate.

**If the intermediate rate is 64 kbit/s or higher**

When the intermediate rate is 64 kbit/s or higher, the following applies:

- The selections on this tab are read-only.
- The bitmask is fixed with all bits set (that is, 1111111).
- The “Left shift” controls are not available.

![Advanced DIU Interface Settings](image)

**Figure C-12** Bitmasks tab when the intermediate rate is 64 kbit/s or higher
If the intermediate rate is less than 64 kbit/s

When the intermediate rate is less than 64 kbit/s, the following applies:

- The “Left shift” controls are available.
- User can specify a left shift for the displayed bitmask.

The default value for the left shift is zero. The maximum value will vary according to the bitmask, but still prevents users from losing the set bits of the mask by shifting them to far left. So, for example, in Figure C-13, the left shift range is 0 to 6. If the bitmask was 00011111, the range would be 0 to 3.

![Advanced DIU Interface Settings]

**Figure C-13** Bitmasks tab when the intermediate rate is less than 64 kbit/s
<table>
<thead>
<tr>
<th>Product Name</th>
<th>Product Code</th>
<th>Release</th>
<th>Dependent Item</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>T30813 Fan Unit Operating Instructions</td>
<td>C33461.20</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T30810.02 Fuse Terminal Operating Instr.</td>
<td>C33508.20</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T35025.xx OSI-DCN Adaptor User Manual</td>
<td>C33585.20</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eksos N20 C2.0 Upgrade Instructions</td>
<td>C33836.22</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETSI Rack (E30528,***) Inst. Instr. (E)</td>
<td>C33912.20</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DC-ITU Operating Instructions</td>
<td>C33976.20</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T30810.01/.11 DC-PSA Operating Instr.</td>
<td>C33983.20</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eksos N20 C2.0 DEU User Manual</td>
<td>C33993.20</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RJ45 cable connector set, 10 pcs</td>
<td>E30419.05</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EKSOS N20 Wall Mounting Set</td>
<td>E30444.01</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EKSOS N20 Wall Mounting Set</td>
<td>E30444.01</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EKSOS N20 Wall Mounting Set</td>
<td>E30444.01</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EKSOS Service Conn. Panel</td>
<td>E30444.02</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETSI-Connection Bar Frame (LSA-Profil)</td>
<td>E30444.03</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection Bar Frame (LSA-Profil)</td>
<td>E30444.04</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU 4x2M 75ohm Cable Acc. Set</td>
<td>E30445.01</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU 4x2M 75ohm Cable Acc. Set</td>
<td>E30445.01</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU 4x2M 120ohm Cable Acc. Set</td>
<td>E30445.02</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU 4x2M 120ohm Cable Acc. Set</td>
<td>E30445.02</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU 4x2M 75/120ohm Cabling Acc. Set</td>
<td>E30445.03</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU 4x2M 75/120ohm Cabling Acc. Set</td>
<td>E30445.03</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCU/SAN CORE2M 120ohm Adapter Cable</td>
<td>E30445.04</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eurocon. 2x32(ww) Cabling Acc. Set</td>
<td>E30445.11</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eurocon. 2x32(ww) Cabling Acc. Set</td>
<td>E30445.12</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eurocon. 2x32(ww) Cabling Acc. Set</td>
<td>E30445.21</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eurocon. 3x7(ww) Cabling Acc. Set</td>
<td>E30445.22</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIU 2x(3x7) Shdl Cabl. Acc.Set</td>
<td>E30445.41</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jumper Cable Pair POTS (32ch.-con.bar)</td>
<td>E30447.02</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jumper Cable ISDN-U (16ch.-con.bar)</td>
<td>E30447.03</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fan Interface Cable Eksos N20</td>
<td>E30804.14</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 0.5m</td>
<td>E30805.05</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 0.5m</td>
<td>E30805.05</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 1m</td>
<td>E30805.10</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 1m</td>
<td>E30805.10</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 1.5m</td>
<td>E30805.15</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 2m</td>
<td>E30805.20</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 2m</td>
<td>E30805.20</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 2.5m</td>
<td>E30805.25</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 3m</td>
<td>E30805.30</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 3m</td>
<td>E30805.30</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 3.5m</td>
<td>E30805.35</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power/Sign.Volt Cable NTM 3.5m</td>
<td>E30805.35</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 0.5m</td>
<td>E30806.05</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 0.5m</td>
<td>E30806.05</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 1m</td>
<td>E30806.10</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 1m</td>
<td>E30806.10</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 1.5m</td>
<td>E30806.15</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 1.5m</td>
<td>E30806.20</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 2m</td>
<td>E30806.20</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 2m</td>
<td>E30806.20</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 2.5m</td>
<td>E30806.25</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 3m</td>
<td>E30806.30</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 3m</td>
<td>E30806.30</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 3.5m</td>
<td>E30806.35</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Alarm Cable NTM 3.5m</td>
<td>E30806.35</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Branching Cable NTM 0.5m</td>
<td>E30815.05</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Branching Cable NTM 1.5m</td>
<td>E30815.15</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC POTS 17-32 N20- 10M</td>
<td>E32847.10</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC POTS 17-32 N20 -15M</td>
<td>E32847.15</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC POTS 17-32 N20- 20M</td>
<td>E32847.20</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC POTS 17-32 N20- 25M</td>
<td>E32847.25</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC POTS 17-32 N20- 35M</td>
<td>E32847.35</td>
<td>B</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© Copyright Nokia Networks Oy
<table>
<thead>
<tr>
<th>Product Name</th>
<th>Product Code</th>
<th>Release</th>
<th>Dependent Item</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC POTS 17-32 N20- 40M</td>
<td>E32847.40</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC POTS 17-32 N20- 50M</td>
<td>E32847.50</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC POTS 17-32 N20- 70M</td>
<td>E32847.70</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC ISDN/POTS 1-16 N20- 10M</td>
<td>E32848.10</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC ISDN/POTS 1-16 N20- 15M</td>
<td>E32848.15</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC ISDN/POTS 1-16 N20- 20M</td>
<td>E32848.20</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC ISDN/POTS 1-16 N20- 25M</td>
<td>E32848.25</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC ISDN/POTS 1-16 N20- 35M</td>
<td>E32848.35</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC ISDN/POTS 1-16 N20- 40M</td>
<td>E32848.40</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC ISDN/POTS 1-16 N20- 50M</td>
<td>E32848.50</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC ISDN/POTS 1-16 N20- 70M</td>
<td>E32848.70</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locks and Frame for Euroconnector</td>
<td>E32899.10</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coax Carrier</td>
<td>E32899.11</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 ISDN BRA Unit (2B1Q,16ch) Func.</td>
<td>P35232.30</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 ISDN BRA Unit (2B1Q,16ch) Func.</td>
<td>P35232.30</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 ISDN BRA Unit (4B3T,16ch) Func.</td>
<td>P35232.31</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 ISDN BRA Unit (4B3T,16ch) Func.</td>
<td>P35232.31</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 LMU Unit Functionality</td>
<td>P35232.40</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 LMU Unit Functionality</td>
<td>P35232.40</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 TR2M4 Unit Functionality</td>
<td>P35232.50</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 TR2M4 Unit Functionality</td>
<td>P35232.50</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 DIU Unit Functionality</td>
<td>P35232.60</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 DIU Unit Functionality</td>
<td>P35232.60</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 Node Feature Set DEU</td>
<td>P35286.01</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 Node Feature Set DEU</td>
<td>P35286.01</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 NCU Unit DEU Functionity</td>
<td>P35286.10</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 NCU Unit DEU Functionity</td>
<td>P35286.10</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 POTS Unit 32ch DEU Functionality</td>
<td>P35286.20</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2.0 POTS Unit 32ch DEU Functionality</td>
<td>P35286.20</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OSI DCN Adaptor Feature Set</td>
<td>P35295.01</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OSI DCN Adapter Functionality</td>
<td>P35295.10</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EKSOS N20 C3.0 Node Manager</td>
<td>P35304.01</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C3.1 EKSOS N20 Node Manager</td>
<td>P35305.01</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETSI RACK WITH BACK PLATES(2,2x0,6x0,3M)</td>
<td>T30400.01</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETSI RACK WITHOUT BACK PLATES(2,2x0,6x0,3M)</td>
<td>T30400.02</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node Manager Cable (Ethernet)</td>
<td>T30404.21</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethernet Cable, 50cm</td>
<td>T30405.01</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>80 cm Eth. cable (Subrack-Subrack)</td>
<td>T30405.08</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50 ohm Ethernet Line Termination</td>
<td>T30405.10</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T-BNC Connector with protective cover</td>
<td>T30405.11</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>120 cm Ethernet Cable (Rack-Rack)</td>
<td>T30405.12</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETSI Rack with back plate (300 mm deep)</td>
<td>T30406.01</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETSI Rack with back plate (d=300 mm)</td>
<td>T30406.02</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Side Plate Set for ETSI Rack (one side)</td>
<td>T30406.03</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Top Mounting Set</td>
<td>T30406.04</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Back Plate Set for ETSI Rack</td>
<td>T30406.06</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inst. Acc. for next to wall/floor inst.</td>
<td>T30406.09</td>
<td>H</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STAND SET FOR ETSI RACK</td>
<td>T30406.10</td>
<td>H</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CABLE SUPPORT SET</td>
<td>T30406.11</td>
<td>G</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CABLE SUPPORT SET</td>
<td>T30406.11</td>
<td>J</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTM 1-slot blank front plate</td>
<td>T30426.01</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTM Plastic cover 19 in./ETSI</td>
<td>T30426.02</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTM Plastic cover 19 in./ETSI</td>
<td>T30426.02</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTM Fibre guidance set</td>
<td>T30426.03</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTM Fibre guidance set</td>
<td>T30426.03</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTM Fibre guidance set</td>
<td>T30426.03</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eksos N20 Subrack 17-slot</td>
<td>T30427.01</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eksos N20 Subrack 17-slot</td>
<td>T30427.01</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eksos N20 Subrack 17-slot</td>
<td>T30427.01</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eksos N20/SAN Subrack 17-slot</td>
<td>T30427.03</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eksos N20/SAN Subrack 17-slot</td>
<td>T30427.03</td>
<td>D</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# SYSTEM RELEASE ITEM LIST

## Eksos N20 C2.0.1 DEU

Approved: TLö 13-FEB-03

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Product Code</th>
<th>Release</th>
<th>Dependent Item</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eksos N20/SAN Subrack 17-slot</td>
<td>T30427.03</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19 in. shelf</td>
<td>T30432.01</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETSI 500mm shelf</td>
<td>T30432.02</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19in./ETSI-2U Air Deflector</td>
<td>T30433.01</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19in./ETSI-2U Air Deflector</td>
<td>T30433.01</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19in./ETSI-5U Air Deflector</td>
<td>T30433.02</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19in./ETSI-5U Air Deflector</td>
<td>T30433.02</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19 in./ETSI-2U Air Deflector with Grill</td>
<td>T30433.04</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19 in./ETSI-2U Air Deflector with Grill</td>
<td>T30433.04</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19 in./ETSI-5U Air Deflector with Grill</td>
<td>T30433.05</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19 in./ETSI-5U Air Deflector with Grill</td>
<td>T30433.05</td>
<td>E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTM Dual Ethernet Cable 1m</td>
<td>T30436.01</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTM Dual Ethernet Cable 3m/0.5m</td>
<td>T30436.02</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adapter for NTM Ethernet Cable</td>
<td>T30436.03</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EKSSS N20/SAN Cartridge 8-slot</td>
<td>T30500.01</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EKSSS N20/SAN Cartridge 8-slot</td>
<td>T30500.01</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EKSSS N20 NANCradtridge 8-Slot</td>
<td>T30500.02</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EKSSS N20 NANCradtridge 8-Slot</td>
<td>T30500.02</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Cable NTM 2.5m</td>
<td>T30803.03</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm Cable NTM &amp; STM-16 2.5m</td>
<td>T30803.04</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Cable NTM 1.5m</td>
<td>T30803.05</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm Cable NTM 1.5m</td>
<td>T30803.06</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sign. Voltage Cable NTM 2.5m</td>
<td>T30803.09</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fan Interface Cable Eksos</td>
<td>T30803.14</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DC-PSA 19 in./ETSI</td>
<td>T30810.01</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DC-PSA 19 in./ETSI</td>
<td>T30810.01</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DC-PSA 19 in./ETSI</td>
<td>T30810.01</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fuse Terminal 19 in./ETSI</td>
<td>T30810.02</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fuse Terminal 19 in./ETSI</td>
<td>T30810.02</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fuse Terminal 19 in./ETSI</td>
<td>T30810.02</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension Unit 1019 in./ETSI</td>
<td>T30810.03</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capacitor Unit 19 in./ETSI</td>
<td>T30812.01</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fan Unit 19 in./ETSI</td>
<td>T30813.01</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fan Unit 19 in./ETSI</td>
<td>T30813.01</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DC-PSU 48V/800W N25mm NTM</td>
<td>T30814.01</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decor. Cover DC-PSA 19in./ETSI</td>
<td>T30827.02</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decorative Cover 2U NTM</td>
<td>T30827.05</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decorative Cover 1U NTM</td>
<td>T30827.10</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCUA 75 ohm</td>
<td>T35010.01</td>
<td>A</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 75 ohm</td>
<td>T35010.01</td>
<td>B</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 75 ohm</td>
<td>T35010.01</td>
<td>C</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 75 ohm</td>
<td>T35010.01</td>
<td>D</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 120 ohm</td>
<td>T35010.11</td>
<td>A</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 120 ohm</td>
<td>T35010.11</td>
<td>B</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 120 ohm</td>
<td>T35010.11</td>
<td>C</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 120 ohm</td>
<td>T35010.11</td>
<td>D</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 75 ohm w/ 120 ohm synch.</td>
<td>T35010.21</td>
<td>A</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 75 ohm w/ 120 ohm synch.</td>
<td>T35010.21</td>
<td>B</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 75 ohm w/ 120 ohm synch.</td>
<td>T35010.21</td>
<td>C</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>NCUA 75 ohm w/ 120 ohm synch.</td>
<td>T35010.21</td>
<td>D</td>
<td>P35286.10</td>
<td>E</td>
</tr>
<tr>
<td>OSI DCM adapter 75 ohm</td>
<td>T35025.01</td>
<td>C</td>
<td>P35295.10</td>
<td>E</td>
</tr>
<tr>
<td>OSI DCM adapter 75 ohm</td>
<td>T35025.01</td>
<td>C</td>
<td>P35295.10</td>
<td>E</td>
</tr>
<tr>
<td>TR2M4a 75 OHM</td>
<td>T35030.01</td>
<td>A</td>
<td>P35232.50</td>
<td>E</td>
</tr>
<tr>
<td>TR2M4a 75 OHM</td>
<td>T35030.01</td>
<td>B</td>
<td>P35232.50</td>
<td>E</td>
</tr>
<tr>
<td>TR2M4a 75 OHM</td>
<td>T35030.01</td>
<td>B</td>
<td>P35232.50</td>
<td>F</td>
</tr>
<tr>
<td>TR2M4a 120 ohm</td>
<td>T35030.11</td>
<td>A</td>
<td>P35232.50</td>
<td>E</td>
</tr>
<tr>
<td>TR2M4a 120 ohm</td>
<td>T35030.11</td>
<td>B</td>
<td>P35232.50</td>
<td>E</td>
</tr>
<tr>
<td>TR2M4a 120 ohm</td>
<td>T35030.11</td>
<td>B</td>
<td>P35232.50</td>
<td>F</td>
</tr>
</tbody>
</table>
## SYSTEM RELEASE ITEM LIST

Eksos N20 C2.0.1 DEU

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Product Code</th>
<th>Release</th>
<th>Dependent Item</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscriber i/f (POTS 32ch) unit</td>
<td>T35050.01</td>
<td>B</td>
<td>P35286.20</td>
<td>E</td>
</tr>
<tr>
<td>Subscriber i/f (POTS 32ch) unit</td>
<td>T35050.01</td>
<td>B</td>
<td>P35286.20</td>
<td>F</td>
</tr>
<tr>
<td>Subscriber i/f (POTS 32ch) unit</td>
<td>T35050.03</td>
<td>F</td>
<td>P35286.20</td>
<td>E</td>
</tr>
<tr>
<td>Subscriber i/f (POTS 32ch) unit</td>
<td>T35050.03</td>
<td>G</td>
<td>P35286.20</td>
<td>E</td>
</tr>
<tr>
<td>Subscriber i/f (POTS 32ch) unit</td>
<td>T35050.03</td>
<td>H</td>
<td>P35286.20</td>
<td>E</td>
</tr>
<tr>
<td>EKSOS N20 DataInterfaceUnit 4x VX Ports</td>
<td>T35106.01</td>
<td>A</td>
<td>P35232.60</td>
<td>E</td>
</tr>
<tr>
<td>EKSOS N20 DataInterfaceUnit 4x VX Ports</td>
<td>T35106.01</td>
<td>B</td>
<td>P35232.60</td>
<td>F</td>
</tr>
<tr>
<td>EKSOS N20 DataInterface.Unit 4x G.703 Ports</td>
<td>T35106.02</td>
<td>A</td>
<td>P35232.60</td>
<td>E</td>
</tr>
<tr>
<td>EKSOS N20 DataInterface.Unit 4x G.703 Ports</td>
<td>T35106.02</td>
<td>B</td>
<td>P35232.60</td>
<td>F</td>
</tr>
<tr>
<td>EKSOS N20 DataIFUnit 2xVxKx2xG.703 Ports</td>
<td>T35106.03</td>
<td>A</td>
<td>P35232.60</td>
<td>E</td>
</tr>
<tr>
<td>EKSOS N20 DataIFUnit 2xVxKx2xG.703 Ports</td>
<td>T35106.03</td>
<td>B</td>
<td>P35232.60</td>
<td>F</td>
</tr>
<tr>
<td>ISDN BRA U-i/f (2B1Q 16 ch) unit</td>
<td>T35111.11</td>
<td>A</td>
<td>P35232.30</td>
<td>E</td>
</tr>
<tr>
<td>ISDN BRA U-i/f (2B3T 16 ch) unit</td>
<td>T35111.12</td>
<td>A</td>
<td>P35232.31</td>
<td>E</td>
</tr>
<tr>
<td>ISDN BRA U-i/f (2B3T 16 ch) unit</td>
<td>T35111.12</td>
<td>A</td>
<td>P35232.31</td>
<td>F</td>
</tr>
<tr>
<td>ISDN BRA U-i/f (2B1Q 16 ch DN) unit</td>
<td>T35111.21</td>
<td>B</td>
<td>P35232.30</td>
<td>E</td>
</tr>
<tr>
<td>ISDN BRA U-i/f (2B1Q 16 ch DN) unit</td>
<td>T35111.21</td>
<td>C</td>
<td>P35232.30</td>
<td>E</td>
</tr>
<tr>
<td>ISDN BRA U-i/f (2B1Q 16 ch DN) unit</td>
<td>T35111.21</td>
<td>C</td>
<td>P35232.30</td>
<td>F</td>
</tr>
<tr>
<td>ISDN BRA U-i/f (2B3T 16 ch DN) unit</td>
<td>T35111.22</td>
<td>B</td>
<td>P35232.31</td>
<td>E</td>
</tr>
<tr>
<td>ISDN BRA U-i/f (2B3T 16 ch DN) unit</td>
<td>T35111.22</td>
<td>C</td>
<td>P35232.31</td>
<td>E</td>
</tr>
<tr>
<td>ISDN BRA U-i/f (2B3T 16 ch DN) unit</td>
<td>T35111.22</td>
<td>C</td>
<td>P35232.31</td>
<td>F</td>
</tr>
<tr>
<td>Line Measurement Unit</td>
<td>T35140.01</td>
<td>A</td>
<td>P35232.40</td>
<td>E</td>
</tr>
<tr>
<td>Line Measurement Unit</td>
<td>T35140.01</td>
<td>B</td>
<td>P35232.40</td>
<td>E</td>
</tr>
<tr>
<td>Line Measurement Unit</td>
<td>T35140.01</td>
<td>C</td>
<td>P35232.40</td>
<td>E</td>
</tr>
<tr>
<td>Line Measurement Unit</td>
<td>T35140.01</td>
<td>C</td>
<td>P35232.40</td>
<td>F</td>
</tr>
</tbody>
</table>
1 About this document

Chapter 2 describes briefly the principles of node compatibility. It also lists the related products, either Nokia’s or other vendors’, that are compatible with Eksos N20 system release C2.0.

Chapter 3 lists the new features of C2.0 system release.

Chapter 4 gives instructions for upgrading from C1.1 to C2.0.

Chapter 5 describes the corrected defects.

Chapter 6 describes the known defects and recommended remedies.

Chapter 7 provides a key to reading the System Release Item List.

2 Compatibility

Eksos N20 products are under continuous development. In order to indicate and manage the functionality and compatibility levels, all products are included in system releases.

2.1 Internal compatibility

The System Release Item List explicitly shows the node compatibility of Eksos N20 products. All products which belong to the same compatibility level (EKN20 C2.0 HA.1) of the system release are guaranteed to be compatible.

2.1.1 Compatibility with other products

This section describes the compatibility of Eksos N20 system release C2.0 nodes with related products.

SAN

Eksos N20 C2.0 is compatible with SYNFONET Access Node (SAN) system release C1.5 or newer.
SYNFONET

Eksos N20 C.2.0 is compatible with all products of the SYNFONET family.

3 New features, units, mechanical structures and applications introduced in C2.0

Support for the following features has been added to system release C2.0:

- V5 support:
  - four V5.2 interfaces in one node
  - max. 16 x 2 Mbit/s links under one V5.2 interface
  - max. V5.2 user port capacity 1440 user ports through converter
  - 64 kbit/s semi-permanent leased line connections via PSTN and ISDN
    BRA tributary interfaces under V5.2
  - 64 kbit/s semi-permanent leased line connections via V5.1 PSTN and
    ISDN BRA tributaries under V5.2
  - free association of 2 Mbit/s links into different V5.2 interfaces
  - free association of tributary user ports into different V5.2 interfaces
  - V5.2 multihosting
  - V5.1 tributaries under V5.2
  - multislot BCC for BRA
  - partial provisioning of ISDN BRA ports
  - C-paths for P-type data
- semi-permanent leased lines:
  - via PSTN, ISDN BRA; either directly or via V5.1 tributary
  - preconnected bearer channel
- line testing:
  - scheduled line testing
  - line test threshold management
  - dial tone test
  - V.xx and X.yy for DIU loopbacks
- data interfaces:
  - X.21, V.24/V.28, V.35, V.36, EIA-530, G.703 co-/contradirectional
  - V.110 support in data interface unit
  - DNT128 interface via ISDN-U unit (2B1Q)
- local DCN and overhead data access:
  - asynchronous V.11 interface
- Q3 DCN:
  - 64 kbit/s V.11 auxiliary interface to 2 Mbit/s TSx channel (synchronous)
- Q1 DCN:
  - Q1 summing points in TSx
  - 64 kbit/s V.11 Q1/Auxiliary interface to 2 Mbit/s TSx channel
    (asynchronous)
- cross-connect at n x 64 kbit/s granularity
- leased lines outside V5
  - n x 64 kbit/s leased line support for ISDN BRA interfaces, data
    interfaces, 2 Mbit/s tributaries and V5.1 tributaries
new units:
- TR2M4 unit: 4 x 2 Mbit/s tributary, basic n x 64 kbit/s and V5
- PSTN unit: 32 channels, basic features, service switch support
- ISDN-U BRA Unit: 16 channels, 2B1Q, with service switch and DNT128 support
- ISDN-U BRA Unit: 16 channels, 4B3T, with service switch and DNT128 support
- Data Interface Unit (DIU): 4 x G.703, 64 kbit/s
- Data Interface Unit (DIU): 4 x V.xx / X.yy
- Data Interface Unit (DIU): 2 x G.703 64 kbit/s and 2 x V.xx / X.yy

new mechanical structures:
- Eksos N20 8-slot cartridge
- Eksos N20/SAN 8-slot cartridge
- new air deflectors and cable tray

new applications:
- n x 64 kbit/s leased line cross-connect services
- data services
- V5.1 tributary for remote sub nodes
- V5.1/V5.2 converter
- service switch functionality
- n x 64 kbit/s DXC.

4 Upgrading from earlier releases

Upgrading from C1.1 using Node Manager

To upgrade the software from C1.1 to C2.0, do the following:

1. Install the Eksos N20 Node Manager (release C3.0).
2. Connect to a C1.1 node.
3. Download the C2.0 software.
4. Activate the software:
   - In the New Level list box of the Software Settings window, select the EKN C2.0 release.
   - Select all units from the list box and check that the unit software product code versions are the ones that you want.
   - Click on the Switch button.
   - Select Data -> Send to Node.
5. Disconnect from the node, then reconnect to the node.
6. Insert new C2.0 units (DIU, TR2M4, new PSTN unit etc) in the subrack.

Full details for upgrading are given in the separate Upgrade Instructions document.
5 Corrected defects

Sometimes the scheduled test time is shown incorrectly in test results

The “V5 Data Link Failure” alarm is active/inactive for a few minutes

One of the 2M links kept on sending the “V5 Data Link Failure” alarm message continuously so that the alarm was active less than a second and a new alarm was activated after 0.5 to 1 minute. This situation lasted about 50 minutes and the case was solved by restarting the NCU unit.

Synchronisation source will not recover after a 2M link break

When the incoming 2M signal is selected as the synchronisation source and a 2M fault occurs, synchronisation is not always recovered to the normal operation. Eksos node gives the 'Loss of timing’ indication even when the 2M signal is in the normal operational state and the timing should recover to the incoming 2M signal.

Feeding current short cut alarm stuck in interface 2 on ISDNUQ

Sometimes one of the ISDN unit’s (ISDNUQ units of HW versions A4, A5, A6, A7) interfaces did not recover from a feeding current short cut fault. The feeding current short cut alarm stayed on.

No flag in C-channel TS15 when V5.2 is stopped

When the V5 interface was stopped, there was a C-channel flag in vital TS16 and in vital standby TS16, but not in vital TS15. In the same case, an unnecessary protection switch occurred. This has no effect on the PSTN or ISDN traffic.

Scheduled line test stability improved

Enabling the register recall function

During a call, it was possible with some switch to activate the register recall function only once.
6 Special instructions, known defects and abnormal situations

This section lists the known functional discrepancies between the Eksos N20 documents and the actual behaviour of the equipment. The known defective functionality is also described.

Node Manager may crash particularly when the interface is started and stopped
If Node Manager crashes, start it again.

Service switch and ADSL
When a temporary service switch is done, the transmission quality may slightly degrade in extreme circumstances. For ADSL, the speed determined by handshaking may slightly decrease.

Number of user ports
The number of user ports is limited approximately to 1100.

V5.1/V5.2 interface is shown as “disabled starting” while it should be “enabled started”
Node Manager may indicate this state, but the interface is functioning normally.

Modifying V5 interfaces
When modifying or removing V5 alarm reports, Node Manager can indicate an incorrect state and give an error message “An error occurred while trying to modify V5 configuration on the node”.

Semi-permanent POTS lines do not work after a NCU software restart
If you have a node with two NCU units and two V5.2 interfaces, restarting the node master NCU causes disabling of the other V5.2 interface and all of its user ports.

Action
You should stop the V5.2 interface and start it again.

DIU: Activating a Remote Loop in the DTE
When a Remote Loop is activated in the local DTE, synchronisation is momentarily lost in the remote DTE.

Action
Make sure that the Remote user can set loop to network2 box has been checked at the remote end.
The synchronisation is recovered automatically.

**Activating a Remote Loop with POH for data interfaces**

When a Remote Loop with POH is activated for data interfaces, the control signals are not looped back if the Remote user can set loop to network box has been checked at the remote end.

**Time slots for n x 64 kbit/s cross-connects**

The time slots for n x 64 kbit/s cross-connects must be consecutive ones.

**Setting up leased lines**

The DIU cross-connect capacity to a 2M interface may be limited if the 2M interface is in V5 use as it may have signalling configured in time slot 15, 16 or 31. In this case, the maximum cross-connection capacity for the DIU units is 15 x 64 kbit/s. This is because TS 16 is always used for Vital signalling at the V5 interface and, consequently, cannot be used for cross-connection purposes.

**Setting default settings for DIU interfaces**

It is not possible to set the default settings for individual data interfaces by Node Manager.

**Action**

If you want to set the default settings for all interfaces of the DIU unit, uninstall the unit by selecting No Unit in the Unit Type dialog box. Then install the unit again as described in the Commissioning & Maintenance document.

**Viewing capacity of DIU.XX**

The capacity of DIU.XX is shown incorrectly when the leased line dialog box is opened for the first time.

**Action**

Select Data -> Refresh from Node when an active leased line window is open.

**Updating the value for the ‘State’ field in Advanced DIU Interface dialog box**

The value shown in the ‘State’ field is not updated after the window is opened.

**Action**

To update the field, do the following:

1. Close the Advanced DIU Interface settings window by clicking on OK.
2. Close the Configure DIU_xxUx window by clicking on OK.
3. Select Data -> Refresh from Node.
4. Double-click on the desired interface in the Configure Unitx window.
5. Click on **Advanced** to view the state in the ‘State’ field.

**Regenerator loop at ISDN interface**
The ISDN interface stops working if a regenerator loop test is activated.

**Action**
The interface starts working again when the U-interface cable is disconnected and reconnected.

You can also reset the interface with Node Manager:
1. Select the ISDN unit by clicking on it in the **Subrack** window.
2. Select **Configure → Interface** to open the **Ux ISDNUQ** dialog box (x stands for the slot number where the unit is installed).
3. Select the interface by clicking on it, then right-click **Configure**. The **Configure ISDNUQ Ux** dialog box opens.
4. Select the **Power Feeding** tab.
5. In the **Interface Power Feeding** group box, set the maximum power to 0.
6. Send the data to the node.
7. Wait for about one minute.
8. Set the maximum power back to the original value.

**Configuring DIU settings**
It is not recommended to configure DIU settings when the interface is in use. Otherwise Node Manager may get stuck.

**Handling of input buffer overflow / underflow alarms**
Handling of input buffer overflow/underflow alarms is not correct in Node Manager. If there are input buffer overflow/underflow alarms in the current alarms list when the interface is in out of use state, you can clear these by setting the Interface Timing on the DIU unit to something else than **Codir, External**. This has to be done when the interface is out of use.

**The Cancel button does not function correctly in the DIU Bitmask tab**
Node Manager does not send the SET requests for attributes unless they have been changed with Node Manager. Clicking **OK** is assumed by Node Manager to signify a change to be made; clicking **Cancel** is not. Before creating leased lines, make sure that the local and remote end bitmask sets are the correct ones.
7 Key to System Release Item List

The System Release Item List provides a table of all the products (that is, sales items) that belong to system release C2.0. In addition to the products (for instance, T35010.01), the list also shows the product releases (for instance, T35010.01 release B).

Because the products are under constant development, the list shows just the latest situation of the system release compatibility. The document is being constantly updated to cover new product releases.

The item list may also contain several releases of the same product, which indicates that the product releases in question are compatible and interchangeable.

The “Dependent Item” column shows if two products are dependent on each other. An example of this is the program for a unit.

The functionality and compatibility levels can be read from the system release code appearing in the item list header.

<table>
<thead>
<tr>
<th>System name abbreviation</th>
<th>Functionality level</th>
<th>Customer version code</th>
</tr>
</thead>
<tbody>
<tr>
<td>EKN20</td>
<td>C2.0 HA.1.1</td>
<td>Internal version number</td>
</tr>
</tbody>
</table>

**Figure 1** Interpreting the system release code
Nokia Eksos N20
Narrowband Multiservice Access Node
System Release C2.0

Product Description
The information in this document is subject to change without notice and describes only the product defined in the introduction of this documentation. This document is intended for the use of Nokia Networks’ customers only for the purposes of the agreement under which the document is submitted, and no part of it may be reproduced or transmitted in any form or means without the prior written permission of Nokia Networks. The document has been prepared to be used by professional and properly trained personnel, and the customer assumes full responsibility when using it. Nokia Networks welcomes customer comments as part of the process of continuous development and improvement of the documentation.

The information or statements given in this document concerning the suitability, capacity, or performance of the mentioned hardware or software products cannot be considered binding but shall be defined in the agreement made between Nokia Networks and the customer. However, Nokia Networks has made all reasonable efforts to ensure that the instructions contained in the document are adequate and free of material errors and omissions. Nokia Networks will, if necessary, explain issues which may not be covered by the document.

Nokia Networks’ liability for any errors in the document is limited to the documentary correction of errors. Nokia Networks WILL NOT BE RESPONSIBLE IN ANY EVENT FOR ERRORS IN THIS DOCUMENT OR FOR ANY DAMAGES, INCIDENTAL OR CONSEQUENTIAL (INCLUDING MONETARY LOSSES), that might arise from the use of this document or the information in it.

This document and the product it describes are considered protected by copyright according to the applicable laws. NOKIA logo is a registered trademark of Nokia Corporation. Any other trademarks mentioned in the documents are the property of their respective companies, and they are mentioned for identification purposes only.

Copyright © Nokia Corporation 2000-2002. All rights reserved.
<table>
<thead>
<tr>
<th>Document</th>
<th>Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>C33836008SE_00</td>
<td>14 Dec 2000</td>
<td></td>
</tr>
<tr>
<td>C33836008SE_A0</td>
<td>9 Apr 2001</td>
<td></td>
</tr>
<tr>
<td>C33836008SE_A1</td>
<td>4 Jan 2002</td>
<td></td>
</tr>
</tbody>
</table>
## Contents

**Chapter 1**  
About this document ........................................... 1

**Chapter 2**  
Introduction to Nokia Eksos N20 .......................... 3

**Chapter 3**  
Features .......................................................... 5  
3.1 Integrated SDH .................................................. 6  
3.2 V5 interfaces ................................................... 7  
3.3 Multihosting V5 ................................................ 7  
3.4 V5.1 to V5.2 conversion ...................................... 8  
3.5 Leased line applications ...................................... 9  
3.6 Remote service switching .................................... 12  
3.7 Fault tolerance ................................................ 13  
3.8 Line testing .................................................... 13  
3.9 Hot insert ....................................................... 19  
3.10 External alarms ............................................... 19

**Chapter 4**  
Application planning ............................................ 21  
4.1 Requirements for all applications ......................... 22  
4.2 V5.2 multiplexer .............................................. 22  
4.3 V5.1 to V5.2 converter ...................................... 24  
4.4 Service switch ................................................ 24  
4.5 Leased line applications .................................... 25  
4.6 Scheduled line testing applications ...................... 26
Chapter 5
Management ................................................. 27
5.1 Eksos N20 Node Manager ................................. 28
5.2 Nokia NMS ............................................... 28
5.3 Eksos N20 Network Management Products .............. 29
5.4 OSI-DCN Adaptor .................................. 30
5.5 Eksos Q3 DCN .................................... 31

Chapter 6
Construction and power supply ............................. 33
6.1 Interface types .................................. 33
6.2 Node architecture .................................. 34
6.3 Installation options ................................ 35
6.4 Power supply options ................................. 36
6.5 Thermal management principles ....................... 36
   6.5.1 General principles .......................... 37
   6.5.2 Guide-lines for open rack installations ............ 40
   6.5.3 Guide-lines for cabinet installations ............... 42

Chapter 7
Eksos N20 products ........................................ 43
7.1 Common units .................................... 43
   7.1.1 Node Control Unit ............................. 43
   7.1.2 Line Measurement Unit ....................... 44
7.2 Interface units .................................... 44
   7.2.1 STM-1 CORE2M unit ......................... 44
   7.2.2 PSTN interface unit (32-channel) .............. 44
   7.2.3 ISDN BRA U-interface unit ................... 45
   7.2.4 Data Interface Unit .......................... 45
   7.2.5 TR2M4 unit ................................ 46
7.3 Power supplies, subracks and accessories ............... 47
   7.3.1 DC-PSA .................................. 47
   7.3.2 Extension Unit ................................ 47
   7.3.3 Capacitor Unit ................................ 47
   7.3.4 Eksos N20 17-slot subrack .................... 47
   7.3.5 Eksos N20/SAN 17-slot subrack ............... 48
   7.3.6 Eksos N20 8-slot cartridge .................... 48
   7.3.7 Eksos N20/SAN 8-slot cartridge ............... 49
   7.3.8 Fan Unit .................................. 49
   7.3.9 Air deflectors ................................ 49
   7.3.10 Cable trays ................................ 50
   7.3.11 Wall Mounting Set .......................... 50
7.4 Software products .................................. 51
   7.4.1 Node software ............................. 51
Chapter 8
Technical specifications ............................................. 53

8.1 Interfaces ..................................................... 53
8.1.1 2 Mbit/s interfaces ............................................. 53
8.1.2 PSTN interface .................................................. 54
8.1.3 ISDN BRA U-interfaces .......................................... 54
8.1.4 Data interfaces .................................................. 55
8.1.5 STM-1 interfaces ................................................. 55
8.1.6 Synchronisation ................................................ 55
8.1.7 Management interfaces ....................................... 56
8.1.8 Auxiliary interfaces .......................................... 56
8.1.9 External supervisory interfaces ................................. 56
8.2 Line testing ...................................................... 57
8.2.1 PSTN tests ...................................................... 57
8.2.2 ISDN BRA tests ................................................ 58
8.3 Power consumption ............................................. 59
8.4 Mechanical specifications ................................... 59
8.4.1 Subrack extension board connectors ....................... 59
8.4.2 Cartridge extension board connectors ..................... 60
8.4.3 Mechanical dimensions ..................................... 60
8.4.4 Weights .......................................................... 61
8.5 Environmental specifications ................................. 62
8.5.1 EMC Immunity .................................................. 63
8.5.2 EMC Emission ................................................... 64
8.6 Eksos N20 Node Manager system requirements ............ 66
8.7 International recommendations ............................... 67
8.7.1 2 Mbit/s interface specifications ............................ 67
8.7.2 V5.1/V5.2 specifications ...................................... 67
8.7.3 SDH specifications .............................................. 68
8.7.4 Synchronisation ............................................... 68
8.7.5 Miscellaneous .................................................. 69
8.7.6 ISDN BRA (U) interfaces ..................................... 69
8.7.7 PSTN voice frequency specifications ....................... 69
8.7.8 Data interface unit .......................................... 70
8.7.9 HDSL ............................................................. 71
8.7.10 Optical fibre .................................................. 71
8.7.11 Power supply .................................................. 71
8.7.12 Network ........................................................ 71
8.7.13 Environmental .............................................. 72
8.7.14 Management .................................................. 73
Chapter 1
About this document

This document provides a general level description of Nokia Eksos N20 Narrowband Multiservice Access Node and covers the following topics:

- An introduction to Eksos N20 (Chapter 2)
- The features of Eksos N20 (Chapter 3)
- The requirements for Eksos N20 applications (Chapter 4)
- The principles of node management (Chapter 5)
- Eksos N20 construction and power supply (Chapter 6)
- The functions of the individual Eksos N20 units (Chapter 7)
- Technical specifications (Chapter 8).

Instructions for installing and commissioning Eksos N20 are given in their own documents. Both the Nokia Eksos N20 User Manual and Nokia Eksos N20 Product Overview are available on CD-ROM.

For brevity, Eksos N20 is used in place of Nokia Eksos N20 Narrowband Multiservice Access Node.
Chapter 2
Introduction to Nokia Eksos N20

Nokia Eksos N20 is an optimised multiservice access node that provides Public Switched Telephone Network (PSTN) and Integrated Services Digital Network (ISDN) services, with efficient packing density and high reliability, to telecom operators. Eksos N20 offers digital cross-connect with a variety of data interface units. Subscriber interfaces can be upgraded remotely for cost-efficient migration from PSTN to ISDN and narrowband to broadband. Eksos N20 supports the use of either an integrated SDH add-drop multiplexer or terminal multiplexer.

Figure 1  Eksos N20 in a 17-slot subrack
The switch interface is concentrating V5.2. Eksos N20 can gather small, non-concentrating V5.1 links into larger V5.2 interfaces, thus performing V5.1 to V5.2 conversion. This V5.1 to V5.2 conversion is implemented with the TR2M4 plug-in unit.

Eksos N20 also supports multihosting, where subscribers from one access node are connected to different local exchanges (LE) or different V5.2 interfaces. The Eksos N20 node can also extract data connections to a data network.

Eksos N20 supports test-in and test-out line tests without any external cabling. Also, scheduled line tests can be run on selected lines and interfaces.

With the Data Interface Units (DIU), Eksos N20 supports direct data connections, providing leased line services for both residential and business customers. Data connections to remote locations can be provided over copper lines with a High bit rate Digital Subscriber Line (HDSL) or ISDN Digital Subscriber Line (IDSL) line terminal.

Non-switched data or voice-frequency (VF) and switched PSTN/ISDN services can be combined in the same node by making use of the non-blocking cross-connection feature. This enables efficient and flexible capacity grooming and redirecting of information on request.

Eksos N20 can be installed in 17-slot subracks or 8-slot cartridges either on its own or together with SYNFONET Access Node (SAN). With all installation options, all cable connections for the interfaces are available on the front panel.
Chapter 3
Features

Eksos N20 is a modular product consisting of several plug-in units and software options. These elements can be combined to build different node types with specific functionalities.

Figure 2   Eksos N20 as a part of network
Based on its modular structure, Eksos N20 includes the following features:

- integrated SDH
- V5.2 interfaces
- multihosting V5.2
- V5.1 to V5.2 conversion
- local and remote data interfaces
- remote service switching
- line testing
- hot insert
- external alarms.

### 3.1 Integrated SDH

Eksos N20 supports integrated SDH connections; it can act as an SDH add-drop multiplexer or terminal multiplexer. The integrated SDH is implemented with the optional SYNFONET Access Node, which can be installed in the same subrack as Eksos N20 units, to provide SDH STM-1 interfaces. The basic application for PSTN and ISDN BRA (Basic Rate Access) services is shown in Figure 3.

![Figure 3 Integrated SDH service](image)

Additional 2 Mbit/s interfaces can be used for data services or for carrying additional V5.2 traffic to a second access node. A single subrack equipped with SDH, ISDN and PSTN units can serve up to 448 PSTN customers or 224 ISDN BRA customers.
3.2 V5 interfaces

V5 is an ETSI/ITU-T standard for a signalling interface between the access network and local exchange. There are two variants of the standard, V5.1 and V5.2, both based on the use of 64 kbit/s interfaces and 2 Mbit/s links.

V5.1 is a single 2 Mbit/s interface which supports PSTN and ISDN BRA user ports. In V5.1, bearer channels for user ports are allocated statically. In V5.2, dynamic bearer channel allocation, that is, concentration, is included in the design.

- Eksos N20 supports V5.2 interfaces and tributary V5.1 interfaces.
- Eksos N20 supports up to 16 x 2 Mbit/s links per V5.2 interface.
- Eksos N20 node sizes are flexible and each node can be built to support up to:
  - 512 local PSTN subscribers under a V5.2 interface
  - 1440 PSTN subscribers behind V5.1 tributary interfaces.

3.3 Multihosting V5

The multihosting V5 capability gives operators the freedom to connect subscribers from one Eksos N20 node to any of the several V5.2 interfaces configured to the node. The subscribers can be connected to the node either locally or remotely via the V5.1 interface. Eksos N20 can behave as a V5.2 concentrating multiplexer with up to four logical V5.2 interfaces that are provided by the same or different local exchanges (LE).

![Diagram of Eksos N20 multihosting V5 interfaces to different local exchanges]

**Figure 4** Multihosting V5.2 interfaces to different local exchanges
Multihosting is implemented with additional Node Control Units (NCU). Each interface requires at least one NCU, and may need more depending on the number of 2 Mbit/s links that are needed for the application. There can be up to four V5.2 interfaces in one Eksos N20 node.

Multihosting may be necessary for load balancing between local exchanges or for taking advantage of the services offered by the various exchanges. Some exchanges may offer only basic PSTN and ISDN services, while some offer also advanced services, such as CENTREX.

### 3.4 V5.1 to V5.2 conversion

Eksos N20 supports tributary V5.1 to aggregate V5.2 conversion. Conversion from V5.1 to V5.2 provides a way to introduce concentration into those parts of the network that were originally built with V5.1. The conversion allows you to upgrade your network and continue to connect to V5.1, for example, in business premises. Conversion from V5.1 to V5.2 is implemented with the TR2M4 unit, which supports up to 4 x 2 Mbit/s V5.1 tributary interfaces.

![Conversion of V5.1 interfaces to V5.2 interfaces](image)

**Figure 5** Conversion of V5.1 interfaces to V5.2 interfaces

In larger V5.2 interfaces, it is possible to use higher concentration ratios, thus making the application more cost-effective.
This multiple V5.1 to V5.2 concentration is general in nature. Hence, it can also be applied to the concentration of V5.1 interfaces from other types of access multiplexers such as Nokia ACM2. Local PSTN and ISDN interfaces are also supported under the same (or a second, if required) V5.2 interface. Eksos N20 also supports efficient and flexible capacity grooming.

3.5 Leased line applications

In addition to on-demand connections and semipermanent POTS/ISDN leased lines under V5.2, Eksos N20 provides flexible leased-line functionality and cross-connection capability.

Although the data applications are shown in Figure 6 separately, both leased line data and V5.x functionality can be combined in the same node.

Eksos N20 supports LL connections via two-wire PSTN interfaces, ISDN interfaces, fractionally used G.703/G.704 2 Mbit/s interfaces, local data interfaces via the Data Interface Units (DIU) and remote data interfaces. The last mentioned can be established via stand alone modems, DNT128 using IDSL (practically an ISDN U-interface (2B + D)), DNT2M through HDSL equipment ACL2 and ACL4, and DNT2M-G (for in-house use with TR2M4). Also, support for remote

Figure 6    Fixed data network for providing leased line data services
access MUX (Nokia ACM2) is offered through the 2M tributary interface combining V5.1 and LL services under the same 2M links.

Eksos N20 has a general-purpose 64 kbit/s cross-connect function. This allows effective grooming of data into the minimum number of 2 Mbit/s aggregate links towards the leased line network. Also local cross-connections between the tributary interfaces of Eksos are supported. Eksos N20 can behave as a basic non-blocking 68 x 2 Mbit/s cross-connect node with n x 64 kbit/s granularity.

Cross-connection functionality also supports carrying leased lines under V5 links if the V5.2 switch supports this.

**Support for multiple cross-connection configuration sets**

Eksos N20 supports two parallel configuration sets (banks) for the leased lines. Each bank is a complete set of leased lines. Only one bank is active at a time. Banks can be used for different profiles, for example, one bank for daytime and the other for night-time operations.

Banks can also be used for efficient defragmentation of 2 Mbit/s interfaces. The 2 Mbit/s interfaces of the provisioned leased lines may contain many small gaps with free time slots. If a customer requests a higher-capacity leased line, the necessary time slots may be available, but they may not be consecutive. The existing leased lines can now be copied to the inactive bank and edited to obtain a large block of free time slots. The new, edited leased line can then be provisioned in the inactive bank, and finally the banks are switched.

Bank switching causes the minimum possible disturbance to the ongoing traffic. Those leased lines that are identical in both banks are not affected at all. The leased lines with one of the endpoints different will encounter a short interruption lasting for a couple of seconds.

**Local LL interfaces**

For PSTN and ISDN-U interfaces, Eksos N20 supports semipermanent leased lines under the control of V5.2. Both types of interfaces can also be configured as permanent leased lines. For ISDN-U, the options for different connections include 1B, 2B and 2B+D. For the 1B leased line, partial provisioning is supported, allowing the B- and D-channel to be provisioned for on-demand use under V5.2. If both B-channels are used for leased lines, the D-channel can be used for packet applications under V5, provided that the LE supports this.
Data Interfaces are supported via Eksos Data Interface Units (DIU), which come in three variations:

- A DIU-VV unit has four V.x/X.21 interfaces. Each of these can be configured as EIA530A, V.24, V.35, V.36 or X.21 interface.
- A DIU-GG unit has four G.703 interfaces of 1x64 kbit/s each.
- A DIU-VG unit has two V.x/X.21 interfaces and two G.703 interfaces.

Using a DIU, it is possible to collect data users near an Eksos. The maximum distance depends on the data interface used. If data users are further away, then network terminals are the best way to collect them to an Eksos N20 node, see “Remote LL interfaces” below.

2 Mbit/s G.703 interfaces are available through NCU and TR2M4 units, which both have four 2 Mbit/s interfaces. Time slots (excluding TS0) can be freely allocated for leased lines, V5 applications or management channels.

**Remote LL interfaces**

Network terminals provide a highly functional, operationally efficient and cost-effective end-to-end access network solution. They can fulfil customers’ needs in various data access applications.

Eksos N20 supports three different types of network terminals. DNT128 is supported via Eksos ISDN-U IF units. DNT2M is connected to TR2M4 via ACL4 HDSL equipment and DNT2M-G directly.

- **DNT128** is Nokia’s stand-alone terminal providing a maximum of 2 x 64 kbit/s leased lines over the ISDN-U interface (IDSL).
  
  The supported data interfaces are V24/V.28, V.11/V.36, V.35, X.21/V.11, G.703/64 kbit/s, EIA-530-A, and 10Base-T (Router/Bridge). Rate adaptation for different bit rates is supported. For more information, refer to [DNT128 User Manual](#).

  With the DNT128 terminal, the D-channel can be used for Q1 management traffic from DNT128 to the Q1 management system (NMS10).

- **DNT2M** is a 2 Mbit/s stand-alone HDSL network terminal for n x 64 kbit/s (n = 1…31) transport over the subscriber loop using two twisted copper pairs. The supported data interfaces are V24/V.28, V.11/V.36, V.35, X.21/V.11, G.703/64 kbit/s, G.703/2M, G.704/2M, EIA-530-A, and 10Base-T (Router/Bridge).

- **DNT2M-G** is a 2 Mbit/s stand-alone G.703/G.704 network terminal, with HDB3 line coding, for n x 64 kbit/s (n = 1…31) transport over the subscriber loop using two twisted copper pairs. The supported data interfaces are V24/V.28, V.11/V.36, V.35, X.21/V.11, G.703/64 kbit/s, G.703/2M, G.704/2M, EIA-530-A, and 10Base-T (Router/Bridge).

- **ACL4** is a line terminal for E1 transport over twisted copper pairs. It provides two separate user data interfaces and an ETSI-compliant framing structure. The total capacity is 2 x 2 Mbit/s. The user data is conveyed either transparently or in a G.704/2M frame structure. For further information, please see [ACL4 Line Terminal User Manual](#).
Network topologies utilising a remote access multiplexer under Eksos N20 are supported via NCU/TR2M4 2M interfaces. In addition to V5.1 connection delivered through TR2M4, the leased line time slots can also be configured under tributary 2M interfaces and further terminated at the local interfaces of the remote multiplexer.

### 3.6 Remote service switching

Remote service switching provides operators with a fast, convenient and cost-effective way of upgrading subscriber services without immediate visit to the equipment site. The site visits can be planned and optimised independently, so that when normal maintenance visits are made to the site, subscriber lines that have been reconfigured using the service switch feature can be permanently reassigned to a suitable interface type, thus freeing the capacity for further remote service switches.

![Eksos N20 Diagram](image)

**Figure 7** Principle of service switch. POTS to ISDN upgrade as an example

There are several options for configuring and utilising the service switch functionality to give an optimum value for different site applications. For an optimum run-time flexibility, the actual configuration can even be done by reconfigurable wiring at the site distribution frame. For those cases where more static configurations are preferred, point-to-point cables can offer a compact and quick-to-build solution. For optimum life time performance and cost, it is important to consider the use and advantages of the service switch already when the installation procedures are being planned.
Subscribers may be upgraded, under network management control, as follows:

- PSTN to ISDN
- PSTN to ADSL
- ISDN to ADSL
- PSTN to combined ADSL + PSTN
- ISDN to combined ADSL + ISDN.

As there is a certain amount of flexibility in utilising and configuring the service switch service on the site, the management functionality of the node offers support for modelling the installed configuration into the node database. With this feature on place, the service switch and its status can be easily managed through the remote management system.

### 3.7 Fault tolerance

The reliability of Eksos N20 is increased by the use of a decentralised power supply system, in which all units are equipped with their own, unit level power supplies.

Configuration backup is provided by all Eksos N20 units, except PSTN units. Any unit, including the NCU, can be replaced without loss of configuration data.

The reliability of data transmission can be enhanced by installing two NCUs in Eksos N20, providing change-over equipment at the other end, or routing the signals through different routes or via SDH.

### 3.8 Line testing

Line testing reduces the cost of access network maintenance by enabling efficient remote fault tracking. Eksos N20 allows testing of copper lines to monitor the quality of the lines, detect and track faults, and predict the availability of the lines for the planned services.

Eksos N20 supports both on-demand and scheduled line testing. Scheduled line tests can be run on selected lines and interfaces. This feature allows discovery and correction of degraded performance before it becomes apparent to subscribers.

Line tests can be run without any external cabling using a Line Measurement Unit (LMU) in the subrack. LMU measures the subscriber lines, including the terminal equipment, that are routed through the PSTN or ISDN units. ISDN loopback and activation or deactivation tests can be done without any additional units.

Eksos N20 Node Manager is the primary tool used for configuring tests and for collecting, storing and analysing the test results. Nokia NMS provides a centralised line test management interface for the Eksos N20 access network and can be integrated in the operator’s own line test management system.
Test control and result management

Eksos N20 offers two alternative methods for activating the test functions.

**On-demand activation** is intended for applications where activation of the test is always directly initiated by external resources, such as service personnel or a line test management system.

**Scheduled activation** utilises an in-built timing function in Eksos N20. This allows test timing to be defined independently of the running of the test. This feature is specifically useful for proactive measurements run periodically during night time. The idea of proactive measurements is to find out beforehand about possible problems on the subscriber lines.

Depending on the type of the test, the results read from the node are either Pass/Fail type indications or more complex arrays of numerical values.

To simplify the management of the measurement results, configurable thresholds can be set for measurements producing numeric values. Typically, Min/Max definitions are allowed. When users upload the results, they are offered an option of filtering out those results that do not exceed the set limits (option Get failed). It is also possible to upload all results (option Get all).

Eksos N20 allows several independent tests, including various schedules, measurements and threshold sets that can be configured simultaneously for different sets of interfaces. This allows for enhanced monitoring of different types of interfaces.

Tests can be run using Reject test, Wait if busy or Cut call criteria. The first two of these do not allow ongoing calls to be interrupted. If the Reject test criterion is used, the test attempt is cancelled for the active interfaces. If the Wait if busy criterion is used, the test in case is activated if the interface is released within a configurable wait time. The Cut call criterion allows activation of the test even if there was an ongoing phone call on the line. In this case, the measurement results
can differ from normal results, since the subscriber line is active at least in the beginning of the measurement period. For PSTN lines, call attempts originating during the test can be detected.

**Test-out (subscriber cable measurements)**

Test-out tests include measurement of the basic cable parameters of PSTN and ISDN subscriber lines. The results are numerical values. These values can be further processed on the node, based on user-configurable thresholds.

<table>
<thead>
<tr>
<th>Test type</th>
<th>Result format</th>
<th>Criteria, thresholds</th>
<th>Activation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic test-out (electrical tests), including measurements for the following subtests:</td>
<td>Pass, Fail. Subtests: Value &amp; status</td>
<td>All subtests’ status OK. Subtests configurable: Low, High</td>
<td>On-demand/ scheduled</td>
</tr>
<tr>
<td>– $A_{RMS}$ voltage (a–gnd, b–gnd, and a–b)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>– DC voltage (a–gnd, b–gnd, and a–b)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>– Capacitance (a–gnd, b–gnd, and a–b)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>– Leakage resistance (a–gnd, b–gnd, a–b, a–b, a–batt, and b–batt)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loop resistance measurement $R_{a-b}$</td>
<td>Value &amp; status</td>
<td>Configurable Low, High</td>
<td>On-demand/ scheduled</td>
</tr>
</tbody>
</table>

**Table 1**

Supported test-out measurements

The overall status of the test is reported as **OK, Overvoltage, Access-Fail, or Off-hook**.

An overvoltage check is run before each measurement is started. If the detected foreign voltages are higher than the protection limit in the LMU, the test session is terminated and no other tests are run.

The measurement-specific status can be **OK** or **Not meas**. Some of the measurements may report **Not meas** to indicate a value that cannot be measured because of non-linear parameters or excessive external voltages.

**Test-in**

Test-in tests include measurements to verify and diagnose the equipment, or even the network, in the aggregate direction. As these tests verify the functioning of the equipment itself, it is possible to make decisions according to measurement results based on pre-defined parameters. Thus, these measurements typically deliver **Pass/Fail** results instead of numerical values.
PSTN Test-in tests | Result format | Criteria, thresholds | Activation
---|---|---|---
PSTN interface diagnostic test, including the following subtests: - Feeding voltage test - Feeding current test - Loop detection test - Ring trip detection test - Ringing current test - Private meter pulse test - CODEC test | Pass, Fail. Subtests: OK/NOK | All subtests OK. Subtests: fixed value | On-demand/scheduled
Dial tone test | Pass, Fail | Dial tone detected | On-demand/scheduled

Table 2 Supported PSTN test-in measurements

PSTN diagnostic test uses the in-built circuitry to stimulate and verify the condition of signalling and voice handling of the interface.

The dial tone test is run by activating a test loop on a PSTN interface (simulating an originating call), which activates the call establish procedure towards the LE.

**Functional ISDN tests**

Eksos N20 offers several mechanisms to support functional ISDN fault tracking.

Faults can be located by running ISDN loopback tests. The loopback tests can separately check the condition of the interface and the line. A timer can be set to deactivate the loop after a certain period. The following tests, specified in ETS 300 012, are available:

<table>
<thead>
<tr>
<th>ISDN loopback tests</th>
<th>Result format</th>
<th>Criteria, thresholds</th>
<th>Activation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop1 (in line termination (LT))</td>
<td>Pass/Fail</td>
<td>1)</td>
<td>On-demand</td>
</tr>
<tr>
<td>Loop1A (in repeater (REG))</td>
<td>Pass/Fail</td>
<td>1)</td>
<td>On-demand</td>
</tr>
<tr>
<td>Loop1A (in regenerator (REG))</td>
<td>Pass/Fail</td>
<td>1)</td>
<td>On-demand</td>
</tr>
<tr>
<td>Loop2 (in NT1)</td>
<td>Pass/Fail</td>
<td>1)</td>
<td>On-demand</td>
</tr>
</tbody>
</table>

1) A selectable test pattern can be inserted and compared with the signal received through the loop. The criteria for comparing the received data is stated in Node Manager as **Percentage of error seconds**. There is a fixed threshold that will define the result of loopback test as **Fail** if more than 5% of the seconds during the loopback activation time are erroneous.

Table 3 Supported ISDN loopback tests
With Loop2, it is possible to loop either the B1 or B2 channel separately or both at a same time. For Loop1/1A, only the B1B2 loop is available.

Further analysis can be done by means of ISDN remote tests, which have been designed basically for the same purpose as the ISDN loopback tests. They can be used for more detailed troubleshooting purposes by an experienced technician.

<table>
<thead>
<tr>
<th>ISDN Remote tests</th>
<th>Result format</th>
<th>Criteria, thresholds</th>
<th>Activation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partial activation test</td>
<td>Pass/Fail</td>
<td>NT confirmation</td>
<td>On-demand</td>
</tr>
<tr>
<td>Full activation test</td>
<td>Pass/Fail</td>
<td>NT confirmation</td>
<td>On-demand</td>
</tr>
<tr>
<td>Node sends corrupt CRC to NT1 *)</td>
<td>Pass/Fail</td>
<td>FarEndBlockError alarm</td>
<td>On-demand</td>
</tr>
<tr>
<td>NT1 sends corrupt CRC to node *)</td>
<td>Pass/Fail</td>
<td>NearEndBlockError alarm</td>
<td>On-demand</td>
</tr>
<tr>
<td>Hold NT1 state *)</td>
<td>Pass/Fail</td>
<td>NT confirmation</td>
<td>On-demand</td>
</tr>
<tr>
<td>Node sends pulse mask to NT1</td>
<td>Pass/Fail</td>
<td>NA</td>
<td>On-demand</td>
</tr>
</tbody>
</table>

*) only with ISDNQ

Table 4

Supported ISDN remote tests
Full activation test

Full activation test activates the ISDN interface from the node up to the terminal equipment. This test passes only if there is a running TE connected to the S-interface of the NT and the U-interface between the NT and LT is working correctly.

Partial activation test

Partial activation test activates the ISDN interface up to the NT. This test passes if the U-interface between the NT and LT is working correctly. By running both tests, it is possible to check if the problem under investigation is located somewhere in the terminal equipment.

Node sends corrupted CRC to NT

The ISDN interface (LT) starts to send corrupted CRC, which will be detected by the NT. As a result, the NT will set the FEBE (FarEndBlockError) bit active in the U-interface. For detecting the FEBE alarm, the performance monitoring function must be switched ON.

NT1 sends corrupted CRC to LT

The ISDN interface (LT) requests the NT to send corrupted CRC to upstream direction. The LT will set the NEBC (NearEndBlockCounter) active. For detecting the NEBC alarm, the performance monitoring function must be switched ON.

Hold NT state

The EOC processor of the NT can be set into HOLD state when running this test.

Node sends signal pulse mask to NT

The ISDN interface will send single pulses to the U-interface. The pulses are issued at 1.5 ms intervals and with the duration of 12.5 μs.

Figure 10 Remote tests available in Eksos N20 ISDN unit
Other services

External Test Access can be utilised to access the cable pairs through the external test access interface of the LMU unit. This access point can be used as a connection point for external instruments used by the service staff or as an inter-system connection point for an external measurement head.

Dry loop can be activated for a selected channel to disconnect the PSTN and ISDN speech and signalling circuitry from the line if the service operation requires this.

Cable pair identification tone can be sent to a selected channel.

3.9 Hot insert

Eksos N20 supports a hot insert feature. Owing to this feature, Eksos N20 is able to detect and, after configuration, use hardware that has been added to Eksos N20 while it is actively running.

3.10 External alarms

At any one time, up to fourteen external alarms can be defined. The severity and alarm text for each input and output are user-defined. After the alarms have been defined, they will be shown in the alarm lists.

The NCU and LMU each have the following External Alarm inputs:

- 3 x Digital Inputs (PAIx)
- 2 x Digital inputs/Outputs (PAIOx)
- 2 x Analog Inputs (IAVx).

Consequently, if a node contains one NCU and one LMU, it will contain:

- 6 x Digital Inputs (PAIx)
- 4 x Digital inputs/Outputs (PAIOx)
- 4 x Analog Inputs (IAVx).
Chapter 4
Application planning

Eksos N20 can be used for a variety of purposes. The following describes the typical node applications.

The Eksos N20 node connects basic PSTN/ISDN users to the local exchange (LE) through the ETSI standard V5.2 interface, as shown in Figure 11. Conversion from V5.1 to V5.2 interface is supported, and this provides an effective growth path, via V5.2 interfaces, to those parts of the network that were originally built with V5.1.

Eksos N20 supports also data users. A multiple non-blocking 64 kbit/s cross-connection service is provided within the node, and various interfaces can be added to provide data services. Different traffic types can be combined, split or groomed as required.

The aggregate interface to the network can be either a standard 2 Mbit/s interface or STM-1.

Figure 11  Typical application of Eksos N20 system
4.1 Requirements for all applications

For all node applications, you will need at least the following:

- a minimum of one NCU unit
  - in slot one if Eksos N20 subrack/cartridge is used
  - in slot three if Eksos N20/SAN subrack or cartridge is used
- node (NSAP) address to identify the node in the network
- node name and its location information
- information about synchronisation sources
- information about the time slots used for Q3 traffic
- local exchange (LE) information.

Each NCU provides four 2 Mbit/s links that can be associated with any V5.2 interface. One 2 Mbit/s link can carry up to 30 (or 31 if time slot 16 is not used for signalling) simultaneous phone calls.

In addition to the above, additional units and information is needed according to the application used. These requirements are listed in sections 4.2 to 4.6.

Restrictions

There can be up to four V5.2 interfaces in a subrack; each V5.2 interface requires at least one NCU.

4.2 V5.2 multiplexer

Requirements

The configuration of the V5.2 interface must be exactly the same in Eksos N20 and local exchange. In one subrack, there can be up to four V5.2 interfaces.

For a V5.2 multiplexer, you will need the following:

- plug-in units
  - a minimum of one NCU in slot one (Eksos N20 subrack/cartridge) or slot three (Eksos/SAN subrack or cartridge); one NCU is needed for each V5.2 interface
  - PSTN and ISDN units for subscriber interfaces; each PSTN unit has 32 interfaces, each ISDN unit has 16 interfaces
- configuration information about the V5.2 interfaces at the LE
  - interface ID and provisioning variant
  - IDs for the 2M links used to connect to the LE
  - time slots and IDs for the communication channels
  - time slots used to provide protection
  - L3 and EF addresses for user ports (= subscriber interfaces).

Each NCU provides four 2 Mbit/s links that can be associated with any V5.2 interface. One 2 Mbit/s link can carry up to 30 (or 31 if time slot 16 is not used for signalling) simultaneous phone calls.
**Example**

An example configuration is shown in Figure 12.

![Figure 12](image.png)

An Eksos N20 with one V5.2 interface serving 320 PSTN and 80 ISDN subscribers with concentration of 1:3 needs:

- 2 NCUs: \(\frac{(320+80)}{3} = 134\) time slots are needed to carry traffic; consequently, 5 links are needed.
- 10 PSTN units
- 5 ISDN units

**Figure 12**  
Example configuration for a V5.2 multiplexer

In the example of Figure 12, you could also slightly increase the concentration so that only four links (that is, one NCU) were needed. This would leave room for another subscriber unit in the subrack. If you use two NCUs, the remaining three links can be used to provide leased lines or to reduce concentration (notice, however, that this requires more capacity on the LE, too). The remaining three links can also be used to build up a second V5.2 interface for multihosting purposes.
4.3 V5.1 to V5.2 converter

Requirements
The configuration at both ends of a V5 interface must always match. In the converter application, the configuration of the V5.2 interface must match the configuration information at the local exchange (LE) and the configuration of the V5.1 interfaces must match the configuration information in the V5.1 node.

For a V5.1/V5.2 converter, you will need the following:

- plug-in units
  - a minimum of one NCU in slot one (Eksos N20 subrack/cartridge) or slot three (Eksos/SAN subrack or cartridge)
  - a minimum of one TR2M4 unit to provide a V5.1 interface to the V5.1 node (one TR2M4 unit can connect to four V5.1 nodes)

- configuration information about the V5.2 interfaces at the local exchange (LE)
  - interface ID and provisioning variant
  - IDs for the 2M links used to connect to the LE
  - time slots and IDs for the communication channels
  - time slots used to provide protection
  - L3 and EF addresses for user ports (= subscriber interfaces)

- configuration information about the V5.1 multiplexers
  - physical 2 Mbit/s used for Eksos N20
  - time slots for the communication channels
  - time slots used for user ports and their addresses
  - information about possible leased lines on the V5.1 node.

4.4 Service switch

Requirements
For a service switch, you will need the following:

- plug-in units
  - a minimum of one NCU in slot one (Eksos N20 subrack/cartridge) or slot three (Eksos/SAN subrack or cartridge)
  - PSTN and/or ISDN units
  - to provide ADSL services, broadband equipment should be available.

- application specific installation and cabling
  - the service switch cabling must be in place

- configuration information
  - configuration information of the V5.2 user ports and their addresses
  - information about the service switch cabling. It is often logistically efficient to standardise the configurations for sets of node types.
  - cabling information about other equipment, such as broadband equipment.
Phases

Switching a service is done in three phases:

1. Preparing the service switch cabling. This phase is the most efficient when the service switch is taken into account in the initial installation. The cabling information is also configured in the node.

2. Switching services for one or more subscriber lines. This is done when a customer requests upgrading to ISDN or ADSL. Switching is done remotely, without visiting the site.

3. Changing the temporary service switches into permanent ones and releasing the resources for new remote service switches. This should be done during the first site visit after the service upgrade.

Restrictions

When configuring the service switch, take into consideration the following restrictions:

- one service switch connection per plug-in unit
- each plug-in unit can access one out of two accessible bus lines
- up to eight service switch connections for PSTN units per subrack
- up to eight service switch connections for ISDN units per subrack
- service switch connections are not activated during ongoing line tests
- line tests have higher priority than service switch connections if the Super Cut Call option is used in line testing.

4.5 Leased line applications

Requirements

For leased line applications, you will need the following:

- mandatory plug-in units
  - a minimum of one NCU in slot one (Eksos N20 subrack/cartridge) or slot three (Eksos/SAN subrack or cartridge)

- optional plug-in units
  - depending on the leased line utilised, either PSTN, ISDN, Data or TR2M4 units
  - ISDN unit in IDSL mode for remote application via DNT128
  - in case of remote application, you may use Nokia HDSL line cards to provide the high speed connection over subscriber cable pairs. ACL4 can be installed in the Eksos subrack, whereas ACL2 needs its own mechanics. At the remote end, you have the choice of Nokia stand-alone terminals and plug-in ACL4/ACL2 line terminals, for example, in the case of a remote access multiplexer.

- configuration information about the leased lines
  - configuration information about the interfaces and time slots that will be used for leased lines
configuration information about other equipment
configuration information of the data terminals.

Special care must be taken to ensure that the configuration of leased line data interface parameters, bit allocations to time slots and possible bit masks are the same at both ends of the leased line connection.

Restrictions
A full ISDN leased line reserves three time slots: two for B-channels, each 1 x 64 kbit/s, and one for D-channel, 1 x 16 kbit/s. Although the D-channel has a bit rate of 16 kbit/s, it is cross-connected at the 64 kbit/s level.

In case of n x 64k / n > 1 connections, all time slots used for a single leased line must be consecutive ones. For example, a single leased line can use time slots 11, 12 and 13, but not 11, 12 and 14.

4.6 Scheduled line testing applications

Requirements
For an application for scheduled line testing, you will need the following:

- plug-in units
  - a minimum of one NCU
    in slot one (Eksos N20 subrack or cartridge) or
    slot three (Eksos N20/SAN subrack or cartridge)
  - an LMU
  - PSTN or ISDN units
- information about tests
  - how often and when are the tests run
  - list of tests to be run
  - list of interfaces on which the test will be run.

Restrictions
The lines to be tested must be in V5 use. The configuration at both ends of a V5 interface must always match. The configuration of the V5.2 interfaces must match the configuration information at the local exchange (LE) and the configuration of the V5.1 interfaces must match the configuration information in the V5.1 node.

Up to ten scheduled tests can be specified.

One LMU is needed for each Eksos N20 subrack.

Although the POTS diagnostic test has a good coverage, it cannot guarantee full functionality.
Chapter 5
Management

Eksos N20 is supported by a suite of management tools, which can be used either separately or as an integrated system.

Eksos N20 has an ITU-T specified interface (Q3) for Nokia Network Management System (NMS) and Eksos N20 Node Manager. The nodes are interconnected using a time slot x in the E1 or direct network management (Q3 Ethernet) connections. Local and remote access are supported simultaneously.

![Diagram of management for Access Network](image-url)

Figure 13  Management for Access Network

Software upgrades can be done by downloading new software versions to the node via the network management interface. This can be done locally or remotely.

Eksos N20 provides features to implement the Q1 DCN (Data Communication Network) to manage Q1-managed equipment in the network.
Eksos N20 also acts as Q1 router and supports the building of the Q1 DCN for Q1-managed equipment. Due to this, the management information from, for example, DNT128, DNT2M or ACM2, can be brought via the Eksos N20 node to the Q1 management system.

5.1 Eksos N20 Node Manager

Eksos N20 Node Manager provides control over all the configuration and operation details of a single Eksos N20 network element, including download and activation of software upgrades. Node Manager is a Windows NT application program which runs on a standard PC.

Node Manager is used for the following functions:

- bringing units into use, and providing each unit and individual channel with the appropriate settings required for the application
- obtaining status information from an Eksos N20 node, including information about any alarms which have been generated on the node
- reconfiguring an Eksos N20 node to modify its role in the network
- subscriber line testing and fault reporting, provided that an LMU is included in the configuration.

Node Manager manages a node interactively. When Node Manager is managing a node, it can request various data from the node about its current state. For example, Node Manager can request from the node a list of its current alarms or a list of its cross-connections.

Eksos N20 Node Manager incorporates an optional security feature. The system administrator can allocate each user to an access level which determines what changes, if any, that particular user can make to the node.

5.2 Nokia NMS


Management of Eksos N20 with Nokia NMS/10

NMS/10 is an element-level management system, which can be used either for small transmission networks or as part of the management solution for larger networks.

Nokia NMS/10 supports management of Eksos N20 from Nokia NMS/10 release C5.1 onwards.

The NMS/10 System Release consists of a core program, the System Frame, and separate agents, mediators and node managers. Agents collect alarms and performance data from various network elements. For Eksos N20 management, Q3 Agent C2.0 component is used.
NMS/10 System Frame provides a network-level user interface and database system management. NMS/10 System Frame runs on top of Hewlett Packard’s OpenView Network Node Manager for Windows NT product. HP OpenView NNM has been extended by Nokia to provide a generic user interface for networks consisting of Nokia’s network elements.

Q3 Agent C2.0 is a software program that collects alarms and performance data from Eksos N20 nodes on the network. Alarm information is stored in the “run-time” memory of the computer on which the Q3 Agent is running, and the destination management systems are notified via SNMP. Performance data is saved to disk files on the Q3 Agent computer and it can be separately retrieved via FTP.

Eksos N20 Node Manager is used to configure the nodes. Node Manager is an independent program. The System Frame integrates Eksos N20 (and other) node managers by making them available for launch. This can be done by, for example, double-clicking a node symbol on a submap.

### 5.3 Eksos N20 Network Management Products

Nokia NMS can be complemented with optional management applications that support Eksos N20 management. These products facilitate the maintenance of the access network and certain service management functions. The products utilise the V5 fragment of Nokia NMS database, which is also accessible to the operator’s system. The following functionalities are available:

- Remote software download of Eksos N20
- Backup of entire node configuration (automatic)
- Backup of V5 data in the database (automatic)
- Database reports
- Remote service upgrade
- V5.1 tributary management
- Line test management.
  - A Line Test Manager is available for customisation with the operator’s information systems. The connection to the operator’s database describing relations of directory numbers, V5 attributes and physical interfaces must be tailored at each system deployment, as there are no standard solutions available.

For further information of these products, refer to *Eksos N20 Network Management Products NMS Tools Product Overview*. 
5.4 OSI-DCN Adaptor

OSI-DCN Adaptor is used for building the management DCN network between Eksos N20 sites and the central network management site.

OSI-DCN Adaptor is connected, via an Ethernet interface, between the Nokia NMS network to the local exchange (LE) or a digital cross-connect system which is in front of the local exchange. The 2 Mbit/s interface of the OSI-DCN Adaptor can provide up to 30 x 64 kbit/s Q3-connections to Eksos N20 nodes. Each OSI-DCN Adaptor has one 2 Mbit/s interface and one active Ethernet interface.

![Diagram of DCN network](image_url)

**Figure 14** Example of a DCN network for Eksos N20 node management

OSI-DCN Adaptor is a unit that fits into the same mechanics as Eksos N20. It can be installed into the same subrack as Eksos N20, or into a separate subrack.

For further information, refer to the *OSI-DCN Adaptor User Manual*. 
5.5 **Eksos Q3 DCN**

Q3 is a message-based management protocol. Q3 management can be conveyed in a payload 64 kbit/s time slot, using E1, or in the Ethernet connection.

Q3 time slots are cross-connected into E1s, which are connected to Nokia OSI-DCN adaptors. From an OSI-DCN adaptor, they are further connected to an OSI router through the Ethernet port.

At bigger sites, there can be direct access to a router network via the local LAN, using the Ethernet connection in Eksos.

The B-channels of the V5 E1 links cannot be used for management because most of the local switches do not support fractional E1 links, where some of the B-channels are outside the V5 E1. On the other hand, Q3 cannot be inside V5 E1, because without an existing V5 connection there is no management connection available.

![Diagram of Q3 DCN using cross-connection close to the local switch](image)

**Figure 15** Q3 DCN using cross-connection close to the local switch

If there are leased line connections configured in Eksos N20, the E1s of these leased lines are used to carry also the Q3 management time slots.

If no permanent leased lines are used, dedicated E1 links need to be reserved for DCN communication.

Leased lines are connected forward to the leased line network, and the Q3 management channel time slots are regrouped to a new E1, which is then
connected to the OSI-DCN adaptor. The OSI-DCN adaptor takes one E1 in and routes the Q3 management data via the Ethernet interface upwards for the OSI routers.

All Eksos nodes within one rack can be connected together using local Ethernet management interfaces. From one of the nodes there has to be one or two Q3 channels upwards, the actual number depending on whether DCN connection protection is used.

If a Nokia DX200 local switch is used, Q3 management channels can be routed in V5 E1 links but outside V5. DX200 supports both fractional V5 and semipermanent connections. Up to 30 Q3 management channels can be connected through the switch to an E1, which is connected to an OSI-DCN adaptor.

Eksos has the OSI stack, which is why OSI routers have to be used for routing.

An OSI-DCN adaptor can support about 100 elements in a level 1 area. There can be two level 1 areas per router. Normally, 100 routers can be connected together in a WAN, thereby providing support for 20000 network elements.

Q3 management channels generate a very small load into a router network. For 100 to 200 elements, the load is typically a few kbit/s. The maximum value is about ten times higher, that is, a few dozen kbit/s.
Chapter 6
Construction and power supply

This chapter briefly describes the interface types, node architecture, installation options and power supply options which are available for Eksos N20. It also describes the thermal management principles for the various installation options.

6.1 Interface types

Eksos N20 nodes are composed of the following types of interfaces:

- PSTN interface
- ISDN Basic Rate Access (BRA) U-interface (2B1Q and 4B3T)
- 2 Mbit/s interface (4 x 2M)
- Data Interface Unit (DIU) interfaces
- STM-1 interface.
6.2 Node architecture

Tributary and aggregate interface units are connected to a common high-speed bus. The main hardware unit, the Node Control Unit (NCU), provides the required core functionality, V5 control functions, node synchronisation, Q3 interface, auxiliary data channel and four 2 Mbit/s aggregate interfaces.

The Line Measurement Unit (LMU) supports on-demand and scheduled line testing.

Various tributary interface units are supported, including PSTN, ISDN BRA U and data (high and low speed); 2 Mbit/s and various other interface types such as STM-1 ADM or TM functionality are also supported.

![Node architecture diagram]

**Figure 16** Node architecture; the basic components of an Eksos N20 node
6.3 Installation options

Eksos N20 units can be installed alternatively in Eksos N20 8-slot cartridges, Eksos N20/SAN 8-slot cartridges, Eksos N20 17-slot subracks or Eksos N20/SAN 17-slot subracks. The cartridges and subracks, in turn, can be mounted into:

- 19” rack according to IEC 297-1 and IEC 297-2
- 600 mm wide rack according to IEC 917, IEC 917-2 and IEC 917-2-1
- 600 mm wide rack according to ETS 300 119-2.

In addition, the 17-slot subracks can be mounted:

- into Nokia Indoor or Outdoor Access Cabinets
- on a wall using the Wall Mounting Set or Nokia Indoor Site.

Nokia Indoor Access Cabinets are intended to be located in basements, corridors, attics or other customer premises. Nokia Outdoor Access Cabinets are compact and reliable solutions for outdoor installations and can also be used in tropical environments.

The wall mounting option is useful when space is limited or when Eksos N20 is installed, for example, in an office.

---

Figure 17  Eksos N20 node showing the 17-slot subrack and main connectors
6.4 Power supply options

Eksos N20 uses a decentralised power supply system, in which all units are equipped with their own, unit-level power supplies. All units require a 48 V (nominal) supply voltage, distributed to the units through the extension board and the subrack motherboard. This voltage can be supplied direct from the central battery through the DC-PSA.

The power supply options are:

- the DC Power Supply Adapter (DC-PSA): nine outputs; auxiliary voltage, station alarms and storage capacitors
- the DC-PSA plus the Extension Unit: 13 outputs; auxiliary voltage, station alarms and storage capacitors.

One DC-PSA can feed three subracks per rack, whereas the combination of DC-PSA plus Extension Unit can feed four subracks per rack.

RFI/EMI-filtering is provided by means of an extension board, which is fitted to each subrack. The extension board also transfers power to, and station alarms from, the subrack.

A Fan Unit and Capacitor Unit are available as optional accessories.

6.5 Thermal management principles

The temperature of air leaving the installation should always be less than +70 °C.

The thermal behaviour of the node in a subrack is dependent on the particular configuration, the location of the subrack in the installation and the ambient temperature. Every installation type should therefore be examined separately.

Special attention must be paid to the routing of cables so that they do not obstruct the airflow through the installation. Cable routing should be carefully planned and large cable bundles should be avoided in the airflow path.

In nodes with high numbers of PSTN subscribers, the actual traffic density defines the thermal load generated by the system. In more extreme cases, load sharing between several interface units can help to lower the maximum power dissipated by each unit, and hence, lower the peak thermal load.

Note
For detailed information about units’ heat dissipation values, see the country-specific document in this manual.
6.5.1 General principles

For the purpose of thermal planning, the system can normally be considered as a “black box” which is defined by certain parameters as shown in Figure 18.

![Thermal model diagram]

Figure 18 Thermal model

The speed of airflow through each installation is dependent on many factors, including the cabinet structure and, where fitted, the size and speed of fans. Therefore, we recommend that installations which differ from the examples given here are verified with temperature measurements. These measurements should include inlet and outlet air temperatures under both normal and worst case operating conditions.

To achieve reliable operating conditions, the following parameters must be managed:

- the temperature of the air flowing into the system
- the speed of the airflow through the system.

In addition to these parameters, when a system is installed above other systems, the incoming air temperature is affected by the distance between the systems and the effect of air mixing. See Figure 19.
Figure 19   Effect of space between subracks

The distance between the systems contributes significantly to air mixing. The larger the distance is, the more effectively the surrounding cool air can mix with air flowing from the lower subrack to the upper one.

If the subracks are very close to each other, the temperature rise within each subrack will accumulate upwards as shown in Figure 20. When several subracks are installed above each other, ensure that the speed of airflow is increased accordingly.

Figure 20   Cumulative temperature increase
Two types of cooling methods can be used: natural convection or forced convection.

The operation of natural convection systems is based on the physical phenomenon of warmer air having a smaller density than colder air. The restrictions in the use of this cooling method are related to the physical properties of air. In practice, natural convection cooling can induce air velocities of 0.1 – 0.2 m/s through a well-ventilated system. See Figure 21.

Forced convection is based on using some external agency to maintain the airflow. By utilizing Fan Units in the installation, the airflow through the system can be increased and enhance the cooling efficiency of the installation. See Figure 22. Forced convection should always be used if broadband units are likely to be installed in the node.
6.5.2 Guide-lines for open rack installations

For installation dimensions and further details, see the Installation document.

Natural convection cooling

The natural convection cooling system should be constructed using 19”/ETSI 4U Air Deflectors and 1U Cable Trays as shown in Figure 21.

The heat dissipation in a natural convection system should not exceed 250 W per subrack (17 slots) and 15 W per plug-in unit. (See the Specific Instructions for XX in this manual for detailed heat dissipation values.)

Figure 21  Natural convection cooling system

If wanted, the cooling system can be enhanced by installing fan units in the rack.
Forced convection cooling

The forced convection cooling system should be constructed using 19”/ETSI 1U Air Deflectors, 19”/ETSI Fan Units, and 1U Cable Trays as shown in Figure 22.

The heat dissipation in a forced convection system should not exceed 450 W per subrack (17-slot) and 25 W per plug-in unit. (See the Specific Instructions for XX in this manual for detailed heat dissipation values.)

Caution

Forced convection should always be used if broadband units are likely to be installed into the node.

Figure 22  Forced convection cooling system
6.5.3 **Guide-lines for cabinet installations**

The cabinet must be capable of handling the total thermal load. The total thermal load is affected by the following factors:

- thermal load of the system being considered
- thermal load of all other systems installed in the same cabinet
- thermal load of the systems to be installed into the cabinet in the future
- external thermal load, such as direct sunshine.

If the cabinet is placed in a dirty environment, ensure that the closing degree (Ingress Protection rating) of the cabinet is appropriate.

---

**Caution**

Do not obstruct the airflow through the “air channels” of the cabinet.

---

**Indoor cabinet installations**

The airflow through the system depends on the overall cabinet design. In general, the integration density and, consequently, the cost efficiency of the site can be greatly enhanced by using Fan Units together with a well-designed cabinet.

The air temperature of the subrack in an indoor cabinet installation is mainly defined by the following factors:

- total power dissipated inside the cabinet
- thermal efficiency of the cabinet
- airflow arrangements inside the cabinet.

**Outdoor cabinet installations**

The cabinet must be able to handle the total thermal load. The use of a heat exchanger or other method of efficient circulation of external air is recommended for all installations.

The air temperature of the subrack in outdoor cabinet installations is mainly defined by the following factors:

- solar radiation (leading to a significant temperature rise inside the cabinet)
- total power dissipated inside the cabinet
- thermal efficiency of the cabinet
- airflow arrangements inside the cabinet.
Chapter 7
Eksos N20 products

This chapter briefly describes the plug-in units, mechanics, power supplies and software products which are available for Eksos N20. For information about such general mechanics as racks and cabinets, see their own separate instructions.

7.1 Common units

7.1.1 Node Control Unit

The Node Control Unit (NCU) contains a CPU environment for all of the common control functions inside the Eksos N20 node. The NCU contains the core functionalities such as the V5 control functions and node synchronisation. This unit also has a Q3 interface for network management and 4 x 2 Mbit/s interfaces for aggregate use. At least one NCU is always required in each Eksos N20 node.

Each Eksos N20 node can support up to four V5.2 interfaces and there must be at least one NCU per each V5.2 interface.

The NCU supports the following interfaces:

- 4 x 2 Mbit/s interface, 120 Ω or 75 Ω
- synchronising input 120 Ω or 75 Ω
- Q3 interface, 10Base-T and 10Base2
- digital and analog inputs and digital outputs for external alarms.

The NCU supports the following features:

- V5.2 interfaces
- multihosting
- leased line services
- adding NCUs to increase aggregate capacity
- external interfaces to network management (Q1/Q3)
- auxiliary data channel interfaces.
7.1.2 Line Measurement Unit

The optional Line Measurement Unit (LMU) makes it possible to test the condition of copper access lines remotely. It operates in conjunction with the test access relays in the interface units. Also, additional alarm inputs and outputs are available through the LMU.

The LMU supports the following features:

- scheduled tests
- line tests for PSTN and ISDN
- high-accuracy measurement of line parameters such as capacitance, foreign voltage and leakage resistance
- external test access (for testing the lines using external test equipment)
- cable-pair identification-tone test for all line types
- dry loop test
- external alarm inputs (digital and analog) and outputs (digital).

7.2 Interface units

7.2.1 STM-1 CORE2M unit

The STM-1 aggregate can be provided using the SAN CORE2M interface module. This SDH module has 8 x 2 Mbit/s capacity for site connections and it is available with either add/drop or terminal multiplexer functionality.

The STM-1 CORE2M unit supports the following interfaces:

- 8 x 2 Mbit/s interface, 120 Ω or 75 Ω
- synchronising inputs and outputs, 120 Ω (or 75 Ω when using an adapter)
- Q3 interfaces, 10Base2
- one (TM) or two (ADM) STM-1 interfaces for short or long haul applications. Optical connector options available.

7.2.2 PSTN interface unit (32-channel)

The standard PSTN unit provides 2-wire analog interfaces for telephone subscribers. Its flexible architecture supports different national mappings and user port requirements.

Each interface is provided with test access relays, which allow subscriber line tests to be run with a test unit integrated into the Eksos N20 subrack or with an external test unit.

The PSTN interface units support the following features:

- 32 x 2-wire subscriber interfaces
- integrated test access
- switching facilities for upgrading subscriber lines to future services
- low power consumption in standby state (power down mode).
7.2.3 ISDN BRA U-interface unit

There are two variant of ISDN Basic Rate Access (BRA) U-interface units, one supports 2B1Q and the other one supports 4B3T line coding. The U-interface operates in line termination (LT) mode. The interfaces are provided with line test relays enabling the connection of the lines to the test bus for testing the subscriber loop condition.

Power feeding from the ISDN unit to the NT, NTa or repeaters may be adjusted within the limits of the total power which may be fed to the line from the unit. Power consumption is continuously monitored to ensure that operation is within safe limits.

The ISDN BRA U-interface units support the following features:

- 16 x 2-wire U-interfaces (2B1Q or 4B3T)
- IDSL interfaces (2B1Q) to DNT128 including Q1 management
- configuration back-up for the NCU
- integrated test access
- switching facilities for upgrading subscriber lines to future services
- intelligent power feeding control for each channel.

7.2.4 Data Interface Unit

There are three different Data Interface Units (DIU) which can be installed into the Eksos N20 node.

- Data Interface Unit with 4 x V.xx/X.21 n x 64 kbit/s interfaces
- Data Interface Unit with 4 x G.703 64 kbit/s interfaces
- Data Interface Unit with 2 x V.xx/X.21 interfaces and 2 x G.703 interfaces.

Data interface units are used for leased line networks. Synchronous bit rates at n x 64 kbit/s (up to 1.984 Mbit/s) and asynchronous slow speed data (v64 kbit/s) are supported with various bit rates.
### IF Unit

<table>
<thead>
<tr>
<th>IF standard</th>
<th>Timing</th>
<th>Conversion/adaptation</th>
<th>Advanced settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>V.xx/X.21</td>
<td>Asynchr.</td>
<td>– Sampling</td>
<td>– V.54</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– R.111</td>
<td>– V.54</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Transparent</td>
<td>– V.14 (&gt;0.6 kbit/s), V.13, V.54</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– V.110</td>
<td>– V.14 (&gt;0.6 kbit/s), V.13</td>
</tr>
<tr>
<td>V.xx/X.21</td>
<td>Synchr. co- or</td>
<td>– Transparent</td>
<td>– V.13, V.54</td>
</tr>
<tr>
<td></td>
<td>contradirectional</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>– V.110</td>
<td>– V.13, V.54</td>
</tr>
<tr>
<td>V.xx/X.21</td>
<td>X.21</td>
<td>– Synchr. signal</td>
<td>– Transparent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>element</td>
<td>– V.13, X.150</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Synchr. octet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>element</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Synchr. external</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>– X.30</td>
<td>– V.13, X.150</td>
</tr>
<tr>
<td>G.703</td>
<td>G.703 (ETS 300 288/9)</td>
<td>Synchr. co- or</td>
<td>– Transparent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>contradirectional</td>
<td></td>
</tr>
</tbody>
</table>

### Table 5  
**DIU features**

In addition to features presented in Table 5, an extensive set of configuration options, such as various bit masks and control signal definitions, are supported. For more detailed information please refer to the *Commissioning and Maintenance* document.

### 7.2.5 TR2M4 unit

There are two different 4 x 2 Mbit/s interface units (TR2M4) which can be installed in the Eksos N20 node.

- TR2M4 unit 75 Ω asymmetric
- TR2M4 unit 120 Ω symmetric.

The TR2M4 unit connects four 2048 kbit/s signals to the Eksos N20 node. Each interface has a transmitter and receiver, which fulfils G.703/G.704 specifications and is terminated in the unit. The TR2M4 unit adapts to the Eksos N20 internal cross-connection bus; cross-connections are made at 64 kbit/s time slot level.

One or more of the 2M interfaces can be used as V5.1 tributary links. With the TR2M4 unit, the Eksos N20 node can convert incoming V5.1 signalling from the tributary side to V5.2 signalling that is used on the aggregate side towards the local exchange. With the TR2M4 unit, it is possible to connect, for example, ACM2 V5.1 nodes, to the Eksos N20 node.
7.3 Power supplies, subracks and accessories

7.3.1 DC-PSA

The DC-PSA (DC Power Supply Adapter) contains power input connectors, separation diodes, transient protection circuitry and circuit breakers for nine outputs. The DC-PSA is recommended for use in most installations. For further details, see the *DC-PSA Operating Instructions*.

The DC-PSA supports the following features:

- circuitry for station alarms, energy storage capacitors and an auxiliary +5 V feed for supervision of unit power supplies within subracks
- connectors for Extension Unit, Capacitor Unit and auxiliary outputs
- two auxiliary battery voltage outputs.

7.3.2 Extension Unit

The Extension Unit provides four additional output connectors for the DC-PSA. The Extension Unit is 1U high with cabling and is intended to be installed directly under the DC-PSA. For further details, see the *DC-PSA Operating Instructions*.

7.3.3 Capacitor Unit

The Capacitor Unit should be used when the maximum power requirement is more than 1000 W. Used in conjunction with the DC-PSA, it increases the holdup times during short battery voltage input failures. The unit features transient protection and a class B station alarm output via the DC-PSA for capacitor failure situations. The capacitor unit has also a LED that indicates these failures. For further details, see the *DC-PSA Operating Instructions*.

7.3.4 Eksos N20 17-slot subrack

The Eksos subrack has 17 slots and it can be installed into 19” and 600 mm wide racks. There are very few equipping restrictions associated with this subrack. An extension board on the top of the subrack allows all cabling to be performed from the front of the subrack. The extension board has connectors for battery voltage, signalling voltage, alarms, service switch, test bus, SV1 measurement, overvoltage protection and fans. A decorative front cover is available, through which it is possible to see the unit LEDs.
7.3.5 Eksos N20/SAN 17-slot subrack

The Eksos N20/SAN subrack is identical to the Eksos subrack, except that slots 1 and 2 are exclusively reserved for the installation of a SAN CORE2M unit.

7.3.6 Eksos N20 8-slot cartridge

The cartridge can be used for small Eksos N20 nodes, and it allows broadband units to be fitted alongside the cartridge in the same 19” equipping space. Alternatively, for upgrade purposes, two 8-slot cartridges may be fitted side by side. These combinations can share power feeding from the same DC-PSA.

The 8-slot cartridge can be installed on a mounting shelf in 19” and 600 mm wide racks. The extension board on top of the cartridge has connectors for battery voltage, signalling voltage, alarms, service switch, test bus, SV1 measurement, overvoltage protection and fans.

Figure 23 Dimensions (in millimetres) of the Eksos N20 17-slot subrack
7.3.7 Eksos N20/SAN 8-slot cartridge

The Eksos N20/SAN cartridge is identical to the Eksos N20 cartridge, except that slots 1 and 2 are exclusively reserved for the installation of a SAN CORE2M unit. Slot 3 is reserved for the installation of an NCU. There are no equipping restrictions for the remaining slots.

7.3.8 Fan Unit

The Fan Unit is designed to be used in installations which require forced cooling. For further details see the Fan Unit Operating Instructions. The Eksos N20 subrack has a combined power and alarm connector which connects to the fan unit.

7.3.9 Air deflectors

Air deflectors are available in 1U, 2U, 4U and 5U heights, with or without front grilles (the 1U version is only available without grille). The 1U and 2U versions are designed for use in installations where forced cooling is implemented, while 4U and 5U versions are intended for natural convection installations. The 1U and 4U versions are intended for use in installations with cable trays.
7.3.10 Cable trays

The use of cable trays improves the thermal management of the node installation and keeps cables tidy. Each node requires the use of two 1U cable trays, one above and one below the node. Cables are guided from the front of the node directly into the front of the cable trays where they are secured with strain reliefs. Cables are guided to the side of the node and into the rack’s cabling space.

7.3.11 Wall Mounting Set

The Wall Mounting Set is ideal for mounting 17-slot Eksos N20 nodes in small locations where space is a premium. In addition to the subrack, the Wall Mounting Set can also accommodate a DC-PSA, fan unit and cross-connection panel.

Figure 25   Eksos N20 can be installed using a Wall Mounting Set
7.4 Software products

7.4.1 Node software
The Eksos N20 node has release-specific software which provides the node functionality. The software can be upgraded to later releases. In addition, depending on their usage, units are provided with unit specific software.

7.4.2 Eksos N20 Node Manager
The Eksos N20 Node Manager is a Windows NT 4.0 application program and runs on a standard PC. This is the basic tool for installation and operation purposes. It is also used for controlling the line test functionality.

7.4.3 Software upgrade kits
The Eksos N20 node can be upgraded from an earlier system release to a later system release. Some new features introduced in a later system release are available with existing plug-in units and a functionality upgrade kit. The upgrade kit includes the required software and upgrade instructions for upgrading the Eksos N20 node to a later system release.
Chapter 8
Technical specifications

This chapter briefly describes the technical specifications of the Eksos N20 in the following order:

- interfaces
- line testing
- power consumption
- mechanical specifications
- environmental specifications
- Eksos N20 Node Manager system requirements
- international recommendations.

8.1 Interfaces

8.1.1 2 Mbit/s interfaces

<table>
<thead>
<tr>
<th>2 Mbit/s interfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2048 kbit/s</strong></td>
</tr>
<tr>
<td>Connector types</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
8.1.2 PSTN interface

<table>
<thead>
<tr>
<th>Analog 2-wire subscriber line interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Voice-frequency specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Based on recommendation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Basic PSTN signalling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscriber line feeding</td>
</tr>
<tr>
<td>Decadic dialling</td>
</tr>
<tr>
<td>Ringing signal and cadence</td>
</tr>
<tr>
<td>Ring trip detection</td>
</tr>
<tr>
<td>Current feed</td>
</tr>
<tr>
<td>Resistance feed</td>
</tr>
<tr>
<td>Polarity reversal</td>
</tr>
<tr>
<td>Metering</td>
</tr>
<tr>
<td>Calling Line Identification</td>
</tr>
<tr>
<td>Loop start</td>
</tr>
<tr>
<td>EMC compatibility</td>
</tr>
</tbody>
</table>

1) Provided that the PSTN mapping used supports these features.

8.1.3 ISDN BRA U-interfaces

<table>
<thead>
<tr>
<th>ISDN BRA U-interfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information transfer rate of 144 kbit/s, 2B+D</td>
</tr>
<tr>
<td>Line code</td>
</tr>
<tr>
<td>Connector</td>
</tr>
</tbody>
</table>
8.1.4 Data interfaces

<table>
<thead>
<tr>
<th>Data interfaces</th>
<th>n x 64 kbit/s ITU-T V.24/V.28, V.35, V.36, X.21/V.11, EIA-530-A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical</td>
<td>Asynchronous slow speed data ≤ 64 kbit/s:</td>
</tr>
<tr>
<td>V/X</td>
<td>– asynchronous to synchronous conversion using:</td>
</tr>
<tr>
<td></td>
<td>– V.14 asynch. rates up to 56 kbit/s</td>
</tr>
<tr>
<td></td>
<td>– sampling up to 4.8 kbit/s</td>
</tr>
<tr>
<td></td>
<td>– sampling and filtering up to 4.8 kbit/s</td>
</tr>
<tr>
<td></td>
<td>– transition coding up to 19.2 kbit/s</td>
</tr>
<tr>
<td></td>
<td>– adaptation function including V.110 and transparent</td>
</tr>
<tr>
<td></td>
<td>transmission up to 56 kbit/s</td>
</tr>
<tr>
<td></td>
<td>– adaptation function including V.110 at 48 kbit/s and</td>
</tr>
<tr>
<td></td>
<td>56 kbit/s synch.</td>
</tr>
</tbody>
</table>

| Electrical      | 64 kbit/s ITU-T G.703, ETS 300 288/9                          |
| G.703           | Data                                                           |
|                 | Synchronous codirectional or contradirectional, or asynchronous|
| Connector       | C/2 2 x (3 x 7) pin Euroconnector                              |

8.1.5 STM-1 interfaces

| Transmission    | 155.520 Mbit/s, ITU-T G.707, S1.1: short haul 1300 nm         |
| Interfaces      | 155.520 Mbit/s, ITU-T G.707, L1.1: long haul 1300 nm           |
|                 | (ETSI VC-12 mapping scheme)                                    |
| Connector types | SC or FC/PC options                                           |

8.1.6 Synchronisation

<table>
<thead>
<tr>
<th>Synchronisation</th>
<th>System clock accuracy</th>
<th>4.6 x 10^{-6}</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronisation source</td>
<td>external 2048 kHz signal or incoming 2048 kbit/s or STM-1 aggregate signal or incoming 2048 kbit/s or STM-1 tributary signal or internal frequency (hold over and free running)</td>
<td></td>
</tr>
<tr>
<td>Synchronisation output</td>
<td>external 2048 kHz interface</td>
<td></td>
</tr>
</tbody>
</table>
8.1.7 Management interfaces

<table>
<thead>
<tr>
<th>Management interface</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector type</td>
<td>10Base-T: Shielded RJ45</td>
</tr>
<tr>
<td></td>
<td>10Base2: BNC</td>
</tr>
<tr>
<td>Electrical interfaces</td>
<td>10Base-T: IEEE 802.3, except §14.3.1.1 (Isolation requirement)</td>
</tr>
<tr>
<td></td>
<td>10Base-2: IEEE 802.3</td>
</tr>
</tbody>
</table>

8.1.8 Auxiliary interfaces

Auxiliary data channel interfaces are provided, which may be used to extend either a Q3 or Q1 type network management DCN (Data Communications Network).

<table>
<thead>
<tr>
<th>Auxiliary data channel interfaces</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>V.11 4-wire interface, 0 - 9600 bit/s, asynchronous</td>
</tr>
<tr>
<td>AUX Data</td>
<td>V.11, synchronous 64 kbit/s, codirectional or contradirectional</td>
</tr>
<tr>
<td>Connectors</td>
<td>Shielded RJ45</td>
</tr>
</tbody>
</table>

8.1.9 External supervisory interfaces

<table>
<thead>
<tr>
<th>External supervisory inputs/outputs on each NCU or LMU</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector type</td>
<td>Shielded RJ45</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>Three with E&amp;M signalling</td>
</tr>
<tr>
<td>Digital input/output</td>
<td>Two with E&amp;M (input mode), open drain (output mode)</td>
</tr>
<tr>
<td>Analog input (2)</td>
<td>One with -70 - 0 V range</td>
</tr>
<tr>
<td></td>
<td>One with 0 - +5 V range</td>
</tr>
</tbody>
</table>
8.2  Line testing

8.2.1  PSTN tests

<table>
<thead>
<tr>
<th>Basic metallic test out:</th>
<th>Range and accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>$AC_{\text{RMS}}$ voltage measurement</td>
<td></td>
</tr>
<tr>
<td>(a-gnd, b-gnd, and a-b)</td>
<td>0 - 2 V $\pm$ 0.1 V</td>
</tr>
<tr>
<td></td>
<td>2 - 50 V $\pm$ 5% $^1$</td>
</tr>
<tr>
<td>DC voltage measurement</td>
<td></td>
</tr>
<tr>
<td>(a-gnd, b-gnd, and a-b)</td>
<td>0 - 5V $\pm$ 0.1 V</td>
</tr>
<tr>
<td></td>
<td>5 - 70 V $\pm$ 2% $^1$</td>
</tr>
<tr>
<td>Capacitance measurement</td>
<td>0 - 100 nF $\pm$ 3 nF</td>
</tr>
<tr>
<td>(a-gnd, b-gnd, and a-b)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100 nF - 1 $\mu$F $\pm$ 3%</td>
</tr>
<tr>
<td></td>
<td>1 $\mu$F - 10 $\mu$F $\pm$ 10%</td>
</tr>
<tr>
<td>Leakage resistance measurement</td>
<td>0 - 1 k$\Omega$ $\pm$ 20 $\Omega$</td>
</tr>
<tr>
<td>(a-gnd, b-gnd, a-b, a-batt, and b-batt)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 k$\Omega$ - 1 M$\Omega$ $\pm$ 2%</td>
</tr>
<tr>
<td></td>
<td>1 M$\Omega$ - 10 M$\Omega$ $\pm$ 10%</td>
</tr>
<tr>
<td>Loop resistance measurement $R_{a-b}$</td>
<td>0 - 1 k$\Omega$ $\pm$ 20 $\Omega$</td>
</tr>
<tr>
<td></td>
<td>1 k$\Omega$ - 1 M$\Omega$ $\pm$ 2%</td>
</tr>
<tr>
<td></td>
<td>1 M$\Omega$ - 10 M$\Omega$ $\pm$ 10%</td>
</tr>
</tbody>
</table>

$^1$) On older PSTN units, the maximum measured AC voltage is limited to 50 V and maximum DC to 70 V.

<table>
<thead>
<tr>
<th>Test in:</th>
<th>Test criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feeding voltage test</td>
<td>The parameters are tested against fixed threshold values. As a result of each test an OK/NO_OK indication is given.</td>
</tr>
<tr>
<td>Feeding current test</td>
<td></td>
</tr>
<tr>
<td>Loop detection test</td>
<td></td>
</tr>
<tr>
<td>Ring trip detection test</td>
<td></td>
</tr>
<tr>
<td>Ringing current test</td>
<td></td>
</tr>
<tr>
<td>Private meter pulse test</td>
<td></td>
</tr>
<tr>
<td>CODEC test</td>
<td></td>
</tr>
</tbody>
</table>
8.2.2 ISDN BRA tests

<table>
<thead>
<tr>
<th>Test out:</th>
<th>Range and accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC_{RMS} voltage measurement (a–gnd, b–gnd, and a–b)</td>
<td>0 – 2 V ± 0.1 V 2 – 100 V ± 5%</td>
</tr>
<tr>
<td>DC voltage measurement (a–gnd, b–gnd, and a–b)</td>
<td>0 – 5 V ± 0.1 V 2 – 100 V ± 5%</td>
</tr>
<tr>
<td>Capacitance measurement (a–gnd, b–gnd, and a–b)</td>
<td>0 – 100 nF ± 3 nF 100 nF – 1 μF ± 3% 1 μF – 10 μF ± 10%</td>
</tr>
<tr>
<td>Leakage resistance measurement (a–gnd, b–gnd, a–b, a–batt, and b–batt)</td>
<td>0 – 1 kΩ ± 20 Ω 1 kΩ – 1 MΩ ± 2% 1 MΩ – 10 MΩ ± 10%</td>
</tr>
</tbody>
</table>

**ISDN tests**

Loopbacks

Faults can be located by making ISDN loopback tests. The loopback tests can separately check the condition of the interface and the line. The following tests specified in ETS 300 012 are available:
- Loop1 to loop in line termination (LT)
- Loop1A to loop in repeater (REG)
- Loop2 to loop in NT

Remote tests

- Partial activation test
- Full activation test
- Node send corrupt CRC to node
- NT1 send corrupt CRC to node
- Hold NT1 state
- Node send pulse mask to NT1
8.3 Power consumption

The power consumption depends on many factors including traffic figures and subscriber loop lengths.

**Typical power consumption of Eksos N20 units**

<table>
<thead>
<tr>
<th>Product</th>
<th>Average power consumption</th>
</tr>
</thead>
<tbody>
<tr>
<td>17-slot Eksos N20 subrack (fully equipped)</td>
<td>250 W</td>
</tr>
<tr>
<td>Eksos N20 8-slot cartridge (fully equipped)</td>
<td>120 W</td>
</tr>
<tr>
<td>NCU</td>
<td>10 W</td>
</tr>
<tr>
<td>LMU</td>
<td>12 W</td>
</tr>
<tr>
<td>PSTN</td>
<td>16 W</td>
</tr>
<tr>
<td>ISDN</td>
<td>11 W</td>
</tr>
<tr>
<td>DIU</td>
<td>10 W</td>
</tr>
<tr>
<td>TR2M4</td>
<td>10 W</td>
</tr>
<tr>
<td>SAN CORE2M</td>
<td>17 W</td>
</tr>
</tbody>
</table>

8.4 Mechanical specifications

8.4.1 Subrack extension board connectors

<table>
<thead>
<tr>
<th>Connector function</th>
<th>Connector type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power connectors P1 and P2</td>
<td>AMP Mate’n’lok</td>
</tr>
<tr>
<td>Signalling voltage connector P3</td>
<td>AMP Mate’n’lok</td>
</tr>
<tr>
<td>Station alarm outputs connector P4</td>
<td>15-pole male D-connector</td>
</tr>
<tr>
<td>Fan power and alarm connector J5</td>
<td>9-pole female D-connector</td>
</tr>
<tr>
<td>Test bus connectors J3A C and D</td>
<td>RJ45</td>
</tr>
<tr>
<td>SV1 measurement connectors J3A A and B</td>
<td>RJ45</td>
</tr>
<tr>
<td>Service switch connectors J2A A to D</td>
<td>RJ45</td>
</tr>
<tr>
<td>Connectors J11, J12 and J13</td>
<td>Phoenix mini-combicon</td>
</tr>
</tbody>
</table>
8.4.2 Cartridge extension board connectors

<table>
<thead>
<tr>
<th>Connector function</th>
<th>Connector type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power connectors P1 and P2</td>
<td>AMP Mate’n’lok</td>
</tr>
<tr>
<td>Signalling voltage connector P3</td>
<td>AMP Mate’n’lok</td>
</tr>
<tr>
<td>Station alarm outputs connector P4</td>
<td>15-pole male D-connector</td>
</tr>
<tr>
<td>Fan power and alarm connector J5</td>
<td>9-pole female D-connector</td>
</tr>
<tr>
<td>Test bus connectors J3A C and D</td>
<td>RJ45</td>
</tr>
<tr>
<td>SV1 measurement connectors J3A A and B</td>
<td>RJ45</td>
</tr>
<tr>
<td>Service switch connectors J2A A to D</td>
<td>RJ45</td>
</tr>
<tr>
<td>Connectors J1 and J2</td>
<td>Phoenix mini-combicon</td>
</tr>
</tbody>
</table>

8.4.3 Mechanical dimensions

<table>
<thead>
<tr>
<th>Product</th>
<th>Dimensions (h x w x d) excluding mounting brackets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subrack 17-slots (without cover)</td>
<td>330 x 450 mm x 240 mm</td>
</tr>
<tr>
<td>Subrack 17-slots (with cover)</td>
<td>340 x 450 mm x 300 mm</td>
</tr>
<tr>
<td>Cartridge 8-slots</td>
<td>345 x 211 mm x 240 mm</td>
</tr>
<tr>
<td>Mounting shelf for 8-slot cartridge (ETSI)</td>
<td>108 x 534 mm x 242 mm</td>
</tr>
<tr>
<td>Mounting shelf for 8-slot cartridge (19&quot;)</td>
<td>104 x 482 mm x 242 mm</td>
</tr>
<tr>
<td>Wall mounting set</td>
<td>810 x 560 mm x 300 mm</td>
</tr>
<tr>
<td>DC-PSA</td>
<td>110 mm x 483 mm x 225 mm</td>
</tr>
<tr>
<td>1U Extension unit</td>
<td>44 mm x 483 mm x 160 mm</td>
</tr>
<tr>
<td>1U Capacitor unit</td>
<td>43 mm x 483 mm x 120 mm</td>
</tr>
<tr>
<td>1U Cable tray</td>
<td>43 mm x 448 mm x 280 mm</td>
</tr>
<tr>
<td>1U Fan unit</td>
<td>43 mm x 448 mm x 280 mm</td>
</tr>
<tr>
<td>1U Air Deflector</td>
<td>44 mm x 445 x 254 mm</td>
</tr>
<tr>
<td>2U Air Deflector</td>
<td>88 mm x 445 x 254 mm (without grille)</td>
</tr>
<tr>
<td></td>
<td>88 mm x 445 x 270 mm (with grille)</td>
</tr>
<tr>
<td>4U Air Deflector</td>
<td>170 mm x 445 x 254 mm (without grille)</td>
</tr>
<tr>
<td></td>
<td>170 mm x 445 x 270 mm (with grille)</td>
</tr>
<tr>
<td>5U Air Deflector</td>
<td>222 mm x 445 x 254 mm (without grille)</td>
</tr>
<tr>
<td></td>
<td>222 mm x 445 x 270 mm (with grille)</td>
</tr>
<tr>
<td>Plug-in units SAN CORE2M</td>
<td>265 mm x 50 x 210 mm</td>
</tr>
<tr>
<td>Other units</td>
<td>265 mm x 25 x 210 mm</td>
</tr>
</tbody>
</table>
### 8.4.4 Weights

<table>
<thead>
<tr>
<th>Product</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAN CORE2M</td>
<td>980 g</td>
</tr>
<tr>
<td>NCU</td>
<td>490 g</td>
</tr>
<tr>
<td>LMU</td>
<td>475 g</td>
</tr>
<tr>
<td>PSTN</td>
<td>1050 g</td>
</tr>
<tr>
<td>ISDN</td>
<td>640 g</td>
</tr>
<tr>
<td>DIU</td>
<td>600 g</td>
</tr>
<tr>
<td>TR2M4</td>
<td>415 g</td>
</tr>
<tr>
<td>Eksos N20 Subrack 17-slot</td>
<td>5400 g</td>
</tr>
<tr>
<td>Eksos N20 8-slot cartridge</td>
<td>2585 g</td>
</tr>
<tr>
<td>1U Air deflector (without grille)</td>
<td>1230 g</td>
</tr>
<tr>
<td>2U Air deflector (without grille)</td>
<td>1050 g</td>
</tr>
<tr>
<td>2U Air deflector (with grille)</td>
<td>1300 g</td>
</tr>
<tr>
<td>4U Air deflector (without grille)</td>
<td>1560 g</td>
</tr>
<tr>
<td>4U Air deflector (with grille)</td>
<td>2030 g</td>
</tr>
<tr>
<td>5U Air deflector (without grille)</td>
<td>1900 g</td>
</tr>
<tr>
<td>5U Air deflector (with grille)</td>
<td>2500 g</td>
</tr>
<tr>
<td>Fan unit</td>
<td>2925 g</td>
</tr>
<tr>
<td>Cable tray</td>
<td>955 g</td>
</tr>
<tr>
<td>Capacitor unit</td>
<td>2000 g</td>
</tr>
<tr>
<td>Extension unit</td>
<td>2350 g</td>
</tr>
<tr>
<td>DC-PSA</td>
<td>5500 g</td>
</tr>
<tr>
<td>OSI-DCN adapter</td>
<td>470 g</td>
</tr>
<tr>
<td>Wall mounting set</td>
<td>7400 g</td>
</tr>
</tbody>
</table>
## 8.5 Environmental specifications

<table>
<thead>
<tr>
<th>Recommendation</th>
<th>ETSI specification prETS 300 019–1–1/2/3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Operation, class 3.2</td>
</tr>
<tr>
<td>Low air temperature</td>
<td>–5 °C</td>
</tr>
<tr>
<td>High air temperature 1)</td>
<td>+45 °C 2)</td>
</tr>
<tr>
<td>Low relative humidity</td>
<td>5 %</td>
</tr>
<tr>
<td>High relative humidity 3)</td>
<td>95 %</td>
</tr>
<tr>
<td>Low absolute humidity</td>
<td>1 g/m³</td>
</tr>
<tr>
<td>High absolute humidity</td>
<td>29 g/m³</td>
</tr>
<tr>
<td>Low air pressure</td>
<td>70 kPa</td>
</tr>
<tr>
<td>High air pressure</td>
<td>106 kPa</td>
</tr>
</tbody>
</table>

**OPERATION:**

- Biological conditions: class 3.2
- Chemically active substances: class 3.2
- Mechanically active substances: class 3.2
- Mechanical conditions: class 3.2

1) High air temperature and low air pressure not prevailing simultaneously

2) Extended temperature range +55 °C with forced convection

3) Condensation and icing is not allowed on the electronics parts or product package
8.5.1 EMC Immunity

### Electrostatic discharge (ESD) EN 61000-4-2

<table>
<thead>
<tr>
<th>Contact discharge</th>
<th>Air discharge</th>
<th>Compliance criterion</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 kV</td>
<td>8 kV</td>
<td>A</td>
</tr>
<tr>
<td>8 kV</td>
<td>15 kV</td>
<td>Loss of function (self recovery)</td>
</tr>
</tbody>
</table>

### Surge immunity EN 61000-4-5

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Compliance criterion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indoor cables: 500 V</td>
<td>B</td>
</tr>
<tr>
<td>Outdoor cables: 1.0 kV</td>
<td>B, differential mode</td>
</tr>
<tr>
<td>1.5 kV</td>
<td>B, common mode</td>
</tr>
<tr>
<td>4.0 kV</td>
<td>B, with primary protection</td>
</tr>
</tbody>
</table>

### Electrical fast transients/bursts (EFT) EN 61000-4-4

<table>
<thead>
<tr>
<th>Cable</th>
<th>Voltage</th>
<th>Compliance criterion</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC power cables</td>
<td>1 kV</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>2 kV</td>
<td>Loss of function (self recovery)</td>
</tr>
<tr>
<td>Signal cables</td>
<td>500 V</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>1 kV</td>
<td>Loss of function (self recovery)</td>
</tr>
</tbody>
</table>

### Radio frequency electromagnetic field disturbances EN 61000-4-6

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Voltage</th>
<th>Compliance criterion</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.15 - 80 MHz</td>
<td>3 V</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>10 V</td>
<td>Loss of function</td>
</tr>
</tbody>
</table>

### Radio frequency electromagnetic field disturbances EN 61000-4-3

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Electric field strength</th>
<th>Compliance criterion</th>
</tr>
</thead>
<tbody>
<tr>
<td>80 - 1000 MHz (AM)</td>
<td>3 V/m</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>10 V/m</td>
<td>B</td>
</tr>
<tr>
<td>1.4 - 2.0 GHz (AM)</td>
<td>3 V/m</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>10 V/m</td>
<td>B</td>
</tr>
</tbody>
</table>
Radio frequency electromagnetic field disturbances ENV 50204

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Electric field strength</th>
<th>Compliance criterion</th>
</tr>
</thead>
<tbody>
<tr>
<td>900 MHz (PM)</td>
<td>3 V/m</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>10 V/m</td>
<td>B</td>
</tr>
<tr>
<td>1.890 GHz (PM)</td>
<td>3 V/m</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>10 V/m</td>
<td>B</td>
</tr>
</tbody>
</table>

8.5.2 EMC Emission

Conducted emission, power leads EN 55022 class A 1995, ETS 300 386–1

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Quasi-peak dB (µV)</th>
<th>Average dB (µV)</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 - 150 kHz</td>
<td>79</td>
<td>–</td>
</tr>
<tr>
<td>0.15 - 0.5 MHz</td>
<td>79</td>
<td>66</td>
</tr>
<tr>
<td>0.5 - 30 MHz</td>
<td>73</td>
<td>60</td>
</tr>
</tbody>
</table>

![Graph showing conducted emission levels for different frequency bands with Q-peak and Average dB values.](image-url)
### Radiated emission, electrical interference field strength (10 m distance)
**EN55022 (C.I.S.P.R 22) Class B**

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Quasi-peak dB (μV/m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 - 230 MHz</td>
<td>30</td>
</tr>
<tr>
<td>230 - 1000 MHz</td>
<td>37</td>
</tr>
</tbody>
</table>

![Graph showing Quasi-peak dB (μV/m) vs. Frequency (MHz)]

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Quasi-peak dB (μV/m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 2.7 GHz</td>
<td>50</td>
</tr>
<tr>
<td>2.7 - 18 GHz</td>
<td>70</td>
</tr>
</tbody>
</table>

![Graph showing Quasi-peak dB (μV/m) vs. Frequency (GHz)]
8.6 Eksos N20 Node Manager system requirements

The hardware and software requirements for the computer running the Eksos N20 Node Manager are given below.

<table>
<thead>
<tr>
<th>System requirements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft Windows NT Version 4.0</td>
</tr>
<tr>
<td>Computer</td>
<td>Any PC capable of running the required version of Microsoft Windows NT</td>
</tr>
<tr>
<td>RAM</td>
<td>128 MB minimum, preferably 192 MB or more</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>100 MB minimum</td>
</tr>
<tr>
<td>Floppy disc drive</td>
<td>3.5” high-density (for installation purposes)</td>
</tr>
<tr>
<td>CD-ROM drive</td>
<td>CD-ROM drive (for installation purposes)</td>
</tr>
<tr>
<td>Display</td>
<td>Colour (at least 16 colours) or grey scale (16 shades of grey)</td>
</tr>
<tr>
<td>Pointing device</td>
<td>Mouse, tracker ball or equivalent with the necessary controlling software</td>
</tr>
<tr>
<td>Printer (optional)</td>
<td>Microsoft Windows NT compatible printer</td>
</tr>
</tbody>
</table>
| Interface ports     | - Ethernet port for Q3 communication to the node  
|                     | - Serial port or Parallel port for printer  
|                     | - Mouse port (if a mouse is used as the pointing device) |
8.7 International recommendations

This is a list of recommendations referred to in technical specifications.

8.7.1 2 Mbit/s interface specifications

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.703</td>
<td>Physical electrical characteristics of hierarchical digital interfaces</td>
</tr>
<tr>
<td>G.704</td>
<td>Synchronous frame structures used at primary and secondary hierarchical levels</td>
</tr>
<tr>
<td>G.706</td>
<td>Frame Alignment and Cyclic Redundancy Check (CRC) Procedures Relating to Basic Frame Structures Defined in Recommendation G.704</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ETSI</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETS 300 418</td>
<td>2048 kbit/s digital unstructured and structured leased lines (D2048U and D2048S)</td>
</tr>
<tr>
<td>ETS 300 419</td>
<td>2048 kbit/s digital structured leased lines (D2048S); Connection characteristics</td>
</tr>
<tr>
<td>ETS 300 420</td>
<td>2048 kbit/s digital structured leased lines (D2048S); Terminal equipment interface</td>
</tr>
</tbody>
</table>

8.7.2 V5.1/V5.2 specifications

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.964</td>
<td>V-interfaces at the digital local exchange (LE) – V5.1-interface (based on 2048 kbit/s) for the support of access network (AN)</td>
</tr>
<tr>
<td>G.965</td>
<td>V-interfaces at the digital local exchange (LE) – V5.2-interface (based on 2048 kbit/s) for support of access network (AN)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ETSI</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN 300 324-1</td>
<td>Signalling Protocols and Switching (SPS); V interfaces at the Local Exchanges (LE) V5.1 interface for the support of Access Network (AN) Part 1: V5.1 Interface Specification</td>
</tr>
<tr>
<td>EN 300 347-1</td>
<td>V interfaces at the digital Local Exchange (LE) V5.2 interface for the support of Access Network (AN) Part 1: V5.2 Interface Specification</td>
</tr>
</tbody>
</table>
8.7.3 SDH specifications

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.707</td>
<td>Network Node Interface for SDH</td>
</tr>
<tr>
<td>G.783</td>
<td>Characteristics of Synchronous Digital Hierarchy (SDH) Equipment Functional Blocks</td>
</tr>
<tr>
<td>G.784</td>
<td>Synchronous Digital Hierarchy (SDH) Management</td>
</tr>
<tr>
<td>G.957</td>
<td>Optical interfaces for equipment and systems relating to the Synchronous Digital Hierarchy</td>
</tr>
<tr>
<td>G.958</td>
<td>Digital line systems based on the Synchronous Digital Hierarchy for use on optical fibre cables</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ETSI</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETS 300 147</td>
<td>Synchronous Digital Hierarchy Multiplexing structure</td>
</tr>
<tr>
<td>ETS 300 417-x</td>
<td>Transmission and Multiplexing (TM) Generic functional requirements for Synchronous Digital Hierarchy (SDH) equipment; consisting of part 1 to part 8</td>
</tr>
<tr>
<td>ETS 300 417-1-1</td>
<td>Part 1-1: Generic processes and performance</td>
</tr>
<tr>
<td>ETS 300 417-2-1</td>
<td>Part 2-1: Physical section layer functions</td>
</tr>
<tr>
<td>ETS 300 417-3-1</td>
<td>Part 3-1: STM-N regenerator and multiplex section layer functions</td>
</tr>
<tr>
<td>ETS 300 417-4-1</td>
<td>Part 4-1: SDH path layer functions</td>
</tr>
<tr>
<td>ETS 300 417-5-1</td>
<td>Part 5-1: PDH path layer functions</td>
</tr>
<tr>
<td>ETS 300 417-6-1</td>
<td>Part 6-1: Synchronisation distribution layer functions</td>
</tr>
<tr>
<td>prETS 300 417-7-1</td>
<td>Part 7-1: Auxiliary layer functions</td>
</tr>
<tr>
<td>prETS 300 417-8-1</td>
<td>Part 8-1: Compound and major compound functions</td>
</tr>
</tbody>
</table>

8.7.4 Synchronisation

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.813</td>
<td>Timing characteristics of SDH equipment slave clocks (SEC)</td>
</tr>
<tr>
<td>G.823</td>
<td>The control of jitter and wander within digital networks which are based on the 2048 kbit/s hierarchy</td>
</tr>
<tr>
<td>G.825</td>
<td>The control of jitter and wander within digital networks which are based on the Synchronous Digital Hierarchy (SDH)</td>
</tr>
</tbody>
</table>
### 8.7.5 Miscellaneous

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.775</td>
<td>Loss of signal (LOS) and alarm indication signal (AIS) defect detection and clearance criteria</td>
</tr>
<tr>
<td>O.153</td>
<td>Basic parameters for the measurement of error performance at bit rates below the primary rate</td>
</tr>
<tr>
<td>O.162</td>
<td>Equipment to perform in-service monitoring on 2048 kHz</td>
</tr>
</tbody>
</table>

### 8.7.6 ISDN BRA (U) interfaces

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.961</td>
<td>Digital transmission system on metallic local lines for ISDN basic rate access</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ETSI</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETS 300 297</td>
<td>Access digital section for ISDN basic access</td>
</tr>
<tr>
<td>ETR 080</td>
<td>Integrated Services Digital Network (ISDN) basic rate access Digital transmission system on metallic local lines</td>
</tr>
</tbody>
</table>

### 8.7.7 PSTN voice frequency specifications

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.711</td>
<td>Pulse Code Modulation (PCM) of Voice Frequencies</td>
</tr>
<tr>
<td>G.712</td>
<td>Transmission Performance Characteristics of PCM Channels</td>
</tr>
<tr>
<td>Q.552</td>
<td>Transmission Characteristics at 2-wire Analog Interfaces of Digital Exchanges</td>
</tr>
</tbody>
</table>
### 8.7.8 Data interface unit

<table>
<thead>
<tr>
<th>ANSI</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>EIA-530A</td>
<td>High Speed 25 Position Interface for Data Terminal Equipment and Data Circuit-Terminating Equipment, including Alternative 26 Position Connector</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>R.111</td>
<td>Code and speed independent TDM system for anisochronous telegraph and data transmission</td>
</tr>
<tr>
<td>V.10</td>
<td>Electrical characteristics for unbalanced double-current interchange circuits operating at data signalling rates nominally up to 100 kbit/s</td>
</tr>
<tr>
<td>V.11</td>
<td>Electrical characteristics for balanced double-current interchange circuits operating at data signalling rates up to 10 Mbit/s</td>
</tr>
<tr>
<td>V.110</td>
<td>Support of data terminal equipments with V-Series type interfaces by an integrated services digital network</td>
</tr>
<tr>
<td>V.13</td>
<td>Simulated carrier control</td>
</tr>
<tr>
<td>V.14</td>
<td>Transmission of start-stop characters over synchronous bearer channels</td>
</tr>
<tr>
<td>V.24</td>
<td>List of definitions for interchange circuits between data terminal equipment (DTE) and data circuit-terminating equipment (DCE)</td>
</tr>
<tr>
<td>V.28</td>
<td>Electrical characteristics for unbalanced double-current interchange circuits</td>
</tr>
<tr>
<td>V.35</td>
<td>List of definitions for interchange circuits between data terminal equipment (DTE) and data circuit-terminating equipment (DCE) on public data networks</td>
</tr>
<tr>
<td>V.36</td>
<td>Modems for synchronous data transmission using 60-108 kHz group band circuits</td>
</tr>
<tr>
<td>V.54</td>
<td>Loop test devices for modems; 11/88</td>
</tr>
<tr>
<td>X.21</td>
<td>Use on public data networks of Data Terminal Equipment (DTE) which is designed for interfacing to synchronous V-Series modems; 11/88</td>
</tr>
<tr>
<td>X.24</td>
<td>List of definitions for interchange circuits between data terminal equipment (DTE) and data circuit-terminating equipment (DCE) on public data networks</td>
</tr>
<tr>
<td>X.150</td>
<td>Principles of maintenance testing for public data networks using Data Terminal Equipment (DTE) and Data Circuit-terminating Equipment (DCE) test loops; 11/88</td>
</tr>
<tr>
<td>X.745</td>
<td>Data Networks and Open System Communications OSI Management</td>
</tr>
</tbody>
</table>
8.7.9 HDSL

<table>
<thead>
<tr>
<th>ETSI</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETR 152</td>
<td>Transmission and Multiplexing (TM); High bitrate Digital Subscriber Line (HDSL) transmission system on metallic local lines; HDSL core specification and applications for 2048 kbit/s based access digital sections including HDSL dual-duplex Carrierless Amplitude Phase Modulation (CAP) based system</td>
</tr>
</tbody>
</table>

8.7.10 Optical fibre

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.652</td>
<td>Characteristics of a single-mode optical fibre cable</td>
</tr>
<tr>
<td>G.653</td>
<td>Characteristics of a dispersion-shifted single-mode optical fibre cable</td>
</tr>
<tr>
<td>G.654</td>
<td>Characteristics of a 1550 nm wavelength loss-minimised single-mode optical fibre cable</td>
</tr>
</tbody>
</table>

8.7.11 Power supply

<table>
<thead>
<tr>
<th>ETSI</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETS 300 132-2</td>
<td>Power supply interface at the input to telecommunications equipment; Part 2: Operated by direct current (DC)</td>
</tr>
</tbody>
</table>

8.7.12 Network

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.805</td>
<td>Generic functional architecture of transport networks</td>
</tr>
</tbody>
</table>
### 8.7.13 Environmental

<table>
<thead>
<tr>
<th>ETSI</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN 61000-4-2...6</td>
<td>Electromagnetic Compatibility (EMC) Part 4: Testing and Measurement Techniques</td>
</tr>
<tr>
<td>EN 61000-4-2</td>
<td>Section 2: Electrostatic Discharge Immunity Test – Basic.</td>
</tr>
<tr>
<td>EN 61000-4-3</td>
<td>Section 3: Radiated, Radio-Frequency, Electromagnetic Field Immunity Test.</td>
</tr>
<tr>
<td>EN 61000-4-4</td>
<td>Section 4: Electrical Fast Transient/Burst Immunity Test.</td>
</tr>
<tr>
<td>EN 61000-4-5</td>
<td>Section 5: Surge Immunity Test.</td>
</tr>
<tr>
<td>EN 61000-4-6</td>
<td>Section 6: Immunity to Conducted Disturbances, Induced by Radio-Frequency Fields.</td>
</tr>
<tr>
<td>ETS 300 386-1</td>
<td>Equipment Engineering (EE); Telecommunication Network Equipment Electromagnetic Compatibility (EMC) Requirements; Part 1: Product Family Overview, Compliance Criteria and Test Levels.</td>
</tr>
<tr>
<td>prETS 300 019-1-1</td>
<td>Environmental Class 1.2: Conditions for weatherprotected, partly temperature controlled storage locations.</td>
</tr>
<tr>
<td>prETS 300 019-1-2</td>
<td>Environmental Class 2.3: Conditions for public transportation</td>
</tr>
<tr>
<td>prETS 300 019-1-3</td>
<td>Environmental Class 3.2: Conditions for stationary use in weatherprotected, partly temperature controlled storage locations.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IEC</th>
<th>Recommendation name</th>
</tr>
</thead>
</table>
Nokia Eksos N20
Narrowband Multiservice Access Node

Specific Instructions for Germany
The information in this document is subject to change without notice and describes only the product defined in the introduction of this documentation. This document is intended for the use of Nokia Networks’ customers only for the purposes of the agreement under which the document is submitted, and no part of it may be reproduced or transmitted in any form or means without the prior written permission of Nokia Networks. The document has been prepared to be used by professional and properly trained personnel, and the customer assumes full responsibility when using it. Nokia Networks welcomes customer comments as part of the process of continuous development and improvement of the documentation.

The information or statements given in this document concerning the suitability, capacity, or performance of the mentioned hardware or software products cannot be considered binding but shall be defined in the agreement made between Nokia Networks and the customer. However, Nokia Networks has made all reasonable efforts to ensure that the instructions contained in the document are adequate and free of material errors and omissions. Nokia Networks will, if necessary, explain issues which may not be covered by the document.

Nokia Networks’ liability for any errors in the document is limited to the documentary correction of errors. Nokia Networks WILL NOT BE RESPONSIBLE IN ANY EVENT FOR ERRORS IN THIS DOCUMENT OR FOR ANY DAMAGES, INCIDENTAL OR CONSEQUENTIAL (INCLUDING MONETARY LOSSES), that might arise from the use of this document or the information in it.

This document and the product it describes are considered protected by copyright according to the applicable laws.

NOKIA logo is a registered trademark of Nokia Corporation.

Any other trademarks mentioned in the documents are the property of their respective companies, and they are mentioned for identification purposes only.

Copyright © Nokia Corporation 2002. All rights reserved.
<table>
<thead>
<tr>
<th>Document</th>
<th>Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>C33993003SE_00</td>
<td>20 Sep 2002</td>
<td></td>
</tr>
</tbody>
</table>
## Contents

Chapter 1  
About this document ........................................... 1

Chapter 2  
Technical specifications ...................................... 3  
  2.1 Power consumption ........................................ 5  
  2.2 Recommendations ......................................... 6

Chapter 3  
Commissioning PSTN user interface .......................... 7  
  3.1 Default settings ............................................ 7  
  3.2 Signalling settings (DC Set) .............................. 8  
  3.3 General settings ............................................ 9  
  3.4 Speech settings ............................................. 9

Chapter 4  
ISDN Interface Unit ............................................. 11  
  4.1 Commissioning power feeding of ISDN user interfaces .... 11  
  4.2 Power consumption and heat dissipation ................. 11

Chapter 5  
PSTN mapping .................................................... 15  
  5.1 Recommendations and standards ......................... 15  
  5.2 Key features .............................................. 15
Chapter 1
About this document

This document describes the features that are specific to Eksos N20 system release designed for Germany.

The specifications and instructions given here complement the other, more generic, documents included in this manual.

- To get an overall picture of the specifications met in Eksos N20 DEU, use this document together with the Product Description document.

- To be able to commission the entire node, and especially the PSTN and ISDN units, use this document together with the Commissioning and Maintenance document.
Chapter 2
Technical specifications

The standards mentioned in Section 2.2 are always fulfilled when using the default settings.

<table>
<thead>
<tr>
<th>Function</th>
<th>Attribute</th>
<th>Set 1 Default</th>
<th>Set 2 Option 2</th>
<th>Set 3 Option 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC feed</td>
<td>Resistance (Ω)</td>
<td>2 x 200</td>
<td>2 x 200</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Current (mA)</td>
<td>25</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Optional current (mA)</td>
<td>35</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>Loop resistance</td>
<td>(Ω)</td>
<td>&lt;1800</td>
<td>&lt;1800</td>
<td></td>
</tr>
<tr>
<td>Off-hook detection</td>
<td>Level (mA)</td>
<td>9</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>On-hook with transmission</td>
<td>(V)</td>
<td>&gt; 43</td>
<td>&gt; 43</td>
<td></td>
</tr>
<tr>
<td>On-hook without transmission</td>
<td>(V)</td>
<td>≥ 48</td>
<td>≥ 48</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>Ri = 2 x 5 kΩ</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metering</td>
<td>Level (V&lt;sub&gt;rms&lt;/sub&gt;)</td>
<td>4.0</td>
<td>5.0</td>
<td>4.0</td>
</tr>
<tr>
<td>Ringing</td>
<td>Level (V&lt;sub&gt;rms&lt;/sub&gt;)</td>
<td>70</td>
<td>70</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Frequency (Hz)</td>
<td>25</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DC offset (V)</td>
<td>30</td>
<td>30</td>
<td></td>
</tr>
</tbody>
</table>

Table 1  Signalling settings
### Table 2  Line feeding settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Default value</th>
<th>Optional value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feeding mode</td>
<td>Normal 1)</td>
<td>Direct battery 1)</td>
</tr>
<tr>
<td>Polarity reversal</td>
<td>Fast</td>
<td>Slow</td>
</tr>
</tbody>
</table>

1) With either normal or optional current (see section 3.2)

### Table 3  General settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Default value</th>
<th>Optional value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metering pulse type</td>
<td>16 kHz</td>
<td>–</td>
</tr>
<tr>
<td>Generator impedance</td>
<td>180 Ω</td>
<td>–</td>
</tr>
<tr>
<td>Nominal load impedance</td>
<td>200 Ω</td>
<td>–</td>
</tr>
<tr>
<td>Metering rise/fall envelope</td>
<td>Slow</td>
<td>Fast 1)</td>
</tr>
<tr>
<td>Ringing mode</td>
<td>Internal</td>
<td>–</td>
</tr>
</tbody>
</table>

1) For testing purposes only

### Table 4  Speech settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Default value</th>
<th>Optional value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal and balance impedance</td>
<td>220 Ω + 820 Ω // 115 nF</td>
<td>270 Ω + 750 Ω // 150 nF</td>
</tr>
<tr>
<td></td>
<td>220 Ω + 820 Ω // 115 nF</td>
<td>270 Ω + 750 Ω //150 nF</td>
</tr>
<tr>
<td></td>
<td>600 Ω</td>
<td>600 Ω</td>
</tr>
<tr>
<td>Input level (Li)</td>
<td>0 dBr</td>
<td>-5 to +3 dBr</td>
</tr>
<tr>
<td>Output level (Lo)</td>
<td>-7 dBr</td>
<td>-10 to 0 dBr</td>
</tr>
</tbody>
</table>

### Table 5  Power supply

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central battery voltage</td>
<td>-48 V (-44 to -58 V)</td>
</tr>
</tbody>
</table>
2.1 Power consumption

Tables 6 and 7 gives some average power consumption figures for different traffic loads.

- < 60 mErl Normal traffic
- 60 to 125 mErl Busy hour
- 125 to 250 mErl Exceptionally heavy traffic.

Note
When estimating the power supply capacity needed, you also have to consider the power required by the NCU (10 W) and ISDN units in the configuration.

<table>
<thead>
<tr>
<th>IFs (pcs)</th>
<th>Units (pcs)</th>
<th>60 mErl</th>
<th>125 mErl</th>
<th>250 mErl</th>
<th>500 mErl</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>1</td>
<td>10</td>
<td>12</td>
<td>16</td>
<td>24</td>
</tr>
<tr>
<td>64</td>
<td>2</td>
<td>20</td>
<td>24</td>
<td>32</td>
<td>48</td>
</tr>
<tr>
<td>128</td>
<td>4</td>
<td>40</td>
<td>48</td>
<td>64</td>
<td>96</td>
</tr>
<tr>
<td>192</td>
<td>6</td>
<td>60</td>
<td>72</td>
<td>96</td>
<td>144</td>
</tr>
<tr>
<td>256</td>
<td>8</td>
<td>80</td>
<td>96</td>
<td>128</td>
<td>192</td>
</tr>
<tr>
<td>320</td>
<td>10</td>
<td>100</td>
<td>120</td>
<td>160</td>
<td>240</td>
</tr>
<tr>
<td>384</td>
<td>12</td>
<td>120</td>
<td>144</td>
<td>192</td>
<td>288</td>
</tr>
<tr>
<td>480</td>
<td>15</td>
<td>150</td>
<td>180</td>
<td>240</td>
<td>360</td>
</tr>
</tbody>
</table>

Depending on the line lengths the accuracy of the power levels is ±10%

The grey areas in P_{tot} columns show the recommended levels for planning the power supply capacity. For small numbers of interfaces, the calculations need to be done according to heavier traffic because the statistical values are not necessarily applicable.

Table 6 Power levels at average line lengths and 25 - 35 mA current limitation
<table>
<thead>
<tr>
<th>IFs (pcs)</th>
<th>Units (pcs)</th>
<th>60 mErl</th>
<th>125 mErl</th>
<th>250 mErl</th>
<th>500 mErl</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>40 mA</td>
<td>20 mA</td>
<td>40 mA</td>
<td>20 mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P_{tot}</td>
<td>P_{tot}</td>
<td>P_{tot}</td>
<td>P_{tot}</td>
</tr>
<tr>
<td>32</td>
<td>1</td>
<td>12</td>
<td>10</td>
<td>16</td>
<td>13</td>
</tr>
<tr>
<td>64</td>
<td>2</td>
<td>24</td>
<td>21</td>
<td>32</td>
<td>26</td>
</tr>
<tr>
<td>128</td>
<td>4</td>
<td>48</td>
<td>42</td>
<td>63</td>
<td>52</td>
</tr>
<tr>
<td>192</td>
<td>6</td>
<td>71</td>
<td>63</td>
<td>95</td>
<td>77</td>
</tr>
<tr>
<td>256</td>
<td>8</td>
<td>95</td>
<td>84</td>
<td>126</td>
<td>103</td>
</tr>
<tr>
<td>320</td>
<td>10</td>
<td>119</td>
<td>104</td>
<td>158</td>
<td>129</td>
</tr>
<tr>
<td>384</td>
<td>12</td>
<td>143</td>
<td>125</td>
<td>189</td>
<td>155</td>
</tr>
<tr>
<td>480</td>
<td>15</td>
<td>178</td>
<td>157</td>
<td>236</td>
<td>193</td>
</tr>
</tbody>
</table>

On long lines the levels can be 20% lower.

The grey areas in $P_{tot}$ columns show the recommended levels for planning the power supply capacity. For small numbers of interfaces, the calculations need to be done according to heavier traffic because the statistical values are not necessarily applicable.

Table 7  Maximum power levels at 40 and 20 mA current limitation

2.2 Recommendations

The following table lists the recommendation referred to in the technical specifications.

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Transmission Characteristics at 2-wire Analog Interfaces of Digital Exchanges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q.552 (11/96)</td>
<td></td>
</tr>
</tbody>
</table>

Table 8  International recommendations and standards
Chapter 3
Commissioning PSTN user interface

3.1 Default settings

Normally, PSTN interfaces can be brought into use with their default settings without having to change any interface related settings. The following default settings are suitable for most applications and have been preintegrated into the software.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Set</td>
<td></td>
</tr>
<tr>
<td>DC set</td>
<td>Default (Set 1)</td>
</tr>
<tr>
<td>Feeding mode</td>
<td>Normal</td>
</tr>
<tr>
<td>Polarity reversal</td>
<td>Fast</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Metering pulse type</td>
<td>16 kHz</td>
</tr>
<tr>
<td>Metering rise/fall</td>
<td>Slow</td>
</tr>
<tr>
<td>envelope</td>
<td></td>
</tr>
<tr>
<td>Ringing mode</td>
<td>Internal</td>
</tr>
<tr>
<td>Speech</td>
<td></td>
</tr>
<tr>
<td>Input level</td>
<td>0 dBr</td>
</tr>
<tr>
<td>Output level</td>
<td>-7 dBr</td>
</tr>
<tr>
<td>Impedance pair</td>
<td>Nominal: 220 Ω + 820 Ω // 115 nF</td>
</tr>
<tr>
<td></td>
<td>Balance: 220 Ω + 820 Ω // 115 nF</td>
</tr>
</tbody>
</table>

Table 9 Default settings for PSTN user interface

The default settings need to be modified only in special cases, such as for exceptionally long or short lines. This section gives some guidelines for choosing the correct alternative settings. For detailed instructions on how to set these settings, refer to the Commissioning and Maintenance document.
The signalling, general and speech settings can be accessed through the Configure PSTN dialog box in Node Manager.

### 3.2 Signalling settings (DC Set)

The following settings can be accessed through the DC Set tab in the Configure PSTN dialog box of Node Manager.

#### DC Sets 1 to 3

There are three sets of settings available for the configuration of the signalling. The DC sets can be defined individually for each interface and should be used as follows:

**Set 1 (selection: default)**
- Default settings conform to the German specifications.
- Suitable for all line lengths.

**Set 2 (selection: option 2)**
- Designed for long lines: metering pulse level higher than in the default set
- Recommended to be used on long lines when metering pulse support is required.

For more detailed information about line lengths and minimum metering levels, see Table 10.

**Set 3 (selection: option 3)**
- Equivalent to Set 1, but inhibits power save state.
- Set 3 is used with some special terminal equipment.
- Idle state voltage is about 44 V instead of 68 V.
- Set 3 increases power consumption. For this reason, Set 3 should be used only when necessary.

#### DC feed

- Current feeding to the line is defined by the DC set selected.
- In each set there are two options:
  - normal current: conforms to the German standards
  - optional current: when increased current is needed.

#### Line feeding settings

**Normal feed**

Selecting normal feed means that the supply voltage source for line feeding is always automatically selected to minimise the power consumption.
Direct battery

Selecting direct battery option means that the battery voltage (−48 V) is always used for line feeding. It inhibits the use of lower internal signalling voltage for short lines.

Note
This option may increase power consumption and heat dissipation.

Polarity reversal time

The default value (Fast) should always be used. The optional values are only intended for testing purposes.

3.3 General settings

The following settings can be accessed through the General tab in the Configure PSTN dialog box of Node Manager.

Metering rise/fall envelope

The default value (Slow) should always be used. The Fast option is only intended for testing purposes.

3.4 Speech settings

The following settings can be accessed through the Speech tab in the Configure PSTN dialog box of Node Manager.

Impedances

- Balance and nominal impedances are always used as pairs.
- Impedance pair can be defined individually for each interface.
  - First impedance (220 Ω + 820 Ω // 115 nF) conforms to the German requirements.
  - (270 Ω + 750 Ω // 150 nF) is defined by ETSI.
  - 600 Ω impedance is primarily meant for testing purposes.
Speech levels

- Input and output level settings can be defined individually for each interface. Levels are adjustable in 0.5 dB steps within the specified range (see Table 4).

- In normal use, the default settings do not need to be changed. The levels only need to be adjusted:

  - **Long loop**: When exceptionally long lines are used, the gain control of the telephone set alone cannot compensate for the strong attenuation. In this case, the default level can be adjusted for the selected lines. Table 10 gives some guidelines for estimating the new levels.

  For example, if the attenuation is compensated by 1.5 dB, the new levels are:

  \[
  L_i = 0 \, \text{dB} - 1.5 \, \text{dB} = -1.5 \, \text{dB} \quad \text{and} \quad
  L_o = -7 \, \text{dB} + 1.5 \, \text{dB} = -5.5 \, \text{dB}
  \]

<table>
<thead>
<tr>
<th>Line type</th>
<th>Line res.</th>
<th>Line length km</th>
<th>Line Att. dB</th>
<th>SPM Level Vrms</th>
<th>Line length km</th>
<th>Line Att. dB</th>
<th>SPM Level Vrms</th>
<th>Line length km</th>
<th>Line Att. dB</th>
<th>SPM Level Vrms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short line</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>4.0</td>
<td>0</td>
<td>0</td>
<td>4.0</td>
<td>0</td>
<td>0</td>
<td>4.0</td>
</tr>
<tr>
<td></td>
<td>300</td>
<td>1.0</td>
<td>1.5</td>
<td>4.0</td>
<td>1.6</td>
<td>2</td>
<td>4.0</td>
<td>2.4</td>
<td>2.5</td>
<td>4.0</td>
</tr>
<tr>
<td></td>
<td>600</td>
<td>2.0</td>
<td>3</td>
<td>4.0</td>
<td>3.2</td>
<td>4</td>
<td>4.0</td>
<td>4.7</td>
<td>5</td>
<td>4.0</td>
</tr>
<tr>
<td>Medium line</td>
<td>700</td>
<td>2.4</td>
<td>4</td>
<td>4.0</td>
<td>3.8</td>
<td>5</td>
<td>4.0</td>
<td>5.5</td>
<td>6</td>
<td>4.0</td>
</tr>
<tr>
<td></td>
<td>800</td>
<td>2.7</td>
<td>4.5</td>
<td>4.0</td>
<td>4.3</td>
<td>5.5</td>
<td>4.0</td>
<td>6.3</td>
<td>7</td>
<td>4.0</td>
</tr>
<tr>
<td></td>
<td>950</td>
<td>3.2</td>
<td>5</td>
<td>4.0</td>
<td>5.1</td>
<td>6.5</td>
<td>5.0</td>
<td>7.5</td>
<td>8</td>
<td>5.0</td>
</tr>
<tr>
<td>Long line</td>
<td>1000</td>
<td>3.4</td>
<td>5.5</td>
<td>(5.0) 4.0</td>
<td>5.4</td>
<td>7</td>
<td>5.0</td>
<td>7.9</td>
<td>8.5</td>
<td>5.0</td>
</tr>
<tr>
<td></td>
<td>1100</td>
<td>3.8</td>
<td>6</td>
<td>(5.0) 4.0</td>
<td>5.9</td>
<td>7.5</td>
<td>5.0</td>
<td>8.7</td>
<td>9</td>
<td>5.0</td>
</tr>
<tr>
<td></td>
<td>1200</td>
<td>4.1</td>
<td>6.5</td>
<td>(5.0) 4.0</td>
<td>6.5</td>
<td>8</td>
<td>5.0</td>
<td>9.4</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1500</td>
<td>5.1</td>
<td>8</td>
<td>5.0</td>
<td>8.1</td>
<td>10</td>
<td>5.0</td>
<td>12</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1600</td>
<td>5.5</td>
<td>9</td>
<td>6.5</td>
<td>8.6</td>
<td>11</td>
<td>5.0</td>
<td>13</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1800</td>
<td>6.1</td>
<td>10</td>
<td>9.7</td>
<td>9.7</td>
<td>12</td>
<td>5.0</td>
<td>14</td>
<td>15</td>
<td></td>
</tr>
</tbody>
</table>

Line res: Loop resistance of copper pair cable, resistance of TE (Terminal Equipment) not included.

Line Att: Copper line attenuation at 1 kHz

Table 10 Cable length and attenuation
Chapter 4
ISDN Interface Unit

4.1 Commissioning power feeding of ISDN user interfaces

Check that the power fed to the line is 97 V. For detailed instructions, see the *Commissioning and Maintenance* document.

No other settings are required. The ISDN unit can start operating with the default settings preconfigured to the software.

4.2 Power consumption and heat dissipation

Tables 13 to 17 give some average power consumption figures for different configurations and traffic loads.

- < 60 mErl Normal traffic
- 60 to 125 mErl Busy hour
- 125 to 250 mErl Exceptionally heavy traffic
- 1000 mErl Line is always activated.

**Note**
When estimating the power supply capacity needed, you also have to consider the power required by the NCU (10 W) and PSTN units in the configuration.

For an explanation of abbreviations used in section 4.2, see Table 11.
Abbreviations used

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT</td>
<td>Network Termination</td>
</tr>
<tr>
<td>REG</td>
<td>Regenerator</td>
</tr>
<tr>
<td>UNI</td>
<td>User-Network interface</td>
</tr>
</tbody>
</table>

**Table 11** Abbreviations used in text

In Tables 13 and 14, the following power and resistance values have been used.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power NT</td>
<td>1.2 W</td>
</tr>
<tr>
<td>Power REG</td>
<td>1.2 W</td>
</tr>
<tr>
<td>Loop resistance NT</td>
<td>1000 Ω</td>
</tr>
<tr>
<td>Loop resistance NT + REG</td>
<td>1000 Ω + 400 Ω</td>
</tr>
</tbody>
</table>

**Table 12** Power and loop resistance values for NT and REG

<table>
<thead>
<tr>
<th>IFs pcs</th>
<th>Units pcs</th>
<th>60 mErl</th>
<th>125 mErl</th>
<th>250 mErl</th>
<th>500 mErl</th>
<th>1000 mErl</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>P_{heat} (W)</td>
<td>P_{tot} (W)</td>
<td>P_{heat} (W)</td>
<td>P_{tot} (W)</td>
<td>P_{heat} (W)</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>10</td>
<td>13</td>
<td>11</td>
<td>18</td>
<td>12</td>
</tr>
<tr>
<td>32</td>
<td>2</td>
<td>20</td>
<td>27</td>
<td>20</td>
<td>30</td>
<td>21</td>
</tr>
<tr>
<td>64</td>
<td>4</td>
<td>40</td>
<td>53</td>
<td>41</td>
<td>60</td>
<td>43</td>
</tr>
<tr>
<td>96</td>
<td>6</td>
<td>60</td>
<td>80</td>
<td>61</td>
<td>90</td>
<td>64</td>
</tr>
<tr>
<td>128</td>
<td>8</td>
<td>70</td>
<td>94</td>
<td>71</td>
<td>105</td>
<td>75</td>
</tr>
<tr>
<td>160</td>
<td>10</td>
<td>99</td>
<td>134</td>
<td>102</td>
<td>150</td>
<td>107</td>
</tr>
<tr>
<td>192</td>
<td>12</td>
<td>119</td>
<td>160</td>
<td>122</td>
<td>180</td>
<td>128</td>
</tr>
<tr>
<td>240</td>
<td>15</td>
<td>149</td>
<td>200</td>
<td>153</td>
<td>225</td>
<td>160</td>
</tr>
<tr>
<td>256</td>
<td>16</td>
<td>159</td>
<td>214</td>
<td>163</td>
<td>240</td>
<td>171</td>
</tr>
</tbody>
</table>

Maximum power setting: 1500 mW (4500 mW for IF16)

Power feeding mode: Restricted (that is, Eksos N20 feeds NT + REG + UNI)

**Table 13** Configuration of 15 NTs and 1 NT + REG, with restricted power
### Table 14

Configuration of 15 NTs and 1 NT + REG, with normal power

In Tables 16 and 17, the following power and resistance values have been used.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power NTab</td>
<td>1.7 W</td>
</tr>
<tr>
<td>Loop resistance NTab</td>
<td>1000 Ω</td>
</tr>
</tbody>
</table>

### Table 15

Power and loop resistance values for NTab
### Maximum power setting: 2250 mW

Power feeding mode: Restricted (that is, Eksos N20 feeds NTab + UNI)

#### Table 16  
Configuration of 16 NTabs, with restricted power

<table>
<thead>
<tr>
<th>IFs pcs</th>
<th>Units pcs</th>
<th>60 mErl</th>
<th>125 mErl</th>
<th>250 mErl</th>
<th>500 mErl</th>
<th>1000 mErl</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>$P_{\text{heat}}$ (W)</td>
<td>$P_{\text{tot}}$ (W)</td>
<td>$P_{\text{heat}}$ (W)</td>
<td>$P_{\text{tot}}$ (W)</td>
<td>$P_{\text{heat}}$ (W)</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>10</td>
<td>14</td>
<td>10</td>
<td>16</td>
<td>11</td>
</tr>
<tr>
<td>32</td>
<td>2</td>
<td>20</td>
<td>28</td>
<td>21</td>
<td>32</td>
<td>22</td>
</tr>
<tr>
<td>64</td>
<td>4</td>
<td>40</td>
<td>55</td>
<td>41</td>
<td>65</td>
<td>44</td>
</tr>
<tr>
<td>96</td>
<td>6</td>
<td>60</td>
<td>83</td>
<td>62</td>
<td>97</td>
<td>66</td>
</tr>
<tr>
<td>128</td>
<td>8</td>
<td>70</td>
<td>96</td>
<td>72</td>
<td>113</td>
<td>77</td>
</tr>
<tr>
<td>160</td>
<td>10</td>
<td>100</td>
<td>138</td>
<td>103</td>
<td>161</td>
<td>110</td>
</tr>
<tr>
<td>192</td>
<td>12</td>
<td>120</td>
<td>165</td>
<td>124</td>
<td>194</td>
<td>132</td>
</tr>
<tr>
<td>240</td>
<td>15</td>
<td>150</td>
<td>207</td>
<td>155</td>
<td>242</td>
<td>165</td>
</tr>
<tr>
<td>256</td>
<td>16</td>
<td>160</td>
<td>221</td>
<td>166</td>
<td>258</td>
<td>176</td>
</tr>
</tbody>
</table>

Maximum power setting: 2250 mW

Power feeding mode: Normal (that is, Eksos N20 feeds NTab)

#### Table 17  
Configuration of 16 NTabs, with normal power

<table>
<thead>
<tr>
<th>IFs pcs</th>
<th>Units pcs</th>
<th>60 mErl</th>
<th>125 mErl</th>
<th>250 mErl</th>
<th>500 mErl</th>
<th>1000 mErl</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>$P_{\text{heat}}$ (W)</td>
<td>$P_{\text{tot}}$ (W)</td>
<td>$P_{\text{heat}}$ (W)</td>
<td>$P_{\text{tot}}$ (W)</td>
<td>$P_{\text{heat}}$ (W)</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>10</td>
<td>12</td>
<td>10</td>
<td>12</td>
<td>10</td>
</tr>
<tr>
<td>32</td>
<td>2</td>
<td>19</td>
<td>24</td>
<td>20</td>
<td>25</td>
<td>20</td>
</tr>
<tr>
<td>64</td>
<td>4</td>
<td>39</td>
<td>48</td>
<td>39</td>
<td>49</td>
<td>40</td>
</tr>
<tr>
<td>96</td>
<td>6</td>
<td>58</td>
<td>71</td>
<td>59</td>
<td>74</td>
<td>59</td>
</tr>
<tr>
<td>128</td>
<td>8</td>
<td>68</td>
<td>83</td>
<td>68</td>
<td>86</td>
<td>69</td>
</tr>
<tr>
<td>160</td>
<td>10</td>
<td>97</td>
<td>119</td>
<td>98</td>
<td>124</td>
<td>99</td>
</tr>
<tr>
<td>192</td>
<td>12</td>
<td>117</td>
<td>143</td>
<td>117</td>
<td>148</td>
<td>119</td>
</tr>
<tr>
<td>240</td>
<td>15</td>
<td>146</td>
<td>178</td>
<td>147</td>
<td>185</td>
<td>149</td>
</tr>
<tr>
<td>256</td>
<td>16</td>
<td>155</td>
<td>190</td>
<td>157</td>
<td>198</td>
<td>159</td>
</tr>
</tbody>
</table>
Chapter 5
PSTN mapping

5.1 Recommendations and standards

PSTN mapping is implemented according to the German PSTN mapping.

5.2 Key features

Supported services

Note that all the services listed below are activated in the Local Exchange (LE).

- Sending of CLI (Calling Line Identity) to user terminal
  - The LE sends the subscriber number information of the calling party to the called terminal.
- Sending subscriber private metering information to user terminal.

Ringing types

<table>
<thead>
<tr>
<th>Initial ring</th>
<th>Normal ringing</th>
<th>1.0 s ring, (with notification of the ended sequence)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type 0</td>
<td>Normal ringing</td>
<td>1.0 s ring, 4.0 s pause</td>
</tr>
</tbody>
</table>

Table 18  Ringing types
8.7.14 Management

<table>
<thead>
<tr>
<th>ITU-T</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.773</td>
<td>Management interface Q3</td>
</tr>
<tr>
<td>G.774.01</td>
<td>Synchronous Digital Hierarchy - Performance Monitoring for the Network Element View</td>
</tr>
<tr>
<td>G.774.02</td>
<td>Synchronous Digital Hierarchy - Management information model</td>
</tr>
<tr>
<td>G.826</td>
<td>Error performance and objectives for international, constant bit rate digital paths at or above the primary rate</td>
</tr>
<tr>
<td>M.3100</td>
<td>Generic Network Information Model - Maintenance: Telecommunications Management Network</td>
</tr>
<tr>
<td>M.3400</td>
<td>TMN Management Functions - Maintenance Telecommunications Management Network</td>
</tr>
<tr>
<td>Q.811</td>
<td>Lower layer protocol profiles for the Q3 interface</td>
</tr>
<tr>
<td>Q.812</td>
<td>Upper layer protocol profiles for the Q3 interface</td>
</tr>
<tr>
<td>Q.835</td>
<td>Line and line circuit test management of ISDN and analogue customer access</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ETSI</th>
<th>Recommendation name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETS 300 304</td>
<td>SDH Information Model for the Network Element View</td>
</tr>
<tr>
<td>ETS 300 150</td>
<td>Protocol suites for Q interfaces for management transmission systems equipment</td>
</tr>
<tr>
<td>EN 300 376-1</td>
<td>Q3 interface at the Access Network (AN) for configuration management of V5 interfaces and associated user ports Part 1: Q3 Interface Specification</td>
</tr>
<tr>
<td>EN 300 377-1</td>
<td>Q3 interface at the Local Exchange (LE) for configuration management of V5 interfaces and associated customer profiles Part 1: Q3 Interface Specification</td>
</tr>
<tr>
<td>EN 300 378-1</td>
<td>Q3 interface at the Access Network (AN) for fault and performance management of V5 interfaces and associated user ports Part 1: Q3 Interface Specification</td>
</tr>
<tr>
<td>EN 300 379-1</td>
<td>Q3 interface at the Local Exchange (LE) for fault and performance management of V5 interfaces and associated customer profiles Part 1: Q3 Interface Specification</td>
</tr>
<tr>
<td>ETS 300 795</td>
<td>V interface at the digital Local Exchange (LE); Access Network (AN) supporting V5; Transmission characteristics and performance design objectives for call handling and bearer channel connection management</td>
</tr>
</tbody>
</table>
## Glossary

### Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2B1Q</td>
<td>2 Binary, 1 Quaternary</td>
</tr>
<tr>
<td>4B3T</td>
<td>4 Binary, 3 Ternary</td>
</tr>
<tr>
<td>10Base-2</td>
<td>10 Mbit/s baseband 185 meters per segment Ethernet LAN</td>
</tr>
<tr>
<td>10Base-T</td>
<td>10 Mbit/s baseband Ethernet using twisted pair cabling</td>
</tr>
<tr>
<td>ACL2</td>
<td>Nokia 2 Mbit/s HDSL line terminal</td>
</tr>
<tr>
<td>ACM2</td>
<td>Nokia 2 Mbit/s primary multiplex equipment</td>
</tr>
<tr>
<td>ADM</td>
<td>Add/Drop Multiplexer</td>
</tr>
<tr>
<td>ADSL</td>
<td>Asymmetric Digital Subscriber Line</td>
</tr>
<tr>
<td>AFI</td>
<td>Authority and Format Identifier</td>
</tr>
<tr>
<td>AIS</td>
<td>Alarm Indication Signal</td>
</tr>
<tr>
<td>AN</td>
<td>Access Network</td>
</tr>
<tr>
<td>AUX</td>
<td>Auxiliary</td>
</tr>
<tr>
<td>BCC</td>
<td>Bearer Channel Connection</td>
</tr>
<tr>
<td>BRA</td>
<td>Basic Rate Access</td>
</tr>
<tr>
<td>CCBS</td>
<td>Completion of Calls to Busy Subscribers</td>
</tr>
<tr>
<td>CLI</td>
<td>Calling Line Identity</td>
</tr>
<tr>
<td>CORE2M</td>
<td>Main unit of SAN, with 2 Mbit/s interfaces</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>CRC</td>
<td>Cyclic Redundancy Check</td>
</tr>
<tr>
<td>DCC</td>
<td>Data Communications Channel</td>
</tr>
<tr>
<td>DCE</td>
<td>Data Circuit-terminating Equipment</td>
</tr>
<tr>
<td>DCN</td>
<td>Data Communication Network</td>
</tr>
<tr>
<td>DC-PSA</td>
<td>Nokia DC Power Supply Adapter</td>
</tr>
<tr>
<td>DEG</td>
<td>Degraded signal</td>
</tr>
<tr>
<td>DIU</td>
<td>Data Interface Unit</td>
</tr>
<tr>
<td>DTE</td>
<td>Data Terminal Equipment</td>
</tr>
<tr>
<td>DNT128</td>
<td>Nokia 2 x 64 kbit/s network terminal</td>
</tr>
<tr>
<td>DNT2M</td>
<td>Nokia 2 Mbit/s HDSL network terminal</td>
</tr>
<tr>
<td>DNT2M-G</td>
<td>Nokia 2 Mbit/s G.703/G.704 network terminal</td>
</tr>
<tr>
<td>DXC</td>
<td>Digital Cross-connect</td>
</tr>
<tr>
<td>E&amp;M</td>
<td>Earth/Minus signalling</td>
</tr>
<tr>
<td>ECC</td>
<td>Embedded Communications Channel</td>
</tr>
<tr>
<td>EFD</td>
<td>Event Forwarding Discriminator</td>
</tr>
<tr>
<td>EMC</td>
<td>Electromagnetic Compatibility</td>
</tr>
<tr>
<td>ENM</td>
<td>Eksos Node Manager</td>
</tr>
<tr>
<td>ESD</td>
<td>Electrostatic Discharge</td>
</tr>
<tr>
<td>ETSI</td>
<td>European Telecommunications Standards Institute</td>
</tr>
<tr>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>HDSL</td>
<td>High data rate Digital Subscriber Line</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>IDI</td>
<td>Initial Domain Identifier</td>
</tr>
<tr>
<td>IDSL</td>
<td>ISDN Digital Subscriber Line</td>
</tr>
<tr>
<td>IF</td>
<td>Interface</td>
</tr>
<tr>
<td>IN</td>
<td>Intelligent Network</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>ISDN</td>
<td>Integrated Services Digital Network</td>
</tr>
<tr>
<td>ITU-T</td>
<td>International Telecommunication Union – Telecommunication Standardization Sector</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LE</td>
<td>Local Exchange</td>
</tr>
<tr>
<td>LED</td>
<td>Light-Emitting Diode</td>
</tr>
<tr>
<td>LL</td>
<td>Leased Line</td>
</tr>
<tr>
<td>LMU</td>
<td>Line Measurement Unit</td>
</tr>
<tr>
<td>LOS</td>
<td>Loss Of Signal</td>
</tr>
<tr>
<td>LT</td>
<td>Line Termination</td>
</tr>
<tr>
<td>MEB</td>
<td>Main Earthing Bar</td>
</tr>
<tr>
<td>NCU</td>
<td>Node Control Unit</td>
</tr>
<tr>
<td>NMS</td>
<td>Nokia Network Management System</td>
</tr>
<tr>
<td>NSAP</td>
<td>Network Service Access Point</td>
</tr>
<tr>
<td>NT</td>
<td>Network Termination</td>
</tr>
<tr>
<td>NTM</td>
<td>Nokia Transmission Mechanics, mechanics platform suitable for several network elements</td>
</tr>
<tr>
<td>ODBC</td>
<td>Open Database Connectivity</td>
</tr>
<tr>
<td>OSI</td>
<td>Open Systems Interconnection</td>
</tr>
<tr>
<td>OVP</td>
<td>Over-Voltage Protection</td>
</tr>
<tr>
<td>PABX</td>
<td>Private Automatic Branch Exchange</td>
</tr>
<tr>
<td>PCM</td>
<td>Pulse Code Modulation</td>
</tr>
<tr>
<td>PDH</td>
<td>Plesiochronous Digital Hierarchy</td>
</tr>
<tr>
<td>PE</td>
<td>Protective Earth</td>
</tr>
<tr>
<td>PEN</td>
<td>Protective Earth and Neutral connected together</td>
</tr>
<tr>
<td>PSTN</td>
<td>Public Switched Telephone Network</td>
</tr>
<tr>
<td>Q1 (Q1')</td>
<td>Nokia’s proprietary management interface (= V.11)</td>
</tr>
<tr>
<td>Q3</td>
<td>network-node management interface (ITU-T)</td>
</tr>
<tr>
<td>RDI</td>
<td>Remote Defect Indication</td>
</tr>
<tr>
<td>REG</td>
<td>Regenerator</td>
</tr>
<tr>
<td>SAN</td>
<td>SYNFONET Access Node</td>
</tr>
<tr>
<td>SDH</td>
<td>Synchronous Digital Hierarchy</td>
</tr>
<tr>
<td>SPLL</td>
<td>Semi-permanent Leased Line</td>
</tr>
<tr>
<td>SPS</td>
<td>Signalling Protocols and Switching</td>
</tr>
<tr>
<td>SSF</td>
<td>Server Signal Failed</td>
</tr>
<tr>
<td>STM–1</td>
<td>Synchronous Transport Module, level 1</td>
</tr>
<tr>
<td>T</td>
<td>Unit of width in mechanics, 5.08 mm</td>
</tr>
<tr>
<td>TDM</td>
<td>Time-division Multiplexing</td>
</tr>
<tr>
<td>TE</td>
<td>Terminal Equipment</td>
</tr>
<tr>
<td>TM</td>
<td>Terminal Multiplexer</td>
</tr>
<tr>
<td>TR2M4</td>
<td>4 x 2 Mbit/s interface unit</td>
</tr>
<tr>
<td>TS</td>
<td>Time Slot</td>
</tr>
<tr>
<td>U</td>
<td>Unit</td>
</tr>
<tr>
<td>U</td>
<td>Unit of height in mechanics, 44.45 mm</td>
</tr>
<tr>
<td>UNI</td>
<td>User–network Interface</td>
</tr>
<tr>
<td>VF</td>
<td>Voice Frequency</td>
</tr>
<tr>
<td>WAN</td>
<td>Wide Area Network</td>
</tr>
</tbody>
</table>
Terms

19-inch rack
A rack which is 19 inches wide and conforms to the IEC 297 specification.

access node
A node implemented between the local exchange (LE) and the user, replacing part or the whole of the local line distribution network.

The access node may consist of multiplexing, cross-connect and transmission functions.

active bank
See leased line bank.

actual unit
See expected unit.

aggregate
That side of the node that provides the interfaces towards the centre of network.

alarm indication signal; AIS
A signal which replaces the normal traffic signal when a critical or major alarm indication has been activated.

asymmetric digital subscriber line; ADSL
Technology which enables high speed data communications over existing twisted pair telephone lines and supports downstream data rate of 1.5 to 8 Mbit/s and upstream data rate of 16 kbit/s to 1 Mbit/s.

An ADSL line uses frequency division to separate the PSTN/ISDN channel, enabling simultaneous PSTN/ISDN and ADSL communications and guaranteeing uninterrupted PSTN/ISDN, even if asymmetric digital subscriber line (ADSL) fails.

authority and format identifier; AFI
See NSAP address.

backplane
A printed circuit board of a subrack or cartridge, where the plug-in units are connected. Also known as motherboard.

bearer channel
A channel (64 kbit/s time slot) on a V5-type interface used to carry subscriber traffic.
cable tray
A construction used in Nokia Eksos N20 installations for guiding cables from the front of the node directly into the front of the construction, where they are secured with strain reliefs, and for improving thermal management of the node.

Capacitor Unit
A unit that provides back-up power during short power disturbances.

cartridge
A mechanical housing that fits in a rack and contains plug-in units.

centrex
A service implemented in public telecommunications exchange which enables the subscriber lines connected to the exchange to use the facilities typical for private branch exchanges or key telephone system extensions.

C-channel (communication channel)
A channel (64 kbit/s time slot) on a V5-type interface used for messaging between the node and the local exchange.

commissioning
The process of taking software or hardware into use for the first time.

concentration
Configuration of a V5.2 interface where the number of subscribers is larger than the number of bearer channels.

cross-connection
Either fixed or flexible connection between two termination points with the same data rate.

data communication network; DCN
A telecommunication network mainly meant for transmitting network management data.

A data transmission network can either be a stand-alone network or be a part of or connected to a telecommunication network. It can be a dedicated network or it can use circuits or channels reserved from other telecommunication network.

dry loop
A feature which allows a PSTN/ISDN interface to be isolated from the subscriber loop, after which it can be tested.

earthing
To make an electric connection between a given point in equipment and the Earth. Also referred to as grounding.
EF address
The address of an ISDN subscriber in a V5 interface.

embedded data communication channel
A channel which is provided as an integral part of a communications facility for the purpose of carrying operations messages. Also known as embedded operations channel (EOC).

equipment loopback
A method for testing the operation of an interface in which the outgoing signal is looped back to the input.

ETSI rack
A rack that conforms to the ETSI specification ETS 300 119-3 and accommodates 500 mm wide subracks or 19-inch subracks with adapters.

event
A notification of a change in the state of the node or of a momentary problem, usually in the communication between the node and the local exchange.
An event is not an alarm.

expected unit
A plug-in unit configured as the default unit in a particular slot in a node.
If the plug-in unit actually installed in the slot (actual unit) differs from the expected unit, the node will send an Unit Mismatch alarm.

extension board
A board at the back of a subrack or cartridge which makes the connectors more easily accessible and includes connectors for station alarms, service switch, test buses, SV1 measurement, overvoltage protection, power supply, fans and signalling voltage.

Extension Unit
A unit that provides four additional outputs for DC-PSA.
Extension Unit is needed, for example, in racks that contain four Nokia Eksos N20 subracks.

Fan Unit
A unit providing forced air circulation for a variety of telecommunications equipment installed in IEC and ETSI compliant mechanical constructions.

fatal error
An unexpected condition where signal transfer is no longer possible.
forced convection
A cooling method which is based on using an external agency to maintain the airflow in a device.

grading message
A message from the node to the local exchange about degraded ISDN line quality.

granularity
The bit rate at which a cross-connection is made.

In Nokia Eksos N20 the granularity is 64 kbit/s, that is, one time slot of a 2 Mbit/s signal. This means that even if a data interface is configured for 9.6 kbit/s it will be cross-connected at 64 kbit/s.

grooming
The merging of partially filled transmission lines into almost fully utilised lines for increased transmission effectivity.

In Nokia Eksos N20, grooming can be used for collecting V5.1 traffic to a V5.2 interface.

grounding
See earthing.

high bit rate digital subscriber line; HDSL
Broadband technology based on copper cables, carrying out a high-rate symmetric digital subscriber connection with two copper cable pairs.

hot insert
A feature enabling to detect, configure and use hardware that has been added to a node while it is actively running.

inactive bank
See leased line bank.

Indoor Access Cabinet
A construction system for housing access node equipment, such as Nokia Eksos N20 and the DYNANET products, providing the subscriber lines to customers.

initial domain identifier; IDI
See NSAP address.

installation
The assembly of constructional parts into a cartridge, subrack and rack, carried out before commissioning.
interface loopback
A method for testing the operation of an interface in which the incoming signal is looped back to the output.

ISDN digital subscriber line; IDSL
An xDSL service based on the use of standard ISDN 2B+D transmission technology. It provides (typically frame relay) data access with variable bit rate including 64 kbit/s and 128 kbit/s.

L3 address
An address identifying a PSTN subscriber port within a V5 interface.

leased line
A permanent connection between two interfaces which is not routed through a local exchange.

leased line bank
A set of leased lines stored in the node.

Nokia Eksos N20 contains two banks, one of which is always active.

link
A 2 Mbit/s interface used for communicating with the local exchange.

In Nokia Eksos N20, link is a 2 Mbit/s interface used for V5 transmission. Within V5.2, links have unique IDs, whereas within V5.1, links have no IDs.

See also primary link and secondary link.

motherboard
See backplane.

multihosting
A feature which enables the same node to be connected to several different local exchanges via separate V5.2 interfaces. It is used for load balancing or taking advantage of the services offered by various local exchanges.

natural convection
A cooling method which is based on the physical phenomenon of warmer air having a smaller density than colder air, resulting in an upward flow of hot air.

NMS
System for controlling and monitoring network elements, for recording their use and performance, in order to provide telecommunications services.

node master
A node control unit (NCU) performing the configuration, data communication network (DCN) and synchronisation related functions.
NSAP address
The address of the node in the data communication network (DCN).

In Nokia Eksos N20, the NSAP address consists of the system ID, authority and format identifier (AFI), initial domain identifier (IDI) and area address.

on demand line testing
A set of line tests to be performed immediately to one or several interfaces.
See also scheduled line testing.

OSI-DCN Adaptor
A plug-in unit used to build data communications network between network elements and the management site. Together with the cross-connection function, the OSI-DCN Adaptor grooms several embedded communication channels (ECCs) into a single 2 Mbit/s connection and passes these to an OSI router via Ethernet, where protocol stacks are similar.

Outdoor Cabinet
A roadside cabinet that houses, for example, Nokia Eksos N20 and DYNANET products.

primary link
A 2 Mbit/s link carrying vital signalling.
See also secondary link.

product code
A code which is used for identifying sales items: plug-in units, programs, manuals etc. Example: T30000.01.

product release
A letter by which the different releases of a product or its part can be identified and separated from each other.
Example: product identification T30000.01 A, where ‘T30000.01’ is the product code and ‘A’ is the product release. The first release of each product is ‘A’, and when the product is enhanced or otherwise changed, the release is incremented (to ‘B’, ‘C’...). See also system release.

PSTN mapping
The usually country-specific definition of the relationship between analog PSTN signalling elements and the V5 protocol.

Q1
A serial protocol used in transferring management information to and from a network element.

Q1 is Nokia’s proprietary management protocol.
Q1 master
The computer (PC) used for managing Q1 nodes.

Q1 slave
A node managed by the Q1 master.

Q1 summing point
A virtual point in the network where the traffic from Q1 slaves is collected together and forwarded to the Q1 master in one leg.

Q3
A set of OSI 7 standard definitions for the transfer of management information to and from a network element across the telecommunications management network q reference point.

rack alarm
An alarm in one of the equipment in the rack indicated by a common alarm lamp. There are three types of rack alarms: A-alarms (prompt), B-alarms (deferred) and D-alarms (reminders of alarm cancellation). Also known as station alarm.

release
See system release and product release.

scheduled line testing
Line tests performed to one or several interfaces at pre-defined dates, times and intervals.

See also on demand line testing.

secondary link
A stand-by 2M link used for protection of vital signalling.

See also primary link.

semi-permanent leased line; SPLL
A permanent connection provided between two user-network interfaces routed through the local exchange.

service switch
A feature which enables changing subscriber services via the management system, instead of switching the physical connection cables.

signalling
In Nokia Eksos N20, communication between the node and the local exchange.
signalling protection
A configuration in which hardware resources are reserved for taking over in case some other hardware fails.
See also V5 protection.

splitter
An analog device for dividing a combined PSTN/ADSL input signal into a PSTN and an ADSL output signal or combining a PSTN and an ADSL input signal together into one output signal.

stand-by time slot
A time slot protecting another time slot carrying ISDN or PSTN signalling.

subrack
A mechanical housing that fits in a rack and contains plug-in units.

switched service
A service which is connected through the network on the basis of the telephone number dialled.

system release
Defines the system and equipment level functionality and compatibility. See also product release.

tributary
That side of the node that provides the interfaces towards the subscriber.

U-interface
An interface between an ISDN network termination equipment (NT1) and the local exchange.

user port
In Nokia Eksos N20, a POTS or ISDN interface which is taken into V5 use and provided with a telephone number.

user port blocking
A feature used for discontinuing the functioning of a user port on account of unpaid telephone bills, for example.

V5
A signalling interface between an access node and local exchange using 64 kbit/s channels and 2 Mbit/s links.
There are two variants of V5: V5.1 and V5.2.
**V5 master**
A node control unit (NCU) dedicated for a V5.2 interface, executing the actual V5.2 software.

**V5 protection**
A feature which enables to move signalling to another link if there is a problem with the link carrying the C-channel.

**V5 slave**
A node control unit (NCU) providing additional 2 Mbit/s interfaces for a V5.2 interface.

**V5.1 to V5.2 conversion**
Application where the user ports of one or more V5.1 interfaces are presented as normal user ports to a V5.2 interface.

**V5.1 interface**
A static multiplexer interface between the local network and subscribers who physically belong to a separate subscriber network.

The V5.1 interface is designed in accordance with the standard ETS 300 324-1 and it supports analog subscriber lines, ISDN basic rate access and semi-permanent connections. In V5.1 the bearer channels for user ports are allocated statically.

**V5.2 interface**
A dynamic concentrator interface between the local network and subscribers who physically belong to a separate subscriber network.

The V5.2 interface is designed in accordance with the standard ETS 300 327-1 and it supports analog subscriber lines, ISDN basic rate access and semi-permanent connections. V5.2 can supply a maximum of sixteen 2 Mbit/s lines and channel protection. In V5.2 the bearer channels for user ports are allocated dynamically.

**vital signalling**
Communication between the node and the local exchange, excluding POTS and ISDN signalling, used for keeping the connection up and running.

**vital stand-by**
The time slot that is used to protect the time slot carrying vital signalling.

**Wall Mounting Set**
A mechanical construction for mounting a 17-slot Nokia Eksos N20 node in a small location.

In addition to the subrack, the Wall Mounting Set can also accommodate a DC-PSA, Fan Unit and cross-connection panel.
Index

Numbers

2 Mbit/s interface, connector pinout (TR2M4):
Installation 72

2 Mbit/s interfaces, connector pinout (NCU):
Installation 61

2M interfaces, configuring:
Comm. and Maintenance 25

2M links
adding to existing V5 interface:
Comm. and Maintenance 60
configuring in V5.1:
Comm. and Maintenance 47
configuring in V5.2:
Comm. and Maintenance 40
primary: Comm. and Maintenance 43

2M-LOS:
Comm. and Maintenance B-10–B-12

2M-RDI:
Comm. and Maintenance B-13

2M-SSF:
Comm. and Maintenance B-14

2M-AIS:
Comm. and Maintenance B-1

addresses
EF:
Comm. and Maintenance 58
L3:
Comm. and Maintenance 58
NSAP:
Comm. and Maintenance 22, A-5
advanced settings, V5.1, configuring:
Comm. and Maintenance 45
advanced settings, V5.2, configuring:
Comm. and Maintenance 37

AFI:
Comm. and Maintenance 22

alarm cables:
Installation 21, 29

Alarm Indication Signal:
Comm. and Maintenance B-1

Alarm Input:
Comm. and Maintenance B-2

Alarm List Incomplete:
Comm. and Maintenance B-2

alarm log, setting:
Comm. and Maintenance 71

alarm thresholds:
Comm. and Maintenance 36
configuring:
Comm. and Maintenance 53

A

abbreviations. See Glossary

access levels:
Comm. and Maintenance A-7
setting:
Comm. and Maintenance A-9

actual unit in slot:
Comm. and Maintenance 25

Add Manual Adjacency dialog box:
Comm. and Maintenance 30
alarms
  alarm connector pinout:
    Installation 31
  colour codes in Node Manager:
    Comm. and Maintenance 94
configuring:
  Comm. and Maintenance 96
  current alarms list:
    Comm. and Maintenance 71, 97
descriptions:
  Comm. and Maintenance B-1
disabling:
  Comm. and Maintenance 95
managing with Node Manager:
  Comm. and Maintenance 96
messages:
  Comm. and Maintenance B-1
rack:
  Comm. and Maintenance 95
severity:
  Comm. and Maintenance 95
severity classes:
  Comm. and Maintenance 93
alarm inputs, external:
  Product Description 19
analog inputs, configuring:
  Comm. and Maintenance 35
anti-static precautions:
  Installation 4
application window:
  Comm. and Maintenance A-11
applications, introduced in release C2.0:
  System Rel. Notes 2
AUX interface, connector pinout:
  Installation 79
AUX management interface, connector pinout:
  Installation 63
blanking plates, fitting:
  Installation 87
block status, viewing:
  Comm. and Maintenance 77

C
  C-channel, ID:
    Comm. and Maintenance 43
  C-channel, signalling settings:
    Comm. and Maintenance 43
  C-channel, V5.1, configuring:
    Comm. and Maintenance 47
  C-channel, V5.2, configuring:
    Comm. and Maintenance 42
cable ties:
    Installation 11–13, 88
cable trays:
    Product Description 50
    Installation 53–56
mounting to rack:
    Installation 54–56
  tying cables to:
    Installation 91
cables
  alarm:
    Installation 21, 29
earting:
    Installation 49
  Ethernet:
    Installation 50
grounding:
    Installation 49
  marking:
    Installation 13–15
  order codes:
    Installation 21, 29
  power:
    Installation 21, 29
  routing in the rack:
    Installation 11–13
types used in Eksos N20:
    Installation 58–60
cabling
  Data Interface Unit:
    Installation 89
  Ethernet:
    Installation 101–104
  optical:
    Installation 15
  plug-in units:
    Installation 88

B
  back-up, configuration:
    Comm. and Maintenance A-15
  Backup Fail:
    Comm. and Maintenance B-2
balanced interface:
  Installation 93–95
BCC Protocol Syntax Error:
  Comm. and Maintenance B-2
bearer channel allocation:
  Product Description 7
BKUP:
  Comm. and Maintenance B-2
cabling space:
*Installation 7*

Calling Line Identification (CLI):
*Country Specific Instr. 15*

Capacitor Unit, use:
*Product Description 47*

capacity of Eksos N20:
*Product Description 7*

cartridge
attaching to shelf:
*Installation 45*
construction:
*Installation 41*
dimensions:
*Installation 41*
installation:
*Installation 41*
mounting onto cartridge shelf:
*Installation 43*
unit locations:
*Installation 84*

cartridge extension board:
*Installation 30*

cartridge extension board connectors, specifications:
*Product Description 60*

cartridge shelf:
*Installation 43*
installing:
*Installation 42*

cartridges, Eksos N20:
*Product Description 48*
dimensions:
*Product Description 49*

CCH:
*Comm. and Maintenance  B-3*

Cessation of Flags on a C-channel:
*Comm. and Maintenance  B-3*

changing node settings:
*Comm. and Maintenance  24*

clearing node configuration data:
*Comm. and Maintenance  91*

closing the node manager:
*Comm. and Maintenance  90*

CMFP:
*Comm. and Maintenance  B-3*

coaxial 2 Mbit/s interface (SAN), connector pinout:
*Installation 78*

coaxial connectors, on TR2M4:
*Installation 72*

coding block:
*Installation 82*

commissioning
basic procedure:
*Comm. and Maintenance  5*

basic settings:
*Comm. and Maintenance  4–6*

general procedure:
*Comm. and Maintenance  3*

leased lines:
*Comm. and Maintenance  13*

requirements:
*Comm. and Maintenance  4*

scheduled line testing:
*Comm. and Maintenance  14*

service switch:
*Comm. and Maintenance  11–13*

V5.1/V5.2 converter:
*Comm. and Maintenance  9–11*

V5.2 multiplexer:
*Comm. and Maintenance  6–9*

communications failure:
*Comm. and Maintenance  A-19*

compatibility, internal:
*System Rel. Notes  1*

Compatibility Failure:
*Comm. and Maintenance  B-3*

compatibility of Eksos N20, with other products:
*System Rel. Notes  1*

concentration, network:
*Product Description  24*

configuration back-up:
*Comm. and Maintenance  A-15*

configuring
2M interfaces:
*Comm. and Maintenance  25*

alarm inputs:
*Comm. and Maintenance  33*

alarm outputs:
*Comm. and Maintenance  34*

alarms:
*Comm. and Maintenance  96*

analog inputs:
*Comm. and Maintenance  35*

cross-connections:
*Comm. and Maintenance  67*

DC set:
*Comm. and Maintenance  49*

DIU interfaces:
*Comm. and Maintenance  65*

ISDN interfaces:
*Comm. and Maintenance  51*

management channels:
*Comm. and Maintenance  29*
PSTN interfaces:
Comm. and Maintenance 49

service switch:
Comm. and Maintenance 61

speech settings:
Comm. and Maintenance 49

stack settings:
Comm. and Maintenance A-6

user ports:
Comm. and Maintenance 56

V5 interface:
Comm. and Maintenance 37

V5.1 interface:
Comm. and Maintenance 45

V5.2 interface:
Comm. and Maintenance 37

connecting
Eksos N20 to SAN:
Installation 91–94

external synchronisation interfaces:
Installation 93–95

interfaces:
Installation 57

management cables:
Comm. and Maintenance 18

power supply:
Installation 19

service switch cables:
Installation 95–98

station alarms:
Installation 19

connecting Node Manager to node:
Comm. and Maintenance 20

connector carriers, inserting and replacing:
Installation 88–90

connector pinout
AUX interface:
Installation 79

AUX management interface:
Installation 63

external supervisory interface:
Installation 64

e external test access interface:
Installation 66

fan:
Installation 27

fan and alarm:
Installation 31

G.703 interface:
Installation 76

ISDN interface:
Installation 70

LMU. See connector pinout, NCU

NCU:
Installation 61–65

power:
Installation 26, 32

PSTN interface:
Installation 68–70

Q1 management interface:
Installation 63

Q3 management interface:
Installation 64

SAN CORE2M coaxial 2 Mbit/s interface:
Installation 78

SAN CORE2M symmetrical 2 Mbit/s
interface:
Installation 78

service switch:
Installation 24

signalling voltage:
Installation 26, 32

SR synchronisation interface (SAN):
Installation 79

ST synchronisation interface (SAN):
Installation 80

station alarm outputs:
Installation 23, 31

SV1 measurement:
Installation 25

test bus:
Installation 25

TR2M4 unit:
Installation 72

V.xx interface (DIU):
Installation 74

X.21 interface (DIU):
Installation 75

connectors
DIU:
Installation 73

ISDN unit:
Installation 67

LMU:
Installation 65

NCU:
Installation 60

PSTN unit:
Installation 67

SAN CORE2M:
Installation 77

TR2M4:
Installation 71

Control Protocol Syntax Error:
Comm. and Maintenance B-3

Control Protocol Time Out:
Comm. and Maintenance B-3

conversion from V5.1 to V5.2:
Product Description 24

cooling

forced convection:
Product Description 41
natural convection:  
Product Description 40

CORE2M unit:  
Installation 77
interaces:  
Product Description 44

creating V5 interface:  
Comm. and Maintenance 37

Critical Fan Failure:  
Comm. and Maintenance B-4

cross-connect function:  
Product Description 10

current alarms list:  
Comm. and Maintenance 71

D

Data folder:  
Comm. and Maintenance A-2

Data Interface Unit  
cabling:  
Installation 89
configuring interfaces:  
Comm. and Maintenance 65
connecting cables to:  
Installation 90
connector pinout:  
Installation 74–77
connectors:  
Installation 73
EMC in cabling:  
Installation 89
loopback tests:  
Comm. and Maintenance 85

Database folder:  
Comm. and Maintenance A-3

DC set:  
Country Specific Instr. 3, 8
configuring:  
Comm. and Maintenance 49

DC-PSA, features:  
Product Description 47

DCN channels, setting:  
Comm. and Maintenance 29

defects, corrected:  
System Rel. Notes 4

DEG:  
Comm. and Maintenance B-4

DEG alarm parameters:  
Comm. and Maintenance 53

Degraded Signal:  
Comm. and Maintenance B-4

digital inputs, configuring:  
Comm. and Maintenance 33
digital outputs, configuring:  
Comm. and Maintenance 34
dimensions, mechanical:  
Product Description 60
direct battery, PSTN:  
Country Specific Instr. 9

DIU unit, interfaces:  
Product Description 45

DLF:  
Comm. and Maintenance B-16, B-17, B-18, B-20
downloading software, with Node Manager:  
Comm. and Maintenance 101

Dying Gasp:  
Comm. and Maintenance B-4

E

earth loops:  
Installation 47

earthling:  
Installation 49
Ethernet cables:  
Installation 50
multiple racks:  
Installation 47–49
protective:  
Installation 47
rack:  
Installation 49
station:  
Installation 47
subrack:  
Installation 50
wrist strap:  
Installation 85
earthing bus conductor:  
Installation 49
earthing wire, minimum cross-section:  
Installation 50

EBOF:  
Comm. and Maintenance B-5

EF addresses:  
Comm. and Maintenance 58

EksosNM2.0 folder:  
Comm. and Maintenance A-2

Eksos Node Manager window:  
Comm. and Maintenance A-11
electrical cables
  precautions:  
    Installation 5
routing:  
    Installation 11
  tying to cable trays:  
    Installation 91

electro-static discharge (ESD), sensitivity to ESD:  
    Installation 4

EMC:  
  Installation 81, 87, 108
EMC gasket:  
  Installation 94
  in cabling DIUs:  
    Installation 89
specifications:  
  Product Description 63, 64
equipping recommendations  
  for a 17-slot subrack:  
    Installation 34–36
  for an 8-slot cartridge:  
    Installation 43–45
ESD. See electro-static discharge

Ethernet cable, connecting Node Manager to node:  
  Comm. and Maintenance 18
Ethernet cables  
  connecting to service connector panel:  
    Installation 40
  earthing:  
    Installation 50
  terminating:  
    Installation 40
Ethernet cabling:  
  Installation 101–104

Event Buffer Overflow:  
  Comm. and Maintenance  B-5
event history log:  
  Comm. and Maintenance 71
  clearing:  
    Comm. and Maintenance 73
  setting up:  
    Comm. and Maintenance 73
  viewing:  
    Comm. and Maintenance 72
EXC:  
    Comm. and Maintenance  B-5
Excessive Bit Error Ratio:  
    Comm. and Maintenance  B-5
exiting from the Node Manager:  
    Comm. and Maintenance 89–91

expected unit in slot:  
  Comm. and Maintenance 25
extension board, functions:  
  Product Description 36
Extension Unit:  
  Product Description 47
external alarms:  
  Product Description 19
  configuring:  
    Comm. and Maintenance 32–34
external supervisory interface, connector pinout:  
  Installation 64
external synchronisation interfaces, connecting:  
  Installation 93–95
external test access interface, connector pinout:  
  Installation 66

F
FAIL:  
  Comm. and Maintenance  B-16
FAN:  
  Comm. and Maintenance  B-4,  B-5
Fan Failure:  
  Comm. and Maintenance  B-5
Fan Unit, installing:  
  Installation 105
Far End Block Error:  
  Comm. and Maintenance  B-5
fault messages:  
  Comm. and Maintenance 93
fault tolerance:  
  Product Description 13
features, introduced in release C2.0:  
  System Rel. Notes 2
features of Eksos N20:  
  Product Description 5–9
FEBE:  
  Comm. and Maintenance  B-5
Feeding Current Short Circuit:  
  Comm. and Maintenance  B-6
Feeding Power Overload:  
  Comm. and Maintenance  B-6
Feeding Power Supply Failure:  
  Comm. and Maintenance  B-6
feeding voltage, to ISDN line:  
  Country Specific Instr. 11
Feeding Voltage Failure:
  Comm. and Maintenance  B-6

fibre cable reels, installing:
  Installation 17

files
  loading data from:
    Comm. and Maintenance  A-17–A-19
  saving data to:
    Comm. and Maintenance  A-15–A-17

FORC:
  Comm. and Maintenance  B-15

forced convection:
  Product Description 41

FPO:
  Comm. and Maintenance  B-6

FPS:
  Comm. and Maintenance  B-6

FPSF:
  Comm. and Maintenance  B-6

front cover
  alignment:
    Installation 108
  attaching:
    Installation 108
  detaching:
    Installation 108

front grilles, installing:
  Installation 107

FVF:
  Comm. and Maintenance  B-6

G

G.703 interface, connector pinout:
  Installation 76

General Problem DNT:
  Comm. and Maintenance  B-7

GPD:
  Comm. and Maintenance  B-7

grading message:
  Comm. and Maintenance 58

ground loops:
  Installation 47

grounding:
  Installation 47

Ethernet cables:
  Installation 50

multiple racks:
  Installation 47–49

rack:
  Installation 49

station:
  Installation 47

subrack:
  Installation 50

grounding wire, minimum cross-section:
  Installation 50

Group Memberships dialog box:
  Comm. and Maintenance  A-9

GSP:
  Comm. and Maintenance  B-4

H

Help, online:
  Comm. and Maintenance  A-14

hot insert feature:
  Product Description 19

I

IBOU:
  Comm. and Maintenance  B-7

IDI:
  Comm. and Maintenance 22, A-5

IDs
  C-channel:
    Comm. and Maintenance 43
  link:
    Comm. and Maintenance 41
  V5.1 interface:
    Comm. and Maintenance 45
  V5.2 interface:
    Comm. and Maintenance 38

impedance pairs:
  Country Specific Instr. 4, 9

In Test:
  Comm. and Maintenance  B-7

INF folder:
  Comm. and Maintenance  A-3

Information window:
  Comm. and Maintenance 23

Input Buffer Overflow/Underflow:
  Comm. and Maintenance  B-7

installation
  procedure:
    Installation 7
  task list:
    Installation 7

thermal management, in open racks:
  Product Description 40
tools:
   Installation 9

installation options:
   Product Description 35

Installation Wizard:
   Comm. and Maintenance 21

installation wizard:
   Comm. and Maintenance 20

installation, thermal management, in cabinets:
   Product Description 42

installing
   air deflectors:
      Installation 107
   cable trays:
      Installation 53–56
   cartridge:
      Installation 44
   Fan Unit:
      Installation 105
   front grilles:
      Installation 107
   plug-in units, work procedure:
      Installation 81
   service connector panel:
      Installation 40
   subrack front cover:
      Installation 108

installing
   cartridge:
      Installation 41
   cartridge onto a cartridge shelf:
      Installation 43
   cartridge shelf:
      Installation 42
   subrack:
      Installation 33
   subrack to rack:
      Installation 34–37

installing units in a node:
   Comm. and Maintenance 22, 24–26

Interface Broken:
   Comm. and Maintenance B-8

interface tests:
   Comm. and Maintenance 82, 85

interface types:
   Product Description 33

interface units:
   Product Description 44

Interfaces, synchronisation interface, pinout:
   Installation 62

interfaces
   2 Mbit/s interface, pinout (NCU):
      Installation 61
   AUX interface, pinout:
      Installation 79
   coaxial 2 Mbit/s interface, pinout:
      Installation 78
   connecting:
      Installation 57
   external supervisory interface, pinout:
      Installation 64
   external test access interface, pinout:
      Installation 66
   fan:
      Installation 22, 30
   G.703 interface, pinout:
      Installation 76
   ISDN U-interface, pinout:
      Installation 70
   power supply:
      Installation 22, 30
   PSTN interface, pinout:
      Installation 68–70
   Q1/AUX management interface, pinout:
      Installation 63
   Q3 interface, pinout:
      Installation 64
   signalling voltage:
      Installation 22, 30
   service switch:
      Installation 22, 30
   station alarm:
      Installation 22, 30
   SV1 measurement:
      Installation 22, 30
   symmetrical 2 Mbit/s interface, pinout:
      Installation 78
   synchronisation interface, pinout:
      Installation 79–81
   test bus:
      Installation 22, 30
   TR2M4 2 Mbit/s interface:
      Installation 72
   V.xx interface, pinout:
      Installation 74
   viewing:
      Comm. and Maintenance 55
   X.21 interface, pinout:
      Installation 75

ISDN
   configuring user ports:
      Comm. and Maintenance 56
   DEG alarm:
      Comm. and Maintenance 53
   line feeding voltage:
      Comm. and Maintenance 51;
      Country Specific Instr. 11
   maximum power:
      Comm. and Maintenance 52
ISDN BRA unit, features:
   Product Description 45
ISDN interfaces, configuring:
   Comm. and Maintenance 51
ISDN loopback tests:
   Comm. and Maintenance 82
ISDN remote tests:
   Comm. and Maintenance 84
ISDN U-interface, connector pinout:
   Installation 70
ISDN unit
   connectors:
      Installation 67
   power consumption:
      Country Specific Instr. 11–15
ISDN user ports, configuring:
   Comm. and Maintenance 56

J
jumper settings
   17-slot subrack:
      Installation 20
   8-slot cartridge:
      Installation 28
jumpers, default positions:
   Installation 21, 29

L
L3 addresses:
   Comm. and Maintenance 58
L3AD:
   Comm. and Maintenance B-18, B-19, B-21
laser safety:
   Installation 3
leased line applications:
   Product Description 9
leased line bank:
   Comm. and Maintenance 68;
   Product Description 10
   managing:
      Comm. and Maintenance 70
leased lines
   commissioning procedure:
      Comm. and Maintenance 14
   commissioning requirements:
      Comm. and Maintenance 13
   configuring:
      Comm. and Maintenance 67
   deleting:
      Comm. and Maintenance 70
   editing:
      Comm. and Maintenance 68
   LEDs
      flashing:
         Comm. and Maintenance 95
      green:
         Comm. and Maintenance 94
      red:
         Comm. and Maintenance 94
      yellow:
         Comm. and Maintenance 94
levels, input and output:
   Country Specific Instr. 4, 10
LGOF:
   Comm. and Maintenance B-8
LID:
   Comm. and Maintenance B-18
line attenuation:
   Country Specific Instr. 10
line coding types in ISDN BRA:
   Product Description 45
line feeding settings, PSTN:
   Country Specific Instr. 3, 4, 8
line lengths, recommended for PSTN:
   Country Specific Instr. 10
Line Test Manager:
   Product Description 29
line testing
   See also LMU; on-demand line tests,
   scheduled line tests
   features supported:
      Product Description 13
   scheduled:
      Product Description 13
   tests supported:
      Comm. and Maintenance 78
Link Control Protocol Syntax Error:
   Comm. and Maintenance B-8
Link Control Protocol Time Out:
   Comm. and Maintenance B-8
link ID:
   Comm. and Maintenance 41
LMU
   connector pinout. See connector pinout, NCU
   connectors:
      Installation 65
   features:
      Product Description 44
   function:
      Product Description 44
loading data from file:
Comm. and Maintenance A-17–A-19
locking clamps:
Installation 86
LOF:
Comm. and Maintenance B-9
LOFS:
Comm. and Maintenance B-10
Log Overflow:
Comm. and Maintenance B-8
loopback tests
aborting:
Comm. and Maintenance 85
cancelling:
Comm. and Maintenance 85
DIU:
Comm. and Maintenance 85
ISDN:
Comm. and Maintenance 82
Loss of Frame:
Comm. and Maintenance B-9
Loss of Multiframe:
Comm. and Maintenance B-9
Loss of Octet Timing:
Comm. and Maintenance B-9
Loss of Signal:
Comm. and Maintenance B-10–B-12
Loss of Timing Information:
Comm. and Maintenance B-11
Loss of V.110 Frame Synchronisation:
Comm. and Maintenance B-10
LOT:
Comm. and Maintenance B-9
LTI:
Comm. and Maintenance B-11

M

MAIN:
Comm. and Maintenance B-11
main application window:
Comm. and Maintenance A-11
main earthing bar (MEB):
Installation 49
main menus of Eksos N20 Node Manager:
Comm. and Maintenance A-20
Maintenance State:
Comm. and Maintenance B-11
Manage Node window:
Comm. and Maintenance 20
management channels, setting:
Comm. and Maintenance 29
management tools
Line Test Manager:
Product Description 29
Node Manager:
Product Description 28
Nokia NMS:
Product Description 28
OSI-DCN Adaptor:
Product Description 30
mapping, V5.2, selecting:
Comm. and Maintenance 43
marking accessories, recommended:
Installation 13
MEB. See main earthing bar
MISM:
Comm. and Maintenance B-16
MISS:
Comm. and Maintenance B-16
mounting
cable tray to rack:
Installation 54–56
Fan Unit:
Installation 105
strain reliefs:
Installation 11
mounting brackets:
Installation 105
in earthing:
Installation 50
multihosting:
Product Description 7, 22

N

natural convection:
Product Description 40
NCU
connector pinout:
Installation 61–65
connectors:
Installation 60
features:
Product Description 43
interfaces:
Product Description 43
power consumption:
Country Specific Instr. 5
network terminals supported:
Product Description 11
node address:
Comm. and Maintenance 22

node applications
leased line:
Product Description 25
scheduled line testing:
Product Description 26
service switch:
Product Description 24
V5.1 to V5.2 converter:
Product Description 24
V5.2 multiplexer:
Product Description 22

node architecture:
Product Description 34

node clock
calibrating:
Comm. and Maintenance 27
real time:
Comm. and Maintenance 22

Node Control Unit. See NCU

node data
clearing configuration:
Comm. and Maintenance 91
editing:
Comm. and Maintenance A-14
printing:
Comm. and Maintenance A-18
saving:
Comm. and Maintenance A-15–A-18

node information, updating:
Comm. and Maintenance 23

node installation wizard:
Comm. and Maintenance 20

Node Manager:
Product Description 28
aborting an operation:
Comm. and Maintenance A-19
access levels:
Comm. and Maintenance A-7
alarm management:
Comm. and Maintenance 96
closing connection to node:
Comm. and Maintenance 89
closing down:
Comm. and Maintenance 90
connecting cable to node:
Comm. and Maintenance 18
connecting to node:
Comm. and Maintenance 20
directory structure:
Comm. and Maintenance A-2
FAQs:
Comm. and Maintenance A-10
installation procedure:
Comm. and Maintenance A-4
main menus:
Comm. and Maintenance A-20
operating:
Comm. and Maintenance A-13
overview:
Comm. and Maintenance A-11
starting:
Comm. and Maintenance 19
system requirements:
Product Description 66
toolbar icons:
Comm. and Maintenance A-12
troubleshooting installation:
Comm. and Maintenance A-10
troubleshooting operation:
Comm. and Maintenance A-19–A-21

node settings
changing:
Comm. and Maintenance 24
viewing:
Comm. and Maintenance 24

node size:
Product Description 7

Node Subrack window:
Comm. and Maintenance 19, A-11
uses:
Comm. and Maintenance A-11

Nokia Applications folder:
Comm. and Maintenance A-3

Nokia TP4 Protocol Stack dialog box:
Comm. and Maintenance A-6

NOKIAMGR folder:
Comm. and Maintenance A-2

normal feed, PSTN:
Country Specific Instr 8

NSAP address:
Comm. and Maintenance 22, A-5
changing:
Comm. and Maintenance A-7
updating:
Comm. and Maintenance 23

O

on-demand line tests
See also line testing
DIU loopback:
Comm. and Maintenance 85
ISDN loopback tests:
Comm. and Maintenance 82
ISDN remote:
  *Comm. and Maintenance* 84
performing:
  *Comm. and Maintenance* 80

online help:
  *Comm. and Maintenance* A-14

operating voltages, PSTN:
  *Country Specific Instr.* 4

optical fibres
  and strain reliefs:
    *Installation* 15
bending radius:
  *Installation* 15
cable reels:
  *Installation* 15, 17
guiding tubes:
  *Installation* 16
handling:
  *Installation* 15
laying:
  *Installation* 15
precautions:
  *Installation* 5
routing:
  *Installation* 11, 15, 16
types:
  *Installation* 58

order codes, marking accessories:
  *Installation* 13

ordering documents:
  *Guide to Documentation* 4

OSI-DCN Adaptor:
  *Product Description* 30

**P**

PBKN:
  *Comm. and Maintenance* B-8

performance monitoring
configuring:
  *Comm. and Maintenance* 74
viewing data:
  *Comm. and Maintenance* 75
viewing history data:
  *Comm. and Maintenance* 76

pins. See connector pinout

plug-in units
cabling:
  *Installation* 88
how to handle:
  *Installation* 4, 85
installing in a node:
  *Comm. and Maintenance* 24–26
installing into subrack:
  *Installation* 86–88

installing, work procedure:
  *Installation* 81
uninstalling:
  *Comm. and Maintenance* 24
unit locations:
  *Installation* 82–85

polarity reversal time, PSTN:
  *Country Specific Instr.* 9

Port Control Protocol Layer 3 Address Error:
  *Comm. and Maintenance* B-12

POW:
  *Comm. and Maintenance* B-12

power cables:
  *Installation* 21, 29

power consumption
ISDN:
  *Country Specific Instr.* 11–15
NCU:
  *Country Specific Instr.* 5
PSTN:
  *Country Specific Instr.* 5

Power Problem:
  *Comm. and Maintenance* B-12

power supply
connecting:
  *Installation* 19
distribution:
  *Installation* 20

power supply options
DC-PSA:
  *Product Description* 36
Extension Unit:
  *Product Description* 36

power supply panel:
  *Installation* 22, 30

powering the node:
  *Comm. and Maintenance* 17

PPO:
  *Comm. and Maintenance* B-12

precautions
anti-static:
  *Installation* 4, 7
electrical cables:
  *Installation* 5
handling plug-in units:
  *Installation* 4
laser safety:
  *Installation* 3
optical fibres:
  *Installation* 5
sensitivity to electro-static discharge (ESD):
  *Installation* 4
primary link:
Comm. and Maintenance 43

Primary Power Out:
Comm. and Maintenance B-12

printing data:
Comm. and Maintenance A-18

priority
alarm:
Comm. and Maintenance 95
synchronisation:
Comm. and Maintenance 26

priviledges, user:
Comm. and Maintenance A-7

product release, definition:
Glossary Glossary-8

PROT:
Comm. and Maintenance B-17, B-19

protecting signalling:
Comm. and Maintenance 43

Protection Protocol Syntax Error:
Comm. and Maintenance B-12

Protection Protocol Time Out:
Comm. and Maintenance B-13

PSTN
line feeding settings:
Country Specific Instr. 3, 4, 8
power consumption:
Country Specific Instr. 5
technical specifications:
Country Specific Instr. 3

PSTN interface, connector pinout:
Installation 68–70

PSTN interfaces, configuring:
Comm. and Maintenance 49

PSTN mapping:
Country Specific Instr. 15

PSTN unit
connectors:
Installation 67
features:
Product Description 44

Q

Q1 management interface, connector pinout:
Installation 63

Q1 Not Supported:
Comm. and Maintenance B-13

Q1 stack, configuring:
Comm. and Maintenance 31

QINS:
Comm. and Maintenance B-13

Q3 interface:
Comm. and Maintenance 18;
Product Description 43

Q3 management interface, connector pinout:
Installation 64

Q3 stack, configuring:
Comm. and Maintenance 29

R

rack, capacity:
Installation 34

rack alarms:
Comm. and Maintenance 95

rack earthing:
Installation 49

rack grounding:
Installation 49

real time clock:
Comm. and Maintenance 22

receiving data from the node
auto refresh:
Comm. and Maintenance A-14
manually:
Comm. and Maintenance A-14–A-16

recommendations
PSTN mapping:
Country Specific Instr. 15

recommendations, international:
Product Description 67

reconfiguring a node:
Comm. and Maintenance 67

reconnecting to a node:
Comm. and Maintenance A-19

release, definition:
Glossary Glossary-9

Remote Defect Indication:
Comm. and Maintenance B-13

Remote Power Feeding Unit Overload:
Comm. and Maintenance B-13

remote upgrade, cabling:
Installation 95

Restart Time Out:
Comm. and Maintenance B-14

ringing cadences:
Country Specific Instr. 15
routing
cables:
  Installation 11
optical fibres:
  Installation 11
RPFO:
  Comm. and Maintenance  B-13

S
SAN CORE2M unit:
  Installation 77
cartridge extension board connectors:
  Product Description 60
cartridge extension board connectors:
  Product Description 59
cartridge extension board connectors:
  Product Description 59
environmental:
  Product Description 62
mechanical:
  Product Description 59
specifications
  cartridge extension board connectors:
    Product Description 60
  environmental:
    Product Description 62
  mechanical:
    Product Description 59
software downloads:
  Comm. and Maintenance 101
software upgrades:
  Product Description 51
saving node data:
  Comm. and Maintenance  A-15–A-18
scheduled line testing:
  Product Description 13, 26
  commissioning:
    Comm. and Maintenance 14
  commissioning procedure:
    Comm. and Maintenance 15
  commissioning requirements:
    Comm. and Maintenance 14
test types:
  Product Description 15, 16
scheduled line tests
  See also line testing
  creating and editing:
    Comm. and Maintenance 86
  setting threshold values:
    Comm. and Maintenance 88
  viewing results:
    Comm. and Maintenance 88
  viewing summary:
    Comm. and Maintenance 89
Signalling Voltage Failure:
  Comm. and Maintenance  B-14
signalling, V5.1, configuring:
  Comm. and Maintenance 47
signalling, V5.2, configuring:
  Comm. and Maintenance 43
signalling interfaces:
  Product Description 7
software downloads:
  Comm. and Maintenance 101
service switch
  commissioning procedure:
    Comm. and Maintenance 11
  commissioning requirements:
    Comm. and Maintenance 11
  configuring:
    Comm. and Maintenance 61
  configuring cabling:
    Comm. and Maintenance 62
  connecting cables:
    Installation 95–98
  upgrade wiring:
    Installation 95
service protection:
  Product Description 12
serve connector panel:
  Comm. and Maintenance 18
service LEDs, operation:
  Comm. and Maintenance 94
service switch
  commissioning procedure:
    Comm. and Maintenance 11
  commissioning requirements:
    Comm. and Maintenance 11
  configuring:
    Comm. and Maintenance 61
  configuring cabling:
    Comm. and Maintenance 62
  connecting cables:
    Installation 95–98
  upgrade wiring:
    Installation 95
service switching:
  Product Description 12
  general rules:
    Comm. and Maintenance 63–65
shielding foil, grounding:
  Installation 11
signalling, V5.1, configuring:
  Comm. and Maintenance 47
signalling, V5.2, configuring:
  Comm. and Maintenance 43
signal status setting:
  Product Description 7
server signal fail:
  Comm. and Maintenance  B-14
software upgrades:
  Product Description 51
specifications
  cartridge extension board connectors:
    Product Description 60
  environmental:
    Product Description 62
  mechanical:
    Product Description 59
  subrack extension board connectors:
    Product Description 59
sending data to the node:
  Comm. and Maintenance 24, A-14
signalling, V5.2, configuring:
  Comm. and Maintenance 43
specifications, technical
EMC emission:
  Product Description 64
EMC immunity:
  Product Description 63
interfaces:
  Product Description 53
line tests:
  Product Description 57
power consumption:
  Product Description 59
speech settings, configuring:
  Comm. and Maintenance 49
SPO:
  Comm. and Maintenance B-14
stack settings, changing:
  Comm. and Maintenance A-6
Startup Failure:
  Comm. and Maintenance B-15
station alarms:
  Comm. and Maintenance 95
  connecting:
    Installation 19
  disabling:
    Comm. and Maintenance 32–34
  enabling:
    Comm. and Maintenance 32–34
station earthing:
  Installation 47
station ground:
  Installation 47
strain reliefs
  and optical fibres:
    Installation 15
  installing:
    Installation 12
  mounting:
    Installation 11
subrack
  construction:
    Installation 33
  earthing:
    Installation 50
  grounding:
    Installation 50
  installing:
    Installation 33
  installing into Wall Mounting Set:
    Installation 38
  mounting brackets:
    Installation 33, 36
  mounting to rack:
    Installation 34–37
  unit locations:
    Installation 83
subrack extension board:
  Installation 22
subrack extension board connectors, specifications:
  Product Description 59
subrack front cover, installing:
  Installation 108
subracks, Eksos N20:
  Product Description 47
dimensions:
  Product Description 48
subscriber private metering:
  Country Specific Instr. 15
SVF:
  Comm. and Maintenance B-14
symmetrical 2 Mbit/s interface, connector pinout:
  Installation 78
synchronisation, priority:
  Comm. and Maintenance 26
Synchronisation Forced:
  Comm. and Maintenance B-15
synchronisation interfaces, connector pinout:
  Installation 62
synchronisation interfaces (ST, SR), connector pinout:
  Installation 79–81
synchronisation settings, configuring:
  Comm. and Maintenance 26
Synchronisation window:
  Comm. and Maintenance 26
SYNT:
  Comm. and Maintenance B-2, B-3, B-8, B-12, B-17, B-19, B-20, B-21
SYSTEM folder:
  Comm. and Maintenance A-2
system release, definition:
  Glossary Glossary-10
System Release Item List, key:
  System Rel. Notes 8
SYSTEM32 folder:
  Comm. and Maintenance A-3

T

TAE:
  Comm. and Maintenance B-15
terms. See Glossary
TEST:
  Comm. and Maintenance B-7
THC:
Comm. and Maintenance B-15

thermal management

cable trays:
Product Description 50

in cabinets:
Product Description 42

in open racks:
Product Description 40

principles:
Product Description 36-40

Threshold Crossed:
Comm. and Maintenance B-15

threshold values for scheduled tests:
Comm. and Maintenance 88

time slots, viewing:
Comm. and Maintenance 55

Time-out Activation Error:
Comm. and Maintenance B-15

toolbar icons in Node Manager:
Comm. and Maintenance A-12

TOUT:
Comm. and Maintenance B-3, B-8, B-13,
B-14, B-17, B-19, B-20, B-21

TR2M4, use:
Product Description 46

TR2M4 unit
connector pinout:
Installation 72

connectors:
Installation 71

tributary units
adding:
Comm. and Maintenance 99

removing:
Comm. and Maintenance 100

replacing:
Comm. and Maintenance 100

restoring settings:
Comm. and Maintenance 100

troubleshooting:
System Rel. Notes 5

installing Node Manager:
Comm. and Maintenance A-10

operating Node Manager:
Comm. and Maintenance A-19-A-21

typographic conventions:
Guide to Documentation 5

U

upgrading, from C1.1 to C2.0:
System Rel. Notes 3

unbalanced interface:
Installation 93-95

uninstalling a unit:
Comm. and Maintenance 24

Unit Failure:
Comm. and Maintenance B-16

unit locations
in cartridge:
Installation 84

in subrack:
Installation 83

Unit Mismatch:
Comm. and Maintenance B-16

Unit Missing:
Comm. and Maintenance B-16

unit slot coding block:
Installation 82

updating node information:
Comm. and Maintenance 23

upgrading, software from C1.1 to C2.0:
Comm. and Maintenance 101

upgrading software:
Product Description 51

user access levels:
Comm. and Maintenance A-7

setting up:
Comm. and Maintenance A-9

user ports
blocking, unblocking, cancelling:
Comm. and Maintenance 58

configuring:
Comm. and Maintenance 56

Ux 2M window:
Comm. and Maintenance 25

V

V.xx interface, connector pinout:
Installation 74

V5 BCC Protocol Data Link Failure:
Comm. and Maintenance B-16

V5 BCC Protocol Time Out:
Comm. and Maintenance B-17

V5 Common Control Protocol Syntax Error:
Comm. and Maintenance B-17

V5 Control Protocol Data Link Failure:
Comm. and Maintenance B-17

V5 interface
configuring:
Comm. and Maintenance 37
creating:
Comm. and Maintenance 45

deleting:
Comm. and Maintenance 60

editing:
Comm. and Maintenance 60

modifying:
Comm. and Maintenance 60

starting:
Comm. and Maintenance 59

stopping:
Comm. and Maintenance 59

V5 interfaces:
Product Description 7

V5 Link Control Protocol Data Link Failure:
Comm. and Maintenance B-18

V5 Link Control Protocol Error while "Out of Service":
Comm. and Maintenance B-17

V5 Link Control Protocol Layer 3 Address Error:
Comm. and Maintenance B-18

V5 Link Identification Failure:
Comm. and Maintenance B-18

V5 Persistent Link Control Protocol Layer 3 Address Error:
Comm. and Maintenance B-18

V5 Port Control Protocol Error while "Out of Service":
Comm. and Maintenance B-19

V5 Port Control Protocol Layer 3 Address Error:
Comm. and Maintenance B-19

V5 Port Control Protocol Syntax Error:
Comm. and Maintenance B-19

V5 Port Control Protocol Timer Expiration Error:
Comm. and Maintenance B-19

V5 Protection Protocol Data Link Failure:
Comm. and Maintenance B-20

V5 Protection Protocol Syntax Error:
Comm. and Maintenance B-20

V5 Protection Protocol Timer Expiration Error:
Comm. and Maintenance B-20

V5 PSTN Protocol Data Link Failure:
Comm. and Maintenance B-20

V5 PSTN Protocol Layer 3 Address Error:
Comm. and Maintenance B-21

V5 PSTN Protocol Syntax Error:
Comm. and Maintenance B-21

V5 PSTN Protocol Time Out:
Comm. and Maintenance B-21

V5.1 interface
configuring:
Comm. and Maintenance 45

starting:
Comm. and Maintenance 59

V5.1 to V5.2 conversion:
Product Description 8, 24

application requirements:
Product Description 24

V5.1/V5.2 converter
commissioning:
Comm. and Maintenance 9–11

commissioning procedure:
Comm. and Maintenance 10

commissioning requirements:
Comm. and Maintenance 9

V5.2 interface
configuring:
Comm. and Maintenance 37

starting:
Comm. and Maintenance 59

V5.2 multiplexer
commissioning:
Comm. and Maintenance 6

commissioning procedure:
Comm. and Maintenance 7–9

requirements for commissioning:
Comm. and Maintenance 6

V5S:
Comm. and Maintenance B-15

vital signalling:
Comm. and Maintenance 43

Vital Standby signalling:
Comm. and Maintenance 43

voltages, used by PSTN:
Country Specific Instr. 4

W

Wall Mounting Set:
Product Description 50

installing subrack:
Installation 37

weights of units & accessories:
Product Description 61

windows, closing:
Comm. and Maintenance 89

wiring
after service is switched:
Installation 99

service switch:
Installation 95
wrist strap:  
*Installation* 85

\[X\]

X.21 interface, connector pinout:  
*Installation* 75